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IMPORTANT NOTE: Refer to the unit’s rear panel for your Model #. 

Model Number: Description: 

OPTIMOD XPN-AM 
 

OPRIMOD XPN-AM Digital Audio Processor and Loudness Controller Software run-
ning natively on an Intel®-based Windows® computer. Provides AM and HD pro-
cessing. 

 
  

  

 

 

h 

CAUTION 

I 
RISK OF ELECTRIC SHOCK 

DO NOT OPEN 

 

CAUTION: TO REDUCE THE RISK OF ELECTRICAL SHOCK, DO NOT REMOVE COVER (OR BACK). 

NO USER SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL. 

WARNING: TO REDUCE THE RISK OF FIRE OR ELECTRICAL SHOCK,  

DO NOT EXPOSE THIS APPLIANCE TO RAIN OR MOISTURE. 

h 
This symbol, wherever it appears, alerts you to 

the presence of uninsulated dangerous voltage 

inside the enclosure  voltage that may be 

sufficient to constitute a risk of shock. 
I 

This symbol, wherever it appears, alerts you to important 

operating and maintenance instructions in the accompa-

nying literature. Read the manual. 
 

 

In accordance to the WEEE (waste electrical and electronic equipment) di-
rective of the European Parliament, this product must not be discarded into 
the municipal waste stream in any of the Member States. This product may be 
sent back to your Orban dealer at end of life where it will be reused or recy-
cled at no cost to you. 
 
If this product is discarded into an approved municipal WEEE collection site or 
turned over to an approved WEEE recycler at end of life, your Orban dealer 
must be notified and supplied with model, serial number and the name and 
location of site/facility. 
 
Please contact your dealer for further assistance. 
 
 www.orban.com 

 

http://www.orban.com/


 

PLEASE READ BEFORE PROCEEDING! 
Manual 

Please review the Manual, especially the installation section, before installing the unit in your computer. 

Trial Period Precautions  

If your unit has been provided on a trial basis: 
 
You should observe the following precautions to avoid reconditioning charges in case you later wish to return the unit to 
your dealer. 
 
(1) Note the packing technique and save all packing materials. It is not wise to ship in other than the factory carton. (Re-

placements cost $35.00). 
 
(2) Avoid scratching the plating. Set the unit on soft, clean surfaces. 
 
(4) Use care and proper tools in removing and tightening screws to avoid burring the heads. 
 

Packing 

When you pack the unit for shipping: 
 
(1) Wrap the unit in its original plastic bag to avoid marring the unit.  
(2) Seal the carton with tape. 
 
If you are returning the unit permanently (for credit), be sure to enclose: 
 

The Manual(s) 
The Registration/Warranty Card 

 
Your dealer may charge you for any missing items. 
 
If you are returning a unit for repair, do not enclose any of the above items. 
 
Further advice on proper packing and shipping is included in the Manual (see Table of Contents). 

Trouble 

If you have problems with installation or operation: 
 
(1) Check everything you have done so far against the instructions in the Manual. The information contained therein is 

based on our years of experience with OPTIMOD and broadcast stations. 
 
(2) Check the other sections of the Manual (consult the Table of Contents) and search the text to see if there might be 

some suggestions regarding your problem. 
 
(3) After reading the section on Factory Assistance, you may call Customer Service for advice during normal California 

business hours. The number is +1 909.860.6760. 
  



 
  

IMPORTANT SAFETY INSTRUCTIONS 

All the safety and operating instructions should be read before the appliance is operated.  

Retain Instructions: The safety and operation instructions should be retained for future reference.  

Heed Warnings: All warnings on the appliance and in the operating instructions should be adhered to.  

Follow Instructions: All operation and user instructions should be followed.  

Water and Moisture: The appliance should not be used near water (e.g., near a bathtub, washbowl, kitchen sink, laundry tub, in a wet base-

ment, or near a swimming pool, etc.). 

Ventilation: The appliance should be situated so that its location or position does not interfere with its proper ventilation. For example, the appli-

ance should not be situated on a bed, sofa, rug, or similar surface that may block the ventilation openings; or, placed in a built-in installation, such as a 
bookcase or cabinet that may impede the flow of air through the ventilation openings.  

Heat: The appliance should be situated away from heat sources such as radiators, heat registers, stoves, or other appliances (including amplifiers) 

that produce heat.  

Power Sources: The appliance should be connected to a power supply only of the type described in the operating instructions or as marked on 

the appliance.  

Grounding or Polarization: Precautions should be taken so that the grounding or polarization means of an appliance is not defeated. 

Power-Cord Protection: Power-supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or 

against them, paying particular attention to cords at plugs, convenience receptacles, and the point where they exit from the appliance. 

Cleaning: The appliance should be cleaned only as recommended by the manufacturer.  

Non-Use Periods: The power cord of the appliance should be unplugged from the outlet when left unused for a long period of time.  

Object and Liquid Entry: Care should be taken so that objects do not fall and liquids are not spilled into the enclosure through openings. 

Damage Requiring Service: The appliance should be serviced by qualified service personnel when:  The power supply cord or the plug has 

been damaged; or  Objects have fallen, or liquid has been spilled into the appliance; or The appliance has been exposed to rain; or The appliance 
does not appear to operate normally or exhibits  a marked change in performance; or  The appliance has been dropped, or the enclosure damaged. 

Servicing: The user should not attempt to service the appliance beyond that described in the operating instructions. All other servicing should be 

referred to qualified service personnel.  

The Appliance should be used only with a cart or stand that is recommended by the manufacturer. 

Safety Instructions (European) 

Notice For U.K. Customers If Your Unit Is Equipped With A Power Cord. 

WARNING: THIS APPLIANCE MUST BE EARTHED. 

The cores in the mains lead are coloured in accordance with the following code: 

 GREEN and YELLOW - Earth BLUE - Neutral BROWN - Live 

As colours of the cores in the mains lead of this appliance may not correspond with the coloured markings identifying the terminals in your plug, pro-
ceed as follows:  

The core which is coloured green and yellow must be connected to the terminal in the plug marked with the letter E, or with the earth symbol, or col-
oured green, or green and yellow. 

The core which is coloured blue must be connected to the terminal marked N or coloured black. 

The core which is coloured brown must be connected to the terminal marked L or coloured red.  

The power cord is terminated in a CEE7/7 plug (Continental Europe). The green/yellow wire is connected directly to the unit's chassis. If you need to 
change the plug and if you are qualified to do so, refer to the table below. 

WARNING: If the ground is defeated, certain fault conditions in the unit or in the system to which it is connected can result in full line voltage between 
chassis and earth ground. Severe injury or death can then result if the chassis and earth ground are touched simultaneously. 
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Conductor WIRE COLOR 

 Normal Alt 

L LIVE BROWN BLACK 

N NEUTRAL BLUE WHITE 

E EARTH GND GREEN-YELLOW GREEN 

AC Power Cord Color Coding 

 



  

 

Safety Instructions (German) 

Gerät nur an der am Leistungsschild vermerkten Spannung und Stromart betreiben. 

Sicherungen nur durch solche, gleicher Stromstärke und gleichen Abschaltverhaltens ersetzen. Sicherungen nie überbrücken. 

Jedwede Beschädigung des Netzkabels vermeiden. Netzkabel nicht knicken oder quetschen. Beim Abziehen des Netzkabels den  

Stecker und nicht das Kabel enfassen. Beschädigte Netzkabel sofort auswechseln. 

Gerät und Netzkabel keinen übertriebenen mechanischen Beaspruchungen aussetzen. 

Um Berührung gefährlicher elektrischer Spannungen zu vermeiden, darf das Gerät nicht geöffnet werden. Im Fall von Betriebsstörun- 

gen darf das Gerät nur Von befugten Servicestellen instandgesetzt werden. Im Gerät befinden sich keine, durch den Benutzer  

reparierbare Teile. 

Zur Vermeidung von elektrischen Schlägen und Feuer ist das Gerät vor Nässe zu schützen. Eindringen von Feuchtigkeit und  

Flüssigkeiten in das Gerät vermeiden. 

Bei Betriebsstörungen bzw. nach Eindringen von Flüssigkeiten oder anderen Gegenständen, das Gerät sofort vom Netz trennen und  

eine qualifizierte Servicestelle kontaktieren. 

 

Safety Instructions (French) 

On s'assurera toujours que la tension et la nature du courant utilisé correspondent bien à ceux indiqués sur la plaque de l'appareil. 

N'utiliser que des fusibles de même intensité et du même principe de mise hors circuit que les fusibles d'origine. Ne jamais  

shunter les fusibles. 

Eviter tout ce qui risque d'endommager le câble seceur. On ne devra ni le plier, ni l'aplatir. Lorsqu'on débranche l'appareil,  

tirer la fiche et non le câble. Si un câble est endommagé, le remplacer immédiatement. 

Ne jamais exposer l'appareil ou le câble ä une contrainte mécanique excessive. 

Pour éviter tout contact averc une tension électrique dangereuse, on n'oouvrira jamais l'appareil. En cas de dysfonctionnement,  

l'appareil ne peut être réparé que dans un atelier autorisé. Aucun élément de cet appareil ne peut être réparé par l'utilisateur. 

Pour éviter les risques de décharge électrique et d'incendie, protéger l'appareil de l'humidité. Eviter toute pénétration  

d'humidité ou fr liquide dans l'appareil. 

En cas de dysfonctionnement ou si un liquide ou tout autre objet a pénétré dans l'appareil couper aussitôt l'appareil  

de son alimentation et s'adresser à un point de service aprésvente autorisé. 

 

Safety Instructions (Spanish) 

Hacer funcionar el aparato sólo con la tensión y clase de corriente señaladas en la placa indicadora de características. 

Reemplazar los fusibles sólo por otros de la misma intensidad de corriente y sistema de desconexión. No poner nunca los fusibles en  

puente. 

Proteger el cable de alimentación contra toda clase de daños. No doblar o apretar el cable. Al desenchufar, asir el enchufe y no el  

cable. Sustituir inmediatamente cables dañados. 

No someter el aparato y el cable de alimentación a esfuerzo mecánico excesivo. 

Para evitar el contacto con tensiones eléctricas peligrosas, el aparato no debe abrirse. En caso de producirse fallos de funcionamiento,  

debe ser reparado sólo por talleres de servicio autorizados. En el aparato no se encuentra ninguna pieza que pudiera ser reparada por  

el usuario. 

Para evitar descargas eléctricas e incendios, el aparato debe protegerse contra la humedad, impidiendo que penetren ésta o líquidos  

en el mismo. 

En caso de producirse fallas de funcionamiento como consecuencia de la penetración de líquidos u otros objetos en el aparato,  

hay que desconectarlo inmediatamente de la red y ponerse en contacto con un taller de servicio autorizado. 

 

Safety Instructions (Italian) 

Far funzionare l'apparecchio solo con la tensione e il tipo di corrente indicati sulla targa riportante i dati sulle prestazioni. 

Sostituire i dispositivi di protezione (valvole, fusibili ecc.) solo con dispositivi aventi lo stesso amperaggio e lo stesso comportamento  

di interruzione. Non cavallottare mai i dispositivi di protezione. 

Evitare qualsiasi danno al cavo di collegamento alla rete. Non piegare o schiacciare il cavo. Per staccare il cavo, tirare la presa e mai  

il cavo. Sostituire subito i cavi danneggiati. 

Non esporre l'apparecchio e il cavo ad esagerate sollecitazioni meccaniche. 

Per evitare il contatto con le tensioni elettriche pericolose, l'apparecchio non deve venir aperto. In caso di anomalie di funzionamento  

l'apparecchio deve venir riparato solo da centri di servizio autorizzati. Nell'apparecchio non si trovano parti che possano essere riparate  

dall'utente. 

Per evitare scosse elettriche o incendi, l'apparecchio va protetto dall'umidità. Evitare che umidità o liquidi entrino nell'apparecchio. 

In caso di anomalie di funzionamento rispettivamente dopo la penetrazione di liquidi o oggetti nell'apparecchio, staccare immediatamente  

l'apparecchio dalla rete e contattare un centro di servizio qualificato.  



I 

WARNING 

This equipment generates, uses, and can radiate radio-frequency energy. If it is not installed 
and used as directed by this manual, it may cause interference to radio communication. This 
equipment complies with the limits for a Class A computing device, as specified by FCC 
Rules, Part 15, subject J, which are designed to provide reasonable protection against such 
interference when this type of equipment is operated in a commercial environment. Operation 
of this equipment in a residential area is likely to cause interference. If it does, the user will be 
required to eliminate the interference at the user’s expense. 

  

I 

WARNING 

This digital apparatus does not exceed the Class A limits for radio noise emissions from digi-
tal apparatus set out in the radio Interference Regulations of the Canadian Department of 
Communications. (Le present appareil numerique n’emet pas de bruits radioelectriques de-
passant les limites applicables aux appareils numeriques [de las class A] prescrites dans le 
Reglement sur le brouillage radioelectrique edicte par le ministere des Communications du 
Canada.)  
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IMPORTANT 

Perform the installation under static control conditions. Simply walking across a rug can gen-
erate a static charge of 20,000 volts. This is the spark or shock you may have felt when 
touching a doorknob or some other conductive surface. A much smaller static discharge is 
likely to destroy one or more of the CMOS semiconductors employed in OPTIMOD. Static 
damage will not be covered under warranty. 

There are many common sources of static. Most involve some type of friction between two 
dissimilar materials. Some examples are combing your hair, sliding across a seat cover or 
rolling a cart across the floor. Since the threshold of human perception for a static discharge 
is 3000 volts, you will not even notice many damaging discharges. 

Basic damage prevention consists of minimizing generation, discharging any accumulated 
static charge on your body or workstation, and preventing that discharge from being sent to or 
through an electronic component. You should use a static grounding strap (grounded through 
a protective resistor) and a static safe workbench with a conductive surface. This will prevent 
any buildup or damaging static. 

 

XPN-AM Software © copyright Rorb Inc. (Robert Orban, President and Chief Engineer).  
Distributed and supported by Orban Labs Inc. under license. 
 
Orban® and Optimod® are registered trademarks. The Orban, Optimod, and PreCode™ trademarks appearing in the 
manual and in the product are used under license from Circuit Research Labs Inc. All trademarks are property of their 
respective companies.  
 
Published September 2020. 
 
This manual © copyright Rorb Inc. This manual may be freely printed out and distributed if this copyright notice is not 
removed. However, no derivative works may be made from the contents of this manual without written permission from 
Rorb Inc. 
 
Thanks go to Greg Ogonowski of Modulation Index LLC for many of the tutorial diagrams in this manual. 
 

 

Orban Labs Inc., 7209 Browning Road, Pennsauken NJ 08110 USA 
Phone: +1 856.719.9900; E-Mail: custserv@orban.com; Site: www.orban.com 
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 Section 1 

 Introduction 
 

CAUTION: To enable the XPN-AM software to exploit the full power of its Intel CPU 
while ensuring smooth, uninterrupted operation, hardware products incorporating 
OPTIMOD XPN-AM ship from the factory with a specific Windows operating system 
and software configuration. DO NOT RECONFIGURE THE OPERATING SYSTEM 
AND/OR INSTALL ADDITIONAL SOFTWARE UNLESS INSTRUCTED TO DO SO BY THE 
VENDOR OF YOUR SYSTEM OR BY SPECIFIC INSTRUCTIONS IN THIS MANUAL. Doing 
so may cause the system to operate improperly and will make Technical Support 
unavailable to you because we cannot support non-tested OS configurations and 
third-party software. 

I 

  

About this Manual  

NOTE: IN ADDITION TO SUPPORTING A HARDWARE VERSION OF XPN-AM, THIS 
MANUAL REFERS TO A SOFTWARE-ONLY VERSION OF XPN-AM, WHICH IS NOT 
CURRENTLY OFFERED FOR SALE. 

The Adobe pdf form of this manual contains numerous hyperlinks and bookmarks. A 
reference to a numbered step or a page number (except in the Index) is a live hyper-
link; click on it to go immediately to that reference. 

To help you find the information you need, this manual has an index (starting on 
page 7-1) and a Table of Contents. To search for a specific word or phrase, you can 
also use the Adobe Acrobat Reader’s text search function. 

 Section 1 contains general information about OPTIMOD XPN-AM and describes 
how to use it in your specific application. The most important material for typi-
cal users appears first. OPTIMOD XPN-AM uses the contemporary concept of 
“target loudness” (per ITU-R BS.1770), so the output level control works differ-
ently than you might expect (it adjusts output peak headroom but not loud-
ness), and the explanation of target loudness (Setting Loudness starting on page 
1-29) is important to understand. 

 Section 2 explains how to install and set up OPTIMOD XPN-AM. 

 Section 3 explains how to customize OPTIMOD XPN-AM’s sound to your re-
quirements and contains descriptions of all tuning controls for the audio pro-
cessing. 
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 Section 4 describes the software that implements OPTIMOD XPN-AM’s function-
ality. 

 Section 5 documents OPTIMOD XPN-AM’s control API. 

 Section 6 contains OPTIMOD XPN-AM’s specifications. 

 Section 7 is the Index. 

The OPTIMOD XPN-AM Digital Audio Processor 

Orban's all-digital OPTIMOD XPN-AM Audio Processor can help you achieve the 
highest possible quality in AM shortwave, medium wave and long wave broadcast 
sound. OPTIMOD-AM delivers louder, cleaner, brighter, FM-like audio with an open, 
fatigue-free quality that attracts listeners and holds them. Because all processing is 
performed by high-speed mathematical calculations, the processing has cleanliness, 
quality, and stability over time and temperature that is unmatched by analog pro-
cessors. 

The XPN-AM supports iBiquity’s HD AM® in-band on-channel digital ra-
dio system. The digital radio processing can also be used for simulcast 
netcasts or DRM digital broadcasts. In this manual, the processing for 
these applications will be referred to as “HD AM” processing, even 
though HD AM is only one application. 

OPTIMOD XPN-AM is descended from the industry-standard 9100 and 9200 
OPTIMOD-AM audio processors. Thousands of these processors are on the air all over 
the world. They have proven that the “OPTIMOD sound” attracts and keeps an au-
dience even in the most competitive commercial environment. 

Because OPTIMOD-AM incorporates several audio processing innovations exclusive to 
Orban products, you should not assume that it can be operated in the same way as 
less sophisticated processors. If you do, you may get disappointing results. 

Take a little time now to familiarize yourself with OPTIMOD-AM. A small investment 
of your time now will yield large dividends in audio quality. 

OPTIMOD-AM was designed to process for the limitations of the average car or table 
radio and for today’s noisy RF environments. Because such processing can make au-
dible many defects ordinarily lost in the usual sea of AM mud, it is very important 
that the source audio be as clean as possible. Orban's publication Maintaining Audio 
Quality in the Broadcast Facility (available in .pdf form from ftp.orban.com) contains 
valuable information and specific suggestions for improving the quality of your au-
dio. 

The rest of Section 1 explains how OPTIMOD-AM fits into the AM broadcast facility. 
Section 2 explains how to install it and set it up. Section 3 tells how to operate 
OPTIMOD-AM. Sections 4 through 6 provide reference information. 

ftp://ftp.orban.com/
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For best results, feed OPTIMOD-AM unprocessed audio. No other audio processing is 
necessary or desirable. 

If you wish to place level protection prior to your studio / transmitter link (STL), use 
an Orban studio level control system expressly designed for this purpose. (At the 
time of this writing, this is the Orban 8200ST OPTIMOD-Studio Compressor/limiter / 
HF Limiter / Clipper.) The 8200ST can be adjusted so that it substitutes for the 
broadband AGC circuitry in OPTIMOD-AM, which is then defeated. 

Audio Input/output Facilities 

For audio I/O, OPTIMOD XPN-AM software uses Windows sound devices, which ap-
pear in the Windows Sound Control Panel. XPN-AM hardware comes with input and 
output sound devices installed and configured for typical usage. The base unit in-
cludes an Optimod-PC 1101e card, which is suitable for analog AM processing and 
(at your option) a ratings encoder loop-through. The 1101e card includes a DSP-
based Optimod-class audio processor that can be used for streaming or for a low-
delay headphone feed1. The 1101e can support mono operation and a ratings en-
coder loop-through. 

HD systems require using multichannel I/O (2-channel input and 6-channel output, 
called “5.1” in Windows, to maintain a sample-accurate delay difference between 
the analog AM and HD outputs. On output, Lf/Rf emits the AM analog output and 
Ls/Rs emits the HD output. HD support requires the optional RME HDSPe AES card. 
The RME’s additional hardware I/O can be used for other software, like Optimod-
PCn 1600 and/or a streaming encoder. 

For Audio-Over-IP I/O, we recommend Dante, although you may use any brand that 
provides a Windows virtual soundcard driver. To prevent glitching and delay build-
up, the internal clocks of all hardware audio I/O devices must be locked to the same 
master clock as the AoIP network. The standard 1101e card provides a wordclock 
reference input for this purpose, as does the RME HDSPe AES. 

Instructions for I/O setup are found in Hardware I/O Setup starting on page 2-15. 

Hardware and Software Requirements 

The OPTIMOD XPN-AM system consists of a core audio processing engine and a 
graphical interface application (called XPN-AM_PC) to control the audio processing 
engine. The core audio processing engine is a Windows Service (called Opti-
mod_XPN_AM_Service). It is copy-protected by a hardware security key plugged into 
a USB port on the host computer. 

                                                      

1 Because of its advanced processing, the delay through XPN-AM is approximately 
one second, making it unusable for driving DJ headphones 
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XPN-AM PC is an application that can run on the same computer as the OPTIMOD 
XPN-AM Service or on any computer connected to the same network. Only the Ser-
vice is copy-protected; your software license allows you to install as many copies of 
XPN-AM PC on as many computers as you wish. Only one instance of XPN-AM PC can 
be connected to a given audio processor at any one time,  

OPTIMOD XPN-AM requires a substantial amount of computing power. To achieve 
most reliable, glitch-free operation, it must be used with carefully selected and con-
figured hardware. The factory-supplied XPN-AM hardware was selected and config-
ured accordingly. 

Operating System 

Windows 10 LTSC (Long-Term Servicing Channel), which is specifically intended for 
embedded systems and which does not update itself without permission. 

 Do not run general-purpose programs (like Microsoft Office) on the same com-
puter. 

 Turn off Windows Defender or other anti-malware software. 

Do not use the computer running the OPTIMOD XPN-AM Service for web 
browsing or email. 

 You may run approved audio playout systems (like Modulation Index’s RadioDJ) 
and approved streaming encoder software (like StreamS Live Encoder). 

 We recommend interconnecting the playout software, OPTIMOD XPN-AM, and 
the encoder via hardware I/O, where all hardware is synced to the same refer-
ence clock (such as wordclock) 

While we had previously recommended Virtual Audio Cable for intercon-
nection, experience has since shown that this can cause the input/output 
delay to slowly increase because VAC gets its clock reference from the 
computer motherboard and cannot be synced to a hardware sound de-
vice or wordclock. This issue causes a slight difference in sample rate be-
tween VAC and the hardware device(s), which manifests itself as a build-
up of delay VAC can only be used safely with a given application if that 
application uses VAC for both input and output and you are using the 
current version of VAC.  

 In Windows CONTROL PANEL > ALL CONTROL PANEL ITEMS > PERFORMANCE 

INFORMATION AND TOOLS > PERFORMANCE OPTIONS, choose ADJUST FOR BEST 

PERFORMANCE. 

 Turn off Windows Automatic Updates, as these can force the computer to re-
boot and interrupt audio.  

 Turn off Windows Sounds. 

 Turn off Fast Startup. 
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CPU 

OPTIMOD XPN-AM requires a genuine Intel i3, i5, or i7, CPU, 6th-generation or high-
er. OPTIMOD XPN-AM uses the Intel AVX2 vector floating point instruction set to 
achieve the required computational efficiency. 

Although the operating system may quickly switch a given audio Processor between 
CPU cores, each Processor spawned by the Service cannot exploit more CPU resources 
than are available for a single core, which may be a Hyperthreaded core. On the 
other hand, several Processors can share one core if that core has enough resources 
to run them all smoothly.  

Depending on your CPU, in addition to XPN-AM you could run one or more instanc-
es of Optimod 1600PCn software for streaming. The standard XPN-AM hardware can 
support one to two instances of 1600PCn software. The main determining factors 
are whether the 1600PCn’s MX peak limiter is activated, and whether the MX limiter 
(if activated) uses SOFT or HARD overshoot compensation.  

Refer to the corresponding table in the 1600PCn manual for the CPU re-
quirements of 1600PCn instances in various operating configurations. 

If you use Hyperthreading (which we recommend), be aware that one physical CPU 
core divides its available resources between two Hyperthreaded cores, and Table 1-1 
indicates the physical resources that are required for XPN-AM instances. 

Intel claims that two Hyperthreaded cores can provide as much as 1.3 
times the processing power available from their host physical core in non-
Hyperthreaded mode. As this is application- and OS-dependent, you will 
have to experiment to see how much (if any) performance bonus you get 
from Hyperthreading in your hardware. 

When you are running four or more processors, the CPU requirements are slightly 
higher (by about 8%) to compensate for the fact that the CPU’s memory cache is 
shared among the various processors. 

When heavily loaded by multiple processors, the CPU will generate a significant 
amount of heat. Be sure that the computer is located in a temperature-controlled 
environment. Insufficient cooling can shorten the life of the CPU and can cause its 
clock speed to be throttled back automatically and unexpectedly, limiting the num-
ber of Processors than it can run without glitching. 

I 
 

Processing Configuration            Per-core Clock (GHz) for 100% utilization 

[Note: requirements are approximate and 
can vary with system configuration.] 

 
6

th
-gen i7 

(AVX2) 

AM analog + HD (no MX)  3.3 GHz 

AM analog + HD (soft MX)  3.9 GHz 

AM analog  2.4 GHz 
 

Table 1-1 
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Summary of OPTIMOD XPN-AM’s Features  

The list of features below pertains only to the OPTIMOD XPN-AM audio processor 
and does not include the features of StreamS Live software, which may also be in-
stalled in the XPN-AM hardware. 

Making the Most of the AM Channel 

 The XPN-AM is suitable for long wave, medium wave, and shortwave (HF) broad-

casts. 

 OPTIMOD-AM rides gain over an adjustable range of up to 25dB, compressing 

dynamic range and compensating for operator gain-riding errors and for gain in-

consistencies in automated systems. 

 OPTIMOD-AM increases the density and loudness of the program material by 

multiband limiting and multiband distortion-canceling clipping, improving the 

consistency of the station's sound and increasing loudness and definition without 

producing audible side effects. 

 OPTIMOD-AM precisely controls peak levels to prevent overmodulation. Asym-

metry in the analog processing channel peak limiter is adjustable from 100% to 

150% positive peak modulation. 

 OPTIMOD-AM supports the XPERI HD Radio® system. The HD AM processor shares 

the phase rotator, stereo synthesizer, mono bass processor, stereo enhancer, 

phase corrector, and AGC with the AM analog processor. Following the AGC, the 

signal path splits into HD and AM chains. The HD chain is an independent pro-

cessing chain with its own set of user-adjustable parameters, including audio 

bandwidth that is separately adjustable from the AM processing’s bandwidth. To 

ensure source-to-source consistency, the HD processing includes full five-band 

compression/limiting that is independent of the five-band compression/limiting 

in the analog processing chain. This output can also be used for netcasts.  

 

OPTIMOD-AM provides up to 12 seconds of built-in, calibrated HD Radio diversity 

delay. It can be remote-controlled via the XPN-AM’s Telnet API, allowing you to 

interface closed-loop delay adjustment hardware. Both “instantaneous” and 

“ramp” modes are available for changing the delay. Small delay changes are ap-

plied to the HD chain so they cannot cause artifacts in the analog AM channel. 

 OPTIMOD-AM controls audio bandwidth as necessary to accommodate the 

transmitted sampling frequency, obviating the need for extra, overshooting anti-

aliasing filters in downstream equipment. The AM processing chain’s bandwidth 

is adjustable from 3.0 kHz to 9.5 kHz (NRSC). The HD high frequency bandwidth 

is adjustable from 10.0 kHz and 20 kHz. 20 kHz is appropriate for high bitrate 

streaming. 15 kHz codec bandwidth may help low bitrate lossy codecs sound bet-
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ter than they do when fed full 20 kHz bandwidth audio, and is well matched to 

the codec used the HD-AM system 

 OPTIMOD-AM compensates for the high- and low-frequency rolloffs of typical AM 

receivers with a fully adjustable program equalizer providing up to 20dB of high-

frequency boost (at 5 kHz) without producing the side effects encountered in 

conventional processors. This equalizer can thus produce extreme pre-emphasis 

that is appropriate for very narrow-band radios. OPTIMOD-AM's fully parametric 

low- and mid-frequency equalizers allow you to tailor your air sound to your pre-

cise requirements and desires. OPTIMOD-AM also fully supports the NRSC stand-

ard pre-emphasis curve. 

 OPTIMOD-AM is a stereo processor that fully protects CQUAM® transmissions, 

conservatively complying with Motorola’s processing requirements that negative 

peak modulation on the left and right channels be limited to –75% modulation. 

General Features  

 Optimod-quality digital audio processing, running natively on an Intel x86 com-

puter, pre-processes audio for consistency and loudness before it is transmitted 

or recorded. 

 Includes AM mono, AM stereo, and HD Radio/netcast processing. Additional 

streaming processors can also be run on the same hardware. 

 Incorporates modern “target loudness” concepts (including those specified in 

EBU R128 and ATSC A/85) using the ITU-R BS.1770 loudness model. Allows you to 

easily set and verify the target loudness of the output. 

 The audio processor runs as a Windows Service on its host computer, so it will 

start automatically with Windows and run reliably in the background.   

 A responsive, smooth, easy-to-use graphic control application runs on local or 

remote PCs and can control any number of OPTIMOD XPN-AM audio Processors, 

either locally (via a localhost TCP/IP connection) or in other XPN-AMs on your 

network via TCP/IP addressing. The Control application allows you complete flex-

ibility to create your own custom presets, to save as many as you want to your 

local hard drive, and to recall them at will. 

 By use of third party Windows Audio drivers, is compatible with audio-over-IP 

input/output (such as Ravenna®, LiveWire®, Dante®, and WheatNet®). 

 Compatible with all Windows sound devices with stable drivers supporting the 

Windows WASAPI standard. (WASAPI stands for Windows Audio Session API and 

was first introduced in Windows Vista.) 
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 PreCode™ technology manipulates several aspects of the audio to minimize arti-

facts caused by low bitrate codecs, ensuring consistent loudness and texture 

from one source to the next. PreCode includes special audio band detection al-

gorithms that are energy and spectrum aware. This can improve codec perfor-

mance on some codecs by reducing audio processing induced codec artifacts, 

even with program material that has been preprocessed by other processing 

than Optimod. 

 Intended for program equalization, a sweepable gentle-slope lowpass filter (6 to 

24 dB / octave) is available in addition to the sharp-cutoff lowpass filter.  

 For specialized purposes like speech processing, a sweepable highpass filter with 

four selectable slopes (6 to 24 dB / octave) is available. Music and speech modes 

have separate cutoff frequencies and slopes, so the automatic speech/music de-

tector can change filter characteristics. 

 The highpass and lowpass program equalizer filters provide click-free switching 

of their cutoff frequencies, so they these may be changed in the middle of pro-

gram material. 

 A DC removal filter with a 0.1 Hz −3 dB low frequency cutoff removes DC offset 

from source material without introducing overshoot and tilt into low-frequency 

waveforms. 

 OPTIMOD XPN-AM ships with many standard presets, designed to accommodate 

almost any programming format. Separately optimized factory presets are avail-

able for the AM and HD processing chains; these can be mixed and matched as 

desired. 

 A Bypass Test Mode facilitates broadcast system test and alignment or “proof of 

performance” tests.  

 OPTIMOD XPN-AM contains a built-in line-up tone generator, facilitating quick 

and accurate level setting in any system. Low-distortion sinewave, non-

overshooting squarewave, and high-precision pink noise test signals are available.  

Audio Processing Features 

 OPTIMOD XPN-AM can increase the density and loudness of the program materi-

al by multiband compression and sophisticated peak limiting, improving the con-

sistency of the station’s sound and increasing loudness and definition remarka-

bly, without producing unpleasant side effects. 

 Automatic left/right phase-skew corrector can eliminate comb-filtering artifacts in 

a mono downmix of stereo source material. This is particularly important for 

mono AM transmissions. 
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 Bass can be made monophonic, with crossover frequencies of 80 or 100 Hz. 

 Two-Band automatic gain control with a phase-linear crossover, adjustable band 

coupling, and window gating compensates for widely varying input levels. The 

AGC rides gain over an adjustable range of up to 25dB, compressing dynamic 

range and compensating for operator gain-riding errors and for gain inconsist-

encies in automated systems 

 Five-Band compression provides a consistent, “processed” sound, free from un-

desirable side effects.  

 

Band-coupling controls allow the gain differences between adjacent bands of 

the five-band compressor to be constrained to any desired value, allowing you 

to preserve as much of the frequency balance of the original program material as 

desired unless doing so would otherwise cause objectionable spectral gain in-

termodulation artifacts. Combined with the phase-linear crossover, this func-

tionality can be used in lieu of the two-band compression found in earlier Opti-

mods.  

 

Parametric soft-knee compression curves with adjustable ratio allow you to fine-

tune the audio to your exact requirements. 

 Stereo Enhancer is based on Orban’s patented analog 222 Stereo Enhancer, 

which increases the energy in the stereo difference signal (L−R) whenever a tran-

sient is detected in the stereo sum signal (L+R). Gating circuitry prevents over-

enhancement and undesired enhancement on slightly unbalanced mono materi-

al. 

 Shelving bass equalizer and four-band parametric equalizer let you color the au-

dio to your exact requirements. To facilitate A/B comparisons, equalizers can be 

bypassed individually and globally. 

 Dynamic High-Frequency Enhancer constantly monitors the ratio of HF to broad-

band energy in the incoming audio and can automatically re-equalize it to 

achieve a target balance between broadband and HF energy. 

 Orban’s exclusive MX peak limiter technology uses a psychoacoustic model to 

achieve an unprecedentedly favorable tradeoff between loudness, transient 

punch, and distortion artifacts.  

 

MX limiting is always used in the AM processing chain and can be activated in 

the HD chain. [For HD or streaming applications where target loudness is below 

approximately −12 LKFS/LUFS, you can reduce CPU load (and with it, heat gener-

ation and power consumption) by defeating the MX limiter and instead using 

our smooth, low-IM look-ahead limiter for the light peak limiting required at 

these low loudness levels.]  
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In all modes of operation, the peak limiter offers “true peak” control by over-

sampling the peak limiter’s sidechain at 192 kHz or higher. This allows OPTIMOD 

XPN-AM to prevent clipping in a playback device’s analog signal path by predict-

ing and controlling the analog peak level following the playback device’s recon-

struction filter.  

 

Without true peak control, analog clipping can occur even if all peak values of 

the digital samples are below 0 dBFS. This phenomenon has also been termed 

“0 dBFS+.”  

 

Thanks to true peak control, sample rate conversion, unless it removes high fre-

quency program energy or introduces group delay distortion, cannot cause sam-

ple peaks to increase more than 0.5 dB in the HD chain (20 kHz bandwidth) and 

0.3 dB in the AM chain (9.5 KHz bandwidth). For example, sample rate conver-

sion from 48 kHz to 44.1 kHz is highly unlikely to cause sample peak clipping in 

the 44.1 kHz audio data.  

 

Accuracy is typically 0.15 dB even with heavy peak limiting, so the output level 

can be set to −0.2 dBFS without true peak levels exceeding 0 dBFS. 

 Orban Stereo Synthesizer with excellent downmix compatibility. “Wide” and 

“narrow” modes (based on Orban’s classic analog 275A Stereo Synthesizer) can 

create an attractively spacious stereo output from mono program material. Syn-

thesis can be invoked manually, or activated automatically by sensing silence in 

the right channel input. It is possible to apply stereo synthesis to the HD pro-

cessing only. 

 BS.1770-4 and CBS Loudness Meters™ measure the subjective loudness of the 

XPN-AM’s outputs and are displayed in the XPN-AM’s control application meter 

window. There are separate loudness meters for the AM and HD chains. The AM 

chain’s loudness meters are preceded by a filter that simulates the frequency re-

sponse of a typical AM radio. 

 OPTIMOD XPN-AM includes third-generation CBS Loudness Controllers™ in the 

HD processing chain. The third-generation improvements reduce annoyance 

more than simple loudness control alone, doing so without audible gain pump-

ing. Attack time is fast enough to prevent audible loudness overshoots, so the 

control is smooth and unobtrusive. Material processed by the CBS Loudness Con-

troller has been shown to be well controlled when measured with a long-term 

loudness meter using the BS.1770 standard. (See Appendix A: Using the ITU 

BS.1770 and CBS Loudness Meters to Measure Loudness Controller Performance 

starting on page 3-67.) 

 A BS.1770 Safety Limiter follows the CBS Loudness Controller in the HD chain, 

When activated, it can further improve the measured performance using the 

BS.1770 meter and which was added for the benefit of organizations with strict 
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objective limits on the indication of a BS.1770-4 meter regardless of the actual 

subjective loudness as determined by human listeners. 

 Uses “multirate” digital signal processing. Internal processing always occurs at 

sample rates from 48 kHz to 256 kHz as needed. 

 Uses 32-bit or 64-bit floating-point arithmetic as appropriate. Can interface to 16-

bit and 24-bit Windows audio devices. 

 

Audio Processing for HD and Netcasts 

Professional-grade HD broadcasting and netcasting require audio processing similar 
to FM broadcast, although there are some important differences in the peak limiting 
because of the different characteristics of the pre-emphasized FM channel and the 
perceptually coded netcasting channel. In particular, netcasting to mobile devices 
benefits from audio processing to overcome external noise. 

Your listeners deserve to get the best quality and consistency you can provide. Good 
audio processing is one important thing that separates the amateur from the profes-
sional. 

Conventional AM, FM, or TV audio processors that employ preemphasis/deemphasis 
and/or clipping peak limiters do not work well with perceptual audio coders such as 
Modulation Index’s SteamS MPEG-4 AAC/HE-AACv2 streaming encoder. The 
preemphasis/deemphasis limiting in these processors unnecessarily limits high fre-
quency headroom. Further, their clipping limiters create high frequency compo-
nents—distortion—that the perceptual audio coders would otherwise not encode. 
None of these devices have the full set of audio and control features found in 
OPTIMOD XPN-AM. 

Peak clipping sounds bad even in uncompressed digital channels because these 
channels do not rely on preemphasis/deemphasis to reduce audible distortion. In-
stead of peak clipping, OPTIMOD XPN-AM’s HD processing gives you a choice of low-
IM look-ahead limiting or advanced MX limiting technology (which includes look-
ahead elements) to protect the following channel from peak overload. 

Location of OPTIMOD-AM 

Optimal Control of Peak Modulation Levels  

The analog AM audio processing circuitry in OPTIMOD-AM produces a waveform 
that is precisely peak-controlled to prevent overmodulation, and is lowpass filtered 
to protect adjacent channels and to conform to government regulations. Severe 
changes in the shape of the waveform can be caused by passing it through a circuit 
with non-constant group delay and/or non-flat frequency response in the 30-9500Hz 
range. Deviation from flatness and phase-linearity will cause spurious modulation 
peaks because the shape of the peak-limited waveform is changed. Such peaks add 
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nothing to average modulation. Thus, the average modulation must be lowered to 
accommodate those peaks so that they do not overmodulate. Transformers can 
cause such problems. 

Landline equalizers, transformers, and low-pass filters in transmitters typically intro-
duce frequency response errors and non-constant group delay. There are three crite-
ria for preservation of peak levels through the audio system: 

 
1) The system group delay must be essentially constant throughout the frequency 

range containing significant energy (30-9,500Hz). If low-pass filters are present, 

this may require the use of delay equalization. The deviation from linear-phase 

must not exceed 1 from 30-9,500Hz. 

2) The low-frequency 3 dB point of the system must be placed at 0.15Hz or lower 

(this is not a misprint!). This is necessary to ensure less than 1% overshoot in a 

50Hz square wave and essentially constant group delay to 30Hz. 

3) Any pre-emphasis used in the audio transmission system prior to the transmitter 

(such as in an STL) must be canceled by a precisely complementary de-emphasis: 

Every pole and zero in the pre-emphasis filter must be complemented by a zero 

and pole of identical complex frequency in the de-emphasis network. An all-pole 

de-emphasis network (like the classic series resistor feeding a grounded capaci-

tor) is not appropriate. 

In this example, the network could be fixed by adding a second resistor between 
ground and the capacitor, which would introduce a zero. 

Low-pass filters (including anti-aliasing filters in digital links), high-pass filters, trans-
formers, distribution amplifiers, and long transmission lines can all cause the above 
criteria to be violated, and must be tested and qualified. It is clear that the above 
criteria for optimal control of peak modulation levels are met most easily when the 
audio processor directly feeds the transmitter. While OPTIMOD-AM’s transmitter 
equalizer can mitigate the effects of group delay and frequency response errors in 
the signal path, an accurate path will still achieve the best results. 

The output of the digital radio-processing path is also precisely peak-controlled at 
the XPN-AM’s output. However, the HDC codec used in the HD AM system and the 
xHE-AAC codec used in the DRM system, like all low bitrate lossy codecs, introduce 
considerable overshoots as a side effect of throwing away data. When you adjust 
the drive level into the codec, it is wise to monitor the output of a radio or modula-
tion monitor and to reduce the drive level to the codec until you no longer see clip-
ping. 

Best Location for OPTIMOD-AM 

The best location for OPTIMOD-AM is as close as possible to the transmitter so that 
its output can be connected to the transmitter through a circuit path that introduces 
the least possible change in the shape of OPTIMOD-AM’s carefully peak-limited 
waveform. This connection could be short lengths of shielded cable (for transmitters 
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with analog inputs) or a direct AES3 connection (if the transmitter has a digital input 
available). If this is impossible, the next best arrangement is to feed the XPN-AM’s 
AES3 digital output through an all-digital, uncompressed path to the transmitter's 
exciter.  

If the programming agency’s jurisdiction ends at the link connecting the audio facili-
ty to the transmitter, a variety of problems can occur downstream. (The link might 
be telephone / post lines, analog microwave radio, or various types of digital paths.) 
The link, the transmitter peak limiters, or the transmitter itself can all introduce arti-
facts that a studio-located audio processor cannot control. 

If the transmitter is not accessible: 

All audio processing must be done at the studio and you must tolerate any damage 
that occurs later. If an uncompressed AES3 digital link is available to the transmitter, 
this is an excellent, accurate means of transmission. However, if the digital link em-
ploys lossy compression, it will disturb peak levels by up to 4 dB. Lossy compression is 
also inappropriate for another reason: it cannot accommodate pre-emphasized au-
dio (like OPTIMOD-AM‘s output) without introducing serious artifacts. 

Unlike FM, where the transmitter usually can be set up to provide pre-emphasis, AM 
transmitters are universally “flat.” Therefore, unlike FM, there is no option when 
using lossy compression to de-emphasize at the output of OPTIMOD-AM and then to 
restore the pre-emphasis at the transmitter. The best one can do is to use NRSC pre-
emphasis, apply NRSC de-emphasis before the lossy link’s input, and then re-apply 
NRSC pre-emphasis at the link’s output. 

If only an audio link is available, use the XPN-AM’s left and right audio outputs and 
feed the audio directly into the link. If possible, request that any transmitter protec-
tion limiters be adjusted for minimum possible action — OPTIMOD-AM does most of 
that work. Transmitter protection limiters should respond only to signals caused by 
faults or by spurious peaks introduced by imperfections in the link. To ensure maxi-
mum quality, all equipment in the signal path after the studio should be carefully 
aligned and qualified to meet the appropriate standards for bandwidth, distortion, 
group delay and gain stability, and such equipment should be re-qualified at rea-
sonable intervals. (See Optimal Control of Peak Modulation Levels on page 1-11). 

If the transmitter is accessible: 

You can achieve the most accurate control of modulation peaks by locating 
OPTIMOD-AM at the transmitter site or by connecting it to the transmitter through 
an uncompressed digital STL.  

Because OPTIMOD-AM controls peaks, it is irrelevant whether the audio link feeding 
OPTIMOD-AM’s input terminals is phase-linear. However, the link should have low 
noise, the flattest possible frequency response from 30-9,500, and low nonlinear dis-
tortion. 
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Studio-Transmitter Link 

Transmission from Studio to Transmitter 

There are several types of studio-transmitter links (STLs) in common use in broadcast 
service: uncompressed digital, digital with lossy compression (like MPEG, Dolby®, or 
APT-x®), microwave, analog landline (telephone / post line), and audio subcarrier on 
a video microwave STL. 

STLs in AM service are used in two fundamentally different ways. They can either: 

 pass unprocessed audio for application to the XPN-AM’s input, or 

 pass the XPN-AM’s peak-controlled analog or digital left and right audio outputs 

for application to the transmitter. 

These applications have different performance requirements. In general, a link that 
passes unprocessed audio should have very low noise and low nonlinear distortion, 
but its transient response is not important. A link that passes processed audio does 
not need as low a noise floor as a link passing unprocessed audio. However, its tran-
sient response is critical. At the current state of the art, an uncompressed digital link 
using digital inputs and outputs to pass audio in left/right format achieves best re-
sults. We will elaborate below. 

Digital Links 

Digital links may pass audio as straightforward PCM encoding or they may apply los-
sy data reduction processing to the signal to reduce the number of bits per second 
required for transmission through the digital link. Such processing will almost invar-
iably distort peak levels; such links must therefore be carefully qualified before you 
use them to carry the peak-controlled output of the XPN-AM to the transmitter. For 
any lossy compression system the higher the data rate, the less the peak levels will 
be corrupted by added noise, so use the highest data rate practical in your system. 

As stated above, links using lossy data reduction cannot pass an OPTIMOD-AM–
processed signal. However, it is practical (though not ideal) to use lossy data reduc-
tion to pass unprocessed audio to the XPN-AM’s input. The data rate should be at 
least of “contribution quality” — the higher, the better. If any part of the studio 
chain is analog, we recommend using at least 20-bit A/D conversion before encod-
ing. Because the XPN-AM uses multiband limiting, it can dynamically change the 
frequency response of the channel. This can violate the psychoacoustic masking as-
sumptions made in designing the lossy data reduction algorithm. Therefore, you 
need to leave “headroom” in the algorithm so that the XPN-AM’s multiband pro-
cessing will not unmask quantization noise. This is also true of any lossy data reduc-
tion applied in the studio (such as hard disk digital delivery systems). 

For MPEG Layer 2 encoding, we recommend 384 kB/second or higher. 

Some links may use straightforward PCM (pulse-code modulation) without lossy data 
reduction. If you connect to these through an AES3 digital interface, these can be 
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very transparent if they do not truncate the digital words produced by the devices 
driving their inputs. Because the XPN-AM’s AM analog-processed output is tightly 
band-limited to 9.5 kHz or below and its digital radio output is tightly band-limited 
to 15 kHz, any link with 32 kHz or higher sample frequency can pass either output 
without additional overshoot.  

Currently available sample rate converters use phase-linear filters (which have con-
stant group delay at all frequencies). Sample rate conversion, whether upward or 
downward, will not add overshoot to the signal if it does not remove spectral ener-
gy from the original signal. 

If the link does not have an AES3 input, you must drive its analog input from the 
XPN-AM’s analog output. This is less desirable because the link’s analog input cir-
cuitry may not meet all requirements for passing processed audio without over-
shoot.  

NICAM is a sort of hybrid between PCM and lossy data reduction systems. It uses a 
block-companded floating-point representation of the signal with J.17 pre-
emphasis. 

Older technology converters (including some older NICAM encoders) may exhibit 
quantization distortion unless they have been correctly dithered. Additionally, they 
can exhibit rapid changes in group delay around cutoff because their analog filters 
are ordinarily not group-delay equalized. The installing engineer should be aware of 
all of these potential problems when designing a transmission system. 

Any problems can be minimized by always driving a digital STL with an AES3 digital 
output, which will provide the most accurate interface to the STL. The XPN-AM’s 
digital input and output accommodate sample rates of 32 kHz, 44.1 kHz, 48 kHz, 
88.2 kHz, and 96 kHz. 

Dual Microwave STLs 

Dual microwaves STLs use two separate transmitters and receivers to pass the left 
and right channels in discrete form. Dual microwave STLs offer greater noise immun-
ity than composite microwave STLs. However, problems include gain- and phase-
matching of the left and right channels, overloads induced by pre-emphasis, and 
requirements that the audio applied to the microwave transmitters be processed to 
prevent overmodulation of the microwave system.  

Lack of transparency in the path will cause overshoot. Unless carefully designed, du-
al microwave STLs can introduce non-constant group delay in the audio spectrum, 
distorting peak levels when used to pass processed audio. Nevertheless, in a system 
using a microwave STL, the XPN-AM is sometimes located at the studio and any 
overshoots induced by the link are tolerated or removed by the transmitter’s protec-
tion limiter (if any). 

The XPN-AM can only be located at the transmitter if the signal-to-noise ratio of the 
STL is good enough to pass unprocessed audio. The signal-to-noise ratio of the STL 
can be used optimally if an Orban Optimod-PC 1101 or Optimod 6300 protects the 
link from overload. You can also use Optimod-PCn 1600 software. 



1-16  INTRODUCTION ORBAN  

 

 

If the XPN-AM is located at the transmitter and fed unprocessed audio from a mi-
crowave STL, it may be useful to use a companding-type noise reduction system (like 
dbx Type 2 or Dolby SR) around the link. This will minimize any audible noise 
buildup caused by compression within the XPN-AM. 

Some microwave links can be modified such that the deviation from linear phase is 

less than +10 from 20 Hz to 9.5 kHz and frequency response is less than 3 dB down 
at 0.15Hz and less than 0.1 dB down at 20 kHz. This specification results in less than 
1% overshoot with processed audio. Many such links have been designed to be easi-
ly configured at the factory for composite operation, where an entire FM stereo 
baseband is passed. The requirements for maintaining stereo separation in compo-
site operation are similar to the requirements for high waveform fidelity with low 
overshoot. Therefore, most links have the potential for excellent waveform fidelity if 
they are configured for composite operation. 

If the STL microwave uses pre-emphasis, its input pre-emphasis filter will probably 
introduce overshoots that will increase peak modulation without any increases in 
average modulation. If the studio level control system is capable of producing a pre-
emphasized output, we strongly recommend that the microwave STL’s pre-emphasis 
be defeated and pre-emphasis performed in the studio level control system. This 
frees the system from potential overshoot. (Optimod 6300 and Optimod-PCn 1600 
software can be readily configured to produce a pre-emphasized output.) 

Further, it is common for a microwave STL to bounce because of a large infrasonic 
peak in its frequency response caused by an under-damped automatic frequency 
control (AFC) phase-locked loop. This bounce can increase the STL’s peak carrier de-
viation by as much as 2dB, reducing average modulation. Many commercial STLs 
have this problem. 

Analog Landline (PTT / Post Office Line)  

Analog landline quality is extremely variable, ranging from excellent to poor. 
Whether landlines should be used or not depends upon the quality of the lines local-
ly available and upon the availability of other alternatives. Due to line equalizer 
characteristics and phase shifts, even the best landlines tend to veil audio quality 
slightly. Moreover, slight frequency response irregularities and non-constant group 
delay characteristics will alter the peak-to-average ratio, and will thus reduce the 
effectiveness of any peak limiting performed prior to their inputs. 

AM Transmitters and Antennas 

The behavior of an FM station is more or less determined by the behavior of the ex-
citer. Alas, this is not true in AM broadcast! The performance of an AM broadcast 
station is highly dependent upon the high-power sections of the transmitter, and 
upon the behavior of the antenna system. 

The extremely high average power and the pre-emphasized high-frequency compo-
nent of audio processed by OPTIMOD-AM put great demands upon the performance 
of the transmitter and antenna system. While improved results can be expected 
from most plants, outstanding results can only be achieved by plants having trans-
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mitters that can accurately reproduce OPTIMOD-AM's output without changing the 
shape of the waveform, and having wideband, symmetrical antenna arrays. 

Any AGCs, compressors, limiters, and clippers that follow OPTIMOD-AM in the circuit 
should be bypassed. OPTIMOD-AM provides all of these functions itself. 

Bypassing the Transmitter's Internal Filters and Clippers 

Some AM transmitters, especially those supplied to stations outside of North or 
South America, contain built-in filters and clippers after their audio inputs. The fil-
ters may have various purposes: A low-pass filter is often included to ensure that the 
transmitter's output spectrum adheres to the occupied bandwidth specifications of 
the governing authority. A high-pass filter may be present to protect the transmitter 
from damage. Safety clippers are often present to prevent the modulator from be-
ing over-driven. 

As discussed in earlier sections, accurate reproduction of OPTIMOD-AM's output re-
quires that the deviation from linear phase must be less than 10 degrees, 30-9500Hz. 
Frequency response must be less than 3dB down at 0.15Hz, and less than 0.1dB 
down at 9.5 kHz. 

The highly processed output of OPTIMOD-AM is carefully band-limited and peak-
controlled. This output will often contain waveforms with flattops like square 
waves. If the transmitter has constant group delay above 30Hz, these difficult wave-
forms will be transmitted intact and peak modulation will be accurately controlled. 

However, if low-frequency response is more than 3dB down at 0.15Hz, as would be 
true if a high-pass filter is present, the group delay above 30Hz will not be constant. 
For example, a typical 50Hz high-pass filter introduces significant non-constant 
group delay to 500Hz — ten times the cutoff frequency. This non-constant group 
delay will tilt the flattops produced by OPTIMOD-AM. The tilt increases the peak 
level of the audio waveform, but not the average level. This will force you to de-
crease the average modulation to prevent the spurious peaks from overmodulating. 

Similarly, a typical EBU 4.5 kHz filter will introduce significant non-constant group 
delay down to 1 kHz about one-fourth the cutoff frequency. This will cause over-
shoot in the highly processed waveforms produced by OPTIMOD-AM. The overshoot 
increases the peak level of the audio waveform, but not the average level. This will 
force you to decrease average modulation even more. 

Alternatively, if you do not decrease the average modulation to accommodate the 
spurious peaks introduced by the filters, the transmitter’s safety clipper will clip the 
peaks. This will introduce out-of-band energy that will almost certainly violate the 
limits on occupied bandwidth specified by the governing authority and will greatly 
degrade the spectral control provided by OPTIMOD-AM. 

To achieve the full performance capability built into OPTIMOD-AM, any filters in the 
transmitter must be bypassed. This is essential! OPTIMOD-AM contains low-pass and 
high-pass filters that are fully capable of protecting the transmitter and controlling 
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occupied bandwidth. Because of their location within OPTIMOD-AM, the internal 
filters do not introduce spurious modulation peaks. 

Any built-in peak clippers in the transmitter should be defeated. OPTIMOD-AM con-
tains a clipping system that is fully capable of controlling transmitter modulation 
without introducing out-of-band energy. If the drive level to the transmitter is even 
slightly excessive, the transmitter clipper will be driven hard enough to create exces-
sive spurious spectrum. Defeating any clippers in the transmitter prevents this possi-
bility. 

This problem will be even worse if OPTIMOD-AM's transmitter equalizer is in use. 
OPTIMOD-AM's output level will frequently exceed 100% modulation because it is 
pre-distorted to complement the transmitter's pulse response. The transmitter's 
built-in safety clipper will surely clip this pre-distorted waveform. 

Power Supplies 

An AM transmitter is required to provide 150% of equivalent unmodulated carrier 
power when it is modulating 100%. High-voltage power supplies are subject to two 
major problems: sag and resonance. 

Sag is a result of inadequate steady-state regulation. It causes the conventional car-
rier shift that is seen on a modulation monitor. Good transmitter engineering prac-
tice usually limits this shift to -5% (which corresponds to about 0.5dB not a highly 
significant loudness loss). 

A more serious problem is dynamic carrier shift, or bounce. This has been known to 
cause up to 3dB loudness loss. Resonances in the power supply's LC filter network 
usually cause it. Any LC network has a resonant frequency. In order to achieve rea-
sonable efficiency, the power supply filter network must be under-damped. There-
fore, high modulation excites this resonance, which can cause overmodulation on 
the low-voltage peaks of the resonance. 

Curing bounce is not at all straightforward because of the requirement that the 
power supply filter smooth the DC sufficiently to achieve low hum. One approach 
that has been employed is use of a 12-phase power supply. Upon rectification, the 
ripple component of the DC is down about -40dB without filtering. A single-
capacitor filter can thus be used, eliminating the filter inductor as a potential source 
of resonance with the capacitor. 

Other sources of resonance include the modulation reactor and modulation trans-
former in old plate-modulated transmitters. Such transmitters will not greatly bene-
fit from a 12-phase power supply. 

The newer generations of transmitters employ switching modulation techniques to 
control bounce far better than do older plate-modulated designs. The latest trans-
mitters using digital modulation techniques have even better performance and most 
are essentially transparent. Being more efficient than older transmitters, they will 
usually pay for themselves with power savings. 
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Asymmetry 

While the physics of carrier pinch-off limit any AM modulation system to an absolute 
negative modulation limit of 100%, it is theoretically possible to modulate positive 
peaks as high as desired. In the United States, the FCC permits positive peaks of up 
to 125% modulation. Other countries have similar restrictions. 

However, some transmitters cannot achieve such modulation without substantial 
distortion, if they can achieve it at all. The transmitter's power supply can sometimes 
be strengthened to correct this. Sometimes, RF drive capability to the final power 
amplifier must be increased. 

Voice, by its nature, is substantially asymmetrical. Therefore, asymmetrical modula-
tion was popular at one time in an attempt to increase the loudness of voice. Tradi-
tionally, this was achieved by preserving the natural asymmetry of the voice signal. 
An asymmetry detector reversed the polarity of the signal to maintain greater posi-
tive modulation. The peaks were then clipped to a level of -100%, +125%. 

OPTIMOD-AM takes a different approach: OPTIMOD-AM's input conditioning filter 
contains a time dispersion circuit (phase scrambler) that makes asymmetrical input 
material, like voice, substantially symmetrical. 

OPTIMOD-AM permits symmetrical or asymmetrical operation of its proprietary 
“MX” peak limiting system. Asymmetrical limiting slightly increases loudness and 
brightness, and can produce dense positive peaks up to 125%.  

Transmission Presets and Transmitter Equalization 

OPTIMOD-AM's transmitter equalizer can cure linear problems caused by the trans-
mitter or antenna system. However, the transmitter equalizer cannot cure nonlinear 
problems, particularly those caused by inadequate power supplies, modulation 
transformers, or reactors. If any of these components saturate or otherwise fail to 
perform under heavy power demands, no amount of small-signal equalization will 
solve their problems. 

OPTIMOD-AM was designed with the assumption that one audio processor would be 
devoted to no more than two transmitters, usually called main and standby (or al-
ternate). Each transmitter might be called upon to change power at night or to 
drive a different antenna array. Only one transmitter is assumed to be on the air at a 
given time. 

OPTIMOD-AM provides four transmission presets for its transmitter equalizer con-
trols and certain other controls. Only one preset can be active at a given time. 

You can access these presets in SETUP > TX PRESET. These presets can be modified in 
SETUP > MODIFY > TX PRESET. Unlike settings in the factory processing presets, trans-
mission preset control settings automatically save and update when you change 
them.    
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Transmitter equalizer controls in a given transmission preset include: 

 LF Gain for the LF tilt equalizer for L+R (mono) [L+R LF GN] 

 LF Breakpoint Frequency for the LF tilt equalizer for L+R [L+R LF FR] 

 HF Shelf Breakpoint Frequency for L+R [L+R HF FR] 

 HF Shelf Breakpoint Frequency for L–R [L–R HF FR] 

 HF Delay equalization for L+R [L+R HF ] 

 HF Delay equalization for L–R  [L–R HF ] 

Transmission Presets also contain the following controls: 

 System Lowpass Filter Cutoff Frequency [LOW PASS] 

 System Lowpass Filter Cutoff Shape [LPF SHAPE] 

 Positive Peak Threshold (Asymmetry) [POS PEAK] 

The transmitter equalizer operates in sum-and-difference mode, recognizing the 
fact that, in CQUAM stereo, the envelope modulation is equal to the sum signal. 
Hence, the sum (L+R) equalizer has all four controls available, while the difference 
(L–R) equalizer offers only the HF shelf and HF delay adjustments. We assumed that 
the L–R path (through the AM stereo exciter) would have no appreciable tilt, while 
the L+R path (through the transmitter’s modulator) could suffer from tilt. 

During mono operation, the L–R signal is zero and the L–R transmitter equalizer 
controls have no effect. 

For convenience, and to describe their most common application, the four transmit-
ter equalizer presets are labeled TX1/DAY, TX1/NIGHT, TX2/DAY, and TX2/NIGHT, 
although they can be applied in a completely general way to the requirements of 
your transmission facility. 

For example, in countries observing NRSC standards you might want to transmit the 
full 9.5 kHz bandwidth during the day, and, in cooperation with other stations on 
first-adjacent channels, reduce audio bandwidth to 5 kHz at night. This will elimi-
nate any skywave-induced monkey-chatter interference between first-adjacent 
channels. Alternatively, your nighttime directional antenna array might have poor 
VSWR performance at high modulating frequencies, so you might find that your 
transmitter works better and produces less distortion if you limit the audio band-
width to those frequencies where the antenna is well behaved. Further, if you oper-
ate a talk format during certain parts of the day, you will probably find that you can 
operate the processing for a louder on-air sound if you restrict the transmitted 
bandwidth below the maximum permitted by government regulation. (Bear in mind 
that most AM radios have an audio bandwidth of 2.5-3 kHz and changing transmis-
sion bandwidth from 5 kHz to 9.5 kHz will produce virtually no audible difference 
on these radios.) 
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Modulation-Dependent Dynamic Carrier Control 

To reduce power consumption, most modern transmitters can implement modula-
tion-dependent dynamic carrier control, where the level of the AM carrier varies dy-
namically as a function of modulation. AM Companding (AMC) reduces the carrier 
power at high modulation levels, the argument being that the modulation will then 
mask any increase in background noise and interference.2 

Thanks to its MX peak limiter, which increases average modulation power compared 
to older Orban AM processors, XPN-AM can create significant power savings when 
used in AMC systems. 

Antenna System 

AM antenna systems, whether directional or non-directional, frequently exhibit in-
adequate bandwidth or asymmetrical impedance. Often, a system will exhibit both 
problems simultaneously. 

An antenna with inadequate bandwidth couples RF energy into space with progres-
sively less efficiency at higher sideband frequencies (corresponding to higher modu-
lation frequencies). It reflects these higher-frequency sideband components back 
into the transmitter or dissipates them in the tuning networks. This not only causes 
dull sound on the air (and defeats OPTIMOD-AM's principal advantage: its ability to 
create a highly pre-emphasized signal without undesirable side effects), but it also 
wastes energy, can cause distortion, and can shorten the life of transmitter compo-
nents. 

Asymmetrical impedance is the common point impedance's not being symmetrical 
on either side of the carrier frequency when plotted on a Smith Chart. This problem 
can cause transmitter misbehavior and sideband asymmetry, resulting in on-air dis-
tortion in receivers with envelope detectors. 

Both of these limitations can cause severe problems in AM stereo and even worse 
ones in HD AM installations. 

Neither problem is easily solved. Unless the radio station engineer is a knowledgea-
ble antenna specialist, a reputable outside antenna consultant should be employed 
to design correction networks for the system. 

Note that many antenna systems are perfectly adequate, particularly for ordinary 
mono analog transmission. However, if the transmitter sounds significantly brighter 
and/or cleaner into a dummy load than it does into your antenna, the antenna sys-
tem should be evaluated and corrected if necessary. 

                                                      

2 Poole and Kesby, “AM Companding: Reducing the Power Consumption of LF and 
MF Transmitters,” BBC Research & Development White Paper WHP 333, 2018. 
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As noted above, if your circumstances or budget preclude correcting your antenna's 
bandwidth and/or symmetry, you will often get lower on-air distortion if you set 
OPTIMOD-AM's low-pass filter to a lower frequency than the maximum permitted 
by the government. Because OPTIMOD-AM's output bandwidth is easily adjustable 
in real time, it is very easy to experiment to see which bandwidth gives the best au-
dio quality on an average AM radio, given the quality of your transmitter and an-
tenna. 

Measuring Studio and Transmission Levels 

VU and PPM metering 

Studio equipment (like mixers) and transmission equipment (like codecs) typically 
use different methods of metering to display audio levels. The VU meter is an aver-
age-responding meter (measuring the approximate RMS level) with a 300ms rise 
time and decay time; the VU indication usually under-indicates the true peak level 
by 8 to 14 dB. The Peak Program Meter (PPM) indicates a level between RMS and the 
actual peak. The PPM has an attack time of 10ms, slow enough to cause the meter 
to ignore narrow peaks and under-indicate the true peak level by 5 dB or more. The 
absolute peak-sensing meter (the type most common in codecs) shows the true peak 
level. It has an instantaneous attack time, and a release time slow enough to allow 
the engineer to read the peak level easily. All of OPTIMOD XPN-AM’s level meters 
are absolute peak sensing. 

Orban offers a free Loudness Meter application for Windows that incor-
porates a true peak-sensing meter, a VU meter, a PPM, and two types of 
subjective loudness meters. It can be downloaded from 
www.orban.com/orban/meter/.   

Figure 1-2 shows the relative difference between the absolute peak level and the 

 

Figure 1-1: VU Meter Indication Compared to Peak Level vs. Time 
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indications of a VU meter and a PPM for a few seconds of music program. 

The studio engineer is primarily concerned with calibrating the equipment to pro-
vide the required input level for proper operation of each device, and so that all de-
vices operate with the same input and output levels. This facilitates patching devices 
in and out without recalibration and ensures that no part of the program chain will 
clip the audio. 

For line-up, the studio engineer uses a calibration tone at a studio standard level, 
commonly called line-up level, reference level, or operating level. Metering at the 
studio is by a VU meter or PPM. As discussed above, the VU or PPM indication under-

 

Figure 1-2: Absolute Peak Level, VU and PPM Indications 
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indicates the true peak level. So the studio standardizes on a maximum program in-
dication on the meter that is lower than the clipping level, so those peaks that the 
meter does not indicate will not be clipped. Line-up level is usually at this same max-
imum meter indication.  

In facilities that use VU meters, this level is usually at 0 VU, which corresponds to the 
studio standard level, typically +4 dBu. For facilities using +4 dBu standard level, in-
stantaneous peaks can reach +18 dBu or higher (particularly if the operator over-
drives the mixer). OPTIMOD XPN-AM’s analog input clips at an instantaneous peak 
level of +20 dBu, which provides 16 dB of headroom above a +4 dBu line-up level. 

In facilities that use the BBC-standard PPM, maximum program level is usually PPM4 
for music and PPM6 for speech. Line-up level is usually PPM4, which corresponds to 
+4 dBu. Instantaneous peaks will reach +17 dBu or more on voice. In facilities that 
use PPMs that indicate level directly in dBu, maximum program and line-up level is 
often +6 dBu. Instantaneous peaks will reach +11 dBu or more. 

Figure 1-3 on page 1-23 shows various common meter scales (true peak reading, VU, 
and four variants of PPM), aligned to show their readings when a −20 dBFS line-up 
tone is applied to them. 

Level and Subjective Loudness Metering in OPTIMOD XPN-AM 

The meters on OPTIMOD XPN-AM show peak input levels, the peak output modula-
tion, and subjective loudness. 

 Input levels are displayed using a VU-type scale 0 to −40dB), but the metering 

indicates absolute sample peak (much faster than a standard PPM or VU meter). 

The maximum digital word at the input corresponds to the 0 dB point on the 

XPN-AM’s input meter. 

This is not a “true peak” (aka “0 dBFS+”) meter per BS.1770 Annex 2; it 
indicates the values of the digital samples applied to the Optimod’s sig-
nal processing. The “Reconstructed Peak” meter in Orban’s free loudness 
meter application (www.orban.com/meter) could be used for this pur-
pose. 

 The two AM chain output meters show the percentage of positive and negative 

peak modulation when the AM OUTPUT LEVEL control is set to match the sensitivi-

ty of the transmitter. 

If the signal path following the Optimod is free from tilt, overshoot and 
ringing, you can use the Optimod’s calibrated test tone generator to set 
the OUTPUT LEVEL control. 

 The HD/’Netcast output meter indicates the values of the digital samples at 

OPTIMOD XPN-AM’s HD/Netcast output, taking into account the setting of 

OPTIMOD XPN-AM’s output level control. 

Note that this meter does not indicate the “true peak” level. However, 
your Optimod’s peak limiters are oversampled at 192 kHz or higher and 
are “true-peak”-aware. 

http://www.orban.com/meter
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If the output sample rate is converted to a rate other than 48 kHz and/or 
passed through a D/A converter, the peak level of the output may in-
crease up to 0.2 dB because 192 kHz is not quite an “infinite” sample 
frequency, which is what would be required to perfectly predict and con-
trol the peak level in these cases. 

 The subjective loudness meters, labeled BS1770 and CBS, display loudness meas-

ured by the ITU-R BS.1770-4 standard (see The ITU-R BS.1770 Loudness Meas-

urement Algorithm on page 1-27) and loudness measured using the CBS Tech-

nology Center algorithm developed by Jones and Torick3, which is discussed im-

mediately below. The loudness meters indicate loudness relative to the active 

TARGET LOUDNESS values for the AM and HD chains, as set either globally or in 

the active processing preset (see Target Loudness on page 1-28).  

The CBS meter is a “short-term” loudness level meter that displays the 
details of moment-to-moment loudness with dynamics slightly faster 
than a VU meter. It can indicate the loudness of short-term sounds (like 
pistol shots) that may be annoying to TV viewers but that the BS.1770 
meter, because of its longer integration time, may not take fully into ac-
count. Created using proprietary modeling software, the DSP implemen-
tation typically matches the original CBS analog meter within 0.5 dB on 
sinewaves, tone bursts and noise. 

The Jones & Torick algorithm improves upon the original loudness meas-
urement algorithm developed by CBS researchers in 1967. Its foundation 
is psychoacoustic studies done at CBS Laboratories over a two year period 
by Torick and the late Benjamin Bauer, who built on S. S. Stevens’ ‘50s-
era work at Harvard University.  

After surveying existing equal-loudness contour curves (like the famous 
Fletcher-Munson set) and finding them inapplicable to measuring the 
loudness of broadcasts, Bauer and Torick organized listening tests that 
resulted in a new set of equal-loudness curves based on octave-wide 
noise reproduced by calibrated loudspeakers in a semireverberant 16 x 14 
x 8 room, which is representative of a room in which broadcasts are nor-
mally heard. They published this work4 along with results from other 
tests whose goal was to model the loudness integration time constants of 
human hearing. These studies concentrated on the moderate sound lev-
els typically preferred by people listening to broadcasts (60 to 80 phons5) 
and did not attempt to characterize loudness perception at very low and 
high levels.  

                                                      

3 Jones, Bronwyn L.; Torick, Emil L., “A New Loudness Indicator for Use in Broadcast-
ing,” J. SMPTE September 1981, pp. 772-777. 

4 Benjamin B. Bauer and Emil L. Torick, “Researches in Loudness Measurement,” IEEE 
Transactions on Audio and Electroacoustics, Volume AU-14, Number 3, September 
1966, pp. 141-151 

5 The phon is a unit of perceived loudness, equal in number to the intensity in deci-
bels of a 1 kHz tone judged to be as loud as the sound being measured.  
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According to this research and its predecessors, the four most important 
factors that correlate to the subjective loudness of broadcasts are these:  

1. The power of the sound. 

2. The spectral distribution of the power. The ear’s sensitivity depends 
strongly on frequency. It is most sensitive to frequencies between 2 and 8 
kHz. Sensitivity falls off fastest below 200 Hz.  

3. Whether the power is concentrated in a wide or narrow bandwidth. 
For a given total sound power, the sound becomes louder as the power is 
spread over a larger number of critical bands (about 1/3 octave). This is 
called loudness summation.  

4. Temporal integration: As its duration increases, a sound at a given lev-
el appears progressively louder until its duration exceeds about 200 milli-
seconds, at which point no further loudness increase occurs.  

Bauer and Torick used the results of this research to create a loudness 
level meter with eight octave-wide filters, each of which covers three crit-
ical bands. (B & T did not use one filter per critical band because this 
would have made the meter, which was realized using analog circuitry, 
prohibitively expensive.) Each filter feeds a full-wave rectifier and each 
rectifier feeds a nonlinear lowpass filter that has a 10 ms attack time and 
a 200 ms release time, somewhat like the sidechain filter in an AGC. This 
models the “instantaneous loudness” perception mechanism in the ear. 
Instantaneous loudness is not perceived directly but is an essential part of 
the total loudness model. 

To map the instantaneous loudness to perceived short-term loudness, the 
outputs of each of the nonlinear lowpass filters are arithmetically 
summed with gains chosen to follow the 70 phon equal-loudness curves 
of the ear as determined by Bauer and Torick’s research. The sum is ap-
plied to a second, slower nonlinear lowpass filter. This has an attack time 
of 120 ms and a release time of 730 ms. Along with the eight nonlinear 
lowpass filters following the individual filters, this filter models temporal 
integration and maps it to the visual display. Meanwhile, the arithmetic 
addition models loudness summation.  

The internationally accepted unit of subjective loudness is the sone. With 
a sinewave, 40 phons = 1 sone. A doubling of sones corresponds to a 
doubling of loudness. However, because broadcasters were accustomed 
to working in decibel units, Jones and Torick chose to map loudness on a 
LED ladder display encompassing −20 to +5 dB in 0.5 dB increments, with 
the understanding that the perceived loudness doubles every 10 dB at 
loudness levels typically heard by broadcast audiences.  

The J & T meter is monophonic. Psychoacoustic studies indicate that when 
multiple acoustic sources are present in a room, loudness is most accu-
rately expressed by summing the power in the sources. For example, driv-
ing two loudspeakers with identical program produces 3 dB higher loud-
ness than a single speaker produces. Therefore, to extend the J & T algo-
rithm to multichannel reproduction, we implement one eight-filter fil-
terbank for each channel and compute RMS sums of the outputs of corre-
sponding filters in each channel before these sums are applied to the 
eight nonlinear lowpass filters. As in the monophonic J & T algorithm, 
the sum of these lowpass filters drives a second nonlinear filter, which 
drives the display.  
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About Target Loudness and ITU-R BS.1770  

The material below applies mainly to applications where the HD processing chain 
drives a netcast encoder where the netcast has a specified BS.1770 target loudness. 
The following text explains the concept of “target loudness” and its relationship to 
the ITU-R BS.1770 loudness measurement algorithm. Instructions for setting target 
loudness start on page 1-29. 

OPTIMOD XPN-AM uses the contemporary concept of “target loudness” to increase 
listener satisfaction by minimizing the need for listeners to readjust their volume 
controls when changing between different broadcast stations or netcast streams. If 
you specify the target loudness (via the TARGET LOUDNESS control), OPTIMOD XPN-
AM will produce the desired loudness. 

The ITU-R BS.1770 Loudness Measurement Algorithm 

In 2006, the ITU-R published Recommendation ITU-R BS.1770: “Algorithms to meas-
ure audio programme loudness and true-peak audio level.” This was later updated 
to BS.1770-4. 

The original BS.1770 loudness meter used a frequency-weighted RMS 
measurement intended to be integrated over several seconds — perhaps 
as long as an entire program segment. As such, it is considered a “long-
term” loudness measurement. 

A major disadvantage of the BS.1770-1 meter was that it weights silence 
and low-loudness material the same as high loudness material. This will 
cause the meter to under-read program material (like dialog) having sub-
stantial pauses that contain only low-level ambience, because louder 
program material contributes most to a listener’s perception of overall 
program loudness. 

To address this problem, the BS.1770-2 algorithm (and its successors) use 
gating. There are two steps in the gating process: first, an absolute gate 
removes silent passages; second, a relative gate weights louder parts of 
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Figure 1-4: BS.1770 Loudness Meter Block Diagram (from ITU-R document) 
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the program more heavily than quieter parts. The gating causes the me-
ter to ignore silence and to integrate only program material whose loud-
ness falls within a floating window extending from the loudest sounds 
within the specified integration period to sounds that are 10 dB quieter 
than the loudest sounds.  

OPTIMOD XPN-AM’s built-in BS.1770 loudness meters compute gated, integrated 
loudness over both a 3-second and 10-second rolling window of integration, so all 
program material from the current time to 3 or 10 seconds before the current time is 
weighted equally. The 10-second loudness is displayed as a blue bar and the 3-
second loudness is displayed as a single white segment. 

The meter is scaled so that “0” corresponds to the active TARGET LOUDNESS value. 
Hence, the loudness level at the consumer’s end will be correct when (1) OPTIMOD 
XPN-AM’s processing is adjusted to make the dominant program material indicate 
“0 LU” on BS.1770 meter, (2) the active Target Loudness value is the same as the 
transmission’s target loudness, and (3) the gain of the Windows output sound device 
you are using is 0 dB. (The CBS meter will usually peak close to “0 dB” too; see page 
1-25 for a discussion of the CBS meter.) Because loudness perception combines the 
contributions of all acoustic sources, there is only one Loudness Level meter indica-
tion regardless of the number of audio channels 

Target Loudness 

The arrival of the ITU-R BS.1770 loudness measurement standard has changed indus-
try practices by encouraging users to specify “target loudness” based on this stand-
ard.  

Several national and international standards-setting bodies have incorporated 
BS.1770 into recommended practices. The advantage of enforcing target loudness is 
that it causes the loudness of various program elements in a broadcast or netcast to 
be roughly consistent with each other, so that it is less likely that users will need to 
adjust their volume controls between program segments. The eventual goal is to 
achieve consistent loudness across all media, like FM radio and netcasts, supported 
by a given receiver or player device. 

AM radio is a notable exception. To maximize the signal-to-noise ratio at the receiv-
er, AM processing is typically adjusted to be as loud as possible without introducing 
excessive distortion or other artifacts that would cause audiences to stop listening. 
In turn, the HD processing’s target loudness must be adjusted to match the loudness 
of the AM channel as closely as possible at the radio. 

For the sake of consistency and because the world is moving in the direction of spec-
ifying target loudness for all deliverables, OPTIMOD XPN-AM incorporates the con-
cept of target loudness in both the AM and HD processing chains. OPTIMOD XPN-
AM does this in two ways: 

 It allows the target loudness to be assigned to each processing preset individual-

ly. This allows AM-chain presets to be designed in the traditional way by balanc-

ing loudness against distortion, as loudness is specified by a given preset’s local 

TARGET LOUDNESS value. The AM chain factory presets have a target loudness of 
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−6 LUFS6 , although this can easily be adjusted to suit your goals. The HD presets 

are designed to be 5 dB quieter than the AM presets, which compensates for the 

receiver’s 5 dB gain offset between the AM and HD demodulators, allowing un-

obtrusive crossfades between the AM and HD signals. 

 It allows the target loudness to be assigned globally (as part of the system pa-

rameters) so that it applies to any preset whose Target Loudness value is set to 

GLOBAL. When you edit a processing preset so that its Target Loudness value is 

GLOBAL, this causes the loudness produced by the preset to be the same as all 

other presets with GLOBAL Target Loudness. All of the XPN-AM’s presets can be 

easily edited to have GLOBAL Target Loudness. 

The XPN-AM’s loudness meters indicate loudness relative to the active target loud-
ness, such that “0” on the meter corresponds to the target loudness.  

Setting Loudness 

Analog AM Processing Chain: The AM processing chain’s output level control chang-
es both peak level and loudness proportionally. Setting it to produce 100% negative 
transmitter modulation with the XPN-AM’s test tone generator or processed audio 
calibrates the AM chain loudness meters so that 100% modulation is equivalent to 0 
dBFS in the digital domain, with the caveat that the AM-chain loudness metering is 
preceded by a filter simulating the high frequency rolloff of a typical AM radio. 

HD/netcast Processing Chain: To make automatic loudness control as straightforward 
and dependable as possible, the HD/netcast chain in OPTIMOD XPN-AM operates 
somewhat differently from older Optimods. Most important, adjusting the output 
level control in HD chain does not change loudness; it only sets the amount of head-
room between 0 dBFS and the maximum peak output level that the audio pro-
cessing produces. This allows you to adjust the processing to compensate for down-
stream overshoots from codecs without changing loudness. (Instead, the processing 
produces more peak limiting.) For example, for the HE-AAC codec it is wise to allow 
1.5 dB of peak headroom by setting the output level control to −1.5 dBFS. 

                                                      

6 The BS.1770 loudness meter indicates in units of LUFS or LKFS (which are identical; 
the LUFS nomenclature is typically used in Europe and LKFS in North America). A 
change of 1 LUFS is the same as a change of 1 dB. These measurements are absolute 
with reference to digital full-scale. LU or LK (without the “FS”) refers to loudness 
relative to the Target Loudness, where the Target Loudness is 0 LU or 0 LK. 

A third-order lowpass filter with a “Bessel” shape and a –3 dB frequency of 2 kHz 
frequency-weights the loudness measurement in the AM processing chain. This simu-
lates the frequency response of a typical AM radio. 
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 In netcast service, if the netcast has a target loudness, set GLOBAL HD TARGET 

LOUDNESS (in I/O>Utilities) to match it. 

 In HD Radio service, set the GLOBAL HD TARGET LOUDNESS of the HD processing to 

match the loudness of the AM channel at the receiver. 

Because it they are placed before OPTIMOD XPN-AM’s peak limiters, 
OPTIMOD XPN-AM’s hidden AM and HD Target Loudness gain controls 
work while allowing OPTIMOD XPN-AM’s peak limiters to prevent clip-
ping or overmodulation in the downstream transmission chain regardless 
of OPTIMOD XPN-AM’s Target Loudness settings. This arrangement al-
lows the user to set the correct loudness at OPTIMOD XPN-AM’s output 
solely by adjusting OPTIMOD XPN-AM’s active Target Loudness value—it 
is unnecessary to adjust any other controls within a factory processing 
preset. 

For recommendations regarding player devices that are not Target Loud-
ness-aware, see EBU − TECH 3344: Practical guidelines for distribution sys-
tems in accordance with EBU R128. The document can be easily found 
with an Internet search engine. 

Automatic Loudness Control in the HD/Netcast Chain: 

 CBS Loudness Controller: OPTIMOD XPN-AM’s HD processing chain includes a 

third-generation CBS Loudness Controller™ for applications where government 

regulations constrain loudness to a specified target. These use the Jones and Tor-

ick loudness meter as a reference for the loudness controller sidechain. (See Lev-

el and Subjective Loudness Metering in OPTIMOD XPN-AM on page 1-24 and 

Appendix A: Using the ITU BS.1770 and CBS Loudness Meters to Measure Loud-

 

Figure 1-5: Simplified Block Diagram of Target Loudness Control 
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ness Controller Performance starting on page 3-67.) 

 BS.1770 Safety Limiter: In  the HD processing chain, the BS.1770 safety limiter 

follows the CBS Loudness Controller and will prevent a BS.1770-2 (or higher) 

loudness meter with a 10-second integration time from indicating higher loud-

ness than the setting of the BS.1770 THRESHOLD control. The BS.1770 Safety Lim-

iter can be used with or without the CBS Loudness Controller’s being active. 

 

Presets in OPTIMOD XPN-AM 

There are two kinds of presets in OPTIMOD XPN-AM: Processing Presets and Setup 
Presets. Both can be customized and saved under different names. 

Each instance of the processing is identified by a Processor number or us-
er-generated alias and each Processor “owns” its individual customized 
presets.  

Processing Presets 

Factory Processing Presets are available for different program formats. See Table 
3-3-1: Analog AM Factory Programming Presets on page 3-30. The description of the 
presets associates with these tables indicates the style of processing. 

There are two sets of Processing presets: one for the analog AM processing and one 
for the digital radio processing (HD). The Processing preset for the analog AM pro-
cessing is the master preset. In addition to parameters specific to the AM analog 
processing, it contains the AGC and stereo enhancer parameters, which are common 
to both the AM analog and digital radio processing chains. Additionally, it points to 
an associated HD preset, which contains only the parameters exclusive to the digital 
radio processing chain. The factory HD presets cannot be used stand-alone; using 
them requires importing them into the current on-air preset via FILE > IMPORT HD 

PRESET in the XPN-AM PC control application and then saving the result as a User 
preset. 

Each Factory Processing Preset on the Open Preset list is really a library of 19 sepa-
rate presets, selected by using the LESS-MORE control to adjust OPTIMOD XPN-AM 
for less or more processing. 

Factory Processing Presets are stored as text files on the hard drive of the 
same computer that runs the OPTIMOD XPN-AM Service. During installa-
tion of the OPTIMOD XPN-AM Service, a Presets folder containing all the 
factory Preset files is created in the  
C:\Program Files (x86)\Orban\OPTIMOD XPN-AM\presets\  
folder. 

Each set of Factory Preset files consists on one “master” file and several 
“less/more” files. Master files contain the preset data that is first loaded 
when you activate a factory preset. Less/more files contain the preset da-
ta that is called up when you edit a factory preset via the Control applica-
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tion’s one-knob “less/more” editing procedure. If there is no less/more 
file for the specific less-more setting you choose, OPTIMOD XPN-AM will 
automatically generate the data by interpolating between the contents 
of the two nearest less/more files. 

The suffix of the master Factory preset files is orb1600f. Within the pre-
set folder on your hard drive, there is a corresponding less/more folder 
named after the master factory preset file. The Less/More files are locat-
ed in these folders. The file names of the less/more files are [preset name] 
LMxxx.orb1600f, where “xxx” is three numbers, like “080” (which cor-
responds to a LESS/MORE value of 8.0). 

All of these files have the “read-only” attribute to make them inconven-
ient to erase, even at the operating system level. You cannot erase or 
overwrite them from the OPTIMOD XPN-AM Control application. If you 
erase or modify a factory or less/more file from an external file manager 
like Windows Explorer (a very unwise thing to do), you will have to rein-
stall the OPTIMOD XPN-AM software to regenerate the file unless you 
have a backup copy of the file elsewhere. 

Each factory preset has an associated folder containing all of the 
less/more files for that preset. The less/more folders are located immedi-
ately below the presets folder; each less/more folder bears the name of 
its associated preset. 

You can create custom “factory” presets that have full LESS-MORE functionality. See 
Creating Custom “Factory” Presets on page 3-64. 

Customizing Processing Presets 

You can change the settings of a Factory Processing Preset, but if you want to pre-
serve your changes, you must then store those settings as a User Preset, which you 
are free to name as you wish. You can also create User presets by editing existing 
user presets and saving the results under a new name. 

The suffix of User Presets is orbXPNAMuser. The Factory preset remains unchanged. 

You cannot create User Presets from scratch. Start by recalling a Factory preset. You 
can then immediately store this in a new User Preset (with “Save As” from the FILE 
menu), give it whatever name you wish, make changes to the settings as desired, 
and then save it again. Alternatively, you can recall a Factory preset, make the 
changes first, and then store this as a User Preset. Either way, the Factory preset re-
mains for you to return to if you wish. 

You can also modify an existing User Preset. 

When you modify an existing preset, whether Factory or User, the 
OPTIMOD XPN-AM server software will automatically generate a tempo-
rary User Preset whose name consists of “Modified” appended to the 
front of the existing preset name. If you do not save your modifications, 
this temporary preset will remain on the server’s hard drive until you fur-
ther modify any preset. Then the temporary preset will be overwritten. 

You can store as many User Presets as the XPN-AM PC application’s host computer 
hard drive and operating system can accommodate. User Presets are shown on the 
“Open Preset” list by the name that you gave them when you saved them.  
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You can name them as you wish, limited only by the file naming limits in your oper-
ating system.  

Do not use a suffix; .orbXPNAMuser will be added automatically. 

User Presets are not stored the C:\Program Files (x86)\Orban\OPTIMOD XPN-

AM\presets\ folder. By default, they are instead stored in on the computer running 
the OPTIMOD XPN-AM Service in  
 
C:\Users\Public\Documents\Orban\OPTIMOD XPN-AM\Processor1\presets  
 
 Additionally, when it connects to the OPTIMOD XPN-AM Service, XPN-AM PC makes 
copies of the Factory Presets and store them here too (although without their asso-
ciated LESS-MORE folders). 

If you are running XPN-AM PC on a different computer from that running the 
OPTIMOD XPN-AM Service, XPN-AM PC automatically copies to the remote comput-
er the User Presets associated with the audio Processor to which you are connected. 
It also copies the Factory Presets. Again, the default folder is  
 
C:\Users\Public\Documents\Orban\OPTIMOD XPN-AM\Processor1\presets. 

To back up a user preset, use the standard Windows file copy mechanism to copy it 
from any folder where it is currently located into a backup folder you have made. It 
is wise to back up User Presets regularly. 

If you want to delete a user preset, use Windows to delete the preset’s associated 
*.orbXPNAMuser file. 

Setup presets 

Setup presets contain setup information, such as input levels, output levels, global 
TARGET LOUDNESS, transmitter equalization, output bandwidth, asymmetry, and op-
erate/defeat switches for various signal-processing blocks. Like Processing presets, 
you may customize Setup presets and save them from FILE > SAVE SETTINGS AS in the 
control application. 

 

Overview of an OPTIMOD XPN-AM Installation 

The OPTIMOD XPN-AM processing software is a Windows Service running on Mi-
crosoft Windows 10 and an Intel x86 CPU. All audio processing is performed natively 
on the x86 CPU except for the low-delay monitor processor, included in the Opti-
mod-PC 1101e card that ships with XPN-AM hardware. 

The XPN-AM’s OPTIMOD XPN-AM audio processing is controlled via the XPN-AM PC 
control application, which can run locally on the same computer as the Service, or 
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remotely on a different computer on your LAN. The control application opens au-
tomatically when you boot the XPN-AM hardware. 

The XPN-AM PC control software is supported only on Windows 7 and 
higher computers.  

 Local operation runs the XPN-AM PC control application on the same computer 

as the Service and requires that the XPN-AM hardware be connected to a key-

board, mouse, and monitor. 

 Network operation allows you to control one or more OPTIMOD XPN-AMs over a 

network, regardless of whether the Service is located in the controlling comput-

er. This is the recommended configuration. It facilitates locating XPN-AM hard-

ware in a machine room without being connected to a keyboard, mouse, or 

monitor. 

Regardless of whether operation is “local” or “network,” a server that accepts 
TCP/IP communications runs in the background as part of the XPN-AM Service. 

Start up the XPN-AM PC control application as you would any Windows application. 
Control applications on remote computers will initialize without connecting to an 
XPN-AM processor, so you must connect the application to the XPN-AM you wish to 
control.  

OPTIMOD XPN-AM hardware can support several independent audio processors. In 
addition to the single, base XPN-AM processor, the hardware can support up to two 
independent streaming processors (Optimod 1600PCn). Each Processor can be con-
trolled independently by its associated PC control application. XPN-AM and 1600PCn 
have separate, dedicated PC Remote applications and Services. The XPN-AM PC con-
trol application always uses TCP/IP to communicate through the XPN-AM’s server 
software to instances of the audio processing. 

Networking the XPN-AM: Overview 

The XPN-AM PC control application can control one or more XPN-AMs installed an-
ywhere on a TCP/IP network, including the Internet. A complex system (such as one 
that a major broadcast group, or large server farm/ISP might operate) could have 
dozens of clients and servers networked together. Each host computer has a TCP/IP 
address and port assigned to it and runs one instance of the OPTIMOD XPN-AM Ser-
vice. We will call such a host computer a “server.” The Service is the “switchboard” 
that allows the XPN-AM PC to control multiple Processors running on one computer. 

The control application can automatically find all Processors within a given host 
computer anywhere on the network if the control application knows the IP address 
of the host computer and the Port number assigned to the Service in TOOLS > 

SERVICE SETTINGS. 

To connect to a Processor, you must first add the host computer/server to your con-
trol application via CONNECT > ADD PROFILE (step 8 on page 2-12). Here, you provide 
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the host computer’s IP address and port number. Once a profile is added, you can 
connect to it by choosing the desired Processor in the CONNECT drop-down list.  

Each local copy of the OPTIMOD XPN-AM Control application allows you to name an 
XPN-AM hardware unit (e.g., “KORB”) so you do not have to remember its IP ad-
dress each time you connect the Control application to it. 

The server names are stored locally on each computer; each local copy of 
the OPTIMOD XPN-AM Control application can create a different profile 
name for a given server. A server’s real “name” is always its IP address. 

You can see a drop-down list of all instances that have been added previously, re-
gardless of whether you are logged onto the host computer housing those instanc-
es. Once you have logged onto the host computer, you can connect to any Processor 
on this list if it is “available” (that is, if it is running in the host and not already con-
nected to a different instance of XPN-AM PC Remote). If you have not previously 
connected to a given instance and specified “remember password,” you must supply 
your User Password before you can connect. 

Once you have specified “Remember Password,” the password dialog box 
will not appear again and the “Remember Password” status can only be 
canceled by an administrator. “Remember Password” can compromise se-
curity, so you should use this feature with discretion. 

Only one instance of XPN-AM PC Remote can be logged into a given XPN-AM at one 
time; the instance will return “in use” if another client attempts to log into the same 
instance. However, more than one client can be logged onto a given host computer 
at once if each client is logged onto a different Processor within that host. 

Section 2 of this manual provides detailed, systematic instructions for setting up a 
network. 

Security 

OPTIMOD XPN-AM is designed for networking. Because most PCs are now net-
worked, the instances must be protected from unauthorized access when network-
ing is activated. Four levels of security achieve this: 

 Each XPN-AM processor has a User password that allows an authorized user to 

“connect” to it via the OPTIMOD XPN-AM PC Remote Application. When this oc-

curs, the user can work with the audio processing functions such as changing 

and editing presets. 

 Each XPN-AM processor has a Terminal Password (operating at the User security 

level) that allows you to connect to an XPN-AM via the OPTIMOD XPN-AM TCP/IP 

terminal server to allow external control of the XPN-AM from either a Telnet cli-

ent or a custom third party application. See OPTIMOD XPN-AM Control API on 

page 5-1. 

 Each OPTIMOD XPN-AM host computer has an Administrator password that al-

lows an administrator to set up the Service and the various Processors. 
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Only an administrator can assign and change user passwords. If the user 
has checked “remember password” on the dialog box requesting pass-
word entry, only the administrator can “uncheck” the “remember pass-
word” function for that instance. 

Unless networking is activated, Processors located in a given machine are 
visible only to the OPTIMOD XPN-AM Control application running locally 
on that machine. They are invisible to other machines on the network. 
Not running in “network” mode therefore provides considerable security. 

 The XPN-AM Service (running on the XPN-AM hardware) has a password that 

prevents unauthorized users from changing the Service properties like audio in-

put/output sound devices. 

 By creating a “Network Accept List,” you can specify which computers are per-

mitted to connect to a given OPTIMOD XPN-AM instance. This provides a layer of 

security that complements password protection. See step (1.D) on page 2-9. 

The XPN-AM PC Remote software allows you to give a Processor an easily remem-
bered name (e.g., “KORB-AM”) so the software does not have to address the Proces-
sor by its generic name, which is PROCESSOR 1. This name is an alias that is local to 
the computer from which you named the Processor; the same Processor could be 
known by a different name on each computer in the network. 

If you give your XPN-AM an alias name, this name will appear (instead of PROCESSOR 

1, etc.) next to the Service name in the Connect drop-down box and at the top left 
hand corner in the XPN-AM PC application when you are connected to that instance. 

Only the generic name (“Processor 1”) is unique. The name is always 
available on “Service Settings” screen, which is accessible from the Tools 
drop-down menu box. The XPN-AM PC Remote application uses the ge-
neric name to identify the folder on the host computer’s hard drive that 
contains the setup and user presets (if any) for that instance. 

Only an administrator can rename an instance (profile), and that name 
will remain only on the machine from which it was assigned that name. 

For XPN-AM PC to access XPN-AM Processors on remote XPN-AM host computers, 
XPN-AM PC must always know these remote Processors’ passwords to access them. 
The administrator initially assigns these passwords while connected to the XPN-AM 
host computer. If you plan network operation, it is important to assign both a User 
and an Administrator password to each Processor in that machine to prevent the 
Processors from being hacked. 

The dual password system is useful in protecting a networked installation 
from being damaged by disgruntled employees or hackers who might get 
access to a User password and server IP address. A malicious user might 
set incorrect presets and audio levels, activate test tones, mute the audio, 
or delete user presets. (This is another reason, other than potential hard 
drive failure, why it is wise to back up user presets.) 

However, a malicious user cannot take exclusive control of a Processor by 
changing its name or password. Only an administrator can do that. 
Meanwhile, the administrator can change User passwords and rename 
Processors from a central location. It is wise to do this each time a person 
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with a User password leaves the employ of the entity doing the stream-
ing or broadcasting—it’s like “changing the locks.” 

No networked Processor is viewable inside XPN-AM PC Remote software until you 
“add” its Profile (which encompasses all audio Processors spawned from a given 
computer’s Service) to the list of viewable instances. Do this by going into 
CONNECT>ADD and then supplying the IP address and the instance’s User password (if 
a password was assigned to that instance). This allows one host computer to ac-
commodate multiple XPN-AM Processors while allowing a given user to view only its 
own Processor(s) from the Control application. 

Optimod-PC 1101e Configuration and Security 

As shipped, the included Optimod-PC 1101e card is configured for typical I/O scenar-
ios, where the XPN-AM’s processed output is available on the analog and both digi-
tal outputs. Basic 1101e setup controls for input selection, output level, and sync 
source are available from the XPN-AM PC Remote application (in I/O>INPUT OUTPUT 

CONFIGURATION). More complex setups, like those using the 1101e’s built-in low-delay 
audio processor for a headphone feed or streaming processor, require configuration 
via the 1101e PC Remote software, which is pre-installed on the XPN-AM host com-
puter. 

The 1101e has multilevel password protection independent of the XPN-AM proces-
sor’s security, although they have similar setup procedures. Refer to the 1101e man-
ual for more information. As shipped, only local access to the 1101e from the XPN-
AM host computer is permitted. 

Using OPTIMOD XPN-AM for Netcasting 

For netcasting, use the XPN-AM’s HD processing chain. It is usually best to run the 
OPTIMOD XPN-AM audio processor on the same computer that runs your streaming 
encoder. This simplifies interconnection between the audio processor(s) and encod-
er(s). 

You can either use the XPN-AM’s HD processing chain or a separate (optional at ex-
tra cost) instance of Orban’s OPTIMOD-PCn 1600 audio processor to drive a stream-
ing encoder. The advantage of using a separate processor is that it does not share a 
front end (AGC etc.) with the AM processor, so you have more freedom to customize 
its sound. 

Using OPTIMOD XPN-AM in Digital Radio Service 

For digital radio, use the XPN-AM’s HD processing chain. The best location for 
OPTIMOD XPN-AM is as close as possible to the transmitter so that OPTIMOD XPN-
AM’s digital output can be connected to the transmitter through a signal path that 
introduces no change in OPTIMOD XPN-AM’s output PCM bitstream. 

Sometimes it is impossible to locate OPTIMOD XPN-AM at the transmitter. Instead, it 
must be located on the studio side of the link connecting the audio facility to the 
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transmitter. If the transmitter is not accessible, all audio processing must be done at 
the studio, and you must tolerate any damage that occurs later. 

If an uncompressed digital link is available, this is an ideal situation because such a 
link will pass OPTIMOD XPN-AM’s output with little or no degradation. However, 
such a link is not always available. 

If only a 32 kHz sample rate link is available, the sample rate conversion 
necessary to downsample the audio will cause overshoots when 
OPTIMOD XPN-AM’s HD processing chain is operated at 20 kHz band-
width because the sample rate converter removes spectral energy. In this 
case, you can minimize overshoot by operating OPTIMOD XPN-AM HD 
chain at 15 kHz bandwidth. (Set it from the HD EQ tab.) 

Unless the path is a digital path using no lossy compression, this situation will yield 
lower performance than if OPTIMOD XPN-AM is connected directly to the transmit-
ter because artifacts that cannot be controlled by OPTIMOD XPN-AM will be intro-
duced by the link to the transmitter. These artifacts can decrease average modula-
tion by 2-4dB and can also add noise and audible nonlinear distortion. In the case of 
lossy digital compression, this deterioration will be directly related to the bitrate. For 
an analog path, the deterioration will depend on the amount of linear and nonline-
ar distortion in the path.  

One strategy is to apply to OPTIMOD XPN-AM’s output signal the same lossy com-
pression that the HD digital radio transmitter would apply. If a digital link is availa-
ble with sufficient bitrate to pass this compressed signal, it can then be passed di-
rectly to the digital radio transmitter without further processing if synchronization 
issues can be resolved. Consult with the manufacturer of your digital radio transmit-
ter to see if this can be done. 

Where only an analog or lossy digital link is available, feed the audio output of 
OPTIMOD XPN-AM directly into the link. If available, the transmitter’s protection 
limiter should be adjusted so that audio is normally just below the threshold of lim-
iting: The transmitter protection limiter should respond only to signals caused by 
faults or by spurious peaks introduced by imperfections in the link. 

Where maximum quality is desired, it is wise to request that all equipment in the 
signal path after the studio be carefully measured, aligned, and qualified to meet 
the appropriate standards for bandwidth, distortion group delay and gain stability. 
Such equipment should be measured at reasonable intervals. 

It is important to understand that the codecs used in digital radio service introduce 
overshoot as a side-effect of bitrate reduction. It is wise to evaluate the codec in use 
for this issue. In general, allowing 2 dB of headroom (by setting OPTIMOD XPN-AM 
HD output level control at −2 dB) will suffice because overshoots above 2 dB have 
low energy and are unlikely to be audible. 

OPTIMOD XPN-AM at the Transmitter: Gain Control before the STL 

The audio received at OPTIMOD XPN-AM’s input should have the highest possible 
quality. To achieve the full audible benefit of OPTIMOD XPN-AM processing, use a 
studio-transmitter link (STL) that is as flat as the bandwidth of OPTIMOD XPN-AM as 
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used in your facility. Ideally, you should use a 20-bit (or better) uncompressed digital 
link with at least 44.1 kHz sample frequency (for HD operation) or 32 kHz (for AM 
analog-only operation). 

Because the audio processor controls peaks, it is not important that the audio link 
feeding OPTIMOD XPN-AM’s input terminals be phase-linear. However, the link 
should have low noise, the flattest possible frequency response from 20-20,000Hz 
(for HD operation), and low nonlinear distortion. 

If the audio link between the studio and the transmitter is noisy (or, if digital, is lim-
ited to 16 bits or less), performing the AGC function at the studio site can minimize 
the audibility of this noise. AGC applied before the audio link improves the signal-
to-noise ratio because the average level on the link will be greater. Further, many 
STLs require level control to prevent the STL from being overloaded. You can use 
Orban’s Optimod-PCn 1600 processing software, Optimod-PC 1101e sound card, or 
Optimod 6300 hardware processor for this purpose. 

Setting Output/Modulation Levels 

IMPORTANT: In OPTIMOD XPN-AM, adjusting the HD chain’s output level control 
does not change loudness; it only sets the amount of headroom between 0 dBFS and 
the maximum peak output level produced by the audio processing. This allows you 
to easily adjust the output level control to compensate for downstream overshoots. 
See Setting Loudness on page 1-29 and step 19 on page 2-43. 

In a perfect world, one could set the peak level at OPTIMOD XPN-AM’s HD output to 
0 dBFS. However, there are at several potential problems that may make it desirable 
to set the modulation level slightly lower. 

 First is the fact that the peak limiter operates at a finite sample rate: 192 kHz 

(non-MX) or 256 kHz (MX). This ensures that overshoot after phase-linear sample 

rate conversion or D/A conversion will not exceed 0.5 dB and will typically be less 

than 0.1 dB. 

 Second is headroom in lossy data compression systems. A well-designed percep-

tual encoder will accept samples up to 0 dBFS and will have internal headroom 

sufficient to avoid clipping. However, there is no guarantee that receiver manu-

facturers or decoder providers will implement perceptual decoders with suffi-

cient headroom to avoid clipping overshoots, and in fact, some very popular 

player devices and software suffer from clipping in the analog domain due to 

overshoot. Such overshoots are the inevitable side effect of increasing the quan-

tization noise in the channel, and can be as large as 3-4dB. Most perceptual en-

coder algorithms are designed to have unity gain from input to output. So if 

peak levels at the input frequently come up to 0dBFS, peak levels at the output 

will frequently exceed 0dBFS (and will be clipped) unless the decoder algorithm 

is adjusted to be less than unity gain.  

 

Canny engineers will therefore familiarize themselves with the performance of 



1-40  INTRODUCTION ORBAN  

 

 

real-world receivers and player software and will reduce the peak modulation of 

the transmissions if it turns out that most receivers are clipping due to perceptu-

al encoding overshoots. Our experience to date indicates that allowing 3dB 

headroom should prevent audible overshoot-induced clipping in low bite-rate 

systems (e.g., 32 kbps streams), while 2dB is adequate for 128kbps and above. 

While some clipping may still occur, it will have a very low duty cycle and will 

almost certainty be inaudible. 

OPTIMOD XPN-AM’s HD/netcast processing supports setting BS.1770 target loudness 
for the transmission medium, making it easy to ensure correct loudness. Some coun-
tries require this by law. While some of the concepts may seem unfamiliar at first, 
learning about them can pay off by increasing audience comfort and satisfaction. 
See About Target Loudness and ITU-R BS.1770  starting on page 1-27. 

Managing Delay from Input to Output 

To optimize audio quality and to allow adding features like automatic phase skew 
correction, we chose to design the XPN-AM audio processing software without re-
gard to input/output delay. Accordingly, the delay can be as much as 1 second with-
out a ratings encoder loop-through, and as much 2 seconds with a ratings encoder. 
If you use XPN-AM’s built-in diversity delay, it will of course be much longer than 
this. 

Except for the Input meters, all of the XPN-AM’s meters are time-
synchronized. When the ratings encoder loop-through is active, the XPN-
AM’s Input meters will not be time-synchronized with the remaining me-
ters. 

Because of limitations of the Windows audio system, the input/output delay is not 
100% repeatable; it is impossible to achieve sample-accurate delay matching of the 
XPN-AM’s audio processor to an external delay. However, the differential delay be-
tween the AM and HD/netcast outputs is precisely locked. (Note that it is necessary 
to use a multichannel Playback sound device, like the optional RME HDSPe AES card, 
to ensure this.) 

In the HD/netcast processing, adjusting the HD MX LIMITER IN/OUT control introduces 
a momentary audio glitch, although the differential delay does not change. This is 
usually not a problem because MX operation always equals or outperforms non-MX 
operation. (It will outperform whenever a significant amount of peak limiter gain 
reduction occurs, as indicated on the LIMITER G/R meters.) The only reason to defeat 
MX operation is to decrease CPU loading. 

A glitch will also occur if you adjust the HD SUBHARMONIC control between OFF and 
any other setting. To prevent this, set the SUBHARMONIC INJECTION to –99 dB. This pre-
vents glitching if you switch between a preset where the subharmonic synthesizer 
defeated and one where it is active. 

OPTIMOD XPN-AM allows the functions listed below to be smoothly activated or 
defeated during audio programming, which is done via controls in the processing 
presets. Because these functions each add significant input/output delay and CPU 
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usage, Setup presets include switches that can defeat these functions entirely and 
remove their delay from the audio path.  

 Phase Skew Correction 

 Stereo Synthesis 

Monitoring on Loudspeakers and Headphones 

In live operations, highly processed audio often causes a problem with the DJ or pre-
senter’s headphones. Thanks to no-compromise audio processing, the delay is too 
long for monitoring in live broadcasting, as it will affect audio cueing and DJ mixing 
in addition to being unacceptably distracting through headphones.  

Such problems can be avoided if the DJ/presenter’s headphones are driven directly 
from the program line or, better, by a low-delay processor connected to the pro-
gram line. If the DJ/presenter relies principally on processor to determine whether a 
digital radio station is on the air, simple loss-of-data and loss-of-audio alarms should 
be added to the system. Such alarms could be configured to cut off audio to the 
DJ/presenter’s phones when an audio or carrier failure occurs. 

The OPTIMOD-PC 1101e card includes appropriate processing, which uses onboard 
DSP to achieve low delay. You must configure it via the 1101e PC Remote applica-
tion by assigning the PROCESSOR MIXER PRE-LIMIT source to the output driving the 
headphones (typically the analog output), using the PROCESS MIXER tab to set input 
routing and drive level to the processor, and choosing whichever processing preset 
your talent prefers. 

Controlling Levels in a Playout System Feeding 
OPTIMOD XPN-AM 

You can help OPTIMOD XPN-AM operate best by setting the level of each program 
element when you load it into the playout system. We recommend normalizing lev-
els in a playout system so that all files have the same BS.1770 loudness, integrated 
over the entire file. This will minimize variations in AGC gain reduction. 

Many audio editing programs permit a sound file to be “peak-
normalized,” which amplifies or attenuates the level of the file to force 
the highest instantaneous peak to reach 0 dBFS. This is a very poor way 
to set the levels of different audio files on a playout system. Absolute 
peak levels have nothing to do with loudness, so peak-normalized files 
are likely to have widely varying loudness levels depending on the typical 
peak-to-average ratio of the audio in the file.  
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Using Lossy Data Reduction in the Audio Chain be-
fore OPTIMOD XPN-AM  

Many broadcasters and netcasters are now using lossy data reduction algorithms like 
MPEG-1 Layer 2 or Layer 3 to increase the storage time of digital playback media. In 
addition, source material is often supplied through a lossy data reduction algorithm, 
whether from satellite or over landlines. Sometimes, several encode/decode cycles 
will be cascaded before the material is finally presented to OPTIMOD XPN-AM’s in-
put. 

All such algorithms operate by increasing the quantization noise in discrete frequen-
cy bands. If not psychoacoustically masked by the program material, this noise may 
be perceived as distortion, “gurgling,” phasiness, or other interference. Psychoa-
coustic calculations are used to ensure that the added noise is masked by the desired 
program material and not heard. Cascading several stages of such processing can 
raise the added quantization noise above the threshold of masking, such that it is 
heard. In addition, there is at least one other mechanism that can cause the noise to 
become audible at the radio. OPTIMOD XPN-AM’s multiband limiter performs “au-
tomatic equalization” that can significantly change the frequency balance of the 
program. This can cause noise that would otherwise have been masked to become 
unmasked because the psychoacoustic masking conditions under which the masking 
thresholds were originally computed were changed. 

Accordingly, if you use lossy data reduction in the studio, you should use the highest 
data rate possible. This maximizes the headroom between the added noise and the 
threshold where it will be heard. In addition, you should minimize the number of 
encode and decode cycles, because each cycle moves the added noise closer to the 
threshold where the added noise is heard. 

Warranty, User Feedback 

User Feedback 

We are very interested in your comments about this product. We will carefully re-
view your suggestions for improvements to either the product or the manual. Please 
email us at info@indexcom.com. 

LIMITED WARRANTY 

Orban Labs Inc. warrants OPTIMOD XPN-AM against defects in material or work-
manship for a period of five years from the date of original purchase for use, and 
agrees to repair or, at our option, replace any defective item without charge for ei-
ther parts or labor.  

IMPORTANT: This warranty does not cover damage resulting from accident, misuse 
or abuse, lack of reasonable care, or loss of parts. No responsibility is assumed for 

mailto:info@indexcom.com
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any special, incidental, or consequential damages. However, the limitation of any 
right or remedy shall not be effective where such is prohibited or restricted by law.  

No other warranty, written or oral, is authorized. 

This warranty gives you specific legal rights and you may have other rights that vary 
from state to state. Some states do not allow the exclusion of limitations of inci-
dental or consequential damages or limitations on how long an implied warranty 
lasts, so the above exclusions and limitations may not apply to you. 
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 Section 2 

 Installation 
 

Hardware Installation 

Allow about 2 hours for installation. 

Installation consists of: (1) unpacking and inspecting the XPN-AM, (2) mounting the 
XPN-AM in a rack, (3) connecting inputs, outputs, Ethernet, and power. 

 
DO NOT connect power to the unit yet! 

1. Unpack and inspect.  

A) If you note obvious physical damage, contact the carrier immediately to make 
a damage claim. Packed with the XPN-AM are: 

Quantity Item             

1  Operating Manual and software on CD 

2  Line Cords (domestic, European) 

4  Rack-mounting screws, 10-32 x ¾—with washers, #10 

1  PC Remote Software CD 

B) Save all packing materials! If you should ever have to ship the XPN-AM (e.g., 
for servicing), it is best to ship it in the original carton with its packing materi-
als because both the carton and packing material have been carefully de-
signed to protect the unit. 

2. Mount the host computer in a rack.  

There should be a good ground connection between the rack and the host com-
puter chassis — check this with an ohmmeter to verify that the resistance is less 

than 0.5. 

When running the maximum number of OPTIMOD processors supported by your 
hardware (XPN-AM plus several Optimod-PCn 1600 processors), the computer’s 
CPU can dissipate more than 100 watts, and you must account for this in your in-
stallation. Mounting the unit over large heat-producing devices (such as a vacu-
um-tube power amplifier) may shorten component life and is not recommended. 

Ambient temperature should not exceed 45C (113F) when equipment is pow-
ered.  

Equipment life will be extended if the unit is mounted away from sources of vi-
bration, such as large blowers and is operated as cool as possible. 
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3. Install the appropriate power cord(s).  

Depending on how they are ordered, some host computers are equipped with 
dual-redundant power supplies with automatic failover. Each power supply has a 
dedicated connection to the AC line. For maximum reliability, connect the two 
supplies to two AC circuits. 

AC power passes through an IEC-standard mains connector and an RF filter de-
signed to meet the standards of all international safety authorities. 

The power cord is terminated in a “U-ground” plug (USA standard), or CEE7 / 7 
plug (Continental Europe), as appropriate to your XPN-AM’s Model Number. The 
green/yellow wire is connected directly to the XPN-AM chassis. 

If you need to change the plug to meet your country’s standard and you are 
qualified to do so, see Figure 2-1. Otherwise, purchase new mains cords with the 
correct line plug attached. 

The host computer requires a significant amount of time to boot up, so a brief 
AC line glitch that causes the computer to restart will cause a significant inter-
ruption in audio service and will shut down Windows abnormally. Therefore, we 
strong recommend driving the computer from an uninterruptable power supply. 
To achieve maximum reliability, connect each power supply to a separate UPS. In 
addition, a UPS should protect the computer from line surges and minimize the 
likelihood of damage caused by them.  

4. Connect inputs and outputs.  

Do this according to the manufacturer’s instructions for the Windows input and 
output devices you will be using. See step 6 on page 2-6. 

 

Figure 2-1: AC Line Cord Wire Standard 
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5. Connect to a network.  

The host computer has two Ethernet ports, one dedicated to control and one to 
audio-over-IP transport, such as Ravenna and Dante. The corresponding audio-
over-IP driver software must be installed in the computer. To achieve highest ca-
pacity and lowest latency, the audio network should be dedicated only to audio 
and should not be shared with other data traffic. 

We recommend that you control the XPN-AM via your non-audio LAN from a 
remote computer running our XPN-AM PC software. This allows the XPN-AM 
hardware to run a maximum number of audio Processors and facilitates locating 
the XPN-AM in a machine room. 

Because the XPN-AM runs the Windows operating system, you must assign it a 
static IP address, subnet mask, and gateway using standard Windows procedures. 
(We assume that you already know how to do this.) Using a static IP allows you 
to connect reliably to the XPN-AM from remote computers running our XPN-AM 
PC remote control software. 

You may also control the XPN-AM from XPN-AM PC software running on the 
XPN-AM hardware. In this case, the XPN-AM PC software communicates with the 
XPN-AM’s audio processing via a “localhost” connection, which is set up in the 
XPN-AM as IP address 127.0.0.1. 

Procedures and instructions for connecting to a PC are subject to development 
and change. We advise you to download the latest version of this manual in pdf 
format from ftp.orban.com/XPN-AM/Documentation.  

You can use Adobe’s .pdf reader application to open and read this file. If you do 
not have the .pdf reader, it is available for free download from www.adobe.com. 

 

Software Installation and Setup 

Optimod XPN-AM hardware comes pre-configured so that you will be able to boot 
up the host hardware, obtain audio I/O, and control the processing by using XPN-
AM PC Remote running on the host computer. However, you will still need to cus-
tomize networking and security settings, which you can do by skipping to Setting up 
Security and Networking starting on page 2-8. The remaining steps describe how to 
install and configure XPN-AM software on the host computer, and are provided for 
reference. These are denoted by asterisks (*). 

Note for XPN-AM Hardware with 1600PCn Software Installed: Step 6 on page 2-6 
provides instructions for setting up or modifying audio I/O assignments in XPN-AM 
and the procedure for (optional) 1600PCn Processors should be obvious by analogy. 
You can also refer to Set up audio I/O for each Processor on page 2-8 of the 1600PCn 
manual. It is important to keep track of which audio devices you assign to a given 
Processor so you don’t accidentally assign a Playback device to more than one Pro-
cessor, whether XPN-AM or 1600PCn. Note that you cannot use the optional RME 
HDSPe AES for 1600PCn I/O; use the 1101e or optional Audio Over Ethernet sound 
devices. 

ftp://ftp.orban.com/XPN-AM/Documentation
http://www.adobe.com/
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Installing and Configuring XPN-AM Software (for Reference) 

1. *Defeat Windows Fast Startup (Windows 8 and higher). 

To achieve most reliable startup, OPTIMOD XPN-AM Service is set for DELAYED 

START in Windows and starts after a 60-second delay. Windows 8 introduced Fast 
Startup, which overrides the delayed start during a power-on Windows boot. To 
ensure that OPTIMOD XPN-AM starts reliably on power-up, you must defeat 
Windows FAST STARTUP: 

A) Navigate to CONTROL PANEL > ALL CONTROL PANEL ITEMS > POWER OPTIONS. 

B) Click CHOOSE WHAT THE POWER BUTTONS DO on the left side of the screen. 

C) Click CHANGE SETTINGS THAT ARE CURRENTLY UNAVAILABLE. 

D) Under SHUTDOWN SETTINGS, uncheck TURN ON FAST STARTUP (RECOMMENDED). 

2. *Install XPN-AM PC software on the computer that will control the XPN-AM pro-

cessor. 

XPN-AM PC software will be installed when you install the Service. However, in 
most cases, it is preferable to control the XPN-AM from another computer be-
cause this will maximize the amount of CPU power dedicated to processing au-
dio. 

To control the XPN-AM from another computer, you must install XPN-AM PC 
software on that computer. Because the XPN-AM PC application is graphics-
intensive but is otherwise requires only a small amount of CPU power, almost any 
modern computer will work if it has competent graphics support. 

XPN-AM PC software is not copy-protected; you may install it on as many 
computers as you wish. Remember that the XPN-AM PC application does 
not do audio processing; it only controls OPTIMOD XPN-AM Service(s) 
running on local or remote computers. The Service does the audio pro-
cessing and is copy-protected via a hardware key. 

A) From ftp.orban.com/XPN-AM, download the installer program, SetupXPN-
AM_x.x.x.x.exe, where “x.x.x.x” represents the software version you are in-
stalling. (For example, for version 1.0 software, this would be 1.0.0.0.) Down-
loading ensures that you get the latest software version. 

B) Run SetupXPN-AM_x.x.x.x.exe on its host computer by right-clicking its icon 
and selecting RUN AS ADMINISTRATOR. The installer will start up. Follow the in-
structions it provides on each screen. In the SELECT COMPONENTS screen, 
choose OPTIMOD APPLICATION FOR REMOTE ACCESS.   
 
This program installs the necessary files and adds an Orban/Optimod XPN-AM 
folder to your computer’s Start Menu. This folder contains shortcuts to the PC 
Remote application and to the documentation. If you accepted the option 
during installation, there is also a shortcut to the PC Remote application on 
your desktop. 

ftp://ftp.orban.com/1000
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3. *Authorize the server computer. 

Plug the XPN-AM PC copy protection key (supplied with your software) into an 
available USB port of the computer you will be using to do audio processing. Any 
computer running the OPTIMOD XPN-AM Service must be authorized. 

The key does not require a Windows driver. 

If the computer is already running without the key, inserting the key will 
not automatically start the Service. Do this from the XPN-AM PC TOOLS > 

SERVICE SETUP window. 

4. *Install XPN-AM PC software on the computer that will run the Service and per-

form audio processing. 

 

Figure 2-2: Service Settings 
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Follow the instructions in step 0 above, except choose OPTIMOD APPLICATION AND 

SERVICE in the SELECT COMPONENTS screen. 
Be sure that you run the installer as Ad-
ministrator. 

During installation, the installer will auto-
matically create an Inbound Rule in the 
Widows Firewall to permit connection to 
the OptimodService3.exe application. 
The firewall must permit inbound connec-
tions if you wish to control OPTIMOD XPN-
AM remotely. 

5. *Set up the Service. 

NOTE: You can only set up the Service via a 
XPN-AM PC running on the same PC as the 
Service, and you must have Administrator 
rights to do so. You cannot use a remote 
instance of XPN-AM PC for this setup. If 
you need to set up the Service remotely, 
use Windows Remote Desktop to control a 
XPN-AM PC running on the Service com-
puter. 

A) Start up the XPN-AM PC application on 
the computer running the Service. 

B) Open the SERVICE SETTINGS window 
from TOOLS > SERVICE SETTINGS. 

C) In the NUMBER OF PROCESSORS drop-
down, set the number to 1. 

If you are running 1600PCn Proces-
sors, note that these are set up from 
1600CPn PC Remote, not XPN-AM PC 
Remote. 

6. *Set up audio I/O for each Processor. 

While there is only one XPN-AM Processor 
in a given XPN-AM host computer, there 
can be more than one (optional) Optimod-
PCn 1600 Processor. 

Each Processor must have a Windows Re-
cording sound device assigned to its input 
and a Windows Playback sound device as-
signed to its output. You may use the same 
device for the input to more than Proces-
sor, but each output must be assigned to a 
different device. Before you configure 

 

 

 

Figure 2-3:  Windows Audio I/O Setup 
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OPTIMOD XPN-AM you must first configure Windows to be consistent with the 
OPTIMOD XPN-AM setup you are planning to use. 

The base Windows sound device is an Optimod-PC 1101e card. HD units include 
RME HDSPe AES card. However, because of driver limitations the RME card can 
only be used for XPN-AM I/O. Its “extra” sound devices cannot be used for 
1600PCn I/O. 

A) Set up the Windows Sound Devices you will be using. 

a) Go to Windows CONTROL PANEL> SOUND> RECORDING> PROPERTIES> 

ADVANCED. Configure the Recording device for stereo operation. Set the 
Recording device to 48 kHz, 24-bit, 2 Channel. 48 kHz is preferred because 
it puts less load on the CPU. 

b) Go to Windows CONTROL PANEL> SOUND> PLAYBACK. Highlight the device, set 
it for configure each Playback device for the same sample rate and bit 
depth that you used for the Recording Device (in PROPERTIES > ADVANCED), 
and 2 Channel or 5.1 Channel (in CONFIGURE). Use 2-channel/stereo for 
analog AM processing and 5.1 for HD output. (Lf/Rf emits the AM analog-
processed signal and Ls/Rs emits the HD-processed output.) 

Many I/O devices support only Stereo / 2 Channel. 5.1 usually require us-
ing the ”Speakers” playback device. 

The drivers of the Playback devices you choose must support Windows 
WASAPI. Most do, as Microsoft introduced and standardized this model 
starting with Windows Vista. 

For both Recording and Playback devices, check ALLOW APPLICATIONS TO 

TAKE EXCLUSIVE CONTROL OF THIS DEVICE and GIVE EXCLUSIVE MODE APPLICATIONS 

PRIORITY. 

c) If the ENHANCEMENTS tab is present for a given playback device, click it and 
check DISABLE ALL ENHANCEMENTS. 

B) Set up OPTIMOD XPN-AM’s inputs and outputs. 

a) In SERVICE SETTINGS > VIEW/SET AUDIO I/O ROUTING, choose the Processor you 
wish to set up. 

b) Specify the input device from the drop-down menu. This must be a device 
that you configured in step A)a) on page 2-7. 

c) Choose the processing mode and output channel mode:  
 
[2.02.0 STEREO ] (Stereo in / stereo out)  
Processing: AM analog processing  only with optional internal Nielsen 
Radio® ratings encoder. The AM analog processing chain always operates 
in stereo, but you can use the INPUT MODE drop-down in I/O > INPUT to 
configure its input to be driven by STEREO, MONO L+R, MONO L, or MONO R. 
In the three mono modes, the left and right outputs are identical.  
Input: Unprocessed Audio In (L/R)  
Output: AM-processed audio Out (L/R), optionally with Nielsen Radio 
watermark.  
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[2.05.1 2XAM; 2XHD] (stereo In / 5.1 Out)  
Processing: AM Analog Processing (driven by STEREO, MONO L+R, MONO L, or 
MONO R); optional stereo HD Output (HD can be turned off or on in I/O > 

UTILITY > HD PROCESSING). Optional internal Nielsen Radio ratings encoders, 
one for the AM chain and one for the HD chain.  
Input: Unprocessed Audio  
Output: AM Analog Processed Audio Out (Lf/Rf) / HD Output (Ls/Rs), both 
optionally including Nielsen Radio watermarks.  
 
The specified Windows Recording and Playback devices must be set up to 
match the processing mode [step (A) on page 2-7] or OPTIMOD XPN-AM 
will issue an error message when you click OK.  

Because many Windows sound devices do not support a true mono 
mode, OPTIMOD XPN-AM’s Mono mode uses stereo (2.0) input and out-
put devices. 

d) Click OK. 

C) Click OK to dismiss the SERVICE SETTINGS dialog box. This will restart the Ser-
vice and briefly mute the audio. 

 

Setting up Security and Networking 

If you do not wish to control XPN-AM from a remote computer, it is unnecessary to 
do the setup described in this section. 

Note that XPN-AM software and (optional) 1600PCn software run on two separate 
Windows Services, and you must set them up separately: You must set up XPN-AM 
security and networking from XPN-AM PC Remote and the 1600PCn from Optimod-
PCn 1600 PC Remote. Moreover, you must do this setup from PC Remote software 
running on the XPN-AM host computer or you must use Windows Remote Desktop 
to access the host computer from elsewhere on your network.  

Both the XPN-AM and 1600PCn Services share the same IP address (that of the host 
computer), but they can be separately addressed by using different TCP/IP Port 
numbers. The instructions below refer to the XPN-AM software and are also broadly 
applicable to the 1600PCn, although their default Port numbers are different. 

1. Set up application control settings. 

These settings can allow XPN-AM PC applications anywhere on your net-
work to connect to the Service. 

A) Open the SERVICE SETTINGS window from TOOLS > SERVICE SETTINGS. See Fig-
ure 2-2: Service Settings on page 2-5. 

B) Choose the Port that you will use to control the Service from XPN-AM PC. 

The default is 12101. 

C) If you wish to allow XPN-AM PC running on other computers to connect to 
the Service, check ALLOW NETWORK TO ACCESS LOCAL PROCESSORS. 
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By default, this box is not checked. When it is not checked, no Processor 
in your computer can be accessed through the OPTIMOD XPN-AM Con-
trol Application running on the network.  

Before you check this box, be sure that you have assigned a password to 
each OPTIMOD XPN-AM Processor in your computer (step 5.D) on page 2-
11). 

D) If you wish to only allow certain IP addresses to connect to the Service: 

a) Check the USE NETWORK ACCEPT list box.  

b) Click the NETWORK ACCEPT LIST button. 

c) Click the ADD button.  

d) Enter host name, domain name, IP address, or subnet 
address in CIDR format. 

Examples: 
 
host.domain.com   Single Computer  

domain.com    Entire Domain  

123.45.67.8    Single Computer  

123.45.67.8/24    Entire IP (subnet) 

Range  

123.45.67.8/255.255.255.0 Entire IP (subnet) 

Range 

e) If you wish to add another computer, repeat steps (a) 
through (c). 

f) When you are finished adding computers, click OK. 

2. Set up Network Terminal Control Settings 

The OPTIMOD XPN-AM Service application hosts a TCP/IP terminal server to allow 
external control of the OPTIMOD XPN-AM Processors from either a Telnet client 
or a custom third party application. Many controls are accessible and all com-
mands are simple text strings. Upon receiving valid commands, OPTIMOD XPN-
AM will con firm by returning a simple text string status message. By implement-
ing external control this way, multiple OPTIMOD XPN-AM Processors can be con-
trolled using standards-based network protocols (that are not Microsoft Win-
dows-specific) anywhere that network connectivity is available. 

A) The IP address of the terminal server is the same as the address of the com-
puter hosting the Service. The default Port is 12106, but you can change this 
as desired.  

B) If you wish to allow only Localhost (127.0.0.1) access to the terminal server, 
check USE LOCALHOST ONLY FOR TERMINAL ACCESS. 

3. Set up security for the Service 

In any but the simplest and most secure installations, we strongly recommend us-
ing password protection to limit access to the SERVICE SETTINGS. Enter it in the 
SERVICE SETTINGS > SERVICE SECURITY / PASSWORD box. 
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4. Local installations: Connecting to an OPTIMOD XPN-AM Processor. 

If XPN-AM PC software is running on the same computer that runs the Service, 
connect to Processors via CONNECT > 

LOCAL. 

5. Set up passwords and names for Proces-

sors in your computer. (optional) 

Before you perform this and subsequent 
steps, please read Overview of an 
OPTIMOD XPN-AM Installation starting 
on page 1-33. OPTIMOD XPN-AM is ver-
satile, so it is important to understand 
the information in that section. 

XPN-AM hardware hosts only one XPN-AM Processor but can host more than one 
(optional) 1600PCn processor. Each 1600PCn Processor hosted on OPTIMOD XPN-
AM hardware appears to the 1600PCn PC remote application as a separate, indi-
vidually addressable audio processor. The number of instances of 1600PCn you 
have purchased determines the maximum number of instances permitted on 
your system. However, turning on CPU-intensive parts of the OPTIMOD XPN-AM 
HD processing or 1600PCn processing (such as MX limiting) may limit the number 
of available instances to fewer than the maximum because all of the CPU power 
has been used up.  

If the CPU is overloaded, you will hear glitches and stuttering in the au-
dio and, in Windows Task Manager on the XPN-AM, you will probably 
see one or more cores of the CPU sitting at close to 100% utilization. 
Each Processor must run almost entirely in one core, although several 
Processors can share one core if that core has enough resources to run 
them smoothly. Note that two Hyperthreaded cores share the CPU re-
sources of a given physical core, so the effective clock speed of a Hyper-
threaded core is slightly more than half that of a physical core. See CPU 
on page 1-5 and the associated discussion. 

Logically, instances are almost independent of each other. XPN-AM and 1600PCn 
PC remote software connect to one instance at a time. Each instance of 1600PCn 
processing can run its own processing presets regardless of what presets other in-
stances are running. 

You must repeat the steps below separately for the XPN-AM Processor and (op-
tional) 1600PCn Processor(s), first using XPN-AM PC Remote and then 1600PCn PC 
Remote. 

A) On the computer running the Service, start the OPTIMOD XPN-AM control ap-
plication, XPN-AM PC.exe, by clicking its icon (“agent”) in your computer’s sys-
tem tray, or from START > PROGRAMS > ORBAN > OPTIMOD XPN-AM.  

Of course, you may create Windows shortcuts to XPN-AM PC using the 
normal Windows mechanisms. 

Newly installed Processors have no passwords. You do not need to assign 
a password to a Processor unless you want that Processor to be accessible 
to a network connected to your computer.  
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Once you have assigned passwords, these passwords can be changed ei-
ther locally or on the network by anyone with the Administrator pass-
word for that instance, but no one else. Do not lose the Administrator 
password you assign in the steps below. 

B) Connect to the Local Processor to which you are assigning a name and pass-
word. 

C) From the Tools menu bar, choose “Administration.” 

Initially, OPTIMOD XPN-AM software identifies a Processor as Proces-
sor[x], where the numbering starts at 1 and increases in steps of 1 for 
each Processor. You can give the Processor an easily remembered name 
(“alias”) by filling in the PROCESSOR NAME field. OPTIMOD XPN-AM soft-
ware can then identify the Processor by this 
name from anywhere on your network.  

If you had previously set up XPN-AM PC on a 
remote computer to include the Profile for this 
service computer [step (8.A) on page 2-13], the 
Profile on the remote computer will not up-
date automatically to show a Processor’s re-
vised Processor Name. To make the revised 
name appear, Delete the Profile on the remote 
computer and Add it again. 

D) Assign a User Password to the Processor by fill-
ing in the USER PASSWORD and CONFIRM 

PASSWORD fields identically. This password al-
lows you to connect to a Processor via XPN-AM 
PC. 

E) Assign a Terminal Password to the Processor by 
filling in the TERMINAL PASSWORD and CONFIRM 

PASSWORD fields identically. This password al-
lows you to connect to a Processor via OPTIMOD 
XPN-AM TCP/IP terminal server to allow external 
control of the OPTIMOD XPN-AM Processors 
from either a Telnet client or a custom third par-
ty application. See OPTIMOD XPN-AM Control 
API on page 5-1. 

F) Assign an Administrator Password to the Proces-
sor by filling in the ADMINISTRATOR PASSWORD 
and CONFIRM PASSWORD fields identically. 

To preserve security, do not make the User and Administrator passwords 
identical. 

Be sure to write down and remember the Administrator Password be-
cause you must have it to change the Processor’s User Password or the 
Processor Name in the future. You may check REMEMBER ADMINISTRATOR 

PASSWORD, but be aware that this will allow anyone with access to the 
Service computer to change the User and Administrator passwords for 
this Processor. Used maliciously, this privilege could lock you out of the 
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Processor, requiring an inconvenient uninstallation, reinstallation and re-
configuration of the Service. 

G) Click SAVE to confirm your entries. 

H) Repeat steps (B) through (G) for each new Processor installed in your local 
computer. 

When you re-enter the CONNECT menu, you will now see the Processors listed by 
the names you have assigned to them, not by their Processor Numbers. 

6. Edit the local OPTIMOD XPN-AM server’s network accessibility, port numbers, and 

Service Security Password. (optional) 

If you have (optional) 1600 PCn processors installed, in the instructions below you 
must use different Port numbers to address the XPN-AM Service and the 1600PCn 
Service because they both have the same IP address, which is the same as the 
host computer’s IP address 

A) If the OPTIMOD XPN-AM application is currently connected to a Processor, dis-
connect it by choosing DISCONNECT from the CONNECT menu. 

B) Navigate to TOOLS > SERVICE SETUP. 

C) Enter the Service Security Password that you originally set in step 3 on page 2-
9. 

The Service Setup Window appears (Figure 2-2 on page 2-5). 

D) Edit parameters in this window as desired. Then click OK. 

7. Edit a given Processor’s name and/or passwords. (optional) 

A) Connect to the local Processor to which you are assigning a name and pass-
word. 

B) From the Tools menu bar, choose “Administration.” 

The Enter Administrator Password window appears. Enter the Processor’s 
Administrator password and hit Enter. 

If you did not enter an Administrator Password in step (5.E), you will not 
see the “Enter Administrator Password” dialog box and the Processor and 
Security Administration window will appear immediately. 

C) The Processor and Security Administration window opens. Edit the fields as 
required. (See step 4 on page 2-10.) 

D) Click “Save” to confirm your changes. 

8. Make Processors visible on remote computers (i.e. those not hosting the Service). 

(optional) 

To aid security, all OPTIMOD XPN-AM Processors are initially hidden from XPN-
AM PC applications running on computers other than the computer hosting the 
Service for those Processors. On each remote-control computer, you must explicit-
ly “add” each Service computer so that its Processors appear on the Connection 
list of the XPN-AM PC application running on the remote-control computer.  



OPTIMOD XPN-AM  INSTALLATION 2-13 

 

To make a Processor controllable from a re-
mote-control XPN-AM PC, you must know 
three things: (1) the IP address of the Service 
computer implementing the Processor, (2) 
the port that was assigned to the Service (de-
fault is 12101 for XPN-AM and 12100 for 
1600PCn), and (3) the User or Administrator 
password of each Processor. 

To add Processors, you must be able to con-
nect to the Orban server software on the 
Service computer running those Processors: 

 The Service computer must be online 

and connected to the network. 

 The Orban server software on the Ser-

vice computer must be running, which 

means that the security key must be 

plugged into a USB socket. 

 The Windows firewall on the Service computer must allow OptimodAPN-

AMService.exe (XPN-AM) and OptimodService3.exe (1600PCn) access to the 

network. (See Using Windows Firewall with OPTIMOD XPN-AM on page 2-

53.) 

 The “Allow Network to Access Local Instances” box in the Service comput-

er’s SERVICE SETUP [step (1.C) on page 2-8] must be selected. 

Computers not actually doing audio processing should not have the OPTIMOD 
XPN-AM Service installed on them; XPN-AM PC Remote does not require (or use) 
the Service to connect to remote Service computers. However, in a network con-
nected to more than one Service computer it is possible to make other Service 
computers visible to XPN-AM PC running on one of them. To do this, ADD the 
Profiles of the additional Service computers one at a time using the instructions 
in step (A) below. In this case, XPN-AM PC can still only control the Service Set-
tings for the computer on which it is installed; the Service Settings of other Ser-
vice computers on the network can only be accessed via their local XPN-AM PC 
applications. 

A) Add a Service computer to the list of available computers containing 
OPTIMOD XPN-AM instances: 

a) Select CONNECT>ADD PROFILE. 

The ADD PROFILE window appears. 

b)  Enter the Profile Name, IP Address, and Port of the Service computer. 

The Profile Name can be any name you wish to use—for example, “Re-
mote.” The profile name is known only to your local computer. The net-
work identifies a given Service computer by its IP address and port, not its 
profile name. The profile name is merely a convenient alias that you use 
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to help identify a Service computer hosting OPTIMOD XPN-AM Processors 
without your having to memorize the computer’s IP address. 

c) Click Add. 

If XPN-AM PC can connect to the Service computer, the Processor Names 
of all Processors running on that Service computer will automatically ap-
pear in the PROCESSORS AT REMOTE SITE list. XPN-AM PC will add them to 
the Connect menu and the Connection List window. You can open the 
Connection List window by selecting it from the VIEW menu. 

B) Add remote computer Profiles and the instances in each Profiled computer as 
desired, by repeating step (A) for each remote computer. 

9. Connect to a remote Processor. (optional) 

You can now connect to any Processor that you added in step 4 on page 2-10 if 
this Processor’s Service is running and connected to the network. 

A)  Click the CONNECT menu. A drop-down menu appears containing a list of all 
remote computers. Drag your mouse down to the desired computer to reveal 
a submenu containing all Processors within it that have been added. Select 
the desired Processor to connect to it. 

B) The “Enter User Password” dia-
log box appears. Enter the pass-
word and click ENTER. If you wish 
to bypass this dialog box auto-
matically in the future, check the 
REMEMBER USER PASSWORD box in 
the ADMINISTRATION screen on 
your local computer [step (5.C) 
on page 2-11]. (Only Administrators of your local Machine can restore this dia-
log box once you have specified 
that it is to be bypassed.) 

After you click ENTER, the Control 
application will display the state 
of the Processor to which you just 
connected, and you can recall pre-
sets, adjust input/output levels, 
edit and save presets, etc. 

10. Delete a remote computer’s profile. (optional) 

If you no longer wish to have a particular remote computer appear in the list of 
available computers, you can delete it from 
the list. Additionally, Deleting a profile and 
then Adding it again will refresh the Processor 
Names if you changed these on the Service 
Computer. 

A) Disconnect from any Processors using the 
CONNECT > DISCONNECT menu item. 
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B) Open the CONNECTION LIST window using VIEW > CONNECTION LIST. 

C) Right-click the remote computer you wish to remove and select DELETE 

PROFILE. 

The remote computer’s profile (and the profiles of all of its correspond-
ing Processors) are removed from your local computer. This action does 
not affect any other computer on the network. 

You can restore the remote computer’s profile by following the instruc-
tions in step (8.A) on page 2-12. 

Hardware I/O Setup 

Overview of Sample Rate Management and Clocking 

XPN-AM can accept any sample rate from 32 to 96 kHz at its AES3 digital inputs and 
can emit 32, 44.1, 48, 88.1, or 96 kHz sample rate at its output. The procedure for 
configuring the system output sample rate depends on whether or not the RME 
HDSPe AIO Pro card (supplied with HD units) is installed, and is described in the steps 
below.  

The 1101e card is equipped with hardware input sample rate converters, which al-
lows it to accept AES3 signals at any standard sample rate, 32-96 KHz. The RME card 
does not have input sample rate converters, so it must be synchronized either to 
house wordclock or to its digital input. In HD installations, the 1101e receives the 
unprocessed input signal and this is looped through to the RME card via a hardware 
AES3 connection after the 1101e has provided sample rate conversion. 

The internal sample rate of the XPN-AM processing software is 48 kHz. The software 
can also run at 44.1, 96, or 192 kHz by using its internal synchronous sample rate 
converters but these take additional CPU power compared to 48 kHz, so 48 kHz is 
preferred. The XPN-AM software and I/O hardware is pre-configured for 48 kHz in-
ternal operation. In an HD Radio installation, you must run XPN-AM at 44.1 kHz. 

Via hardware sample rate converters, the supported sample rates at the 1101e card’s 
AES3 digital outputs are 32, 44.1 kHz, 48 kHz, and 96 kHz, 16-bit or 24-bit. It is 
shipped for 48 kHz/24-bit output. The 1101e card’s WAV I/O must run at 48 kHz. 

The optional RME HDSPe AES card can accept any input sample rate from 32 to 192 
kHz. Unlike the 1101, the RME HDSPe can run internally at several different sample 
rates, and its output sample rate is always the same as its internal sample rate be-
cause the card does not have sample rate converters. In XPN-AM, the card is shipped 
configured for 48 kHz input/output. If you need a different sample rate (typically 
44.1 kHz), you must reconfigure the sample rates of both the card (in the Windows 
Sound control panel and in the RME PC application) and the XPN-AM software (in 
XPN-AM PC’s Service setup window). See step 6 Error! Reference source not found.on 
page 2-21. 
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Clock Synchronization: When the optional RME HDSPe card is installed, you can ei-
ther use the 1101e’s internal clock as a master clock and lock the RME card to it, or 
you can lock both the 1101e and the RME HDSPe to an external wordclock. 

The clocks of both the 1101e and the ARS16e-SRC should be locked together. There 
are two ways to do this (see step 2.A) on page 2-18). 

 Drive both the RME HDSPe AES and the 1101e’s wordclock inputs from two out-

puts of your house wordclock generator. Configure both cards to sync to exter-

nal wordclock. This is the preferred method because the reference is always 

available, even when XPN-AM is starting up. 

 Drive the 1101e’s wordclock input (the BNC connector on the rear flange) from 

wordclock or a 10 MHz GPS-locked reference. Configure the 1101e to accept 

wordclock/10 MHz sync via I/O>INPUT OUTPUT CONFIGURATION>DIGITAL CLOCK 

REFERENCE. Connect the 1101e DIGITAL OUTPUT 1 to the RME card’s DIGITAL INPUT 

1/2 and configure the RME card so that it is locked to its DIGITAL INPUT 1/2. This 

locks the RME to house wordclock or 10 MHz via the 1101e.  Note that when 

booting up XPN-AM, the clock reference will only be available to the RME card 

after the 1101e finishes starting up. 

Optimod-PC 1101e 

Base XPN-AM units ship with an installed Optimod-PC 1101e card for audio I/O. This 
card looks like two separate full-duplex sound devices to Windows. It is controlled 
by Optimod-PC Remote software, which is installed on XPN-AM hardware. Common-
ly used setup controls are also available in XPN-AM PC software (I/O>INPUT OUTPUT 

CONFIGURATION).  

The 1101e’s analog and digital inputs and outputs appear on a DB-25 connector. 
XPN-AM ships with a matching cable with XLR inputs and outputs for everything but 
wordclock, which is on a female BNC connector. A BNC on the rear flange of the 
1101e card provides a parallel wordclock input. 

The 1101e manual, block diagram, and I/O connector wiring diagram are available 
from the software’s HELP menu. 

As shipped, WAVE1 IN and WAVE1 OUT route audio to and from the XPN-AM soft-
ware. WAVE2 IN and WAVE 2 OUT are available for other uses, such as accommodat-
ing an onboard playout system. The analog output and both AES3 outputs emit the 
processed AM analog audio. 

As shipped, the input to the XPN-AM processor uses the 1101e’s Direct Mixer 1 and is 
a mix of the analog input and the two AES3 digital inputs. Most users will want to 
choose one of these inputs and mute the others. You can do this from the XPN-AM 
PC Remote software (I/O>INPUT OUTPUT CONFIGURATION). 
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1. Connect basic I/O 

A) Connect the 1101e input (analog or digital 1) to your audio source. Digital is 
preferred. 

You may wish to configure your system so that OPTIMOD-PC will auto-
matically switch to a backup feed if a primary feed fails. The ANALOG L/R 
and DIGITAL 2 inputs can be programmed to mute automatically if the 
DIGITAL 1 input is locked to an AES3 input signal and to unmute if the 
DIGITAL 1 input loses lock. 

You must use Optimod-PC Remote to set this up. In I/O>DIRECT MIXER 1, 
check (by clicking) the BACKUP INPUT FOR DIGITAL 1 box on either (or both) 
of the ANALOG L/R and DIGITAL 2 inputs. If both are checked, then a failure 
of the DIGITAL 1 INPUT will automatically unmute only the DIGITAL 2 INPUT. 
If the DIGITAL 2 INPUT then fails, the ANALOG L/R INPUT will automatically 
unmute. 

You can set these functions separately on the Processor mixer and the Di-
rect Mixers. The three mixers will behave independently according to 
their individually set programming. 

If both “backup for digital 1” and “mute” are selected, the backup func-
tion will override the mute function. 

B) Connect the 1101e outputs according to your needs. 

 As-shipped, all three outputs emit the AM-processed signal, which is called 

DIRECT WAVE 1 in the SIGNAL ROUTE FROM drop-down above each output 

fader in 1101 PC’s I/O > OUTPUT LEVELS  tab. 

 However, you might want to use one output (typically the analog stereo 

output pair) to drive talent headphones with a signal processed by the 

1101e’s onboard low-delay audio processor. This signal is called PROCESSOR 

MIXER PRE-LIMIT in the SIGNAL ROUTE FROM drop-down. Refer to the 1101e 

manual for instructions on how to use its audio processor, whose drive level 

and input routing are controlled from the I/O > PROCESS MIXER tab. 

2. Set up the 1101e for basic I/O. 

You can make commonly-needed adjustments to the 1101e direct from XPN-AM 
PC Remote in the I/O > INPUT/OUTPUT CONFIGURATION tab (see Figure 2-4: 1101e 
Configuration in XPN-AM PC Remote on page 2-18). 

If you have the 1101e PC application open and it connected to the 1101e 
card via a “Localhost (127.0.0.1)” or other network connection, the con-
trols in 1101e PC Remote will change graphically in real time as you ad-
just them from XPN-AM PC. However, if you are connected to the 1101e 
via the default “Local” connection, the GUI will not show XPN-AM-driven 
changes in real time, but will instead update when you toggle focus be-
tween the tab containing the controls (mostly Direct Mixer 1) and anoth-
er tab, or if you close and reopen the I/O window.  
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If you change these controls from 1101e PC Remote and the INPUT/OUTPUT 

CONFIGURATION tab is open in XPN-AM PC Remote, the controls in XPN-AM 
PC Remote will not update automatically because the 1101e cannot 
“push” these control changes to the XPN-AM, so the XPN-AM needs to 
poll the 1101e Service to detect control values. To update the controls 
appearing in XPN-AM, click on the tab background somewhere outside 
the controls. Controls will also update if you change focus to another tab 
and back again, or if you close and open the I/O windows. 

A) Set the DIGITAL CLOCK REFERENCE as required. 

The 1101e’s internal sample rate is always 48 kHz. Via hardware sample 
rate converters, it can emit 32, 44.1, 48, 88.2, or 96 kHz. These sample 
rate converters are locked to the chosen DIGITAL CLOCK REFERENCE, which 
also syncs the internal 48 kHz sample rate used for WAVE I/O. 

Regardless of whether the 1101 is locked to an external reference or its 
internal crystal oscillator, you can freely set the output to 32, 44.1, 48, 
88.2, or 96 kHz—the locked output sample frequency does not have to be 
the same as in the reference sample frequency. For example, if the refer-
ence sample frequency is 32 kHz and the output sample frequency is set 
to 48 kHz, the actual output sample frequency will be exactly 48/32 x the 

 

Figure 2-4: 1101e Configuration in XPN-AM PC Remote 
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reference sample frequency. 

 INTERNAL uses the 1101e’s internal timebase to set its output sample rate. 

You can use this if your facility does not use wordclock or other master syn-

chronization source. Because of its input sample rate converters, the 1101e 

can accept asynchronous sources. If your XPN-AM has the optional RME 

card installed, you must sync the RME card to one of the 1101e’s digital 

outputs. 

 EXT SYNC DIGITAL IN 1 synchronizes the 1101e’s timebase to the AES3 signal 

appearing at Digital Input 1. You can use this to ensure that the XPN-AM’s 

output sample rate at its two AES3 outputs are synched to XPN-AM’s Digi-

tal Input 1. It is useful if there is no wordclock reference available. 

 EXT SYNC DIGITAL IN 2 synchronizes the 1101e’s timebase to the AES3 signal 

appearing at Digital Input 2. 

 WORD CLOCK/10 MHZ IN synchronizes the 1101e’s timebase to a 1x wordclock 

or 10 MHz reference signal applied to the 1101e’s wordclock input. The 

1101e will automatically detect which type of reference signal is applied. 

The 1101e can accept 32, 44.1, 48, 88.1, or 96 kHz wordclock inputs and 
via internal multipliers and dividers, will lock the 1101e’s internal 48 kHz 
sample rate to any of these reference frequencies. (For example, the 
1101e will automatically multiply a 32 kHz wordclock frequency by 3/2 to 
derive a 48 kHz reference.) 

The 1101e digital outputs can be set to 32, 44.1, 48, 88.1, or 96 kHz, using 
the locked internal 48 kHz clock as a sync reference. Hence, the 
wordclock sample rate can be different than the sample rate at either 
1101e output, whose sample rates can be set independently. 

B) Choose your primary input. 

There are three checkboxes that allow you to mute the analog input, Dig-
ital Input 1, or Digital Input 2. Mute all but your primary input. 

If your primary input is Digital Input 1 and you wish to set up automatic 
backup in case signal to this input is lost, see step 1.A) on page 2-17. 

3. Set up a low-delay headphone processor (optional) 

Refer to the 1101e manual for details. 

A) Open the 1101e PC Remote application. 

B) In I/O > PROCESS MIXER, choose the input used to drive the headphone proces-
sor. You can mute the unused inputs or configure them for automatic backup. 
See step 1.A) on page 2-17. 

C) Recall an 1101 processing preset from the 1101 by clicking the P button on the 
1101 PC toolbar. 

D) With program material driving XPN-AM at normal operating levels, in the 
process mixer adjust the level of the input you chose in step B) above to pro-
duce 10 dB of 1101 AGC gain reduction. 
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E) In I/O > OUTPUT LEVELS assign the output you wish to use for headphone moni-
toring to PROCESSOR MIXER PRE-LIMIT and adjust it to your preferred level. 

F) At your leisure, audition processing presets to find one that your talent pre-
fers. All presets can be further adjusted via the 1101 LESS-MORE control. 

 
RME HDSPe AES 

The optional RME HDSPe AES card supports the XPN-AM’s built-in HD processing by 
using the RME HDSPe’s multichannel (5.1) playout facilities to ensure sample-
accurate time lock between the AM and HD outputs.  

As shipped, the RME card is set up for 48 kHz output sample rate. It does not have 
input or output sample rate converters, so the sample rate of its input must be abso-
lutely identical to the sample rate of its output. 

The RME HDSPe AES card has a DB25 connector for AES3 input and output, labeled 
AES 1-4 8. This uses a “Tascam” pin configuration. The input and outputs shown in 
Table 2-1 are available from AES 1-4. Wordclock input and output as found on the 
rear flange of the card on BNC connectors. 

Overview: For convenience and robustness, we recommend applying your digital in-
put signal to the 1101e’s AES1 input (which has a sample rate converter, making the 
input sample rate non-critical). Route the input signal via the 1101e’s Direct Mixer to 
the 1101e’s AES1 output. Connect the 1101e’s AES1 output to the RME’s AES1/2 in-
put. Set the sample rate of the 1101e’s AES1 output to the desired output sample 
rate of the RME card. Synchronize the RME’s internal sample rate to the 1101e’s 
AES1 output. (You can alternatively sync the RME to wordclock if the 1101e is also 
synced to wordclock. This alternative has the advantage of faster lock.) Set the XPN-
AM’s internal I/O sample rate to match. 

1. Set up the 1101e to receive an analog or AES3 digital input signal. 

See step 1.A) on page 2-1717. 

2. Route the 1101e’s inputs to its Digital 1 Output. 

Open the 1101e PC Application. In the 
I/O>OUTPUT Levels tab, choose DIRECT 

MIXER 1 as the source. 
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3. Set the 1101e’s sync reference source. 

A) In I/O>CONFIGURATION, set the 1101e to 
synchronize to an external clock source. 
Refer to Clock Synchronization on page 
2-16. In an HD Radio installation, this 
must be 44.1 kHz, locked to a GPS ref-
erence. 

B) Apply the reference to the 1101e’s 
WORDCLOCK/10 MHZ input, and verify 
that the SYNC INPUT FREQ responds and 
does not show NO LOCK. 

 

4. Connect the inputs and outputs. 

A) Connect the 1101e’s Digital Output to the RME’s AES 1/2 Input. 

B) Connect the RME’s AES 1/2 Output to the AM input of your transmitter. 

C) Connect the RME’s AES 5/6 Output to the HD input of your transmitter. 

Cable Identifier Function 

AES 1/2 In main program audio input 

AES 1/2 Out AM-processed output 

AES 5/6 Out HD-processed output 

Table 2-1: RME HDSPe I/O Connections 

5. RME HDSPe AES clocks to house sync. 

The RME card can be controlled via the RME TotalMix application, which is pre-
installed. The RME HDSPe AES manual is available for download: 

https://archiv.rme-audio.de/download/hdspaes32_e.pdf 

A) Launch the TotalMix application and open the SETTINGS window. 

B) Set the CLOCK SOURCE TO AES1 
or WORDCLOCK, depending on 
which you are using. 

 

6. Reset the output sample rate (optional). 

Changing sample rate requires changing the rate from the RMS TotalMix applica-
tion and also requires setting the sample rate and bit depth identically in the 
Windows Sound control panel for all inputs and outputs. 

A) From XPN-AM PC, stop the XPN-AM Service. 

a) If XPN-AM is currently connected (i.e. shows meters and controls), 
disconnect it via the CONNECT menu item. 

b) Click the STOP button in TOOLS > SERVICE SETTINGS. 

https://archiv.rme-audio.de/download/hdspaes32_e.pdf
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B) Open RME TotalMix application 
and choose the new sample rate in 
the RATE SELECT drop-down menu. 
The picture shows 44.1 kHz. 

 

C) Open the Windows Sound con-
trol panel and select the 
PLAYBACK tab. 

(Note that the screenshot, 
prepared for an earlier ver-
sion of the product, shows a 
“Lynx AES16e” sound de-
vice instead of RME HDSPe 
AES.) 

 

D) Right-click SPEAKERS (RME 
HDSPe AES) and choose 
PROPERTIES. 

E) Click the ADVANCED tab and 
choose 24bit [xxxx] kHz, where 
xxxx is your new sample rate. 
Then clock OK. 
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F) In the Sound control pan-
el, click SPEAKERS (RME 
HDSPe AES) and then click 
the CONFIGURE button.  
 
If 5.1 SURROUND is not al-
ready highlighted, click it.  
 
Then click the NEXT button 
in the following screens 
until the FINISH BUTTON 
appears. Click it. 

 

G) For each remaining RME 
HDSPe AES Playback device 
(3/4 through 7/8), right-
click it, choose PROPERTIES 

> ADVANCED, and select 2 

CHANNEL, 24 BIT [XXXX] KHZ, 
where xxxx is your new 
sample rate. Then click OK. 

 

H) In Windows Sound control 
panel, click the RECORDING 
tab. 
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I) Right click RECORD 01 + 02 

(RME HDSPe AES) and 
choose PROPERTIES > 

ADVANCED. 

J) Select 2 CHANNEL 24 BIT [XXXX] 

KHZ, where xxxx is your de-
sired sample rate. 

 

K) For each remaining RME 
HDSPe AES Record device 
(3/4 through 7/8), right-click 
it, choose PROPERTIES > 

ADVANCED, and select 2 

CHANNEL, 24 BIT [XXXX] KHZ, 
where xxxx is your new sam-
ple rate. Then click OK. 

 

L) As soon as the XPN-AM ap-
plication opens, go to TOOLS 

> SERVICE SETTINGS and click 
the EDIT button in the 
VIEW/SET AUDIO ROUTING box. 
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M) Set the SAMPLE RATE to 
your desired rate and 
click OK.  
 
If you get an error mes-
sage regarding unsup-
ported sample rate, bit 
depth, etc., double-check 
to make sure that the 
RME HDSPe AES Speakers 
properties are 24-bit at 
your desired sample rate 
and that the channel con-
figuration is 5.1 [steps (E) 
and (F) on page 2-23].  
 
(Note that the screenshot 
shows “Lynx” instead of 
“RME.”) 

 

N) If the Service is stopped (in TOOLS > SERVICE SETTINGS) restart it. Then connect 
to the XPN-AM processor via the CONNECT menu item.  
 
If you get an error message and cannot connect to the Service, re-check the 
RME Speakers configuration per step (M) above. 

 
 

Setup: The OPTIMOD XPN-AM Control Application 

Once you have connected the OPTIMOD XPN-AM Control application to an 
OPTIMOD XPN-AM Processor, the software allows you to control the Processor as if 
it were a dedicated hardware processor. The Control application displays gain reduc-
tion meters, as well as controls that allow you to edit the sound of the factory pre-
sets to your liking. Section 3 of this manual explains these sound editing controls in 
detail. 

 

1. Make sure that the transmitter is turned off. 

This avoids potential damage caused by overdriving it. You will set the modula-
tion level later in this setup procedure. 

2. Select the Processor you are setting up. 

A) From the CONNECT menu on the Control application, select the Processor you 
are setting up by connecting to it. 

If you wish, you can edit the factory default Input/Output (“IO”) setup. 
You also have the option to OPEN SETUP or SAVE SETUP AS in the Control 
application’s FILE menu. Therefore: 
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 You can save your current setup to a file and then apply it to another Pro-

cessor. 

 You can load a previously saved setup into the Processor that is currently 

selected 

3. Activate or defeat processing features as needed. 

OPTIMOD XPN-AM allows you to deactivate processing blocks that you 
do not need. This can reduce input/output delay and/or reduce CPU us-
age. 

A) From the TOOLS menu, open the I/O Mixer and click the UTILITY tab. 

B) Set each switch as appropriate. 

 HD PROCESSING: Activates or defeats the HD processing chain. If you are not 

using it, defeat it to save energy and run the CPU at a lower temperature. 

To use HD processing, you must have previously set up the audio I/O for 5.1 

In / 5.1 Out per step 6 on page 2-6. 

 STEREO SYNTHESIZER: The stereo synthesizer is not a compute-intensive pro-

cess, but it introduces about 187 ms of look-ahead delay to allow its auto-

matic mode sensing to work (by sensing silence in the right channel). De-

feating the stereo synthesizer removes this delay. 

 PHASE CORRECTOR: The phase corrector is a moderately CPU-intensive pro-

cess that introduces about 170 ms of delay. It does not operate in the back-

ground when it is defeated in the active processing preset. Therefore, the 

main benefit to defeating it in the System is to remove its delay. 

 EXTERNAL AGC: Setting this to YES defeats XPN-AM’s built-in AGC.  

 

When you are first setting up XPN-AM, temporarily set the control to NO so 

that you can easily set operating levels using the AGC G/R meter. 
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 RATINGS LOOP: Allows you to use the C/LFE inputs and outputs to connect a 

ratings encoder. 

To prevent loss of audio, silence sense automatically bypasses the ratings 
encoder loopthrough if it detects audio at the input of the ratings en-
coder but not at its output for at least two seconds. 

The ratings encoder loop is located just after the AM multiband compres-
sor and only applies encoding to the AM analog output. The loop adds 
about 600ms of delay to the AM analog chain. When the ratings loop is 
active, the meter delays in the AM processing chain are adjusted to keep 
these meters time-synchronized. However, because the HD and AM pro-
cessing chains have different delays when the ratings loop is active, this 
causes the HD meters to indicate early compared to the AM meters. 

 DELAY CHANGE MODE: Allows the HD diversity delay to be smoothly ramped 

with a slew rate of 0.025 seconds/second, or to jump immediately to a new 

value. Use JUMP when you are first setting up the diversity delay. Use RAMP 

to make small adjustments on-air. This is typically done automatically by an 

external device, whose output is connected to XPN-AM via its terminal con-

nection. Refer to OPTIMOD XPN-AM Control API on page 5-1. 

The ramp is not pitch-corrected, but the pitch shift is small 
enough (about 1/3-semitone) to be unobjectionable when small 
delay adjustments occur. 

 LOUDNESS METER UNITS: This determines the label of the BS.1770 loudness 

meter and only affects the graphics. LkFS is typically used in the United 

States and LUFS in Europe. 

4. Set the Input Mode. 

[Stereo, Mono L+R, Mono L, Mono R] 

The INPUT MODE determines whether the AM analog processing is fed from the 
stereo input or from mono derived from it. It does not affect the HD processing, 
which is always driven by the stereo input. 

All processing blocks prior to the AM/HD split (DC removal highpass filter, 
mono bass blend, phase corrector, and AGC) operate in stereo. The INPUT 

MODE processing occurs between the AGC and the AM equalizer block.  

A) Click the [IO] button to open the IO window. 

B) Click the INPUT tab. Then select the INPUT MODE from the drop-down. 

5. Adjust Input Reference Level. 

[–10 to –40 dBFS (VU) or –3 to –33 dBFS (PPM) in 0.5 dB steps] 

The reference level VU and PPM (Peak) settings track each other with an 
offset of 7 dB. This compensates for the typical indications with program 
material of a VU meter versus the higher indications on a PPM. 

This step sets the center of the XPN-AM’s gain reduction range to the level to 
which your studio operators peak their program material on the studio meters. 
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This assures that the XPN-AM’s processing presets will operate in their preferred 
range. 

You may adjust this level with a standard reference / line-up level tone from your 
studio or with program material. 

Note that in this step, you are calibrating to the normal indication of the studio 
meters; this is quite different from the actual peak level.  

If you know the reference level that will be presented to the XPN-AM, set the 
reference level to this level, but please verify it with the steps shown directly be-
low. 

A) Click the RECALL PRESET button ([P] on the button bar). 

B) Double-click AM GENERAL MEDIUM. 

C) Calibrate using Tone. 

[Skip to step (D) if you are using Program material to calibrate the XPN-
AM to your standard studio level.] 

a) Verify EXTERNAL AGC is set to NO. 

Refer to step 3 on page 2-26.) 

b) Feed a tone at your reference level to the XPN-AM 

If you are not using a studio level controller, feed a tone through your 
console at normal program levels (typically 0VU if your console uses VU 
meters). 

If you are using a studio level controller that performs an AGC function, 
such as an Optimod 6300, adjust it for normal operation. 

c) Adjust the INPUT REFERENCE LEVEL control to make the XPN-AM’s AGC 
meter indicate 10 dB gain reduction. 

d) Skip to step (E). 

D) Calibrate using Program. 

[Skip this step if you are using Tone to calibrate the XPN-AM to your 
standard studio level — see step (C) above.] 

a) Verify EXTERNAL AGC is set to NO. 

Refer to step 3 on page 2-26. 

b) Feed normal program material to the XPN-AM 

Play program material from your studio, peaking at the level to which 
you normally peak program material (typically 0VU if your console uses 
VU meters). 

c) Adjust the INPUT REFERENCE LEVEL control to make the XPN-AM’s AGC 
meters indicate an average of 10 dB gain reduction when the console’s VU 
meter or PPM is peaking at its normal level. 
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If the AGC gain reduction meter averages less than 10 dB gain reduction 
(higher on the meter), re-adjust the INPUT REFERENCE LEVEL to a lower 
level. 

If the AGC gain reduction meter averages more gain reduction (lower on 
the meter), re-adjust the INPUT REFERENCE LEVEL to a higher level. 

E) When finished, reset EXTERNAL AGC to YES if required (e.g., if that was its set-
ting prior to setting INPUT REFERENCE LEVEL. 

Refer to step 3 on page 2-26. 

F) Set the WAVE 2 INPUT LEVEL control (optional). 

This control is provided to accommodate an onboard emergency playout 
system if installed. 

a) Set the playout system’s output sound device to WAVE OUT 2 (ORBAN OPTIMOD 

1101). 

b) Go to the I/O > INPUT/OUTPUT CONFIGURATION tab. 

c) Play out typical program material and adjust the WAVE 2 INPUT LEVEL control 
to produce the desired amount of gain reduction (typically 10 dB of AGC 
gain reduction). 

 

6. Set output bandwidth. 

Note to those familiar with other Orban AM processors: In XPN-AM, the highpass 
filter cutoff frequency is not set globally. Instead, it is set in the AM EQ and AM 

SPEECH MODE tabs of the active processing preset. You can have separate settings 
that respond automatically to the XPN-AM’s speech/music detector. 

A) Click the TRANSMISSION PRESET tab and select TX1/DAY. 

To describe their most common application, the four transmission presets 
are labeled TX1/DAY, TX1/NIGHT, TX2/DAY, and TX2/NIGHT, although 
they can be applied in a completely general way to the requirements of 
your transmission facility. Transmission Presets can be recalled by remote 
control (GPI or PC Remote). TX1/DAY is the default transmission preset 
and many stations will always use it once they have set it up. 

The controls within a given transmission preset include lowpass filter cut-
off frequency, lowpass filter shape, positive peak threshold (asymmetry), 
and six transmitter equalizer controls. 

Only one transmission preset can be active at a given time; that preset 
determines the parameters applied to the analog AM processed output. 
Transmission Presets do not affect the output emitting the HD-processed 
signal. 

Once you have selected a transmission preset, that preset will be active 
until you explicitly select another via the front panel or remote control. 
This is true even if AC power is interrupted.  

B) Select the desired filter frequency via the LOW PASS FILTER FREQUENCY drop-
down. 
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Lowpass filter cutoff frequencies range from 2.5 kHz to 9.5 kHz (NRSC) in 
0.5 kHz steps. The setting of the lowpass filter controls your RF occupied 
bandwidth, so it is very important to set it to meet the government 
standards in your country. 

In Region-2 countries, we recommend configuring the XPN-AM for 7.0 
kHz lowpass filtering (via the active transmission preset) and the 
18dB/octave HF EQUALIZER active with a GAIN of 10dB and a CURVE of 0 (via 
the active processing preset). This is similar in spirit to the NRSC pre-
emphasis, which also has a maximum gain of 10dB. However, it provides 
more midrange boost than the NRSC pre-emphasis, which helps the vast 
majority of radios in the field. These are narrowband radios with 2 to 3 
kHz audio bandwidth (3dB down). Of course, if you wish to broadcast 
with strict NRSC pre-emphasis, you can easily adjust the XPN-AM's HF 
Equalizer to do this by setting the HF EQUALIZER SHAPE to NRSC. 

Some U.S. broadcasters have now chosen to reduce their output band-
width below the NRSC limit voluntarily. A 2006 NRSC study with a subjec-
tive listening panel indicated that the panel preferred 6.5 or 7.0 kHz 
bandwidth with typical AM processing, radios, and interference environ-
ments. The advantage of operating with a lower-than-NRSC bandwidth is 
that XPN-AM’s peak limiting system does not have to operate on very 
high frequency energy that could otherwise cause IM distortion in the 
peak limiting system, so it is possible to improve the loudness/distortion 
tradeoff. 

For countries where narrowband lowpass filtering is required, we rec-

 

Figure 2-5: Effect of the LPF Shape Control with F = 5.0 kHz 
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ommend setting OPTIMOD-AM’s lowpass filter to 6.0 kHz. This will meet 
the requirements of ITU-R 328-5 without further lowpass filtering in the 
transmitter. Any such lowpass filters already in the transmitter should be 
removed to prevent overmodulation caused by the filter's overshoot and 
ringing. 

NOTE: Unlike some other Orban AM processors, there is no lowpass filter 
setting available in the processing preset, just in the transmission preset.  

C) To determine whether the input lowpass filter is down 0.1 dB, 3 dB, or 6 dB at 
the lowpass filter cutoff frequency, select the corresponding LOW PASS FILTER 

SHAPE button. By making the transition between the passband and stopband 
progressively more rounded and gentle, each step trades off duller sound 
against less ringing. See Figure 2-5 on page 2-30. 

D) Set the lowpass cutoff frequency for any other Transmission Presets you will 
be using. Note that each preset has an independent setting for lowpass cut-
off, lowpass shape, and asymmetry. 

a)  Click the button corresponding to the transmission preset you are setting 
up.. 

b) Adjust the filter frequency as you did in the steps above. 

7. Set output and configuration level. 

This step assumes you have previously configured the Windows Playback sound 
device you will be using to drive your AM transmitter and (optionally) your HD 
and ratings encoder hardware. 

This is a preliminary level adjustment. Later in this installation procedure, you 
will set XPN-AM for the highest modulation level that your facility can produce. 
If your transmission facility proved to have overshoot, tilt, or ringing when you 
tested it in step 8 on page 2-33, you will have to go through the Transmitter 
Equalizer adjustment procedure, which starts with step 9 on page 2-34. 

A) If your XPN-AM is equipped with an Orban 1101e card for hardware I/O and 
you are using the 1101e’s analog outputs, you can get slightly better peak 
modulation control (by perhaps 2%) by using the XPN-AM’s LF tilt equalizer to 
flatten the 1101e’s analog outputs’ very low frequency response. In the active 
Transmission Preset (I/O > TRANSMISSION PRESET > EQUALIZER), set the L+R LF 

FREQ control to 3 HZ, and set the L+R LF GAIN control to 1.7 dB. 

 

If you are using the 1101e’s digital output to drive the transmitter, set 
the L+R LF GAIN CONTROL to 0 dB because low frequency equalization is 
not usually required with modern transmitters.  
 
To double check, we still recommend testing the entire transmission sys-
tem with an oscilloscope per step 8 on page 2-33. It may turn out that 
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you can get tighter peak modulation control by adjusting the XPN-AM’s 
transmitter equalizer while observing the RF envelope at your transmis-
sion system common point per steps 9 through 12 below. 

B) Make sure that the transmitter is turned off. 

C) Set the AM OUTPUT > 100% OUTPUT LEVEL control to –20 dBFS. 

D) Turn on the 400Hz calibration tone. To do this: 

a) Click the TEST tab. 

b) Set TONE LEVEL to 50%. 

c) Set the TEST MODE to SINE. 

d) Set SINE FREQUENCY to 400 HZ. 

e) Set the Lf and Rf selectors to TONE. 

E) Set AM modulation. 

XPN-AM’s 100% OUTPUT LEVEL control adjusts all AM-processed outputs 
(analog and digital) simultaneously. As shipped, the 1101e emits the AM-
processed signal on its analog output and both digital outputs. 

In HD processors, the optional RME HDSPe AES card emits the AM-
processed signal on the DIGITAL 1/2 output and emits the HD-processed 
signal on the DIGITAL 5/6 output. 

For convenience, the 1101e’s DIGITAL 1 OUTPUT LEVEL and DIGITAL 2 OUTPUT 

LEVEL controls are available from XPN-AM PC software. As shipped, the 
1101e’s analog output level is set so that it clips when it receives 0 dBFS 
from the XPN-AM. The 1101e’s analog output level control is not availa-
ble from XPN-AM PC Software; if needed, you must adjust it from the 
1101e PC application. 

If you will be using both the 1101e analog and digital outputs to drive a 
transmitter (for example, for main and backup), adjust the modulation 
for the analog connection first. You can then trim the digital outputs.~~ 

Note that this procedure allows 2 dB of headroom for the following 
alignment steps. This should suffice for most plants. 

a) In I/O > MAIN OUTPUT, advance the 100% OUTPUT LEVEL control to produce 
40% modulation of the transmitter as observed on a modulation monitor 
or analyzer connected to your transmitter’s sample point. If you plan to 
modulate to +125%, to prevent clipping do not set the 100% OUTPUT LEVEL 

higher than –5 dBFS in this step. (You will typically tun it up approximately 
2 dB in the next step; do not exceed –3 dBFS.) 

b) If you are using the analog output and one or both of the 1101e’s digital 
outputs to drive a separate transmitters or STLs:  
 
After you have set the modulation via the analog output, from I/O > 

INPUT/OUTPUT CONFIGURATION adjust the DIGITAL 1 OUTPUT LEVEL and/or 
DIGITAL 2 OUTPUT LEVEL control as required to produce 40% modulation 
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from the transmitters(s) receiving the digital output(s).  
 
If you cannot produce 40% modulation with the relevant DIGITAL OUTPUT 

LEVEL  control set to 0.0 dB, turn up the 100% OUTPUT LEVEL control in I/O > 

MAIN OUTPUT to produce 40% modulation. Note how far you turned up the 
control; in the 1101e PC Remote application you must then turn down the 
ANALOG 1 OUTPUT LEVEL control (in I/O OUTPUT LEVELS) by the same amount. 

F) In IO > TEST, set the TEST MODE to OPERATE. 

G) Drive the XPN-AM with program material and observe the negative modula-
tion level. Trim the XPN-AM’s 100% OUTPUT LEVEL control so that you observe 
98% modulation on negative peaks. Do not exceed –3 dBFS. 

Spend time observing the modulation with different program material. If 
you see the peak modulation level vary significantly depending on pro-
gram material, the XPN-AM’s transmitter equalizer can usually improve 
this situation considerably. 

Note that if you set the processing up for asymmetrical modulation 
(which is done by editing the active Transmission Preset) and you observe 
negative peaks that are higher than positive peaks, you can correct this 
by changing the setting of the MAIN OUTPUT > OUTPUT POLARITY drop-
down. 

8. Test the equipment downstream from OPTIMOD-AM. 

Test the RF envelope at the transmitter’s output to determine if it exhibits tilt, 
overshoot, or ringing. If you observe these problems, you can often adequately 
equalize it them with the XPN-AM’s transmitter equalizer, whose settings are de-
termined by the on-air Transmission Preset. 

Dealing with tilt and overshoot may seem fussy, but every dB of tilt or overshoot 
is a dB of loudness lost! 

Use the XPN-AM's built-in square wave generator to make this test: 

A) Navigate to IO > TEST. 

B) Set the TONE MOD to 0%. 

C) Set the TEST MODE to SQUARE. 

D) You may now turn the final amplifier on. Observe the RF envelope at the 
common point with a DC-coupled oscilloscope and advance the TONE MOD 
control until you can easily see the shape of the square wave. 

Sweep the SQUARE FREQUENCY control from 125 to 1000 Hz and observe 
the shape of the square wave as you do so. If you are driving more than 
one transmitter and/or your antenna load changes between day and 
night, test all combinations that you will be using. 

If the square wave is free from tilt and ringing at all frequencies in the 
sweep, you do not need to set up the transmitter equalizer in steps 9 
through (10.G)a) below. Otherwise, you must do so to achieve the high-
est loudness and coverage that your facility can produce. 
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If you observe problems with some combinations of transmitter and load 
but not others, record which combinations cause problems. You will only 
need to set up set up the Transmitter Equalizer for these combinations. 
You will dedicate one Transmission Preset for each problematic combina-
tion so that each combination can be equalized independently. 

Figure 2-6 on page 2-36 shows tilt and Figure 2-8 on page 2-38 shows 
ringing. 

 

Caution: To avoid damaging the transmitter, do not exceed 50% modula-
tion with square waves. 

Important: Do not place additional clipping devices after OPTIMOD-AM! 
The additional distortion introduced by these devices will totally nullify 
the advantages of OPTIMOD-AM's distortion-canceling clipper and will 
cause the out-of-band energy induced by clipping to violate FCC or ITU-R 
standards. 

 

9. Equalize the transmitter’s low frequency square wave response. 

[Skip the Transmitter Equalizer adjustment steps [(steps 9 though (10.G)a)] if the 
RF envelope square wave test you preformed in step 8 above showed no sign of 
tilt, overshoot, or ringing.] 

Overview of Transmitter Equalization 

The Transmitter Equalizer has a low frequency section to equalize tilt and a high 
frequency section to equalize overshoot and ringing. If you are adjusting a 
CQUAM AM stereo plant, you must also adjust a second set of high frequency 
controls (for the L–R channel). These L–R controls do nothing in a mono facility. 

The Transmitter Equalizer does not affect the XPN-AM’s HD processed output. 

The Transmitter Equalizer setup parameters are stored independently in the four 
Transmission Presets. If you are driving two transmitters, you will usually dedicate 
either one or two Transmission Presets to each transmitter. Using two transmis-
sion presets per transmitter allows you to equalize that transmitter and its an-
tenna load independently for day and night operation. This may be desirable if 
the transmission parameters (power or antenna pattern) change between day 
and night. 

In addition to the Transmitter Equalizer controls, you must set the LOWPASS and 
POS PEAK controls in each preset you use. 

If you are only driving one transmitter and the plant’s parameters do not change 
between day and night, then you only need to use and adjust the default TX1 / 

DAY Transmission Preset. 

Description of the TX EQ Controls 

LF FREQ: Determines the frequency at which the response of the Tilt 
Equalizer section of the Transmitter Equalizer is up approximately +3dB. 
This control is only available for the L+R (envelope modulation) channel.  
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LF GAIN: Determines the maximum amount of low frequency correction 
provided by the Tilt Equalizer section of the Transmitter Equalizer. The 
control is only available for the L+R channel. 

HF DELAY: Determines the frequency at which the delay equalizer section 
of the Transmitter Equalizer begins to add phase shift to correct for non-
constant delay in the transmitter and antenna system. This control is 
available for both the L–R and L+R channels. 

The L–R channel is only of interest if you are equalizing a CQUAM AM 
stereo installation. In mono installations, the L–R Transmitter Equalizer 
controls have no effect. 

HF GAIN: Determines the frequency at which the High Frequency Shelving 
Equalizer section of the Transmitter Equalizer begins to roll off the high 
frequency response, compensating for overshoot in the transmitter and 
antenna system. This control is available for both the L–R and L+R chan-
nels. 

Procedure for LF Equalization 

You will set up one XPN-AM Transmission Preset at a time.  

A) Connect the vertical input of the oscilloscope to the transmitter’s sampling 
loop (or other convenient source of RF).  

B) Connect the sync (or external trigger) input of the oscilloscope to an available 
XPN-AM analog output or the audio output of your modulation monitor. 

C) Turn on the XPN-AM's built-in square wave generator: 

a) Navigate to SETUP > TEST. 

b) Set the TONE MOD to 0%. 

c) Set the MODE to SQUARE. 

d) Set SQUARE FREQUENCY to 125 HZ. 

D) Turn on the carrier. 

E) Observe the RF envelope at the common point with a DC-coupled oscilloscope 
and advance the TONE LEVEL control to produce 30% modulation. 
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F) Navigate to IO > TRANSMISSION PRESET > TX1/DAY. 

G) Review the RF envelope display. 

Many transmitters (particularly older designs) will produce an RF enve-
lope resembling Figure 2-6. If the oscilloscope display looks like this, con-
tinue to step (H). 

If the oscilloscope display looks like Figure 2-7, no low frequency equali-
zation is necessary. Skip to step 10 on page 2-37. 

H) Set the L+R LF GAIN to 10.0 dB.  

Setting the L+R LF GAIN control to maximum low-frequency boost en-
sures response that is closest to true DC-coupling, optimizing square 
wave response. Note that if the system requires only a slight amount of 
equalization and is over-equalized even with the L+R LF FREQ at 3 Hz, 
you must set the L+R LF GAIN control lower than 10.0 dB. 

Depending on the transmitter, this large amount of boost at sub-audible 
frequencies might cause bounce and/or distortion on heavy bass transi-
ents in music. In step 12 on page 2-39, you will be instructed to turn the 
L+R LF GAIN control down until these problems are no longer observed. 
This will make the measured square wave response poorer. However, en-
gineering realities force a compromise between best small signal (i.e., 
square wave) response and best large signal (i.e., bounce and distortion) 
performance. This compromise is best made by careful experimentation 
with program material to find the setting of the L+R LF GAIN control that 
gives the highest average modulation without audible distortion. 

I) Adjust the L+R LF FREQ to make the square wave as flat as possible.  

Work quickly to avoid overheating the transmitter. Figure 2-7 shows the 
result of a successful adjustment. If a display like that in Figure 2-7 could 
not be produced by adjusting the L+R LF FREQ and L+R LF GAIN controls, 
transmitter low-frequency response is inadequate and there is too much 
low-frequency rolloff. 

A transmitter that cannot be fully equalized can cost up to 4dB average 

  
Figure 2-6: Unequalized RF envelope 

(showing tilt) 

Figure 2-7: RF envelope requiring 

no tilt equalization 
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modulation even though audible frequency response does not suffer be-
cause equalization occurs below the audible frequency range. This prob-
lem cannot be corrected without modifying the transmitter. In many cas-
es, such modification is easy: it merely requires bypassing the highpass fil-
ter(s) in the input stage of the transmitter. It also may require replacing 
coupling capacitors with capacitors of a larger value. In other cases, fun-
damental inadequacies in the input, inter-stage transformers (if used), 
and/or modulation transformers (if used) are the cause. 

Unless the transmitter is of a relatively modern solid-state design, being 
unable to equalize it fully is a good reason to replace it with an up-to-
date solid-state design using a switching or digital modulator. In most 
cases, this purchase will pay for itself in reduced power bills and the new 
transmitter will sound far better on the air. 

J) Turn off the transmitter and allow it to cool down for several minutes. 

10.  Equalize transmitter high-frequency response. 

A) Set the XPN-AM's square wave controls to produce a 1 kHz square wave at 
30% modulation:  

a) Navigate to IO > TEST. 

b) If necessary, set the MODE to SQUARE. 

c) Set the SQUARE FREQUENCY to 1000 HZ. 

Note: Because the XPN-AM is digital, its square wave generator cannot 
produce any harmonics higher than 24 kHz (one-half of its 48 kHz sam-
pling frequency). To prevent visible ringing of the square wave due to 
this sharp cutoff of its higher harmonics, we have applied an internal 
pulse-shaping digital filter to the output of the XPN-AM's square wave 
generator. This filter rounds off the edges and prevents significant ring-
ing. You may want to look directly with the scope at the unequalized 
output of the XPN-AM to get a feel for what this waveform looks like be-
fore it is applied to your transmitter. 

B) Make sure that the oscilloscope is synchronized to the square wave. 

To avoid overheating the transmitter, perform steps (C) through (F) quickly. 

C) Turn on the carrier. Observe the RF envelope at the common point with a DC-
coupled oscilloscope and trim the TONE LEVEL control (if necessary) to produce 
30% modulation. 

Adjustment of the high frequency transmitter equalizer controls cannot 
be done into a dummy load because the transmitter will overshoot and 
ring differently when loaded by the reactance of your antenna system. 

D) Navigate to IO > TRANSMISSION PRESET > TX1/DAY. 

E) Set the L+R HF DELAY and L+R HF FREQ controls to OFF. 

If no overshoot is observed, skip to step (G). 

F) Adjust the L+R HF DELAY and L+R HF FREQ controls to minimize ringing and 
overshoot. 
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The L+R HF DELAY and L+R HF FREQ controls interact. First, adjust the L+R 

HF FREQ control until any ringing is reduced to the same level as the flat 
part of the square wave (you will still have ringing, but no overshoot). 
Then adjust the L+R HF DELAY control (which will further reduce the am-
plitude of the ringing on the leading edge of the square wave while in-
troducing a new ring on the trailing edge) until the amplitudes of the 
ringing at the leading and trailing edges are equal. The peaks of the ring-
ing at both edges should approach the flattop modulation level as closely 
as possible without exceeding it. Note that the L+R HF FREQ control does 
most of the work. 

Note also that the L+R HF DELAY control will produce little or no visible 
effect until you set it beyond 40. 

Adjusting the L L+R HF DELAY control like this usually reduces the level of 
the ringing to below the flattop modulation level. Reducing the setting 
of the L+R HF FREQ control until the ringing is again at the flattop modu-
lation level will unbalance the ringing at the leading and trailing edge of 
the square wave, and necessitate further adjustment of the L+R HF DELAY 
control. Alternate between these two interactive controls until the peaks 
of ringing at both the leading and trailing edges of the square wave are 
at the flattop modulation level. Figure 2-8 illustrates a typical waveform 
before adjustment and Figure 2-9 shows the result of a successful adjust-
ment. (The waveform produced by your system may look quite different.) 

G) Turn off the square wave generator and turn off the carrier to allow the 
transmitter to cool down for several minutes: 

a) Navigate to SETUP > TEST. 

b) Set the MODE to OPERATE. 

11.  Set the L–R Transmitter Equalizer controls. 

[Skip this step unless you are setting a CQUAM AM stereo facility. The controls 
under adjustment in this step do not affect a mono facility if the XPN-AM’s ana-
log processing chain is set to a mono mode.] 

  

Figure 2-8: Unequalized RF envelope 

(showing ringing) 

Figure 2-9: RF envelope showing 

successful HF equalization 
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After you have set up the CQUAM exciter for best separation without any audio 
processing by following its manufacturer’s instructions, you should trim the XPN-
AM’s L–R HF FREQ and L–R HF DELAY controls to maximize stereo separation 
through the entire transmission chain, including the XPN-AM. In most cases, you 
will maximize separation if you set these controls to the same settings as their 
L+R counterparts. However, it may be worthwhile to sweep the system and trim 
the L–R controls to maximize separation. To do so: 

A) Navigate to SETUP > I/O CALIB. 

B) Set the AM PROC control to STEREO. 

C) Navigate to SETUP > TEST. 

D) Set the MODE to BYPASS. 

E) Connect the output of a sweep generator to one input channel of the XPN-
AM (either left or right). Ground the other channel to minimize crosstalk. 

Alternatively, you can use a sweep generator with a digital output and 
use the XPN-AM’s digital input. 

F) Set the sweep generator’s output level to produce about 50% modulation. 

G) Observe the output of your CQUAM stereo modulation monitor correspond-
ing to the undriven channel. 

H) Navigate to IO > MODIFY TRANSMISSION PRESET > TX1/DAY. 

I) Set the L–R HF FREQ and L–R HF DELAY controls the same as their L+R coun-
terparts. 

J) Interactively tweak these controls to maximize separation (by minimizing the 
maximum amount of crosstalk into the undriven channel). It may turn out 
that no improvement is possible. 

K) Navigate to SETUP > TEST. 

L) Set the MODE to OPERATE. 

12.  Test the polarity and LF transmitter equalization settings under program condi-

tions. 

A) Apply program material to OPTIMOD-AM's input at normal operating levels. 

B) Click the [P] button and recall the AM GENERAL MEDIUM preset: 

C) Turn on the carrier.  

D) Navigate to IO > TRANSMISSION PRESET > TX1/DAY. 

E) Set the POS PEAK control to 125%: 

F) Check modulation asymmetry with the oscilloscope or with your modulation 
monitor. 

If negative peaks are modulating higher than positive peaks: 

a) Click the MAIN OUTPUT tab . 
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b) Change the setting of the OUTPUT POLARITY control. 

G) Set the POS PEAK control as desired. 

Set the POS PEAK control as high as your government regulations and 
transmitter performance will allow. In the U.S., FCC Rules limit this to 
125%. 

Be sure to allow sufficient headroom in the processor’s output to ac-
commodate asymmetry and/or transmitter equalization (which pre-
distorts the waveform to compensate for non-ideal transmitter perfor-
mance). Setting the IO > MAIN OUTPUT > AM OUTPUT > 100% OUTPUT LEVEL 
control to –3 dBFS is usually adequate. 

If you choose to modulate asymmetrically with a transmitter that com-
presses peaks in the positive direction, do not attempt to modulate be-
yond the performance limitations of your transmitter. Doing so would 
only cause distortion and possible violation of occupied bandwidth regu-
lations. If  

H) Observe the oscilloscope and adjust the gain of the Windows Playback device 
emitting the AM-processed signal or the transmitter’s input gain to achieve as 
high negative peak modulation as possible without carrier pinch-off. 

If all is well, the negative peaks of the envelope modulation will usually 
hang close to 100% at all times except during pauses. If the correct ad-
justment of the output level control seems dependent on the nature of 
the program material, the transmitter probably suffers from power sup-
ply bounce. See the next step. 

To achieve highest possible modulation without carrier pinch-off (and 
therefore most efficient utilization of available transmitter power), the 
output level control must be adjusted with program material (not test 
tones), because the transmitter will almost always behave somewhat dif-
ferently with program material than with tone. For example, tone cannot 
excite power supply bounce. 

I) Adjust the L+R LF GAIN control in the transmitter equalizer. (optional) 

Some transmitters cannot be corrected fully because the bass boost pro-
duced by the equalizer exaggerates power supply bounce problems 
and/or causes actual saturation or clipping of modulator stages, trans-
formers, reactors, etc. In some cases, a compromise between full tilt cor-
rection and these other problems may have to be achieved by careful ex-
perimentation with program material. The XPN-AM's L+R LF GAIN control 
is designed to permit such a compromise.  

The preceding transmitter equalization adjustment (using square waves) 
was done using the maximum low-frequency boost to ensure response 
that is closest to true DC coupling, which optimizes square wave re-
sponse. If this large amount of boost at sub-audible frequencies causes 
bounce and/or distortion on heavy bass transients in music, turn the L+R 

LF GAIN control down until these problems are no longer observed. This 
will make the measured square wave response poorer. However, engi-
neering realities force a compromise between best small signal (i.e., 
square wave) response and best large signal (i.e., bounce and distortion) 
performance. This compromise is best made by careful experimentation 
with program material to find the setting of the L+R LF GAIN control that 
gives the highest average modulation without audible distortion. 
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If the tilt correction trips overload relays when program material is 
broadcast, it is often possible to readjust the trip point of these relays to 
avoid this problem but do this with the greatest care, because the trans-
mitter will be endangered by an improperly adjusted overload relay. 

Orban accepts no responsibility for transmitter failures introduced by 
such re-adjustments, or by the high average power, bass and treble pre-
emphasis, or by any other characteristics of OPTIMOD-AM audio pro-
cessing. 

The care and feeding of your transmitter requires the application of 
sound engineering judgment: inadequate transmitters (typically of old 
vacuum-tube plate-modulated design) may fail, may have their tube life 
shortened, etc. Such transmitters are simply incapable of supplying the 
average power demands of OPTIMOD-AM processing regardless of 
transmitter equalization. If the station is to achieve the full benefits of 
OPTIMOD-AM processing, these transmitters must be either repaired, 
modified, or replaced. A modern transmitter will sound better and con-
sume substantially less power. 

13.  If you will be using other Transmission Presets, repeat steps 8 through 12 to set 

them. 

Substitute the name of the Transmission Preset under adjustment for “TX1/DAY” 
in these steps. 

Do not forget the set the LOWPASS and POS PEAK controls for each Transmission 
Preset that you use. 

14. Set Digital Radio output level (optional). 

[Skip this step if you are not using the HD/netcast processing] 

A) Navigate to IO > MAIN OUTPUT > HD OUTPUT > 100% OUTPUT LEVEL. 

B) Set the output level to match the clipping level of the digital radio input. 
–2.0 dBFS is a good match to the HD Radio codec. Refer to the transmitter 
manufacturer’s instructions to obtain the correct level. 

IMPORTANT: You cannot use the HD output level control to adjust the 
loudness of the digital channel. This control only sets the peak level ap-
pearing at the HD digital output, and thus the headroom allowed for co-
dec overshoots. To match the loudness of the HD channel to that of the 
analog channel on an HD AM receiver, adjust the IO > GLOBAL > HD 

TARGET LOUDNESS control. 

15.  End I/O setup. 

If you are using a external AGC and you temporarily set the EXT AGC to NO in 
step 1 on page 2-25, set the EXT AGC to YES. 

16.  Select an AM analog processing preset. 

Press the [P] button and double-click a preset whose name begins with “AM.” 

The other presets are HD presets. 
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Selecting a preset is the first step in determining the loudness/distortion 
tradeoff you wish to make. See Factory Programming Presets starting on 
page 3-28.  

17. Adjust AM analog Loudness (optional) 

Once you have set the output modulation, you can adjust the loudness of the 
AM analog transmission via the AM LESS-MORE and AM TARGET LOUDNESS controls 
in the AM LESS-MORE tab of the active processing preset. The loudness/distortion 
tradeoff of all of the AM analog presets was optimized for a target loudness of 
–6 LUFS, so after you have chosen your preferred processing preset, we recom-
mend using LESS-MORE for most of your loudness adjustments. 

For the AM analog processing, the calibration of the BS.1770 loudness 
meter is such that 0 dBFS corresponds to 100% negative modulation, 
with the caveat that the loudness metering is preceded by a lowpass fil-
ter with a 2 kHz passband and an 18 dB/octave, which simulates a “typi-
cal” AM radio. 

For more information, refer to About Target Loudness and ITU-R BS.1770  
starting on page 1-27. 

18. Import an HD/netcast preset (optional). 

[Skip this step if you are not using the HD/netcast processing.] 

The HD processing and the analog AM processing split after the ratings encoder 
loop-through, which follows the AGC. The HD processing provides separate con-
trols for target loudness, LESS-MORE, equalization (including band mix), multi-
band compression, and peak limiting. 

Because of the gross difference is perceived audio bandwidth between AM ana-
log and HD reception, crossfades between the AM analog and HD signals will 
never be imperceptible—the best you can do is to ensure that they are delay-
matched. We therefore recommend using lighter processing on the HD channel 
than on the AM channel, which optimizes the performance of the HDC codec.  

XPN-AM provides a number of importable HD/netcast presets. These are presets 
whose names do not have the “AM” prefix. They provide settings for all of the 
abovementioned controls except for TARGET LOUDNESS, which is set to GLOBAL so 
that it is controlled by the I/O > GLOBAL > HD TARGET LOUDNESS control. The de-
fault value of global HD target loudness is –11 dBFS. 

After you import an HD preset, it becomes part of the overall on-air preset, and 
you can save this combination as a User preset via FILE > SAVE PRESET AS. 

To import an HD preset: 

A) Navigate to FILE > IMPORT HD CONTROLS. 

B) Double-click the desired file. 

You may use any file that does not have the “AM” prefix. 

The dialog box will stay open until you click DONE. Even when the dialog 
box is open, you may click on any “HD” tab in the GUI to observe the ef-
fect of the imported preset on the user controls. 
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19. Set HD/netcast target loudness (optional). 

[Skip this step if you are not using the HD/netcast processing.] 

After you have imported your desired HD preset, use the IO > GLOBAL > HD 

TARGET LOUDNESS control to set its loudness to match the loudness of the AM an-
alog signal as much as possible during a receiver crossfade.. 

Note that if you have chosen lighter processing for the HD channel than 
for the AM channel (as we recommend), the relative loudness of the two 
channels will not be completely consistent, although the shared AGC will 
help. 

20. Set the diversity delay (optional) 

[Skip this step if you are not using the HD/netcast processing.] 

The delay difference between the AM and HD outputs is tightly controlled down 
to the sample. In many cases you may wish to use the XPN-AM’s built-in diversity 
delay instead of the delay built into your HD Radio exciter. 

During adjustment, if the change does not exceed ±1.5 seconds, XPN-AM holds 
the delay in the AM path constant while changing the delay in the HD path. If 
the change is greater than ±1.5 seconds, the AM delay jumps to a new value that 
re-centers the available adjustment range at ±1.5 seconds. 

To set the delay: 

A) In I/O > UTILITIES, set the DELAY CHANGE MODE to JUMP. 

JUMP causes the delay to change almost immediately, where the respon-
siveness is mainly limited by XPN-AM’s intrinsic input/output delay. RAMP 

takes too long to be useful for initial coarse adjustment. For example, 
changing the delay from 0 to 8 seconds would take more than 5 minutes, 
and there would be several glitches as the ±1.5 second limit was exceed-
ed and the AM delay re-centered itself. 

B) Using instrumentation of your choice to measure the relative delay between 
the AM and HD channels at the receiver, set the DIVERSITY DELAY control to the 
match the delays. 

This will cause glitching in the audio if you make a large change. Moreo-
ver, if you boot up XPN-AM with the delay at “0” and then set the delay 
from “0” to some higher value, a momentary audio mute might occur. 

Note: In order to implement delay trimming by changing the HD path de-
lay while holding the AM delay constant, setting the delay to other than 
“0” adds at least 1.5 seconds of delay to the AM and HD paths. 

C) After you have matched the HD and AM signals at the receiver, set the XPN-
AM’s DELAY CHANGE MODE to RAMP. This allows you to make small delay ad-
justments smoothly on-air by limiting the rate of delay change to 0.025 sec-
onds/second. This change will occur in the HD path, not the AM path. 

This feature is most valuable if you automate it by connecting a delay 
measuring device to the XPN-AM’s API via Ethernet. 
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21. Activate the ratings encoder loop-through (optional). 

[Skip this step if you have not installed a ratings encoder.] 

If you have configured the XPN-AM’s input/output to use a ratings encoder and 
have installed the encoder, activate it by setting I/O > UTILITY > RATINGS LOOP to 
IN. 

If you attempt to activate the ratings encoder without having a correctly-
operating ratings encoder installed, setting RATINGS LOOP to IN will acti-
vate a silence-sensing fail-safe that automatically bypasses the ratings 
loop after about 2 seconds. 

To maximize encoding opportunities, the ratings encoder loop-through is 
placed after the AM multiband compressor. This means that it applies en-
coding only to the AM output and a separate encoder would need to be 
inserted after the HD output to encode HD. 

22. Set the Meter Delay (optional) 

The XPN’AM’s meters can be delayed for best match between the audio you hear 
and what you see in the XPN-AM’s GUI. You can adjust the METER DELAY from I/O 

> UTILITY. 

Note that the HD chain meters will not be time-synchronized to the AM 
chain meters when the ratings encoder loop-through is used. This reflects 
the fact that the ratings encoder loop adds about 600 ms to the AM pro-
cessing chain’s delay. 

23. To copy an IO setup from a source Processor to a destination Processor (optional): 

a) If you have not already saved the IO setup you wish to apply to the 
destination Processor, use the XPN-AM PC to connect to the source 
Processor. Then go to FILE/SAVE SETUP and save the IO setup of the source 
Processor. 

When saving, use any legal operating system filename other than de-
fault.orbs, which is a reserved name. Setup files have the form *.orbs. 

A given Processor’s setup is stored in the Registry on the computer where 
that Processor resides. 

The current active setup file is always the last file that was recalled by the 
FILE/OPEN SETUP operation. If you have never recalled a setup file this way, 
the current active setup is stored in a file named system.orbs. 

The current active setup file is a transient file. That is, the OPTIMOD XPN-
AM Control application updates it whenever you change the setup man-
ually. The OPTIMOD XPN-AM Control application also automatically up-
dates the file when the application starts and reads the setup infor-
mation from the Registry. You cannot assume that a *.orbs setup file 
(other than default.orbs)is static or that it will retain its original infor-
mation. 

The factory default system setup is stored as default.orbs. This is a read-
only file. It is the only system setup file that is static and unchanging. For 
further security, it is automatically regenerated each time the Orban Con-
trol Program or Service starts up. 
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b) Connect the XPN-AM PC to the destination Processor. 

c) Go to FILE/OPEN SETUP. 

d) Navigate to the folder containing the setup file you wish to retrieve. 

This will usually be the file you saved in step (a). 

The OPTIMOD XPN-AM file system labels the Processor folders as “Proces-
sor[x],” which is the generic name for a given Processor as shown in the 
TOOLS > ADMINISTRATION dialog box for that Processor. In that folder will 
be a preset folder containing the setup you wish to restore. 

e) Highlight the setup file and select OPEN. 

The OPTIMOD XPN-AM Control application will automatically make a 
copy of just-opened setup file in the destination Processor’s Presets fold-
er. It will automatically update this file if you make manual changes to 
the destination Processor’s IO setup. The original setup file is not 
changed. 

B) If you wish to edit an existing (or factory) setup, proceed to step 3 below. 

C) When you are finished setting up each Processor, close the I/O MIXER window 
by clicking DONE. 

 

Problems and Possible Causes 

Always verify that the problem is not the source material being fed to OPTIMOD 
XPN-AM, or in other parts of the system. 

OPTIMOD XPN-AM does not start up immediately after Windows boots. 

 A delay of 120 seconds is normal and by design. The OptimodService3 start-up 

mode in Windows is AUTO (DELAYED). This helps prevent Windows from compet-

ing with OPTIMOD XPN-AM for CPU cycles during start-up.  

When you launch the OPTIMOD XPN-AM control application, meters and controls do not ap-
pear. 

 You must connect the control application to a Processor using the CONNECT 

menu. This is true even if the control application and audio processing are run-

ning on the same computer. 

You cannot connect to a given Processor from XPN-AM PC. 

 The Service is not running or is configured incorrectly. Be sure that the output 

sound device you are using is configured in WINDOWS CONTROL PANEL > SOUND to 

match OPTIMOD XPN-AM’s output format (stereo or 5.1), sample rate (44.1, 48, 

96, or 192 kHz), and bit depth (16-bit or 24-bit). XPN-AM PC will usually issue an 

error message if there is a mismatch. The Service will not allow audio processing 

to occur if the input and output devices are configured incorrectly. See step 6 on 

page 2-6. 
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 If the Processor is password-protected, you must know it to connect to that Pro-

cessor. This will be obvious because you will be asked for the password when 

you try to connect. 

 The Service is stopped. The Service will only run if a valid copy protection key is 

inserted into a USB slot. 

 The Service has a build date that is after the expiration date of your software 

license. See OPTIMOD XPN-AM does not start up immediately after Windows 

boots above. 

 The computer’s CPU is insufficiently powerful to support OPTIMOD XPN-AM op-

eration. This will usually cause audio stuttering, but in extreme cases will cause 

the Service not to start. 

 Necessary runtime files were not installed. To ensure correct installation, you 

must run the installer application as Administrator. 

You cannot connect to the OPTIMOD XPN-AM Service. 

 If the Service has been assigned an Administrator Password (step 3 on page 2-9), 

you must supply it to gain access to the Service Settings. 

 The copy protection key is not present. Note that the Service will not start up 

automatically if you insert the key after you have booted the host computer. If 

the key was missing, first insert the key and then start the Service from TOOLS > 

SERVICE SETTINGS in XPN-AM PC. 

The OPTIMOD XPN-AM Service crashes when you try to add Processors. 

 The computer on which you are running the Service must have a CPU that sup-

ports the Intel SSE4.1 vector instruction set. All Intel i-series processors support 

SSE4.1. See CPU on page 1-5. 

 You are attempting to run more processors than your computer’s CPU can ac-

commodate. However, this will usually just cause audio stuttering but will not 

cause the Service to crash. See CPU on page 1-5. 

You cannot connect to a given OPTIMOD XPN-AM Processor from a remote computer running 
XPN-AM PC on your network. 

 You must check the ALLOW NETWORK TO ACCESS LOCAL PROCESSORS box in the 

TOOLS > SERVICE SETTINGS dialog box for the Service on the Service computer 

that implements that Processor. See Figure 2-2: Service Settings on page 2-5. 

Other possible causes are: 

 The version of XPN-AM PC on the remote computer is the not same as the ver-

sion on the computer running the Service. If it is not, it will issue an error mes-

sage. Please install the same version on the remote machine. XPN-AM PC is not 

copy-protected, so you may freely install it on as many computers as you wish. 

 Your computer’s firewall is blocking the connection. See page 2-53. 
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 Password is wrong. 

 The target Processor is open on another XPN-AM PC application running on your 

network. 

 The system that houses the target Processor is not on. 

 The Orban Windows service routine, OptimodXPN-AMService.exe, is not running 

in the computer doing the audio processing. 

 The Service has malfunctioned. It is usually possible to restart the Service from 

the TOOLS > SERVICE SETTINGS dialog box in XPN-AM PC running on the Service 

computer. (You may have to restart it twice.) If all else fails, try restarting Opti-

modXPN-AMService from CONTROL PANEL > ADMINISTRATIVE TOOLS > SERVICES.  

If you have forgotten your Administrator or User Password. 

 If you have forgotten an individual Processor’s password, you can change it if 

you know the Administrator Password. See step (5.D) on page 2-11. 

 There is no “backdoor” to retrieve a given Service’s Administrator password. If 

you have forgotten the Administrator password, you must uninstall OPTIMOD 

XPN-AM using the Orban uninstaller, available from the Windows Programs 

menu. When you uninstall, you will be asked if you want to retain your settings 

for use in a new install. Select NO. This will wipe out all of your audio routing 

settings and passwords, allowing you to create a fresh installation with default 

settings . 

  

Before you uninstall, you may use Windows Explorer to make a backup copy of 

the existing system.orbs for each Processor. The default location is:  

C:\Users\Public\Documents\Orban\OPTIMOD XPN-AM\  

Processor [x]\presets\  

Use a different name than system.orbs (like Processor1.orbs) for the copy. Af-

ter you reinstall, you can use these files to restore your I/O settings except for I/O 

routing. Do this by copying them back into the Processor[x] folders after you 

have connected XPN-AM PC to each of the processors. Then make them active 

via the FILE > OPEN SETTINGS menu item in XPN-AM PC. You must do this once for 

each Processor. (See step 5 on page 2-27 for more detail.) 
  

Meters in the XPN-AM PC Control Application freeze momentarily but audio continues to be 
processed normally. 

 This is by design. The software thread controlling the meters is given lower than 

“normal” priority in Windows to prevent the meters from interrupting im-

portant threads that maintain audio continuity. Quickly changing control set-

tings will sometimes temporarily cause the meters to freeze because the control 

setting messages have a higher priority than the meters. 

Poor peak level control in HD/netcast transmission 

 Thanks to its “true-peak” limiter, which anticipates and controls peak levels fol-

lowing an ideal reconstruction filter in the analog domain, OPTIMOD XPN-AM 
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audio processing usually controls its output peak levels to an accuracy of 0.2 dB 

at any output sample rate—in principle, sample rate conversion is similar to re-

construction. However, codecs like HE-AAC have intrinsic peak overshoots and 

you must allow headroom for these to prevent audible clipping in player devic-

es. 1.5 dB is typically sufficient, as the remaining clipping will have a low duty cy-

cle and is unlikely to be audible. OPTIMOD XPN-AM’s HD OUTPUT LEVEL control 

directly controls headroom without affecting loudness. For example, to allow 1.5 

dB of headroom for codec overshoots, set this control to −1.5 dB. 

 An analog connection can cause analog-domain overshoot if the connection is 

not phase linear and has a low-frequency cutoff of greater than 0.15Hz (at 

−3dB). 

Audible distortion 

 Make sure that the problem can be observed on more than one sound system 

and at several locations.  

 Verify that the source material at OPTIMOD XPN-AM's audio inputs is clean. 

Heavy processing can exaggerate even slightly distorted material, pushing it over 

the edge into unacceptability.  

 The subjective adjustments available to the user have enough range to cause 

audible distortion at their extreme settings. Advancing the MB FINAL LIMIT DRIVE 

control too far will inevitably cause distortion. Setting the LESS-MORE control 

beyond “9” will cause audible distortion of some program material. 

 OPTIMOD XPN-AM’s MX peak limiter has several controls that affect the 

tradeoff between bass punch and IM distortion between the bass and midrange. 

Try turning up BASS PRE-LIMITING and BASS LIMITING (move them more towards to 

right of the screen). Setting BASS PRE-LIMIT MODE to HARD and setting the MX 

LIMITER THRESHOLD control slightly below “0” can also help. 

Audible noise in processed audio 

 Excessive compression will always exaggerate noise in the source material. 

OPTIMOD XPN-AM reduces this problem with its compressor gate, which freezes 

the gain of the AGC and compressor systems whenever the input noise drops be-

low a level set by the Gate Threshold control, preventing noise below this level 

from being further increased.  

 

There are two independent silence gates in each processing channel of the XPN-

AM. The first affects the AGC and the second affects the Multiband Compressor. 

Each has its own threshold control. (See  on page 3-51.)  

 

In live news programming, the setting of the GATE THRESHOLD control is quite 

critical if you want the processing to be undetectable to the audience. If this 

control is set too low, then the XPN-AM will pump up quiet sounds like ambi-

ance to unnaturally high levels. Refer to Section 3 of this manual for a further 

discussion. 
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 If you are using OPTIMOD XPN-AM's with a soundcard having an analog input, 

the overall noise performance of the system is usually limited by the overload-to-

noise ratio of the soundcard’s analog-to-digital converter. 

 In digital radio applications, if an analog studio-to-transmitter link (STL) is used 

to pass unprocessed audio to OPTIMOD XPN-AM, the STL's noise level can se-

verely limit the overall noise performance of the system because compression in 

OPTIMOD XPN-AM can exaggerate the STL noise. For example, the overload-to-

noise ratio of a typical analog microwave STL may only be 70-75dB. In this case, 

it is wise to use an Orban Studio Level Controller (like an Orban 6300 or another 

OPTIMOD XPN-AM) to perform the AGC function prior to the STL transmitter 

and to control the STL's peak modulation. This will optimize the signal-to-noise 

ratio of the entire transmission system. An uncompressed digital STL will per-

form much better than any analog STL. Section 1 of this manual has a more de-

tailed discussion.  

Shrill, harsh sound; excessive sibilance 

 Excessively high settings of the HF GAIN control can cause this problem. It can 

also be caused by excessively high settings of the B5 THRESHOLD (Band 5 Com-

pression Threshold) control. In the latter case, you are first likely to notice the 

problem as harsh sibilance on voice. 

System will not pass line-up tones at full output level/100% modulation 

 This is normal in OPERATE mode. Sine waves have a very low peak-to-average 

ratio by comparison to program material. The processing thus automatically re-

duces their peak level to bring their average level close to that of program ma-

terial, promoting a more consistent and well-balanced sound quality.  

 

To pass line-up tones transparently, use Bypass Mode (in I/O > TEST) with the 

BYPASS GAIN set to 0 dB.. 

Speech/music detector toggles continuously between Speech and Music with a low-frequency 
test tone 

 This can occur when the main highpass filter and speech highpass filters are set 

differently. If the test frequency is midway between the two filter frequencies, 

switching between them will cause the tone level to change abruptly, fooling 

the speech/music detector into thinking that this is a speech waveform. This issue 

never arises with program material. See Highpass Filter on page 3-47.   
 

General dissatisfaction with subjective sound quality 

 Make sure that all Windows audio processing is defeated for the Playback Win-

dows sound device you are using. See step 6.A)c) on page 2-7. 

 OPTIMOD XPN-AM is a complex processor that can be adjusted for many differ-

ent tastes. For most users, the factory presets, as augmented by the gamut of-

fered by the LESS-MORE control for each preset, are sufficient to find a satisfac-

tory “sound.” However, some users will not be satisfied until they have accessed 

other Modify Processing controls and have adjusted the subjective setup controls 
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in detail to their satisfaction. Such users must fully understand the material in 

Section 3 of this manual to achieve the best results from this exercise. 

Incorrect Loudness in HD or netcasts 

 Be sure that the HD TARGET LOUDNESS control in I/O > UTILITY is set to your desired 

target loudness. 

 Be sure that the XPN-AM’s input reference level control is set to produce normal 

amounts of AGC gain reduction. See step on page 2-5 on page 2-27. 

 If the loudness controller is on, be sure that the LOUDNESS THRESHOLD control is 

set to 0 dB. 

This matches the loudness controller’s threshold to the XPN-AM’s active 
TARGET LOUDNESS value. 

 If you are using the loudness controller: Once Target Loudness is correct, be sure 

that your active preset is causing the XPN-AM’s Loudness Gain reduction meter 

to indicate approximately 3 dB of gain reduction on normal dialog. Adjust its HD 

MB FINAL LIMIT DRIVE control if it does not.  

 

There are two LOUDNESS LEVEL meters. “dB” indicates according to the CBS 

(Jones & Torick) algorithm. The Lk (or LU) meter indicates BS.1770 short-term 

loudness as a floating yellow segment and BS1770-4 Integrated Loudness as a 

bar. The Integrated measurement uses a 10-second rolling window.  

 

When the loudness controller is operating normally, the XPN-AM’s LOUDNESS 

LEVEL (dB) meter should be peaking around 0 dB on speech. If it is not and you 

are using a custom preset, you might get better loudness control by slightly 

tweaking the LOUDNESS THRESHOLD control to make the LOUDNESS LEVEL (dB) me-

ter peak around 0, bearing in mind that the correct setting is 0 dB. A maximum 

variation of ±1 dB will typically suffice. 

If the XPN-AM’s active TARGET LOUDNESS setting is not the same as your 
transmission’s target loudness, the XPN-AM’s Loudness Level meters will 
be calibrated incorrectly, so even if the meters are indicating 0 dB, loud-
ness at the consumer’s player device will be incorrect. 

Note that because the XPN-AM’s Loudness Level (dB) meter shares the 
loudness controller’s filterbank, the meter does not show the effect of 
the LOUDNESS ATTACK control, which shapes the loudness controller’s gain 
reduction signal outside the loudness controller’s feedback loop. It also 
does not show loudness reduction caused by OPTIMOD XPN-AM’s peak 
limiters. Therefore, if you are using values of LOUDNESS ATTACK below 
about 50% and/or large amounts of peak limiting, the loudness of transi-
ent events may be significantly higher than the Loudness Level (dB) me-
ter indicates. 

The BS.1770 meters [LOUDNESS LEVEL (Lk or LU)] are located after all pro-
cessing, so they accurately indicate the BS.1770 short-term and Integrated 
loudness of OPTIMOD XPN-AM’s output.  
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 If you are not using the loudness controllers: Use the HD FINAL LIMIT DRIVE control 

to calibrate the preset’s loudness such that the  HD BS.1770 loudness meter indi-

cates 0 LU during normal operation with typical program material. Loudness will 

not be as consistent as it is when the loudness controller is active. 

A BS.1770 loudness meter indicates higher loudness than expected with some program material 

 Set the BS.1770 SAFETY LIMIT THRESHOLD control closer to 0 LU. This control is in 

the active processing preset. Using the BS.1770 safety limiter will prevent the 

meter from reading above the preset threshold but may cause subtle loudness 

pumping because of limitations in the BS.1770 algorithm. See BS.1770 Safety 

Limiter on page 3-22 for a more detailed discussion.  

 

Your Optimod has a built-in BS.1770-4 (or higher) long-term (gated) meter with 

a 10-secondintegration time. This should agree with an external BS.1770-4 meter 

that is set up with a 10-second gated integration time, a “Relative” scale (i.e. LK 

or LU), and a reference level equal to your Optimod’s active TARGET LOUDNESS 

value. 

 We do not recommend using the loudness controllers with music-oriented for-

mats, as they will unnecessarily constrain dynamics. In particular, the BS.1770 

Safety Limiter is likely to cause music produced with high amounts of dynamics 

compression to be unnaturally quiet with respect to speech. If the loudness con-

trollers are turned off (as they are in most radio-style presets), the setting of the 

TARGET LOUDNESS control will correspond only approximately to the measured 

loudness. To fine-tune the loudness for your program material, tweak the HD 

MB FINAL LIMIT DRIVE control. Use OPTIMOD XPN-AM’s loudness meters to guide 

you. 

CBS Loudness Controller reduces transient punch of programming 

 Reduce the amount of fast gain reduction in the loudness controller by setting 

the LOUDNESS ATTACK control closer to 0%. This will allow more short loudness 

peaks to pass through without attenuation by the loudness controller. We be-

lieve that the range from 50% to 70% offers the most useful tradeoffs between 

reducing punch and allowing irritating short-term loudness bursts to pass 

through uncontrolled. 

Transient loudness events (like esses in speech) sound obtrusively loud 

 Set the SPEECH B5 THRESHOLD control more negative.  

 Set the TRANSIENT ENHANCE control closer to 0 ms. 

 

Technical Support 

If you are beta-testing XPN-AM, please contact rorban@orban.com directly with set-
up or technical questions. 

mailto:rorban@orban.com
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For non-beta units, if you require technical support contact Orban customer service 
(but please try to find the answer in this manual first). 

See https://www.orban.com/orbansupport for contact information. Be prepared to 
describe the problem accurately. Know the serial number of your XPN-AM and the 
software, and service versions are you running. 

The software version number is available in XPN-AM PC via Help > About 
OPTIMOD XPN-AM… If you used the automatic installer, the software 
version number in the XPN-AM PC installed in the computer running the 
Service will be the same as the version number of the Service. 

Before you return a product to the factory for service, please refer to this manual. 
Make sure you have correctly followed installation steps, operation procedures, and 
any appropriate troubleshooting suggestions. If you are still unable to solve a prob-
lem, contact our Customer Service department. Often, a problem is relatively simple 
and can be fixed quickly after telephone or email consultation. 

If you must return a product for factory service, please notify Customer Service by 
telephone or email before you ship the product; this helps us to be prepared to ser-
vice your unit upon arrival. In addition, when you return a product to the factory for 
service, we strongly recommend you include a letter describing the problem.  

Please refer to the terms of your Limited Five-Year Standard Warranty, which ex-
tends to the first end user. After expiration of the warranty, a reasonable charge 
will be made for parts, labor, and packing if you choose to use the factory service 
facility. Returned units will be returned C.O.D. if the unit is not under warranty. 
Orban will pay return shipping if the unit is still under warranty. In all cases, the cus-
tomer pays transportation charges to the factory (which are usually quite nominal). 

Shipping Instructions 

Use the original packing material if it is available. If it is not, use a sturdy, double-
walled carton large enough to accommodate at least 1.5 inches (4 cm) of cushioning 
on all six sides of the unit, and with a minimum bursting test rating of 200 pounds 
(91 kg). Place the chassis in a plastic bag (or wrap it in plastic) to protect the finish, 
then pack it in the carton with at least 1.5 inches of cushioning on all sides of the 
unit. “Bubble” packing sheets, thick fiber blankets, and the like are acceptable cush-
ioning materials; foam “popcorn” and crumpled newspaper are not. Wrap cushion-
ing materials tightly around the unit and tape them in place to prevent the unit 
from shifting out of its packing.  

Close the carton without sealing it and shake it vigorously. If you can hear or feel 
the unit move, use more packing. Seal the carton with 3-inch (8 cm) reinforced fi-
berglass or polyester sealing tape, top and bottom in an “H” pattern. Narrower or 
parcel-post type tapes will not withstand the stresses applied to commercial ship-
ments. 

Mark the package with the name of the shipper, and with these words in red: 

https://www.orban.com/orbansupport
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DELICATE INSTRUMENT, FRAGILE! 
 
Insure the package properly. Ship prepaid, not collect. Do not ship parcel post. Your 
Return Authorization Number must be shown on the label or the package will not be 
accepted. 

 

Using Windows Firewall with OPTIMOD XPN-AM 

Depending upon your network security requirements, it may be necessary to config-
ure a software firewall application like Windows Firewall, included with Windows. 

 

1. Enable Windows Fire-

wall: 

A) Navigate to 
CONTROL PANEL > 

WINDOWS FIREWALL 

B) Click Turn Windows 
Firewall On or 

Off. 

C) Enable the On 
(recommended) 
button. 

D) Select the Ad-
vanced tab. 

 
 

 

2. Choose the network device that will be used for OPTIMOD XPN-AM access and will 

be protected with Windows Firewall. 
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A) Click Settings… 

 

 

 

B) Click Add… 
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C) Enter the Description of the service, the name 
or IP address, the External Port number, and 
the Internal Port number. 

 

 

D) Select TCP. 

The IP address will be that of the 
computer. To avoid any conflict, we 
recommend choosing a Port higher 
than 1024 that is not otherwise as-
signed according to IANA: 

http://www.iana.org/assignments/port-
numbers 

 

Port 12100 is the default for the OPTIMOD XPN-AM Control Application. 

Port 12101 is the default for the OPTIMOD XPN-AM Terminal Application. 

All processors are controlled by the same Service and share the sma port 
number. 

E) Select OK. 

A dialog box appears, indicating that 
the Orban Optimod XPN-AM Service is 
accessible through Windows Firewall. 
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F) If any changes are required (like IP address 
or port): 

a) Click Edit. 

b) Make the changes. 

c) Click OK. 

 

 

NAT (Network Address Translation) Firewalls 

If the computer containing OPTIMOD XPN-AM is on a network behind a NAT fire-
wall, you must configure the firewall to allow outside access to the OPTIMOD XPN-
AM computer from another computer outside the firewall. This is usually done via 
router port forwarding: The OPTIMOD XPN-AM port(s) are forwarded to the 
OPTIMOD XPN-AM computer by configuring the NAT firewall accordingly. The 
OPTIMOD XPN-AM computer is then addressed with the network IP address (WAN) 
instead of the actual IP address of the OPTIMOD XPN-AM computer.  

For a single IP addressable network, each port can only be used once unless your 
router supports port forwarding. Therefore, if you have more than one computer 
with OPTIMOD XPN-AM requiring outside access, each computer must have a unique 
OPTIMOD XPN-AM port. If your router supports port forwarding, you can assign 
unique incoming ports, map them to the different IP addresses and then use the 
same ports on each computer. 

The OPTIMOD XPN-AM Control application uses TCP only. 

Refer to your router/firewall documentation for the exact configuration procedure, 
paying close attention to the network security risks inherent in configuration 
changes. 

SNMP Support 

[SNMP is not supported in beta software.] 

The SNMP (Simple Network Management Protocol) features allow you to monitor 
your Optimod’s status and to send Alarm notifications to your network via the 
Ethernet connection of your Optimod’s host computer. It is beyond the scope of this 
manual to provide a general explanation of how SNMP works. The text below pro-
vides sufficient information to use your Optimod in your specific SNMP setup if you 
are already familiar with the general principles of setting up SNMP.  



OPTIMOD XPN-AM  INSTALLATION 2-57 

 

SNMP Software Installation 

SNMP support is installed automatically on your computer when you install 
OPTIMOD XPN-AM software. 

SNMP Network Setup 

To set up SNMP, you must run OPTIMOD XPN-AM control software on the same 
computer that houses the OPTIMOD XPN-AM card(s) being monitored by SNMP. 
SNMP runs as part of the same Windows Service that manages communication be-
tween OPTIMOD XPN-AM, your com-
puter, and your network.  

From the TOOLS menu, select SERVICE 

SETTINGS to access the SNMP configu-
ration controls.  

 SNMP (Enable/Disable): enables or 

disables the SNMP feature.  

 Primary Manager Address: sets the 

address of the Primary SNMP Man-

ager.  

 Primary Manager Port: sets the port 

of the Primary SNMP Manager. 

When SNMP is enabled, you 
can disable the primary or 
secondary manager by set-
ting its port to 0. 

 Secondary Manger Address: sets the 

address of a Secondary SNMP Man-

ager.  

 Secondary Manger Port: sets the 

address of a Secondary SNMP Port.  

  

SNMP mib File Location 

 

The default XPN-AM install location is: 

\Program Files\Orban\OPTIMOD XPN-AM\orbanXPN-AM.mib  
or 
C\Program Files(x86)\Orban\OPTIMOD XPN-AM\orbanXPN-AM.mib 

 
SNMP Default Settings 

 

 SNMP Agent: Disabled 
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 Primary Manager(Alarm) Address: 192.168.254.254 

 Primary Manager (Alarm) Port: 0  

 Secondary Manger (Alarm) Address: 192.168.254.254 

 Secondary Manger (Alarm) Port: 0  

  

SNMP Features 

 

Get/Query: 

 Processor name 

 Software version  

 Primary and Secondary Manager IP 

 Primary and Secondary Manager Port 

 InputSilence  

 

Traps/Alert:  

 InputSilence  

 

SNMP Community String:  

The “SNMP Community string” is like a user id or password that allows access to a 
router's or other device's statistics. Set it in SERVICE SETTINGS>SNMP SETTINGS to im-
plement SNMP security. PRTG sends the community string along with all SNMP re-
quests. If the community string is correct, the device responds with the requested 
information. If the community string is incorrect, the device simply discards the re-
quest and does not respond. 

 Read String allows users to set a password for SNMP to retrieve information 

from the Optimod. Default is PUBLIC. 

 Write String allows users to set a password for SNMP to write (set) information 

from the Optimod. Default is PRIVATE.  

Nielsen Radio Watermarking (optional) 

XPN-AM provides optional, built-in Nielsen Audio® watermarking. Analog AM XPN-
AM processors provide one instance; HD XPN-AM processors provide a second in-
stance for the HD/netcast output. 
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1. Set up time synchronization. 

Watermarking requires time synchronization with a network timeserver. XPN-AM 
uses Window’s internal clock to derive the watermark’s timestamp. As shipped. 
XPN-AM’s Windows 10 LTSC operating system is configured to synchronize its in-
ternal clock to a network timeserver. 

When watermarking, XPN-AM must be connected to the Internet to ensure that 
its clock is on-time, and Windows must be configured to synchronize with an In-
ternet timeserver. To verify this: 

A) Access the Windows desktop by connecting a keyboard, mouse, and monitor 
to XPN-AM or by using Windows Remote Desktop. 

B) Open the DATE AND TIME control panel and click the DATE AND TIME tab. 

C) Make sure that the TIME ZONE is set to your local time zone. 

D) Click the INTERNET TIME tab. Then click the CHANGE SETTINGS tab. 

a) Verify that SYNHRONIZE WITH AN INTENRET TIMESERVER is checked. 

b) Verify that the SERVER is time.nist.gov and enter this into the SERVER  

window if is not. 

c) Click the UPDATE NOW button and verify that Windows returns a “The clock 
was successfully synchronized…” message. If it fails to do so, troubleshoot 
and correct your Internet connection. Instructions for doing this can be 
readily found online. 

 

 

2. Request watermarking licenses. 

Contact your Nielsen Regional Engineer or send an email to encod-
ing@nielsen.com to obtain the necessary CSID and CBET codes. See step 3.C) on 
page 2-60. 

mailto:encoding@nielsen.com
mailto:encoding@nielsen.com
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3. Configure the analog AM encoder 

A) Start the XPN PC Remote software and connect to the XPN-AM processor. 

B) Click the [IO] button on XPN-AM PC to open the XPN-AM I/O window. Then 
click the NIELSEN RADIO RATINGS tab. 

C) Fill in the CSID hex value and the CBET check digits value that Nielsen supplied 
to your station. (Do not use the values shown in the example screenshot on 
page 2-61.) 

CSID is CBET Source Identification a.k.a. CBET Media Code. Nielsen assigns 
one or more CSIDs (CBET Source Identification) to each content provider 
or distribution source. Included as a component of each watermark, the 
CSID uniquely identifies the distribution source. 

CBET is check digit authentication The check digit is a 2-byte string of 
upper-case alphabetic characters assigned to a specific Source ID. The ap-
plication must present the correct check-digit. For the commonly used 
test CSID, 0x11233, the check-digit string is “AF.” 

D) Choose the correct CBET mode. 

Mode 1 Indicates to configure encoder for International (Canada). Mode 
2 Indicates Encoder to configure for the US region. 

E) Choose the desired EAS MODE. 

The CBET Watermark engine refrains (steps aside) from encoding EAS 
(Emergency Alert System) alerts when ENABLED. 

F) Choose the desired STEPASIDE mode: OVERWRITE or STANDARD. 

The Prior Detection mode can be OVERWRITE or STANDARD. In STANDARD 
mode, a prior watermark detected on same layer of encoding will be 
overwritten. 

G) Click the WATERMARKING ENABLE button. 

H) Click the APPLY button. 

The Status window above the Apply button will confirm if the configura-
tion is valid or will identify specific errors. 
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4. Configure the HD/netcast encoder (optional). 

 If you are using the HD/netcast encoder for your HD channel, check USE 

SETTINGS FROM AM and click APPLY. 

 If you are using the encoder for a netcast or purposes other than HD, config-

ure the encoder per Nielsen’s instructions to you. See step 3 on page 2-60. 

5. Enable or disable watermarking. 

Click the I/O MIXER tab and then the UTILITIES tab. Switch RATINGS LOOP to OUT to 
bypass the AM and HD encoders. Select IN to use the encoders. 

When watermarking is enabled, it adds an additional input/output delay 
of 80 ms to the Optimod. Therefore, enabling and disabling watermark-
ing will create a short dropout and will change the delay. 

Log Files for Nielsen Support 

The Nielsen Status Log for each encoder is displayed in its associated (AM or HD) 
NIELSEN RADIO RATINGS tab. Version numbers and configuration status are displayed 
and can be copied to the Windows clipboard. 
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 Section 3 

 Operation 
 

 

Figure 3-1: The OPTIMOD XPN-AM Control Application 

The OPTIMOD XPN-AM Control Application 

 Input Meters show the peak input level applied to the audio processing, in units 

of dBFS. Higher levels call for higher settings of the INPUT REFERENCE LEVEL con-

trol. If the meter indicates “0,” this indicates that the input peak level has 

reached 0 dBFS. This is common if the program material applied to OPTIMOD 

XPN-AM was aggressively mastered and there is unity gain between the playout 

system and the input of OPTIMOD XPN-AM. 

The Input meters will be visually out-of-sync with the remaining meters 
when the ratings encoder loop-through is used. 

 AGC meter shows the gain reductions of the “Master” (above-200 Hz) and 

“Bass” (below-200 Hz) bands in the slow AGC processing that precedes the 

multiband compressor. Full-scale is 24dB gain reduction.  
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 Gate indicators show gate activity. They light when the input audio falls below 

the threshold set by the gate threshold controls. (There are two gating circuits—

one for the AGC and one for the multiband compressor/limiter—each with its 

own gate threshold control.) When gating occurs, the AGC and compressor’s re-

covery times slow drastically to prevent noise rush-up during low-level passages. 

 HF Enhancer meter shows the amount of dynamic 4 kHz first-order high frequen-

cy shelving equalization, in dB, being applied to the signal. 

 Stereo Enhancer meter shows the amount of extra gain, in dB, being applied to 

the stereo difference signal (L−R) to increase the apparent width of the stereo 

soundstage. 

 Multiband gain reduction meters (AM and HD) show the gain reduction in the 

AM and HD multiband compressors. Full-scale is 25 dB gain reduction. Each me-

ter is split vertically to show the gain reduction in the left and right channels.  

 Limiter (AM and HD) meters show the amount of peak limiting (dB) in the left 

and right channels, which we chose not to couple because the fast release time 

of this circuit would otherwise cause elements in one channel to modulate the 

opposite channel objectionably. Full-scale is 12 dB gain reduction (HD) and 24 dB 

(AM). 

 Bass Limiter meters (AM and HD) show the amount of peak limiting applied to 

the bass energy in the left and right channels. Full-scale is 12 dB gain reduction. 

 Loudness meters (AM and HD) show the subjective loudness of the output, meas-

ured using the 1981 Jones & Torick CBS Technology Center algorithm and by the 

ITU. BS.1770 algorithm. (See page 1-25 for a discussion of the CBS meter and 

page 1-27 for BS.1770.) 

Although the AM and HD processing is stereo, there is only one meter for 
each algorithm because a given listener has only one perception of loud-
ness.  

The meter is calibrated with reference to the Target Loudness value that 
you specify in the XPN-AM’s active Setup for that processing chain. (See 
step 17 on page 2-42 and step 19 on page 2-43.)  

 HD Loudness Gain Reduction shows the amount of gain reduction that the HD 

Loudness Controller and BS.1770 safety limiter are producing. (The AM pro-

cessing chain does not provide loudness controllers, just loudness meters.) The 

CBS controller gain reduction appears in blue, while the BS.1770 safety limiter 

gain reduction appears in cyan. The two indications are stacked, so the edge of 

the meter shows the total gain reduction produced by both algorithms. Full-

scale is 12 dB gain reduction. These meters will only show gain reduction if the 

LOUDNESS THRESHOLD and BS.1770 SAFETY LIMIT THRESHOLD are not off (HD 

MULTIBAND tab in the active processing preset). 
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 AM Output Meters show the negative and positive peak modulation produced 

by the left and right channels of the AM processing, assuming that the AM 100% 

OUTPUT LEVEL control is adjusted to make the transmitter’s modulation depth 

agree with the Optimod’s meters. The meter is located before the transmitter 

equalizer, so it does not show any peak level increase caused by the equalizer.

  

In TONE mode the AM 100% OUTPUT LEVEL control is in-circuit so that TONE  mode 

can be used as an approximate guide for setting transmitter modulation. (Align-

ing with tone does not take into non-ideal transmitter behavior, including tilt 

and ringing.)  

 

In BYPASS MODE the AM 100% OUTPUT LEVEL control is defeated, and the gain 

from the input to the AM output is calibrated by the BYPASS GAIN control in I/O > 

TEST. Hence in BYPASS mode, when the BYPASS GAIN control is set to 0 dB, 100% 

on the meters corresponds to 0 dBFS at the input. 

 HD Output Meters show the peak level of the processed samples at OPTIMOD 

XPN-AM’s HD output, in dBFS. They will clearly show the effect of the HD 100% 

OUTPUT LEVEL CONTROL. (For example, setting this control to −2.0 dBFS will cause 

the meters to peak at −2.  

 

Unlike the AM processing, the HD 100% OUTPUT LEVEL control does not affect 

loudness, only peak level, so the HD output meters indicate correctly in OPERATE, 

BYPASS and TONE  modes. 

 Control Pane shows editing controls that allow you to customize the factory pre-

sets. The control pane is organized in tabs, grouped by AM, HD, and controls 

common to AM and HD (Stereo Enhancer and AGC). There are two levels of con-

trol: Basic Control (using the LESS-MORE and EQUALIZER tabs), and Advanced 

Control (using all tabs). Clicking a given tab will expose the controls pertaining 

to the tab’s title.  

 

Sliders can be grouped according to the following rules. When sliders are 

grouped, adjusting one slider will cause all other sliders in that group to move 

by the same number of increments. 

 At least one slider in a given window is always active and will be the base 

for any grouping. 

 SHIFT CLICK will toggle a slider’s status (ADD or REMOVE) with the current 

group of one or more sliders. 

 CONTROL CLICK will add a slider to the current group. 

 CLICK DRAG will un-group all current sliders and make a new group consist-

ing of the sliders within the hatched selection box. 
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 CONTROL CLICK DRAG will add the sliders within the hatched-selection box 

to the current group 

 CLICKing on a part of the window outside of any slider will ungroup the 

sliders. 

 CLICKing a slider outside the group will ungroup all current sliders and se-

lect the clicked one. 

 I/O Window allows you to set input and output levels and system setup parame-

ters. 

 File Menu allows you to open factory and user presets, import HD settings into 

the currently active preset, and save user presets that you have created by edit-

ing factory presets or older user presets. When you save a preset, it is saved on 

the computer running the OPTIMOD XPN-AM Service and on the computer run-

ning the Control Application. To share presets between cards, use a file manager 

or Windows Explorer to copy preset files from one folder to another.  

You can also save and restore the state of the OPTIMOD XPN-AM I/O controls by 
using the SAVE SETTING and OPEN SETTINGS menu items. 

 Edit Menu can open up the OPTIMOD XPN-AM I/O Mixer screens. It can reveal 

the processing controls, which are organized in tabs and allow you to edit pro-

cessing presets to get the sound you want. 

 View Menu allows you to display or hide the Toolbar, which contains icon-based 

shortcuts for common tasks. It also allows you to hide or display the status bar 

and the Connection List, and lets you activate help for individual controls using 

Windows Tooltips. 

 Tools Menu allows you to access the OPTIMOD XPN-AM I/O window, the 

PROCESSOR ADMINISTRATION screen, and the SERVICE SETTINGS Screen. 

 Connect Menu allows you to connect to an OPTIMOD XPN-AM Processor to per-

form the various tasks implemented by the Control application and the 

OPTIMOD XPN-AM Mixer application. It also allows you to add, edit and remove 

profiles and to disconnect from a processor. 

 Help Menu provides access to the Help and About functions, including the Oper-

ating Manual. 

 Info Bar shows: 

 the OPTIMOD XPN-AM Processor to which you are currently connected 

 the preset that the Processor is running 
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 the state of the automatic Music/Speech detector 

 the CPU core in which the Processor is running 

 the active AM and HD TARGET LOUDNESS values. 

 the current delay difference between the AM and HD outputs, produced by 

the HD diversity delay. 

 Toolbar contains icons that implement common functions, like recalling, import-

ing and saving presets, opening the I/O setup screen, opening the advanced 

modify screens, saving presets, and Help. 

Introduction to Processing 

Some Audio Processing Concepts 

Reducing the peak-to-average ratio of the audio increases loudness. If peaks are re-
duced, the average level can be increased within the permitted modulation limits. 
The effectiveness with which this can be accomplished without introducing objec-
tionable side effects (such as pumping or intermodulation distortion) is the single 
best measure of audio processing effectiveness. 

Compression reduces the difference in level between the quiet and loud sounds to 
make more efficient use of permitted peak level limits, resulting in a subjective in-
crease in the loudness of quiet sounds. It cannot make loud sounds seem louder. 
Compression reduces dynamic range relatively slowly in a manner similar to riding 
the gain. Limiting and clipping, on the other hand, reduce the short-term peak-to-
average ratio of the audio. 

Limiting increases audio density. Increasing density can make loud sounds seem 
louder, but can also result in an unattractive busier, flatter, or denser sound. It is im-
portant to be aware of the many negative subjective side effects of excessive density 
when setting controls that affect the density of the processed sound. 

Clipping sharp peaks does not produce any audible side effects when done moder-
ately. Excessive clipping will be perceived as audible distortion. 

Look-ahead limiting is limiting that prevents overshoots by examining a few milli-
seconds of the unprocessed sound before it is limited. This way the limiter can antic-
ipate peaks that are coming up. 

Loudness control prevents the subjective loudness from exceeding a preset thresh-
old. 

Loudness and density 

The amount of gain reduction determines how much the loudness of soft passages will 
be increased (and, therefore, how consistent overall loudness will be). The automatic 



3-6  OPERATION ORBAN  

 

 

gain control (AGC) and the multiband limiter both provide gain reduction, although 
their effects are quite different. 

In a competently-designed processor, audibly objectionable distortion occurs only 
when the processor is clipping peaks to prevent the audio from exceeding the peak 
modulation limits of the transmission channel. The less clipping that occurs, the less 
likely that the listener will hear distortion. However, to reduce clipping, you must 
decrease the drive level to the clipper, which causes the average level (and thus, the 
loudness) to decrease proportionally. 

Receiver high frequency rolloff introduces further complications. A typical receiver’s 
severe HF rolloff reduces the headroom available at high frequencies and makes it 
difficult to achieve a bright sound. This is because bright sound requires considerable 
high frequency power to appear at the output of the receiver, thus requiring a very 
large amount of high frequency power to be transmitted so that a sufficient amount 
will survive the receiver’s rolloff. 

To increase brightness and intelligibility at the receiver, the XPN-AM’s NRSC 
pre-emphasis boosts the treble at 6dB/octave starting at 2.1 kHz. HF CURVE settings 
from 0 to 10 produce more severe pre-emphasis, boosting at 18dB/octave where 2 
kHz is up about 3 dB. Without very artful processing, this pre-emphasis will radically 
increase the level of the peaks and force you to decrease the average level 
proportionally. Orban's MX limiter technology greatly eases this trade-off, but cannot 
eliminate it. Therefore, you can only increase brightness by reducing average 

modulation (loudness)  unless you accept the increased distortion caused by driving 
the MX limiter harder. 

In AM processing, there is a direct trade-off between loudness, brightness, and 
distortion. You can improve one only at the expense of one or both of the other two. 
Thanks to Orban's psychoacoustically-optimized designs, this is less true of Orban 
processors than of any others. Nevertheless, all intelligent processor designers must 
acknowledge and work within the laws of physics and psychoacoustics as they apply 
to these trade-offs. 

Speech/Music Detector 

The Speech/Music Detector allows OPTIMOD XPN-AM to change its processing pa-
rameters depending on whether the input program material is speech or other ma-
terial (usually music). 

The algorithm is straightforward: Speech is detected if (1) the input is mono, and (2) 
there are syllabic pauses at least once every 1.5 seconds. Speech with a stereo music 
background will usually be detected as “music,” or the detector may switch back 
and forth randomly if the stereo content is very close to the stereo / mono detector’s 
threshold. Mono music with a “speech-like” envelope may be incorrectly detected as 
“speech.” Music incorrectly detected as “speech” can exhibit a slight loss of loudness 
and punch, but misdetection will never cause objectionable distortion on music. 

Speech that is not located in the center of the stereo sound field will always be de-
tected as “music” because the detector always identifies stereo material as “music.” 
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AM Processing: The Art of Compromise 

Noise, interference, and narrow bandwidth inherently restrict AM audio quality. Be-
cause of this, purist goals (“the output should sound just like the input”) are irrele-
vant because receiver design makes them impossible to achieve. Instead, the goal of 
processing should be to deliver the highest subjective quality through this limited 
transmission channel to the listener's ear. This always requires substantial compres-
sion and limiting to ensure that the received signal will override the noise and inter-
ference over the maximum possible geographical area. It also requires high frequen-
cy boost to compensate for the high-frequency rolloff in all AM radios. 

The XPN-AM’s AM GENERAL MEDIUM factory preset at a LESS-MORE setting of 7 meets 
these requirements and provides a forward, high-presence sound that is subjectively 
undistorted even on high-quality automobile radios. This is the default preset upon 
initial power-up of the XPN-AM. You may continue using this preset or choose an-
other preset as you deem appropriate. 

If the amount of transmitter power available is limited and you wish to cover the 
widest possible area, you may choose to process harder (by advancing the LESS-

MORE control at the cost of slight audible distortion and increased compression). 
You may also wish to reduce the amount of high frequency receiver equalization 
and/or decrease the audio bandwidth of the processing (by adjusting the system 
low-pass filter) because you will discover that you can achieve a louder sound with 
the same amount of distortion if you do this. 

You will find out that in any setup there is a direct trade-off between loudness, 
brightness, and distortion. You can improve any single parameter, but only at the 
expense of one or both of the other two. This is true of any processor, not just 
OPTIMOD-AM. Perhaps the most difficult part of adjusting a processor is determin-
ing the best trade-off for a given situation. If most of your listeners are located 
where your signal is strong, it is wiser to give up ultimate loudness to achieve 
brightness and low distortion. A listener can compensate for loudness by simply ad-
justing the volume control. But there is nothing the listener can do to make a dirty 
signal sound clean again, or to undo the effects of excessive high-frequency limiting. 

If processing for high quality is done carefully, the sound will also be excellent on 
small radios. Although such a signal might fall slightly short of ultimate loudness, it 
will tend to compensate with an openness, depth, and punch (even on small radios) 
that cannot be obtained when the signal is excessively squashed. On the other hand, 
if many listeners receive a weak signal or one that is frequently contaminated by 
interference, then processing harder to achieve maximum loudness, uniformity, and 
average modulation will let the station be heard more easily. You may therefore 
wish to process quite differently during the day than at night, when skywave inter-
ference is often a problem. OPTIMOD-AM's programmable presets make this easy. 

If women form a significant portion of the station's audience, bear in mind that 
women are more sensitive to distortion and listening fatigue than men are. In any 
format requiring long-term listening to achieve market share, great care should be 
taken not to alienate women by excessive stridency, harshness, or distortion. 
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AM radio has been losing its market share to FM in many countries because the pub-
lic believes that AM has lower sound quality. While this is inevitably true (except in 
the automobile, where multipath often degrades FM reception below “entertain-
ment quality”), the damage can be minimized by processing the audio to make the 
best of the limitations of the AM channel and to avoid processing artifacts. 
OPTIMOD-AM is uniquely effective in optimizing these trade-offs, and the discussion 
below tells you in more detail how to do this. 

Shortwave/HF Processing 

The goals for HF broadcasters are likely to be quite different than they would be in 
MW, LW, or FM broadcast. Listeners to HF broadcasts are often highly motivated 
and will continue to listen even when the signal is severely degraded by poor prop-
agation conditions or by interference that would almost certainly cause the average 
LW, MW, or FM listener to tune to another station. 

In LW and MW, the audio processor set-up controls are usually used to match the 
processor’s ”sound” to a certain type of music or talk programming. HF is different. 
In HF, the audio processor is usually adjusted to provide a sound at the receiver that 
is as esthetically satisfying as possible, given the probable signal quality at the re-
ceiver. The broadcasting organization usually does not have the luxury of making 
fine adjustments to match different types of program material because such fine 
adjustments will almost certainly be masked by the variability of the propagation 
and interference experienced by the listener. This fact considerably simplifies the 
adjustment procedure. We have tuned the XPN-AM’s AM HF-SW preset (and its asso-
ciated LESS-MORE variations) with these compromises in mind. 

Working Together 

Best results will be achieved if Engineering, Programming, and Management go out 
of their way to communicate and cooperate with each other. It is important that 
Engineering understands well the sound that Programming desires, and that Man-
agement fully understands the trade-offs involved in optimizing certain parameters 
(such as loudness and coverage) at the cost of others (such as brightness or distor-
tion). 

Monitor Rolloff Filter for the Analog AM Channel 

The response curve of the monitor system is as important as its quality. Because the 
studio monitor typically has a flat response, and because OPTIMOD-AM's AM-
channel output is ordinarily significantly pre-emphasized, the sound that emerges 
from the monitor will be shrill and unpleasant if it is not rolled off. You can do this 
with an external equalizer or with Orban’s MRF-23 Monitor Rolloff Filter. While 
Orban no longer manufactures these filters, they are often available from on-line 
auction sources. 

The response of the Orban Monitor Rolloff filter can be jumpered to emulate an 
“ideal” NRSC radio or to complement the frequency response of the HF equalizer 
with its HF CURVE set to 0. Because there are so few radios with anything approach-
ing NRSC response (even in NRSC countries), we believe that it is wiser to jumper the 
Monitor Rolloff Filter for non-NRSC operation in almost all situations. If this 
18dB/octave rolloff is used, the response of this filter is approximately complemen-
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tary to the frequency response of the HF Equalizer with HF CURVE set to 0. (See Fig-
ure 3-14 on page 3-45.) Because the filter shelves off at high frequencies (to match 
the receiver equalization) instead of continuing to roll off like a real radio, the mon-
itor will sound somewhat brighter than a real radio and cannot be used to make 
final subjective adjustments of OPTIMOD-AM setup controls. Nevertheless, it is suit-
able as a reference for assessing quality, as it will clearly reveal distortion and other 
problems that may arise in the plant. Indeed, it will be somewhat more revealing 
than a real radio. 

Reference Radios for Adjusting the Analog AM Processing 

However, do not rely on your monitor alone for subjectively evaluating your air 
sound. It is a good idea to develop a set of “reference radios” with which you are 
familiar and which are similar to those used by a majority of your audience. Too of-
ten, just one radio (typically the Program Director or General Manager's car radio) is 
used to evaluate air sound. Unless all of your listeners happen to have the same ra-
dio, this approach will not give an accurate indication of what your audience is hear-
ing. 

Based on their high-frequency response, AM radios can be divided into three groups: 

 Group 1: Wideband AM stereo radios, typically with response that approximately 

follows the recommended NRSC “modified 75µs” de-emphasis to 5 kHz or 

above. These are radios that conform to the NRSC/EIA's “AMAX” specifications 

and can bear the AMAX® logo. 

 Group 2: Radios with a response down 3dB at approximately 2 kHz, with a gen-

tle rolloff above that frequency. Because the rolloff is gentle, pre-emphasis can 

be used to brighten the sound. 

 Group 3: Radios with a response down 3dB at approximately 2 kHz, with a very 

steep rolloff above that frequency. The steepness of the rolloff eliminates the 

possibility of improving the audio through pre-emphasis. In our opinion, these 

radios must be written off as producing hopelessly bad sound. Very few people 

would enjoy listening to music on these radios  although they could be used for 

listening to talk programs, or for repelling pigeons and muggers. 

The vast majority of present-day radios are in the second and third categories. In all 
three types of radio, bass performance is unpredictable from model to model. The 
best-sounding “Group 1” AM receiver we know of is the Sony SRF-A100 AM stereo 
radio (now discontinued), which can be switched between wideband and narrowband 
operation. Use headphones, or drive an external amplifier and speaker with the Sony's 
headphone output (its own tiny speakers cannot be used for reference purposes). A 
representative good-sounding wideband mono radio is the now-discontinued General 
Electric Superadio. As of the current writing, the number of AMAX radios available is 
very limited, with the widest distribution being certain premium Delco radios that 
have been provided with General Motors automobiles. In “Group 2,” we are fond of 
the Radio Shack MTA- series of small table radios. 
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Be aware that many radios produce excessive distortion all by themselves, especially if 
they are located near the transmitter. If the station monitor (driven through 
OPTIMOD-AM's monitor rolloff filter) sounds clean but your radio audio is distorted, 
don't trust the radio! If the General Manager's auto radio sounds distorted, he or she 
should not jump to the conclusion that there is something wrong with the station or 
with the engineer's ears.  

Modulation Monitors 

Many modulation monitors and RF amplifiers indicate higher modulation than the 
transmitter is actually producing. This forces the engineer to reduce transmitter 
modulation unnecessarily, which can cost you up to 3dB of loudness! It is very 
important to be sure that your modulation monitor is accurately calibrated and that it 
does not exhibit overshoot on program material. Several newer monitors are designed 
for accurate pulse response without overshoot. Any of these monitors will enable you 
to obtain the highest loudness achievable from your transmitter and antenna system. 
If the monitor is used remotely, be sure that the RF amp doesn't overshoot. 
Overshoots in RF amps have been observed to be as high as 3dB. 

Monitor readings should be compared with an oscilloscope observing the modulated 
RF envelope. If the monitor indicates 100% negative peaks when the oscilloscope 
reveals no carrier pinch-off, suspect inaccuracy in the monitor. 

Judging Loudness 

Apparent loudness in the analog AM channel will vary with the frequency response of 
the radio and with the accuracy with which the radio is tuned. Narrowband radios will 
usually get very much louder if tuned off center while a highly equalized signal is 
being received. This means that if your auto radio is not electronically-tuned, you must 
manually fine-tune its push-button settings before you can make meaningful loudness 
comparisons. Loudness is a very complex psychoacoustic phenomenon. One station 
cannot be judged louder than another can unless it is consistently louder on many 
different receivers with many different types of program material. Because a 
wideband radio reproduces more of the frequency range in which the 
highly-equalized signal concentrates its energy (and to which the ear is most 
sensitive), a highly equalized signal may sound quieter than an unequalized signal on 
a narrowband radio, while the reverse is true on a wideband radio. 

For the digital radio channel, it is much easier to compare loudness between stations 
because the audio has frequency response to 15 kHz and the radios are essentially flat. 
It is not wise to start a digital channel “loudness war” because setting the processor 
up to cause large loudness disparities between the analog and digital channels will 
simply irritate listeners and is likely to cause tune-outs as listeners are forced to 
constantly grab their volume controls. Moreover, processing the digital channel for 
loudness is likely to increase codec artifacts significantly. 

Processing for Low Bitrate Codecs and HD Radio 

The most common bit rate in the iBiquity HD Radio AM system is 36 kbps, while the 
bit rate in the Digital Radio Mondiale (DRM) system varies according to transmission 
mode but is also low. HD AM uses the HDC codec, while DRM uses the MPEG xHE-
AAC codec. Both codecs employ Coding Technology’s Spectral Band Replication 
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technology; xHE-AAC is more recent and more advanced. Codecs with SBR transmit 
only lower frequencies (for example, below 8 kHz) via the codec. The decoder at the 
receiver creates higher frequencies from the lower frequencies by a process similar 
to that used by “psychoacoustic exciters.” 

36 kbps is a very low bit rate to achieve entertainment-quality stereo audio, even 
with an advanced codec like HDC. To maximize audio quality, the XPN-AM offers a 
choice of look-ahead limiting or MX limiting for the final peak limiting of the digital 
processing chain. 

The appropriate equalization and multiband compression for analog AM are very 
different from those appropriate for HD AM or similar channels using lossy codecs. 
The equalizer in the analog AM processing chain is usually set to pre-process for the 
limitations of conventional AM radios, while the five-band compressor is generally 
operated with medium or faster release times to increase program density, maximiz-
ing loudness and coverage. By contrast, the HD AM channel uses no pre-emphasis, 
has no limitations on low frequency response, and has high frequency response to 
15 kHz. However, the codec does not respond well to very dense material. 

The equalizer in the digital radio processing chain can be used freely to color the 
audio as necessary to create a signature sound for the station. Meanwhile, the five-
band compressor should be operated with a slow release time so that it smooths out 
spectral inconsistencies between sources while not significantly affecting program 
density — added density would unnecessarily stress the very low bit rate codec used 
in the HD AM system. 

Although the HD AM receivers crossfade between analog and digital when the digi-
tal drops out, it is impossible to make this crossfade subtle because the audio band-
width typically changes from 15 kHz to 3 kHz and the soundfield collapses to mono. 
The best that one can do is to approximately match the loudness of the HD and ana-
log chains. Fortunately, the receiver applies 5 dB more gain to the digital signal than 
to the analog signal, so even highly processed analog signals can achieve approxi-
mate loudness parity with lightly processed digital signals. 

The XPN-AM’s HD presets have been adjusted to achieve reasonable loudness parity 
with the AM analog presets when the audio bandwidth of the analog decoding sec-
tion of the radio is approximately 2.5 kHz. If the bandwidth is wider, then analog 
loudness will increase. There is no perfect solution to this problem; the best com-
promise tunes the processing for an average (2.5 kHz audio bandwidth) radio. 

About OPTIMOD XPN-AM’s Signal Processing Features 

Audio Processing Signal Flow 

The signal flows through OPTIMOD XPN-AM in order through the following blocks: 

 DC Removal  



3-12  OPERATION ORBAN  

 

 

 Input Conditioning, includes defeatable highpass filtering, lowpass filtering and 

phase rotation. 

 Stereo Synthesizer, auto-detecting and defeatable, uses Orban’s classic comple-

mentary comb filter technique (stereo processing only) 

 Mono Bass processing blends the left and right channels below 80 or 100 Hz (de-

featable; stereo processing only). 

 Left/Right Phase Skew Correction corrects phase shifts between the left and right 

stereo channels that could otherwise cause comb filtering in the mono sum (ste-

reo processing only). 

 Stereo Enhancement uses upward expansion of the stereo difference signal as 

triggered by transients in the stereo sum signal. 

 Ratings encoder loop-through 

 Two-Band Gated AGC, with target-zone window gating and silence gating 

After the AGC, the signal splits into AM analog and HD processing chains. Each pro-
vides the following features except as noted. 

 Equalization, including high-frequency enhancement 

 Receiver Equalization (NRSC or 18 dB/octave shelf; AM chain only) 

 Subharmonic Synthesizer creates energy one octave below program energy in 

the range of 50-90 Hz when such energy is not present at the input and when 

music is detected. 

 Downward Expander in five bands 

 Multiband Compression in five bands 

 Automatic Loudness Control using Orban’s third-generation CBS Loudness Con-

troller™ algorithm plus BS.1770 Safety Limiter (HD chain only) 

 Peak Limiting. The AM chain always uses MX limiting; the HD chain allows you 

to choose MX and low-IM look-ahead limiting. 

Tutorial: More about Dynamics Processing (starting on page 3-23) provides a basic 
tutorial on the concepts of dynamics processing, including AGC, compression, and 
peak limiting. 

Sample Rate Conversion 

The base sample rate of OPTIMOD XPN-AM’s internal processing 48 kHz even when 
the input and output are configured for 44.1, 96 or 192 kHz; in these cases, synchro-
nous sample rate conversion occurs at the input and output. This 48 kHz rate ac-
commodates a 20 kHz audio bandwidth in the HD chain with a comfortably wide 4 
kHz transition band for the anti-aliasing filter. 
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Input Conditioning 

 A highpass filter with a cutoff frequency of 0.15 Hz removes DC offset from 
source material without causing significant tilt of low-frequency squarewaves. 

 A defeatable phase rotator makes speech more symmetrical, reducing its peak-
to-average ratio by as much as 6 dB without adding nonlinear distortion. Hence, 
phase rotation can be very useful for loudness processing of speech. 

 Stereo Synthesizer 

 The stereo synthesizer emulates the classic analog Orban 275A automatic stereo 
synthesizer.  
 
This process creates an artificial stereo difference signal (L−R) by passing the 
mono input through a multistage allpass filter. After matrixing with the original 
mono input (which is the L+R signal) to produce the synthesized left and right 
channels, the result is a “complementary comb filter” whose notches are spaced 
in frequency in an approximately logarithmic manner. Because only the L−R sig-
nal is created artificially, it cancels out of a mono mixdown, making the synthe-
sizer’s output completely mono-compatible. This processing is only available in 
stereo mode. 

 The synthesizer can be invoked manually or by automatic detection of silence on 
the right input channel.  

 Mono Bass Processing 

 This applies a steep-slope 80 Hz or 100 Hz highpass filter to the stereo difference 
signal (L−R). A compensating delay is applied to the L+R signal, making the 
bandwidth of the transition between mono and well-separated stereo as narrow 
as possible. This processing is only available in stereo mode. 

 We strongly recommend activating mono bass processing when the stereo syn-
thesizer is active. 

 Stereo Enhancement 

 OPTIMOD XPN-AM provides a stereo enhancement algorithm based on Orban’s 
analog 222 Stereo Enhancer, which increases the energy in the stereo difference 
signal (L−R) whenever a transient is detected in the stereo sum signal (L+R). By 
operating only on transients, the 222 increases width, brightness, and punch 
without unnaturally increasing reverb (which is usually predominantly in the L−R 
channel). 

 Use stereo enhancement with care if you are driving a low bitrate codec. At low 
bitrates, these codecs use various parametric techniques for encoding the spatial 
attributes of the sound field. Stereo enhancement can unnecessarily stress this 
encoding process. 
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Figure 3-2: OPTIMOD XPN-AM Digital Signal Processing Simplified Block Diagram (preliminary) 
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 Gating circuitry detects “mono” material with slight channel or phase imbalanc-
es and suppresses enhancement so this built-in imbalance is not exaggerated. It 
also allows you to set a “width limit” to prevent over-enhancement of material 
with significant stereo content, and will always limit the ratio of L−R / L+R to 
unity or less. 

 Left/Right Phase Skew Correction 

 The phase skew corrector maximizes the quality of a mono mixdown that might 
occur in a receiver or player device. At higher frequencies (where audible comb 
filtering of the mono sum is most likely to occur), the corrector removes phase 
differences between the left and right channels, converting the HF signal into 
“intensity stereo” while preserving phase differences at lower frequencies where 
these differences are important for psychoacoustic “envelopment.” The PHASE 

CORRECTOR CROSSOVER control in the LESS-MORE tab of the active Processing 
Preset sets the crossover frequency above which phase correction occurs, and 
IN/OUT activates or defeats the phase corrector via a delay-matched crossfade. 

This process can not only correct problems due to phase skew between the left and 
right channels of an analog recording due to head gap misalignment, it can also cor-
rect comb filtering caused by spaced microphones feeding the left and right chan-
nels, which can occur on drum kits and other sources that have been multi-miced. 

Because the phase skew corrector can subtly alter the stereo spatial effect, we rec-
ommend using it only as necessary (for example, with formats that play older re-
cordings from the analog era). It can be smoothly activated and defeated via a de-
lay-matched crossfade, so it is practical to do live switching between a preset with 

  

Figure 3-3: AGC Output vs. Input as a Function of the 

AGC Ratio Control 

Figure 3-4:  AGC Output vs. Input Showing Window 
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the process active and one where it is inactive. 

Because it adds considerable delay and uses a significant amount of CPU power, the 
phase skew corrector can be bypassed completely in I/O > UTILITY. If you are not us-
ing it and do not need to activate it smoothly “on-air,” bypass it. 

Two-Band Gated AGC 

The AGC is a two-band device, using Orban’s patented “master/bass” band coupling. 
It uses a linear-phase crossover. 

There are two 
gain-control 
sidechains, one 
for each stereo 
channel. To pre-
serve RMS opera-
tion, the 
MAXIMUM DELTA 

GR control oper-
ates a constant-
power, symmet-
rical panpot. 
When the 
MAXIMUM DELTA 

GR control is set 
to 0, it applies 
equal amounts 
of left and right 
energy to both 
sidechains, which 
causes the left 
and right 
sidechains to 
track each other, 
maintaining 100% stereo coupling. As the MAXIMUM DELTA GR control is set to higher 
values, it progressively applies less right-channel energy to the left-channel sidechain 
and vice-versa. Setting the control to a higher value will partially correct stereo pro-
gram material with left/right channel imbalances. Higher settings should be used 
with caution, as they can cause instability in the stereo image.  

The AGC contains a compression ratio control that allows you to vary to ratio be-

tween 2:1 and essentially :1. Lower ratios can make gain riding subtler on critical 
formats like classical and jazz. See Figure 3-3. 

The AGC incorporates target-zone gating. If the input program material’s level falls 
within a user-settable window (typically 3dB), the release time slows to a user-
determined level. It can be slow enough (0.5 dB/second) to effectively freeze the op-
eration of the AGC. This prevents the AGC from applying additional, audible gain 
riding to material that is already well controlled. It also lets you run the AGC with 

 

Figure 3-5: AGC Gain vs. Input Level Showing Window 
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fast release times without adding excessive density to material that is already dense. 
Figure 3-4 shows the behavior of the window for AGC DRIVE = 12 dB. 

The AGC has a dedicated silence-gating detector whose threshold can be set inde-
pendently of the silence gating applied to the multiband compressor. In stereo 
mode, the gating detector is operated from the output of the left-channel panpot 
implemented by the MAXDELTAGR control, so if this control is set for fully uncoupled 
operation (not recommended) and there is energy only in the right channel, then 
the gate will activate. 

Lowpass and Highpass Filtering 

 A highpass filter, tunable between 20 Hz and 200 Hz and with selectable 6, 12, 
18, or 24 dB/octave slopes, is useful for production applications where it is neces-
sary to remove low frequency rumble from a recording, and in news/talk broad-
casting formats. To prevent distortion in the receiver (caused by fast RF AGC 
modulating the audio) we recommend always using highpass filtering in the AM 
analog processing. 50 Hz at 24 dB/octave is a good starting point. 

 A gentle-slope (6, 12, 18, or 24 dB/octave) lowpass filter, tunable between 4 kHz 

 

Figure 3-6: LF and Dynamic HF Shelving Equalizer Frequency Response 

 

Figure 3-7: Parametric Equalizer Frequency Response for Narrow and Wide Bandwidths 
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and 15 kHz and with selectable 6, 12, 18, or 24 dB/octave slopes, can be useful to 
fine-tune HF response. 

 A very steep lowpass filter can be tuned between 2.5 kHz and 9.5 kHz (AM 
chain) or 10-20 kHz (HD chain). Set it to complement the bandwidth of the 
transmission channel that OPTIMOD XPN-AM is driving. “20 kHz” is a placehold-
er that is actually “no filter.” 

The HF Enhancer is a program-controlled HF shelving equalizer that intelligently and 
continuously analyzes the ratio between broadband and HF energy in the input 
program material. It can equalize excessively dull material without over-enhancing 
bright material. It interacts synergistically with the five-band compressor to produce 
sound that is bright and present without being excessively shrill. 

The BRILLIANCE control adds additional gain before the Band 5 multiband compres-
sor, so it acts like a steep-slope shelving equalizer. 

See Figure 3-6 and Figure 3-7 on page 3-17 for illustrative frequency responses of 
the shelving and parametric equalizers. 

Subharmonic Synthesizer 

The subharmonic synthesizer generates subharmonics of fundamental frequencies in 
the 50-90 Hz range. The subharmonics are one octave below the frequencies from 
which they are generated (i.e., 25 to 45 Hz) and track the levels of their generating 
frequencies. 

If input program material below 45 Hz is present, the subharmonic synthesizer au-
tomatically reduces the level of the synthesized subharmonics to prevent excess 
build-up of energy below 45 Hz. 

To prevent introducing unnatural coloration in male speech, the subharmonic syn-
thesizer is defeated when the automatic speech/music detector detects speech. 

Although it is available in both the AM and HD chains, we recommend using the 
subharmonic synthesizer only in the HD chain. 

Receiver Equalizer (AM chain only) 

The receiver equalizer compensates for rolloff in an average AM receiver, which is 
down 3 dB at 2 kHz and whose frequency response falls at 18 dB/octave until 5 kHz, 
at which point the rolloff varies widely between receivers. See Receiver Equalizer on 
page 3-44. 

Multiband Compressor/Limiter 

The multiband compressor/limiter operates in five frequency bands. Each band com-
pressor has a KNEE and RATIO control. A soft knee and gentle ratio are particularly 
useful in production and mastering applications, allowing subtle compression that 
retains as much of the dynamics of the input program material as the operator de-
sires. (The SOFT KNEE AND SOFT KNEE MX presets are intended for mastering; they ex-
ploit the soft knee features.) These features are also exploited in the TV 5B DRAMA 

preset. 
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Figure 3-8: Multiband Compressor Crossover Filters (Illustrative) 

 

Several band-coupling controls allow the gain reduction of a given band’s compres-
sor to be affected by the gain reduction in its neighboring band’s compressor. These 
coupling controls allow anything from quasi-wideband compression to fully inde-
pendent multiband compression. 

Each band in the stereo multiband compressor has two sidechains—one for the left 
and one for the right channel. You can separately set the left/right coupling of each 
band anywhere from 100% stereo coupled to fully independent. 

 In STEREO mode, there is one LOUDNESS LEVEL meter, AGC GATE indicator, and 

MB GATE indicator. However, you can still uncouple each band in both the AGC 

and multiband compressors to a variable extent—anywhere from perfect stereo 

coupling to completely uncoupled operation. The coupling control determines 

the maximum amount of gain difference permitted between the left and right 

channels in a given band and therefore the amount of stereo image shift per-

mitted in each frequency band. 

Peak Limiter 

OPTIMOD XPN-AM’s look-ahead peak limiter prevents overshoots by examining a 
few milliseconds of the unprocessed sound before it is limited. This way the limiter 
can anticipate peaks that are coming up. The limiter’s sidechain is oversampled to 
192 kHz to prevent significant overshoot from occurring after sample rate conver-
sion or D/A conversion. 

In the HD processing chain, the HD 100% OUTPUT LEVEL control is a peak limiter 
threshold control, so you can adjust the amount of headroom allowed in the down-
stream channel while not changing loudness. 

In the AM processing chain, the limiter’s threshold is fixed with respect to the input 
of OPTIMOD-FM’s digital output level control so the limiter’s drive level solely de-
termines the gain reduction. Two cascaded gain controls set this drive level. One is 
AM MB LIMIT DRIVE; the second is a “hidden” control whose gain is set by the active 
TARGET LOUDNESS value (see Figure 1-5 on page 1-30). 

Band 1 Band 2 Band 3 Band 4             Band 5

10 100 1,000 10,000 100,000
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For more about the concept of target loudness, see About Target Loudness and ITU-
R BS.1770  starting on page 1-27. 

The AM processing always us-
es MX limiting. 

Loudness Control 

Included in the HD chain only, 
OPTIMOD XPN-AM’s third-
generation CBS Loudness Con-
troller and BS.1770 Safety Lim-
iter cooperatively and auto-
matically control subjective 
loudness.  

Useful in speech-oriented ap-
plications and when govern-
ment regulations (often based 
on EBU R128) require control 
of subjective loudness, the 
third-generation CBS Loudness 
Controller follows the multi-
band compressor in the signal 
flow diagram. This placement 
reduces the drive level into 
the peak limiter when the loudness controller produces gain reduction. This mini-
mizes peak-limiter-induced artifacts.  

The loudness controller takes into account control settings that affect the peak lim-
iter so that the loudness controller approximately monitors the loudness at the lim-
iter’s output, not the loudness at the multiband compressor’s output. It does so by 
scaling its sidechain drive by two gain factors: (1) the HD MB LIMIT DRIVE control and 
(2) the XPN-AM’s active HD TARGET LOUDNESS value, which is determined either 
globally or by the active preset depending on the active preset’s HD TARGET 

LOUDNESS setting. (See Figure 1-5 on page 1-30 and Peak Limiter on page 3-19.) 

The OPTIMOD XPN-AM AM and HD chains both provide a BS.1770 “integrated” me-
ter with an integration time of 10 seconds, a BS.1770 “short-term” meter (ungated, 
3-second integration), and a CBS Loudness Meter. In the AM chain, the loudness me-
ters are preceded by a 2 KHz / 18 dB/octave lowpass filter that simulates an average 
AM radio. 

The Loudness Controller works by constantly monitoring the subjective loudness of 
the XPN-AM’s HD output. The subjective loudness is a single value that represents 
the listener’s impression of the loudness in the listening room. It takes into account 
the contribution of all stereo channels. 

When subjective loudness would otherwise exceed the threshold set by the 
LOUDNESS THRESHOLD control, the CBS Loudness Controller reduces the gain of mate-
rial above 200 Hz, preventing loudness from exceeding the threshold. To prevent 

 

Figure 3-9: Peak Limiter Output vs. Input  
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the loudness controller from causing too much dynamic bass boost, you can use the 
LOUDNESS CONTROLLER BASS COUPLE control to limit the maximum difference be-
tween the gain of the band below 200 Hz and the band above 200Hz. For example, 
when this control is set to 3 dB and the loudness controller’s gain reduction is 10 dB, 
the gain reduction below 200 Hz will be 7 dB. However, if the loudness controller’s 
gain reduction is 2 dB, the gain reduction below 200 Hz will be 0 dB because the dif-
ference is now less than 3 dB. 

The loudness controller is triggered mainly by program material that has a lot of en-
ergy between 1 and 7 kHz, which is the ear’s most sensitive range. The five-band 
compressor can automatically re-equalize such program material so that it does not 
induce unnatural-sounding gain reduction in the loudness controller, and will de-ess 
extremely sibilant program material before the loudness controller receives it. 

The loudness controller’s attack and release times are tuned to match the loudness 
integration times of the ear and are program-adaptive. Only the attack time is user-
adjustable. 

If you feel that the Loudness Controller is not controlling the loudness of commer-
cials or other subjectively loud program material sufficiently well, you may wish to 
set the threshold lower, forcing the Loudness Controller to do more work. You may 
also wish to activate the BS.1770 Safety Limiter. 

In the LOUDNESS GAIN REDUCTION meter, the gain reduction of the BS.1770 safety lim-
iter (in dB units) is stacked with gain reduction of the CBS loudness controller. The 
CBS controller gain reduction appears in blue, while the BS.1770 safety limiter gain 
reduction appears in cyan. The CBS Loudness Controller produces both fast and slow 
loudness control; the fast control rides on top of the slow control. You can easily see 
this dual-speed operation on the LOUDNESS GR meter. The LOUDNESS ATTACK control 
determines how much fast control the Loudness Controller produces. As the control 
is turned down toward 0%, it allows longer and longer loudness peaks to pass 
through. 

Because of the system topology, the LOUDNESS LEVEL (CBS) meter assumes 
that the LOUDNESS ATTACK control is always set to 100% and does not indi-
cate the effect of lower settings. As long as the control is set to 50% or 
higher, this limitation should not have any significant effect on the loud-
ness level meter’s accuracy, and regardless of setting does not affect the 
BS.1770 loudness meter’s accuracy. However, it is wise to double-check 
the effect of the LOUDNESS ATTACK control on subjective loudness by listen-
ing tests and/or use of an external loudness level meter like the free 
Orban Loudness Meter for Windows, which uses the same algorithm as 
the built-in LOUDNESS LEVEL meter (www.orban.com/meter). 

The Loudness Controller may reduce the dramatic effect of music programming. In 
radio processing, we feel that it is mainly useful for speech programming, particular-
ly live news/talk formats with levels and audio quality that vary unpredictably from 
source to source. 

Turning down the LOUDNESS ATTACK control provides another way to maintain the 
dramatic impact of loudness transients; it can let short transients through while still 
constraining long-term loudness to a fixed threshold.  

http://www.orban.com/meter
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BS.1770 Safety Limiter 

Following the CBS Loudness Controller is a BS.1770 Safety Limiter that will prevent a 
BS.1770-2 (or higher) Integrated loudness meter with 10-second integration time 
from indicating higher than the setting of the BS.1770 THRESHOLD control, which is 
found in the MULTIBAND page. The BS.1770 THRESHOLD control is part of the on-air 
processing preset. 

If your organization does not have a strict policy about processing for the BS.1770 
meter but you are still required by the governing authority to comply with loudness 
limits, we recommend that you set the BS.1770 THRESHOLD control as high as possi-
ble while still complying with the regulation.  

The BS.1770 safety limiter receives the output of the CBS Loudness Con-
troller and drives the final peak limiters. The total amount of loudness 
control-induced gain reduction is the sum of the gain reduction produced 
by the CBS Loudness Controller and the gain reduction produced by the 
BS.1770 safety limiter. The gain reduction produced by the BS.1770 safety 
limiter changes slowly, seldom exceeds 2 dB, and is indicated by the cyan 

section of the LOUDNESS GR meter. The gain reduction produced by the 
CBS Loudness Controller may change slowly or quickly (depending on the 
nature of the program material), appears in blue, and rides on top of the 
BS.1770 gain reduction. The peak reading of the meter thus shows the 
total gain reduction that both controllers produce. 

We included this safety limiter for customers whose policies require the 
BS.1770 loudness meter reading to be constrained below specified 
threshold regardless of how loud human listeners perceive the program 
to be. Our experience suggests that the BS.1770 meter will often over-
read material with unusually low peak-to-average ratios, like highly pro-
duced commercials and promos. Strict reliance on the BS.1770 meter can 
therefore make such material sound unnaturally quiet compared to sur-
rounding material, so we prefer the sound when the CBS Loudness Con-
troller is used exclusively for loudness control. 

For a more detailed discussion of these issues, refer to Appendix A: Using 
the ITU BS.1770 and CBS Loudness Meters to Measure Loudness Control-
ler Performance, starting on page 3-67. 
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Tutorial: More about Dynamics Processing 

 

Figure 3-10: AGC Attack and Release 

 

Figure 3-11: Compressor Attack and Release 
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Figure 3-12: Peak Limiter Attack and Release 

 

Figure 3-13: Compressor Attack and Release (Bad Design) 
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OPTIMOD XPN-AM’s AGC, multiband compressor, and peak limiter are all forms of 
dynamics processing. Their main differences are the speed of the attack and release 
times and their compression ratios. In OPTIMOD XPN-AM’s AGC and multiband com-
pressor, these parameters are all user-adjustable. To prevent peak overshoots, the 
peak limiter must have an instantaneous attack time and the infinite compression 
ratio. 

Figure 3-11, Figure 3-12 and Figure 3-13 show the audio level as a function of time 
and are conceptual and simplified. In fact, the attack and release time characteristics 
of OPTIMOD XPN-AM’s AGC and multiband compressors automatically adapt them-
selves to the program material they are processing. 

Figure 3-10 shows the slow attack and release characteristics typical of AGC. This di-
agram shows an infinite compression ratio; lower ratios are available in OPTIMOD 
XPN-AM’s AGC. The AGC performs slow gain riding; it does not increase program 
density. 

Figure 3-11 shows the attack and release times found in OPTIMOD XPN-AM’s multi-
band compressors, which are substantially faster than the AGC. The multiband com-
pressor is designed to be able to increase program density if the user wants, but also 
has slow attack and release times available if the user wants to retain the density of 
the original program material. 

Figure 3-12 shows a typical peak limiter attack and release characteristic. The attack 
is instantaneous to prevent overshoots. Figure 3-12 is not drawn to the same time 
scale as Figure 3-10 and Figure 3-11; the release time of OPTIMOD XPN-AM’s peak 
limiter is hundreds of times faster than that of the AGC or multiband compressor. 

Figure 3-13 shows one of the many things that can go wrong in a badly designed 
compressor. The attack causes more gain reduction than necessary to reduce the 
output level to the threshold of compression, and the gain must then recover to 
bring the output level to the compression threshold. This attack overshoot and sub-
sequent release causes audible “gulping” or “gain pumping,” which gives the im-
pression that the program level is constantly changing in an audibly obtrusive way. 
The gain pumping exacerbated by a release time that is too slow, so that the audio 
level starts out too quiet at the beginning of the release period and then slowly and 
obviously recovers to its final value. While this kind of sound is sometimes used for 
artistic purposes in production and mastering, in a processor like OPTIMOD XPN-AM 
(which is designed to handle all types of program material gracefully without intro-
ducing objectionable side-effects), it imposes an unstable sonic signature on all pro-
gram material and is considered one of the marks of incompetently-designed pro-
cessing. 

Customizing OPTIMOD XPN-AM’s Sound 

See Figure 3-2: OPTIMOD XPN-AM Digital Signal Processing Simplified Block Diagram 
on page 3-14. 
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The subjective setup controls on OPTIMOD XPN-AM give you the flexibility to cus-
tomize your station’s sound. Nevertheless, as with any audio processing system, 
proper adjustment of these controls consists of balancing the trade-offs between 
loudness, density, and audible distortion. The following pages provide the infor-
mation you need to adjust OPTIMOD XPN-AM controls to suit your format, taste, 
and competitive situation. 

Processing presets in XPN-AM are compound presets, consisting of an AM and HD 
control set. The AM control set is the “master” set and includes the controls located 
in the processing blocks that precede the AM/HD split (after the AGC). The HD part 
of the preset is created by importing a factory HD preset or previously modified 
compound preset (FILE > IMPORT HD CONTROLS). When you save a preset as a User 
preset (FILE > SAVE PRESET AS), you are saving the compound preset. 

You need not (in fact, cannot) create a sound entirely from scratch. All User Presets 
are created by modifying Factory Presets or by further modifying Factory Presets 
that have been modified previously.  

When you start with one of our Factory presets, there are two levels of subjective 
adjustment available to you to let you customize the Factory preset to your re-
quirements: Basic Control and Advanced Control.  

Basic Control 

The single LESS-MORE control (one for AM and one for HD) changes many different 
subjective setup control settings simultaneously according to a table that we have 
created in OPTIMOD XPN-AM’s factory presets, which are files with the Windows 
read-only attribute. In this table are sets of subjective setup control settings that 
provide, in our opinion, the most favorable trade-off between loudness, density, 
and audible distortion for a given amount of processing. We believe that most 
OPTIMOD XPN-AM users will never need to go beyond the LESS-MORE level of con-
trol, because the combinations of subjective setup control settings produced by this 
control have been optimized by our audio processing experts on the basis of years of 
experience designing audio processing and on hundreds of hours of listening tests. 

Unlike previous Optimods, the LESS-MORE control has been designed keep loudness 
roughly constant when adjusted. Instead, turning it up typically changes texture by 
increasing the multiband compressor drive (and this the amount of multiband com-
pressor gain reduction), while decreasing the peak limiter drive appropriately.  

To change a preset’s loudness, change the value of the TARGET LOUDNESS (AM or HD, 
depending on which chain you are adjusting), which you can do by editing the local 
value of the AM or HD TARGET LOUDNESS in the processing preset (AM LESS-MORE or 

HD LESS-MORE tab), or setting that value to GLOBAL and then changing the global 
TARGET LOUDNESS value (in I/O > GLOBAL). All AM factory presets are set to –6 LUFS 
and all HD factory presets are set to GLOBAL, which facilitates matching the loudness 
of the AM and HD signals during crossfades at the receiver. 

Changing the value of a given chain’s TARGET LOUDNESS changes the drive level into 
its associated peak limiter (and hence, changes its gain reduction). This does not 



OPTIMOD XPN-AM  OPERATION 3-27 

 

 

change the indication of its loudness meters because they indicate loudness relative 
to the active TARGET LOUDNESS value. 

It is wise to set a given chain’s LESS-MORE control to achieve a sound as close as pos-
sible to your desired sound before you make further modifications at the Advanced 
Modify level. This is because the LESS-MORE control gets you close to an optimum 
trade-off between loudness and artifacts, so any changes you make are likely to be 
smaller and to require resetting fewer controls. 

In OPTIMOD XPN-AM, a given chain’s LESS-MORE control affects only the dynamics 
processing (compression and peak limiting) in that chain—OPTIMOD XPN-AM’s 
equalization and stereo enhancement are decoupled from LESS-MORE. You can 
therefore change EQ or stereo enhancement and not lose the ability to use LESS-

MORE. When you create a user preset, OPTIMOD XPN-AM will automatically save 
your EQ and stereo enhancement settings along with your LESS-MORE setting. When 
you recall the user preset, you will still be able to edit your LESS-MORE setting if you 
wish. 

Advanced Control 

If you want to create a signature sound for your broadcast or netcast that is far out 
of the ordinary or if your taste differs from the people who programmed the LESS-

MORE tables, you will find the advanced processing controls useful. You can custom-
ize or modify any subjective setup control setting to create a sound exactly to your 
taste. You can then save the settings in a User Preset and recall it later.  

Compressor attack time, release time, and threshold controls are available. These 
controls can be dangerous in inexperienced hands, leading you to create presets 
that sound great on some program material but overdrive the peak limiter on other 
material, causing objectionable pumping or distortion. We therefore recommend 
that you create custom presets at the Advanced Modify level only if you are experi-
enced with audio processing sound design and if you are willing to take the time to 
double-check your work on many different types of program material. 

The PC Remote software organizes its controls in tabbed screens. The EQUALIZATION, 
STEREO ENHANCER, and LESS-MORE labs access the Basic Modify controls. The remain-
ing tabs show the Advanced Modify controls, logically organized by functionality. 

Important Note: Once you have edited a preset’s dynamics parameters in 
Advanced Modify, LESS-MORE control is no longer available in Basic Mod-
ify. As noted above, we strongly recommend using the LESS-MORE control 
to achieve a sound as close as possible to your desired sound before you 
make further modifications at the Advanced Modify level. 

Gain Reduction Metering 

Because it uses floating point processing, OPTIMOD XPN-AM has essentially unlim-
ited amounts of available gain reduction, unlike Orban’s DSP-based processors. 
However, the meter should never exceed 25 dB gain reduction if OPTIMOD XPN-AM 
has been set up for a sane amount of gain reduction under ordinary program condi-
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tions. If any AGC or compressor gain reduction meter reads full-scale, this is usually a 
sign that you are using too much gain reduction, which can cause unpleasant com-
pression artifacts. 

The peak limiter gain reduction meters have 12 dB of range. If you are using the MX 
limiter, it is common for these meters to go to fully scale briefly without audibly ob-
jectionable consequences. However, you must assess this by ear for the program ma-
terial you are processing. 

Fundamental Requirements:  
High-Quality Source Material and Accurate Monitoring 

A major potential cause of distortion is excess peak limiting. Another cause is poor-
quality source material, including the effects of your playback machines, electronics, 
any lossy compression (like MP3), and studio-to-transmitter link (if any). If the source 
material is distorted even slightly, that distortion can be exaggerated by OPTIMOD 
XPN-AM—particularly if a large amount of gain reduction is used. Very clean audio 
can be processed harder without producing objectionable distortion.  

A high-quality monitor system is essential. To modify your sound effectively, you 
must be able to hear the results of your adjustments. In too many facilities, the best 
monitor is significantly inferior to the sound systems found in many listeners’ 
homes! 

 

Factory Programming Presets 

Factory Programming Presets are our “factory recommended settings” for various 
program formats or types. The Factory Programming Presets are starting points to 
help you get on the air quickly without having to understand anything about adjust-
ing OPTIMOD XPN-AM’s sound. 

You can easily edit any of these presets with the LESS-MORE control to optimize the 
trade-off between loudness and distortion according to the needs of your format, 
although this is often unnecessary. It is OK to use unmodified factory presets on the 
air. These represent the best efforts of some very experienced transmission pro-
cessing sound designers. We are sometimes asked about unpublished “programming 
secrets” for Optimods. In fact, there are no “secrets” that we withhold from users. 
This manual reveals our “secrets” and the presets embody all of our craft as pro-
cessing experts. The presets are editable because other sound designers may have 
different preferences from ours, not because the presets are somehow mediocre or 
improvable by those with special, arcane knowledge that we withhold from most of 
our customers. 

Start with one of these presets. Spend some time listening critically to your sound. 
Listen to a wide range of program material typical of your format and listen on sev-
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eral types of audio systems (not just on your studio monitors). Then, if you wish, cus-
tomize your sound using the detailed information in the sections that follow. 

Each factory preset has full LESS-MORE capability. The table shows the presets, in-
cluding the source presets from which they were taken and the nominal LESS-MORE 
setting of each preset. Some of the Five-Band presets appear several times under 
different names because we felt that these presets were appropriate for more than 
one format; these can be identified by a shared source preset name. 

Important! If you are dissatisfied with the sound available from the facto-
ry presets, please understand that each named preset is actually 19 pre-
sets that can be accessed via the LESS-MORE control. Try using this control 
to trade off the amount of dynamic range reduction against processing 
artifacts and side effects. Once you have used LESS-MORE, save your edit-
ed preset as a User Preset. 

Do not be afraid to choose a preset other than the one named for your program-
ming if you believe this other preset has a more appropriate sound. Also, if you 
want to fine-tune the frequency balance of the programming, feel free to use Basic 
Modify and make small changes to the Bass, Mid EQ, and HF EQ controls. OPTIMOD 
XPN-AM lets you make changes in EQ (and stereo enhancement) without losing the 
ability to use Less-More settings.  

Of course, Less-More is still available for the unedited preset if you want 
to go back to it. Other than by purposeful abuse within Windows (the 
preset files have the read-only attribute and this should not be changed), 
there is no way you can erase or otherwise damage the Factory Presets. 
So, feel free to experiment. 

AM Presets 

All factory presets contain parameters for both the analog AM and digital radio 
processing chains.  

AM GENERAL MEDIUM is the default factory preset. It is based on the MED2 multiband 
release time and is adjusted to sound equally good on voice and music. It is most 
appropriate for listeners in strong signal areas because it does not bring up low-level 
material as much as presets based on the Fast multiband release time. 

AM GENERAL HEAVY is based on the Fast multiband release time, and is designed to 
sound good on voice and music. Because it processes harder than the GENERAL MEDIUM 
preset, it can be louder, but it does not sound as punchy or dynamic. It is a good 
choice when many listeners are subject to noise and interference and you want the 
highest possible loudness. 

AM NEWS uses a MFAST2 multiband release time. Because of this, the unit adapts 
quickly to different program material, providing excellent source-to-source 
consistency. This “automatic equalization” action of the multiband compressor has 
been adjusted to produce less bass than in the GENERAL presets, and the gating 
threshold is set considerably higher. This maximizes voice intelligibility, including 
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low-quality sources like telephone. The high gating threshold resists noise pumping 
even with noisy material.  

AM NEWS + NR is identical to the News preset except that the Dynamic Noise 
Reduction function is also activated, producing even more noise reduction on 
moderately noisy program material. However, the Dynamic Noise Reduction function 
can produce audible side effects that include noise pumping on very noisy material 
and a subtle loss of crispness on high-quality voice. So you should listen carefully to 
decide if it is preferable to News for your situation. 

AM SPORTS is based on the MFAST multiband release time. It is intended for play-by-
play sports programming, where crowd noise is part of the mix. Compared to NEWS, 
the AGC is operated with a slower release time to avoid pumping up crowd noise as 
much as the News preset would. Yet the MFAST multiband release time still provides 
excellent consistency, intelligibility, and loudness. This preset uses the Dynamic Noise 
Reduction function to reduce noise pump-up. 

AM FINE ARTS is based on the Slow multiband release time. It is designed for classical 
and jazz programming where an open, lightly processed sound is more desirable than 
the last bit of loudness. 

AM MUSIC MEDIUM is based on the SLOW2 multiband release time. It is designed for 
various adult-oriented music formats where an easy, relaxed sound is considered more 
important than the highest possible loudness. 

AM MUSIC HEAVY is based on the MFAST multiband release time. It uses a slower AGC 
release than AM GENERAL HEAVY and the B3 multiband compressor threshold is 1 dB 
lower, so the midrange is less forward than the midrange in the AM GENERAL HEAVY 

preset.  

The AM PRESENCE preset, as its name suggests, emphasizes the spectrum around 3 
kHz. It is a loud preset that emphasizes speech intelligibility. It uses the MFAST re-
lease time and HARD bass clipping to maintain bass punch at the expense of some 
bass distortion. MW stations seeking to increase their coverage and to cut through 

AM FACTORY PROGRAMMING PRESETS  
Preset Names Source Preset Normal LESS-MORE 

AM FINE ARTS AM FINE ARTS 7.0 

AM GENERAL HEAVY AM GENERAL HEAVY 7.0 

AM GENERAL MEDIUM AM GENERAL MEDIUM 7.0 

AM HF-SW AM HF-SW 7.0 

AM MUSIC HEAVY AM MUSIC HEAVY 7.0 

AM MUSIC MEDIUM AM MUSIC MEDIUM 7.0 

AM NEWS + NR AM NEWS + NR 7.0 

AM NEWS AM NEWS 7.0 

AM PRESENCE AM PRESENCE 7.0 

AM SPORTS AM SPORTS 7.0 
 

Table 3-3-1: Analog AM Factory Programming Presets 
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co-channel interference are appropriate candidates for this preset. 

This preset is tuned for the typical narrowband MW radio and will sound shrill and 
unpleasant on wideband radios (of which there are very few in the market). If you feel 
that the preset has too much distortion, feel free to turn it down it with LESS-MORE to 
taste. 

You can also reduce the midrange boost if you feel this is excessive. Part of the boost 
is implemented in the Equalization section and part is implemented by the 
compression threshold controls, which are found in Advanced Modify. 

AM HF-SW is intended for international shortwave transmission using 4.5 kHz or 
lower audio bandwidth. In recognition of the severe noise and interference 
problems often encountered in HF propagation, the preset has been ``tuned" to 
emphasize loudness and intelligibility, with the FAST release time increasing 
loudness and average modulation. Compared to the medium-wave-oriented presets, 
AM HF-SW has a more ``forward" midrange balance and less bass. This is because 
bass costs modulation without contributing proportional intelligibility (it also can 
make intermodulation distortion worse during selective fading), and because a 
boosted midrange can most effectively cut through noise to provide intelligibility. 

HD Presets  

HD FACTORY PROGRAMMING PRESETS  
Preset Names Source Preset Normal LESS-MORE 

HD FINE ARTS HD FINE ARTS 7.0 

HD GENERAL HEAVY HD GENERAL HEAVY 7.0 

HD GENERAL MEDIUM HD GENERAL MEDIUM 7.0 

HD HF-SW HD HF-SW 7.0 

HD MUSIC HEAVY HD MUSIC HEAVY 7.0 

HD MUSIC MEDIUM HD MUSIC MEDIUM 7.0 

HD NEWS + NR HD NEWS + NR 7.0 

HD NEWS HD NEWS 7.0 

HD PRESENCE HD PRESENCE 7.0 

HD SPORTS HD SPORTS 7.0 
 

Table 3-3-2: HD Factory Programming Presets 

 

 These presets determine the HD-exclusive control settings. They do not affect 
the parts of the processing that are common to the AM and HD chains (stereo 
synthesizer, mono bass, phase rotator, phase corrector, stereo enhancer, and 
AGC). 

 Except for “HD,” all HD presets are named the same as the factory AM analog 
presets that include them. However, by using the FILE > IMPORT HD CONTROLS 
functionality in XPN-AM PC Remote, you can use any HD preset with any AM an-
alog preset. 
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 These presets have LESS-MORE capability (accessed from the HD LESS-MORE tab) 
that is independent of AM LESS-MORE.  

 All HD presets use the MX peak limiter. 

 

Editing Presets 

OPTIMOD XPN-AM is very flexible, enabling you to fine-tune your sound to your re-
quirements. Each preset can be edited with the LESS-MORE control. In all presets, 
LESS-MORE attempts to keep the target loudness constant and equal to the active 
TARGET LOUDNESS value, which is either local to the preset, or if the preset’s TARGET 

LOUDNESS control is set to GLOBAL, the TARGET LOUDNESS specified in I/O SETUP > 

GLOBAL. 

If you want to create your own User Presets, the following detailed discussion of the 
processing structures is important to understand. If you only use Factory Presets or if 
you only modify them with LESS-MORE, you may still find the material interesting 
but you do not need to understand it to get excellent sound from OPTIMOD XPN-
AM. We have carefully designed OPTIMOD XPN-AM’s factory presets and most users 
will not need to go beyond these. 

The LESS-MORE control sets the amount of overall processing while attempting to 
keep the target loudness constant. Typically, it does this by adjusting the MULTIBAND 

DRIVE and MB FINAL LIMIT DRIVE controls in a complementary way: If the MULTIBAND 

DRIVE IS turned up, the MB FINAL LIMIT DRIVE is turned down. Hence, with music pre-
sets OPTIMOD XPN-AM’s loudness meters show how LESS-MORE affects loudness. 

Because the music-oriented presets do not use OPTIMOD XPN-AM’s CBS 
Loudness Controller or BS.1770 Safety Limiter, the loudness meters will 
show more variation than they do for speech-oriented presets that use 
the loudness controller. However, we believe that subjectively, they pro-
vide excellent consistency of both loudness and texture between pro-
gram elements. 

The controls give you the flexibility to customize your sound. However, as with any 
audio processing system, proper adjustment of these controls requires proper bal-
ancing of the trade-offs explained above. The following provides the information 
you need to adjust controls to suit your applications and taste. 

Stereo Enhancer Controls 

The stereo enhancer emulates the Orban 222 analog stereo enhancer, which in-
creases the energy in the stereo difference signal (L−R) whenever a transient is de-
tected in the stereo sum signal (L+R). It complements Optimix, increasing the sense 
of envelopment and space while maintaining excellent downmix compatibility. The 
stereo enhancer’s gating operates under two conditions. 



OPTIMOD XPN-AM  OPERATION 3-33 

 

 

 The two stereo channels are close to identical in magnitude and phase. 

In this case, the enhancer assumes that the program material is actually 
mono and thus suppresses enhancement to avoid creating undesired 
channel imbalance. 

 The ratio of L−R / L+R of the enhanced signal tries to exceed the threshold set by 

the L-R / L+R Ratio Limit control. 

In this case, the enhancer prevents further enhancement in order to pre-
vent excess L−R energy, which can sound unnatural and which can in-
crease multipath distortion in FM broadcasting. 

The STEREO ENHANCER meter indicates the amount of gain (in dB) that applied to the 
L−R signal. 

It is unwise to use stereo enhancement with low bitrate codecs. At low 
bitrates, these codecs use various parametric techniques for encoding the 
spatial attributes of the sound field. Stereo enhancement can unneces-
sarily stress this encoding process. 

 
The stereo enhancer has the following controls: 

Amount sets the maximum spatial enhancement. 

Enhancer In / Out bypasses the stereo enhancer. OUT is equivalent to setting the 
AMOUNT to 0. 

L-R / L+R Ratio Limit sets the maximum amount of enhancement to prevent multi-
path distortion. However, if the original program material exceeds this limit with no 
enhancement, the enhancer will not reduce it. 

Stereo Enhancer Controls  

Name Range 

Amount 0.0 ... 10.0 

In / Out Out / In 

Ratio Lim 70 … 100% 

Depth 0 … 10 
 

Table 3-3: Stereo Enhancer Controls 

Stereo Synthesizer Controls 

The stereo synthesizer emulates the classic analog Orban 275A automatic stereo syn-
thesizer1. 

                                                      

1 The 275A manual, which provides substantial detail, can be downloaded from 
ftp://ftp.orban.com/275A/. 

ftp://ftp.orban.com/275A/
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Stereo Synthesizer Controls  

Name Range 

Mono>Stereo Algorithm Bypass, Auto, Upmix 

In / Out Wide, Narrow 

Mono>Stereo Separation 0 … 10 
 

Table 3-4: Stereo Synthesizer Controls 

This process creates an artificial stereo difference signal (L−R) by passing the mono 
input through a multistage allpass filter. After matrixing with the original mono in-
put (which is the L+R signal) to produce the synthesized left and right channels, the 
result is a “complementary comb filter” whose notches are spaced in frequency in an 
approximately logarithmic manner. Because only the L−R signal is created artificially, 
it cancels out of a mono mixdown, making the synthesizer’s output completely 
mono-compatible2. 

The synthesizer can be activated manually via PC Remote or the API (see Section 5 of 
the manual). Automatic activation is also available. In AUTOMATIC mode, synthesis 
from audio on the left input channel will occur if silence is detected on the right in-
put channel. A 187 ms look-ahead delay in the audio path compensates for the de-
lay built into the detector to prevent false triggering on extremely brief right chan-
nel pauses. Silence gating prevents triggering unless there is activity on the left 
channel.  

 
The stereo synthesizer has the following controls, located in the UPMIX page of the 
GUI: 

Mono>Stereo Upmix (BYPASS, AUTO, UPMIX) allows you to manually bypass the syn-
thesizer or force it to always upmix from material on the left channel. AUTO forces 
upmixing when silence is detected on the right input channel, as described above. 

Mono>Stereo Algorithm (WIDE, NARROW) sets the number of notches in the comple-
mentary comb filters. WIDE produces fewer notches than NARROW. WIDE produces the 
most dramatic effect on music, while NARROW prevent speech from becoming un-
naturally wide-sounding, and is preferable in speech-orinted applications.  

Mono>Stereo Separation sets the gain applied to the allpass filter chain. 0 suppresses 
synthesis, while 10 causes the magnitudes of the L+R and L−R signals to be identical.  

Assuming equal gains in the L+R and L−R channels, the mathematics of 
the process require the phase difference of the L and R channels to be 90 
degrees at the frequencies where their magnitudes are equal. This can 
produce“phasiness” that some people dislike. If the output of the synthe-

                                                      

2 Robert Orban: “A Rational Technique for Synthesizing Pseudo-Stereo from Mono-
phonic Sources,” J. Audio Engineering Society, Volume 18 Issue 2 pp. 157-164; April 
1970 
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sizer is applied to OPTIMOD XPN-AM’s phase correction algorithm, this 
will remove the “phasiness” at higher frequencies at the expense of put-
ting bumps of up to 3 dB in the frequency response of the mono sum (as-
suming that MONO>STEREO SEPARATION = 10). Because of this compatibility 
issue, we recommend instead simply turning down the MONO>STEREO 

SEPARATION control until the result sounds comfortable and convincing. 7 
(where the L−R signal is 70% of the L+R signal) is a good compromise 
value. 

 

AGC Controls 

The AGC smoothly rides gain before the multiband compressor. Unlike AGCs in some 
other Optimods, only a linear-phase crossover is available and the left and right 
channels are coupled using RMS summation. The AGC MAXDELTAGR control deter-
mines the amount of coupling.  While we have removed some features relating to 
left/right band coupling and sum-and-difference operation, we believe that the new 
AGC design used in the XPN-AM is substantially smoother and more transparent 
than the AGCs used in earlier Optimods. 

AGC (“AGC Off/On”) control activates or defeats the AGC.  

It is usually used to defeat the AGC when you want to create a preset with minimal 
processing (such as a CLASSICAL preset). The AGC is also ordinarily defeated if you 
are using a studio level controller to protect a transmission link before OPTIMOD 
XPN-AM. However, in this case it is better to defeat the AGC globally in System Set-
up [see step 3 on page 2-26]. 

AGC Drive control adjusts signal level going into the slow dual-band AGC, therefore 
determining the amount of gain reduction in the AGC. This control also adjusts the 
“idle gain”—the amount of gain reduction in the AGC section when the structure is 
gated. (It gates whenever the input level to the structure is below the threshold of 
gating.) 

The total amount of gain reduction in the Five-Band structure is the sum of the gain 
reduction in the AGC and the gain reduction in the five-band compressor. The total 
system gain reduction determines how much the loudness of quiet passages will be 
increased (and, therefore, how consistent overall loudness will be). It is determined 
by the setting of the AGC DRIVE control, by the level at which the console VU meter 
or PPM is peaked, and by the setting of the MULTIBAND DRIVE (compressor) control. 

AGC Release (“AGC Master Release”) control provides an adjustable range from 0.5 
dB/second (slow) to 20 dB/second (fast). The increase in density caused by setting the 
AGC RELEASE control to fast settings sounds different from the increase in density 
caused by setting the Five-band’s MULTIBAND RELEASE control to FAST. You can trade 
the two off to produce different effects. 

Unless it is purposely speeded-up (with the AGC RELEASE control), the automatic 
gain control (AGC) that occurs in the AGC prior to the multiband compressor makes 
audio levels more consistent without significantly altering texture. Then the multi-
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band compression audibly changes the density of the sound and dynamically re-
equalizes it as necessary: booming bass is tightened; weak, thin bass is brought up; 
highs are always present and consistent in level. 

The various combinations of AGC and compression offer great flexibility: 

 Light AGC + light compression yields a wide sense of dynamics, with a small 

amount of automatic re-equalization. 

 Moderate AGC + light compression produces an open, natural quality with au-

tomatic re-equalization and increased consistency of frequency balance. 

 Moderate AGC + moderate compression gives a denser sound, particularly as the 

release time of the multiband compressor is sped up. 

 Moderate AGC + heavy compression (particularly with a FAST multiband release 

time) results in a “wall of sound” effect, which may cause listener fatigue. 

Adjust the AGC (with the AGC DRIVE control) to produce the desired amount of AGC 
action, and then fine-tune the compression and clipping with the Five-Band struc-
ture’s controls. 

AGC Gate (“AGC Gate Threshold”) control determines the lowest input level that 
will be recognized as program by OPTIMOD XPN-AM; lower levels are considered to 
be noise or background sounds and cause the AGC or multiband compressor to gate, 
effectively freezing gain to prevent noise breathing. 

There are two independent silence-gating circuits in OPTIMOD XPN-AM. The first 

AGC Controls  
Name Range 

AGC Off / On Off / On 

AGC Drive −10 ... 25 dB 

AGC Master Release 0.5, 1.0, 1.5, 2 … 20 dB / S 

AGC Bass Release 1 … 10 dB/sec 

AGC Gate Threshold Off, −44 ... −15 dB 

AGC Bass Coupling  0 … 24 dB, Off 

AGC Window Size  −25 … 0 dB 

AGC Window Release 0.5 … 20 dB 

AGC Ratio :1, 4:1, 3:1, 2:1 

AGC Bass Threshold −12.0 … 2.5 dB 

AGC Idle Gain −10 … +10 dB 

AGC Master Attack  0.2 … 6 

AGC Bass Attack  1 … 10 

AGC Crossover Allpass, LinearNoDelay,  

AGC Matrix L/R, sum/difference 

AGC MaxDelta GR 0.0 … 24.0 dB, off 

Master Delta Thresh −6.0 … +6.0 dB 

Bass Delta Thresh −6.0 … +6.0 dB 
 

Table 3-5: AGC Controls 
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affects the AGC and the second affects the multiband compressor. Each has its own 
threshold control. 

In the five-band compressor, the multiband silence gate causes the gain reduction in 
bands 2 and 3 of the five-band compressor to move quickly to the average gain re-
duction occurring in those bands when the gate first turns on. This prevents obvious 
midrange coloration under gated conditions, because bands 2 and 3 have the same 
gain. 

The multiband gate also independently freezes the gain of the two highest frequen-
cy bands (forcing the gain of the highest frequency band to be identical to its lower 
neighbor), and independently sets the gain of the lowest frequency band according 
to the setting of the DJ BASS boost control (in the Equalization screen). Thus, with-
out introducing obvious coloration, the gating smoothly preserves the average 
overall frequency response “tilt” of the multiband compressor, broadly maintaining 
the “automatic equalization” curve it generates for a given piece of program mate-
rial. 

If the MB GATE THR (Gate Threshold) control is turned OFF, the DJ BASS con-
trol is disabled. 

AGC Bass Coupling  control clamps the amount of dynamic bass boost (in units of dB) 
that the AGC can provide. 

The AGC processes audio in a master band for all audio above approximately 200 Hz 
and a bass band for audio below approximately 200 Hz. The AGC Master and Bass 
compressor sidechains operate without internal coupling. The gain reduction in the 
BASS audio path is either the output of the Bass compressor sidechain or the output 
of the Master band sidechain. The AGC BASS COUPLING control sets the switching 
threshold. For example, if the AGC BASS COUPLING control is set to 4 dB and the mas-
ter gain reduction is 10 dB, the bass gain reduction cannot decrease below 6 dB even 
if the gain reduction signal from the Bass compressor sidechain is lower. However, 
the audio path bass gain reduction can be larger than the master gain reduction 
without limit. In the previous example, the bass gain reduction could be 25 dB  

The normal setting of the AGC BASS COUPLING control is 0 dB, which allows the AGC 
bass band to correct excessive bass as necessary but does not permit it to provide a 
dynamic bass boost. 

Window Size determines the size of the floating “slow zone” window in the master 
band of the AGC. (The Bass band is not windowed.) 

The window works by slowing down changes in the AGC gain reduction that are 
smaller than the WINDOW SIZE. The window has 2:1 asymmetry around the current 
AGC gain reduction. For example, if the WINDOW SIZE is set to 4 dB, the window ex-
tends 4 dB in the release direction and 2 dB in the attack direction. 

If the AGC needs to respond to a large change in its input level by making a gain 
change that is larger than the window, then the AGC’s attack and release controls 
determine the AGC’s response time. However, if the change in input level is smaller 
than the window size, the WINDOW RELEASE control determines the attack and re-
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lease times. This is usually much slower than the normal AGC time constants. This 
prevents the AGC from building up density in material whose level is already well 
controlled. 

The previous explanation was somewhat simplified. In fact, the window has “soft 
edges.” Instead of switching abruptly between time constants, the attack and re-
lease times morph smoothly between the setting of the WINDOW RELEASE control and 
the setting of the AGC master release and attack controls. 

The normal setting for the WINDOW SIZE is 3 dB. 

Window Release (see WINDOW SIZE above.) 

AGC Ratio determines the compression ratio of the AGC. The compression ratio is 
the ratio between the change in input level and the resulting change in output lev-
el, both measured in units of dB. 

OPTIMOD XPN-AM compressor can be operated at a compression ratio as low as 2:1. 
This can add a sense of dynamic range and is mostly useful for subtle fine arts for-
mats like classical and jazz. 

AGC Bass Threshold determines the compression threshold of the bass band in the 
AGC. It can be used to set the target spectral balance of the AGC. 

As the AGC BASS COUPLING control is moved towards “100%,” the AGC BASS 

THRESHOLD control affects the sound less and less. 

The interaction between the AGC BASS THRESHOLD control and the AGC B CPL con-
trol is a bit complex, so we recommend leaving the AGC BASS THRESHOLD control at 
its factory setting unless you have a good reason for readjusting it. 

AGC Idle Gain. The “idle gain” is the target gain of the AGC when the silence gate is 
active. Whenever the silence gate turns on, the gain of the AGC slowly moves to-
wards the idle gain. 

The idle gain is primarily determined by the AGC DRIVE setting—a setting of 10 dB 
will ordinarily produce an idle gain of −10 dB (i.e., 10 dB of gain reduction). Howev-
er, sometimes you may not want the idle gain to be the same as the AGC DRIVE set-
ting. The AGC IDLE GAIN control allows you to add or subtract gain from the idle gain 
setting determined by the AGC DRIVE setting. 

You might want to do this if you make a custom preset that otherwise causes the 
gain to increase or decrease unnaturally when the AGC is gated. For example, to 
make the idle gain track the setting of the AGC DRIVE control, set the AGC IDLE GAIN 
control to zero. To make the idle gain 2 dB lower than the setting of the AGC DRIVE 
control, set the AGC IDLE GAIN control to −2. 

AGC Bass Attack sets the attack time of the AGC bass compressor (below 200Hz). 

AGC Master Attack sets the attack time of the AGC master compressor (above 
200Hz). 
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AGC Bass Release sets the release time of the AGC bass compressor. 

AGC Maximum Delta GR approximates the maximum gain difference permitted be-
tween the two stereo channels of the AGC. Set it to “0” for perfect stereo coupling. 

Equalizer Controls 

The table summarizes the equalization controls. The equalizer is located between 
the AGC and five-band compressor sections. Except for the AM receiver equalizer 
(see page 3-44), the EQ facilities in the AM and HD chains are identical. 

See Figure 3-6 and Figure 3-7 on page 3-17 for typical equalizer frequency response 
curves. 

Any equalization that you set will be automatically stored in any User Preset that 
you create and save. For example, you can use a User Preset to combine an unmodi-
fied Factory Programming Preset with your custom equalization. Of course, you can 
also modify the Factory Preset (with Basic or Advanced Modify) before you create 
your User Preset. 

Except for BASS GAIN, most of the factory presets use less than 3 dB of equalization. 

 

Bass Shelf Controls, the 5-band 
structure’s low bass equalization 
controls, are designed to add 
punch and slam to rock and urban 
music. They provide a parametric 
shelving equalizer with control 
over gain, hinge frequency, and 
slope (in dB/octave). 

Bass Shelf Hinge Frequency sets the frequency where shelving starts to 
take effect. 

Bass Gain sets the amount of bass boost (dB) at the top of the shelf. 

Bass Slope sets the slope (dB/octave) of the transition between the top 
and bottom of the shelf. 

Because the Five-Band structure often increases the brightness of pro-
gram material, some bass boost is usually desirable to keep the sound 
spectrally well balanced. Adjustment of bass equalization must be deter-
mined by individual taste and by the requirements of your format. Be 
sure to listen on a wide variety of consumer systems—it is possible to cre-
ate severe distortion on poor quality speakers by over-equalizing the 
bass. Be careful! 

The moderate-slope (12 dB/octave) shelving boost achieves a bass boost 
that is more audible on smaller radios, but which can sound boomier on 
high-quality systems. The steep-slope (18 dB/octave) shelving boost cre-
ates a solid, punchy bass from the better consumer systems with decent 
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bass response. The 6 dB/octave shelving boost is like a conventional tone 
control and creates the most mid-bass boost, yielding a “warmer” sound. 
Because it affects the mid-bass frequency range, where the ear is more 
sensitive than it is to very low bass, the 6 dB/octave slope can create more 
apparent bass level at the cost of bass “punch.” 

There are no easy choices here; you must choose the characteristic you 
want by identifying your target audience and the receivers they are most 
likely to be using. Regardless of which curve you use, we recommend a 
+2 to +5 dB boost for most formats. Larger amounts of boost will in-
crease the gain reduction in the lowest band of the multiband compres-
sor, which may have the effect of reducing some frequencies. So be 
aware the large fixed bass boosts may have a different effect than you 
expect because of the way that they interact with the multiband com-
pressor. (The GREGG presets use this effect purposely to create a dynamic 

Equalizer Controls 
Group Name Range 

Bass Shelf Bass Frequency 80, 85, 90, 95, 100, 105, 110, 115, 120, 125, 
130, 135, 140, 145, 150, 160, 170, 180, 190, 
200, 210, 220, 230, 240, 250, 270, 290, 310, 
330, 350, 380, 410, 440, 470, 500Hz 

Bass Gain 0 … 12 dB 

Bass Slope 6,12,18 dB/Oct 

Low Low Frequency 20 ... 500 Hz 

Low Gain −10.0 … +10.0 dB 

Low Width 0.8 ... 4 octaves 

Mid Mid Frequency 250 ... 6000 Hz 

Mid Gain −10.0 … +10.0 dB 

Mid Width 0.8 ... 4 octaves 

High High Frequency 1.0 … 15.0 kHz 

High Gain −10.0 … +10.0 dB 

High Width 0.8 ... 4 octaves 

All All Frequency 20 Hz … 20.0 kHz 

 All Gain −10.0 … +10.0 dB 

 All Width 0.8 ... 4 octaves 

HF Enhancer High Frequency 
Enhancer 

0 … 15 dB 

 Sensitivity Trim –10 … +10 dB 

 Threshold Trim 0 … +20 dB 

Subharmonic 
Injection 

Subharmonic Injection Off, −99.0 … 0 dB 

DJ Bass (5B) DJ Bass Boost Off, 1… +10 dB 

Highpass Filter, 
Speech HP Filter 

Highpass Filter Freq Off, 20, 30, 40, 50, 60, 70, 80, 90, 100, 110, 
120, 130, 140, 150, 170, 200 Hz 

 Highpass Filter Slope 6, 12, 18, 24 dB / octave 

LP Filter (EQ) Lowpass Filter Freq 4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15 kHz 
 Lowpass Filter Slope 6, 12, 18, 24 dB / octave 

LP Filter (steep) Lowpass Filter 10, 11 ,12, 13, 14, 15, 20 kHz 

Phase Rotate Phase Rotate In / Out 

HF Equalizer HF Equalizer Gain 0.0…+22.0 dB 

(AM only) HF Equalizer Shape 0.0…10.0, NRSC 
 

Table 3-6: Equalizer Controls 
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cut in the mid-bass.) 

Low Frequency Parametric Equalizer is a specially designed equalizer whose boost 
and cut curves closely emulate those of a classic Orban analog parametric equalizer 

with conventional bell-shaped curves (within 0.15 dB worst-case). This provides 
warm, smooth, “analog-sounding” equalization. 

LF Freq determines the center frequency of the equalization, in Hertz. 
Range is 20-500Hz. 

LF Gain determines the amount of peak boost or cut (in dB) over a 10 dB 
range. 

LF Width determines the bandwidth of the equalization, in octaves. The 
range is 0.8-4.0 octaves. If you are unfamiliar with using a parametric 
equalizer, 1.5 octaves is a good starting point. These curves are relatively 
broad because they are designed to provide overall tonal coloration, ra-
ther than to notch out small areas of the spectrum. 

The LF parametric can be used in the mid-bass region (100-300Hz) to add 
“warmth” and “mellowness” to the sound when boosting. When cutting, 
it can remove a “woody” or “boxy” sound.  

The equalizer, like the classic Orban model 622B, has constant “Q” 
curves. This means that the cut curves are narrower than the boost 
curves. The width (in octaves) is calibrated with reference to 10 dB boost. 
As you decrease the amount of EQ gain (or start to cut), the width in oc-
taves will decrease. However, the “Q” will stay constant. 

“Q” is a mathematical parameter that relates to how fast ringing damps 
out. (Technically, we are referring to the “Q” of the poles of the equaliz-
er transfer function, which does not change as you adjust the amount of 
boost or cut.) 

The curves in OPTIMOD XPN-AM’s equalizer were created by a so-called 
“minimax” (“minimize the maximum error” or “equal-ripple”) IIR digital 
approximation to the curves provided by the Orban 622B analog para-
metric equalizer. Therefore, unlike less sophisticated digital equalizers 
that use the “bilinear transformation” to generate EQ curves, the shapes 
of OPTIMOD XPN-AM’s curves are not distorted at high frequencies. 

Midrange Parametric Equalizer is a parametric equalizer whose boost and cut curves 
closely emulate those of an analog parametric equalizer with conventional bell-
shaped curves. 

Mid Freq determines the center frequency of the equalization, in Hertz. 
Range is 250-6000Hz. 

Mid Gain determines the amount of peak boost or cut (in dB) over a 10 
dB range. 

Mid Width determines the bandwidth of the equalization, in octaves. The 
range is 0.8-4.0 octaves. If you are unfamiliar with using a parametric 
equalizer, one octave is a good starting point. 

With Five-Band presets, the audible effect of the midrange equalizer is 
closely associated with the amount of gain reduction in the midrange 
bands. With small amounts of gain reduction, it boosts power in the 



3-42  OPERATION ORBAN  

 

 

presence region. This can increase the loudness of such material substan-
tially. As you increase the gain reduction in the midrange bands (by turn-

ing the MULTIBAND DRIVE control up), the MID GAIN control will have 
progressively less audible effect. The compressor for the midrange bands 

will tend to reduce the effect of the MID frequency boost (in an attempt 
to keep the gain constant) to prevent excessive stridency in program ma-
terial that already has a great deal of presence power. Therefore, with 
large amounts of gain reduction, the density of the presence region en-
ergy will be increased more than will the level of energy in that region. 
Because the 3.7 kHz band compressor is partially coupled to the gain re-

duction in the 6.2 kHz band in most presets (as set by the B4>5 

COUPLING control), tuning MID FREQ to 2-4 kHz and turning up the MID 

GAIN control will decrease energy in the 6.2 kHz band—you will be in-
creasing the gain reduction in both the 3.7 kHz and 6.2 kHz bands. You 

may wish to compensate for this effect by turning up the BRILLIANCE 
control. 

With Two-Band presets, the midrange equalizer will behave much more 
as you might expect because the two-band structure cannot automatical-
ly re-equalize midrange energy. Instead, increasing midrange energy will 
moderately increase the Master band’s gain reduction. 

Use the mid frequency equalizer with caution. Excessive presence boost 
tends to be audibly strident and fatiguing. Moreover, the sound quality, 
although loud, can be very irritating. We suggest a maximum of 3 dB 
boost, although 10 dB is achievable. In some of our factory music presets, 
we use a 3 dB boost at 2.6 kHz to bring vocals more up-front. 

High Frequency Parametric Equalizer is an equalizer whose boost and cut curves 
closely emulate those of an analog parametric equalizer with conventional bell-
shaped curves. 

High Freq determines the center frequency of the equalization, in Hertz. 
The range is 1-15 kHz 

High Gain determines the amount of peak boost or cut over a 10 dB 
range. 

High Width determines the bandwidth of the equalization, in octaves. 
The range is 0.8-4.0 octaves. If you are unfamiliar with using a parametric 
equalizer, one octave is a good starting point. 

Excessive high frequency boost can exaggerate hiss and distortion in pro-
gram material that is less than perfectly clean. We suggest no more than 
4 dB boost as a practical maximum, unless source material is primarily 
from high-quality digital sources. In several of our presets, we use this 
equalizer to boost the upper presence band (4.4 kHz) slightly, leaving 

broadband HF boost to the BRILLIANCE and/or HF ENHANCE controls. 

All Frequency Parametric Equalizer is similar to the other parametric sections but can 
be swept over the entire audio band, from 20 Hz to 20 kHz.  

Brilliance controls the drive to Band 5. The Band 5 compressor/limiter dynamically 
controls this boost, protecting the final limiter from excessive HF drive. We recom-
mend a maximum of 4 dB of Brilliance boost and most people will prefer substan-
tially less. 
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DJ Bass (“DJ Bass Boost“) control determines the amount of bass boost produced on 
some male voices. In its default OFF position, it causes the gain reduction of the 
lowest frequency band to move quickly to the same gain reduction as its nearest 
neighbor when gated. This fights any tendency of the lowest frequency band to de-
velop significantly more gain than its neighbor when processing voice because voice 
will activate the gate frequently. Each time it does so, it will reset the gain of the 
lowest frequency band so that the gains of the two bottom bands are equal and the 
response in this frequency range is flat. The result is natural-sounding bass on male 
voice. This is particularly desirable for most speech-oriented programming. 

If you like a larger-than-life, “chesty” sound on male voice, set this control away 
from OFF. When so set, gating causes the gain reduction of the lowest frequency 
band to move to the same gain reduction (minus a gain offset equal to the numeri-
cal setting of the control) as its nearest neighbor when gated. You can therefore set 
the maximum gain difference between the two low frequency bands, producing 
considerable dynamic bass boost on voice. This setting might be appropriate for 
news and sports. 

The difference will never exceed the difference that would have other-
wise occurred if the lowest frequency band were gated independently. If 
you are familiar with older Orban processors like OPTIMOD-FM 8200, this 
is the maximum amount of boost that would have occurred if you had set 

their DJ BASS BOOST controls to ON. 

The amount of bass boost will be highly dependent on the fundamental 
frequency of a given voice. If the fundamental frequency is far above 
100Hz, there will be little voice energy in the bottom band and little or 
no audio bass boost can occur even if the gain of the bottom band is 
higher than the gain of its neighbor. As the fundamental frequency 
moves lower, more of this energy leaks into the bottom band, and you 
hear more bass boost. If the fundamental frequency is very low (a rarity), 
there will be enough energy in the bottom band to force significant gain 
reduction, and you will hear less bass boost than if the fundamental fre-
quency were a bit higher. 

This control is only available in the Five-Band structure.  

If the GATE THRESH (Gate Threshold) control is turned OFF, the DJ BASS 
boost setting is disabled. 

The High Frequency Enhancer is a program-adaptive, 6 dB/octave shelving equalizer 
with a 4 kHz turnover frequency. It constantly monitors the ratio between high fre-
quency and broadband energy and adjusts the amount of equalization in an at-
tempt to make this ratio constant as the program material changes. It can therefore 
create a bright, present sound without over-equalizing material that is already 
bright. 

High Frequency Enhancer is a mix control for the high frequency enhancer 
that sets the amount of enhanced high frequencies being mixed into the 
input and clamps the maximum enhancement to the control’s setting. 

Sensitivity Trim (v0.9.9 and higher) trims the ratio of high-frequency to 
wideband energy produced by HF Enhancer at a given setting of the HIGH 

FREQUENCY ENHANCER control. Higher settings increase the amount of en-
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hancement.  Default is 0 dB, which retains the behavior of the previous 
high frequency enhancer. This had only one control: HIGH FREQUENCY 

ENHANCER. 

Threshold Trim (v0.9.9 and higher) trims the high frequency enhancer in-
put level above which full HF enhancement occurs. Higher settings pro-
duce lower amounts of enhancement at low levels. Default is 0 dB, which 
produces the same behavior as previous versions of the HF enhancer. 
Note that the HF Enhancer is driven by the AGC, so its input level tracks 
the AGC’s output level. 

Receiver Equalizer 

HF Gain (“High Frequency Shelf Gain”) determines the amount of high 
frequency boost provided by the XPN-AM’s receiver equalizer. 

HF Curve (“High Frequency Shelf Curve”) determines the shape of the 
curve produced by the XPN-AM’s receiver equalizer. 

The high-frequency receiver equalizer (AM chain only) is designed to compensate 
for the high frequency rolloff in average AM radios. The typical AM radio is down 
3dB at 2kHz and rolls off at least 18dB/octave after that. The HF equalizer provides 
an 18dB/octave shelving pre-emphasis that can substantially improve the brightness 
and intelligibility of sound through such narrowband radios. The HF equalizer has 
two controls: a gain control that determines the height of the shelving curve (dB), 
and a curve control, calibrated with an arbitrary number that determines how ab-
ruptly the shelving equalizer increases its gain as frequency increases. 0 provides the 
most abrupt curve; 10 provides the gentlest. The HF CURVE control is used to 
trade-off harshness on wider-band radios against brightness in narrow-band radios. 

An HF CURVE of 0 provides the same equalization that was originally supplied as 
standard on early OPTIMOD-AM 9100 units and was later provided by the 9100’s 
green module. Compared to higher settings of the HF Curve control, it provides 
much more boost in the 5 kHz region, and tends to sound strident on wideband ra-
dios. However, it can be very effective where narrowband radios remain the norm. 

With an HF CURVE setting of 0, an HF GAIN control setting of 22 dB will create a per-
ceived bandwidth of 6 kHz on “Group 2” AM radios (see page 3-9); a 15 dB setting 
yields a 5 kHz perceived bandwidth, 10 dB yields 4 kHz, and 5 dB yields 3 kHz. Ad-
vancing the HF GAIN control will result in a brighter, higher fidelity sound, but it will 
also require that the listener tune the radio more carefully. 

If most of your listeners have wider-band radios (as may be the case in North Ameri-
ca), use the NRSC curve, which can be chosen with the HF CURVE control. For a 
somewhat brighter sound that can benefit narrowband radios more, yet is still com-
patible with wideband NRSC radios, use HF CURVE = 10 and HF GAIN = 10dB. HF 

CURVE = 10 corresponds to the RED pre-emphasis module in Orban's analog 
9100-series OPTIMOD-AM processors. 
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Note that the added brightness caused by using an HF CURVE of 10 (as opposed to 
using NRSC) may tend to increase the first-adjacent interference being generated by 
your station, contrary to the purpose and intentions of the NRSC. 

HF CURVE settings between 0 and 10 smoothly interpolate between the two ex-
tremes, and provide more flexibility for user adjustment. An HF CURVE setting of 5 
provides the curve family associated with the YELLOW pre-emphasis module in 
Orban's analog 9100-series OPTIMOD-AM processors. 

With the HF CURVE control at any setting other than NRSC, extreme amounts of 
high-frequency boost may result in a slight `lisping' quality on certain voices. This is 
because the high-frequency boost will increase the high-frequency content of sibi-
lant voices, which can only be boosted to 100% modulation. Since the spectral bal-
ance of the voice is altered, this may be perceived as a lisping sound. 

The receiver equalizer is of limited benefit to narrowband radios with abrupt 
rolloffs. We believe that these radios benefit more from a boost at 3 kHz, combined 
with very little HF shelving EQ. These radios have almost no response at 5 kHz and 
above, so boosting frequencies above 5 kHz wastes modulation. Using a bell-shaped 
boost at 3 kHz causes the boost to decline naturally at frequencies that the radio 
cannot reproduce. You can use the midrange, all-frequency, or HF parametric equal-
izer to create such a boost. 

 
Figure 3-14: HF Receiver Equalizer Curves 
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Figure 3-14 on page 3-45 shows the curve families for the HF equalizer. 

 

 

Figure 3-15: Equal Loudness Curves 

 

Subharmonic Injection The subharmonic synthesizer generates subharmonics of fun-
damental frequencies in the 50-90 Hz range. The subharmonics are one octave be-
low the frequencies from which they are generated (i.e., 25 to 45 Hz) and track the 
levels of their generating frequencies. Subharmonic injection can be varied from 0 
to 100% of the level of the generating frequency. 50% is a good starting point for 
popular music formats. 

If input program material below 50 Hz is present, the subharmonic synthesizer au-
tomatically reduces the level of the synthesized subharmonics to prevent excess 
build-up of energy below 50 Hz (i.e. the amount of subharmonic injection will be 
lower than the setting of the SUBHARMONIC INJECTION control). 

To prevent introducing unnatural coloration in male speech. the subharmonic syn-
thesizer is defeated when the automatic speech/music detector detects speech.  

It is important to understand that material below 50 Hz takes up lots of peak level 
to produce significant loudness. Moreover, the close spacing of psychoacoustic 
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“equal loudness“ curves3 below 50 Hz means small changes in amplitude lead to 
large change in subharmonic loudness. The unpredictability of receiver bass re-
sponse means that the perceived loudness of subharmonics is highly receiver-
dependent. Because of the amount of peak level they use up, subharmonics will al-
ways make a broadcast sound quieter for a given amount of processing arti-
facts/distortion—they use up peak level that otherwise could be dedicated to audio 
to which the ear is more sensitive. (This is an inevitable effect of the equal-loudness 
curves.) For all these reasons, it is wise not to overdo subharmonic synthesis. 

While it was included (for completeness) in the AM chain, it is usually unwise to use 
it because of the susceptibility of many radios to RF AGC-induced IM distortion when 
extremely low modulating frequencies are present, and because subharmonics will 
use up modulation that could otherwise be devoted to increasing loudness and cov-
erage. 

Note that when you apply an L+R sinewave at a frequency between 50 to 
90 Hz to the XPN-AM’s input, the XPN-AM’s speech/music detector will 
detect this as “speech,” so no subharmonics will be produced. To test the 
subharmonic synthesizer with tone, there must be at least 2 dB of level 
difference between the left and right inputs. In other words, be sure that 
the XPN-AM’s speech/music detector is indicating “music” in the XPN-AM 
PC GUI. 

 

Highpass Filter, Speech Highpass Filter determines if a sweepable 6, 12, 18 or 24 
dB/octave highpass filter will be placed in-circuit before other processing. The 6, 12 
and 18 dB/octave filters have a Butterworth response and the indicated frequency is 
where the filter is 3 dB down. The 24 dB/octave filter has a Chebychev response with 
0.01 dB of passband ripple. The indicated highpass frequency of this filter is the 
passband edge of the filter. (For example, if the filter is set to 20 Hz, the high filter’s 
response will be flat ±0.01 dB to 20 Hz. 

The highpass filter is useful for reducing low frequency noise and, in the AM chain, 
preventing distortion in receivers whose fast RF AGC time constants can otherwise 
modulate the recovered audio with low bass, causing IM distortion. 

Two control sets (each containing FREQUENCY and SLOPE) are available, one for mu-
sic mode and one for speech mode. These can be switched via OPTIMOD XPN-AM’s 
automatic speech/music detector. 

It is wise to make sure that the main and speech-mode highpass filter set-
tings are the same unless you specifically want to apply additional 
highpass filtering to speech. Like all automatic speech/music detectors, 
the one in your Optimod can occasionally make mistakes, so it is also wise 
in mixed-format programming to set the filter no higher than 70 Hz. This 
way, if the Optimod mistakenly identifies music as speech (or decides that 

                                                      

3 The equal-loudness curves are popularly known as “Fletcher/Munson” curves, alt-
hough these have been superseded by ISO 226:2003. The image was taken from 
en.wikipedia.org. 
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voice-over-music is speech), it will not cause an obvious dropout of bass 
frequencies. 

Note that an L=R test tone whose level changes depending on whether 
speech or music is detected can repeatedly toggle the speech/music de-
tector between “speech” and “music” modes. This is because the sudden 
jump in tone level is “speech-like” and triggers the speech/music detec-
tor’s syllabic detector. An example is a 100 Hz tone when the main 
highpass filter frequency is 50 Hz and the speech highpass filter frequen-
cy is 200 Hz. This issue never occurs with program material. 

Lowpass Filter (steep) control sets the bandwidth (and therefore the amount of high 
frequency signal OPTIMOD XPN-AM passes) from 10 kHz to 20 kHz. The lowpass fil-
ter can replace any anti-aliasing filters in downstream equipment. Set the filter to 20 
kHz (full bandwidth) for downstream equipment with sample rates of 44.1 or 48 
kHz. Set the filter to 15 kHz for 32 kHz sample rate. For other sample rates, set the 
filter so that it is as close as possible to 45% of the sample rate without exceeding 
45%. 

This setting is unique to the preset in which it resides. Regardless of its 
setting, OPTIMOD XPN-AM will not permit the system bandwidth to ex-
ceed the bandwidth set by the MAX LOWPASS FILTER parameter located in 
the Configuration page of the I/O Mixer. 

Lowpass Filter (gentle) is intended for program equalization, not anti-aliasing like 
the steep lowpass filter. It is intended mainly for mastering where the steep lowpass 
filter might cause audibly objectionable ringing. It is sweepable from 4 to 15 kHz 
with slopes of 6, 12, 18 or 24 dB/octave. The filter’s shape is Butterworth, and the 
setting indicates the frequency where the filter is 3 dB down. 

Phase Rotator determines if the phase rotator will be in-circuit. The purpose of the 
phase rotator is to make voice waveforms more symmetrical. Because it can slightly 
reduce the clarity and definition of program material, we recommend leaving it OUT 

unless program material is mainly speech, where it may result in cleaner sound be-
cause it can substantially reduce the amount of gain reduction that OPTIMOD XPN-
AM’s look-ahead limiter produces on speech waveforms. 

The phase rotator is located before the AM/HD split so that it applies the same 
amount of phase shift to both Am and HD channels. This reduces the likelihood that 
objectionable comb filtering will occur during an AM<>HD crossfade in the radio.  

Multiband Compressor Controls 

Following the AGC is an equalization section, a five-band compressor, a dynamic 
single-ended noise reduction system, an output mixer (for the five bands), and a 
peak limiter. 

When the input is noisy, you can sometimes reduce the noise by activating the sin-
gle-ended noise reduction system. Functionally, the single-ended noise reduction 
system combines a broadband downward expander with a program-dependent low-
pass filter. This noise reduction can be valuable in reducing audible hiss, rumble, or 
ambient studio noise. We use it for the news and sports factory presets. 
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The Five-Band structure does not have a separate Loudness Controller because its 
Five-Band compressor automatically re-equalizes the spectral balance of various 
pieces of program material in a way that tends to make their loudness more con-
sistent. 

The Five-Band Structure’s Full and Advanced Setup Controls 

The tables below summarize the Five-band and Band Mix controls in the dynamics 
section. The AGC, Equalizer, Stereo Enhancer, and Clipper controls are common to 
both the Two-Band and Five-Band structures and are discussed in their own sections 
in Section 3. 

Multiband Drive control adjusts the signal level going into the five-band compressor, 
and therefore determines the average amount of gain reduction in the five-band 
compressor. Range is 25dB. The control sets the drive into the multiband compres-
sion and thus the amount of gain reduction that it produces. 

Adjust the MULTIBAND DRIVE control to your taste and programming requirements. 
Used lightly with a slow or medium release time, the Five-Band compressor produces 
an open, re-equalized sound. The Five-Band compressor can increase audio density 
when operated at a fast or medium-fast release because it acts more and more like a 
fast limiter (not a compressor) as the release time is shortened. With fast and medi-
um-fast release times, density also increases when you increase the drive level into 
the Five-Band compressor because these faster release times produce more limiting 
action. Increasing density can make loud sounds seem louder, but can also result in 
an unattractive busier, flatter, or denser sound. It is very important to be aware of 
the many negative subjective side effects of excessive density when setting controls 

Multiband Controls  
Advanced Name Range 

Multiband Drive 0 ... 25 

Multiband Gate Threshold Off, −44 ... −15 dB 

Downward Expander Off, −18.0 … 12.0 dB 

Speech  Downward Expander Off, −18.0 … 12.0 dB 

B5 Downward Expander Off, −18.0 … 12.0 dB 

Downward Expander Stereo Coupling  

Crossover Linear, Allpass 

B1/B2 Crossover 100 Hz, 150 Hz, 200 Hz 

B1/B2 Crossover Slope Shallow, Steep 

B1 MaxDeltGr 0 … 24 dB, Off 

B2 MaxDeltGr 0 … 24 dB, Off 

B3 MaxDeltGr 0 … 24 dB, Off 

B4 MaxDeltGr 0 … 24 dB, Off 

B5 MaxDeltGr 0 … 24 dB, Off 

Loudness Threshold Off, +10.0 … -14.0 dB 

Loudness Attack 0…100% 

Loudness Bass Couple 0…12 dB, Off 

BS.1770 Threshold 0…6 dB, Off 

Mono Bass On, Off 

Mono Bass Crossover 80, 100 Hz 
 

Table 3-7: Multiband Controls 
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that affect the density of the processed sound. 

Because OPTIMOD XPN-AM’s AGC algorithm uses sophisticated window gating, it is 
preferable to make the AGC do most of the gain riding (instead of the five-band 
compressor), because the AGC can ride gain quickly without adding excessive density 
to program material that is already well controlled. The five-band compressor is typ-
ically used with 5 to 10 dB of average gain reduction so it can perform automatic re-
equalization of material that the AGC has already controlled without adding exces-
sive density to the audio or re-equalizing to an unnatural extent. 

The MULTIBAND DRIVE interacts with the MULTIBAND RELEASE. With slower release time 
settings, increasing the MULTIBAND DRIVE control scarcely affects density. Instead, the 
primary danger is that the excessive drive will cause noise to be increased excessively 
when the program material becomes quiet. You can minimize this effect by activat-
ing the single-ended noise reduction and/or by carefully setting the MULTIBAND GATE 

THRESHOLD control to freeze the gain when the input gets quiet. 

When the release time of the Five-Band compressor is set towards FAST, the setting 
of the MULTIBAND DRIVE control becomes much more critical to sound quality be-
cause density increases as the control is turned up. Listen carefully as you adjust it. 
With these fast release times, there is a point beyond which increasing the Five-Band 
compressor drive will no longer yield more loudness, and will simply degrade the 
punch and definition of the sound. Instead, let the AGC do most of the work. 

To avoid excessive density with fast Five-Band release time, we recommend using no 
more than 5dB gain reduction in band 3, compensating for any lost loudness by 
speeding up the AGC RELEASE instead.  

Multiband Release; Speech Multiband Release control can be switched to any of sev-
en settings. 

Multiband Attack/Release/Threshold  
Advanced Name Range 

Multiband Release Slow, Slow2, Med, Med2, MFast, MFast2, Fast 

Speech Multiband Release Slow, Slow2, Med, Med2, MFast, MFast2, Fast 

Loudness Threshold Off, 0.0 … -24.0 dB 

Loudness Attack 0…100% 

Loudness Bass Couple 0…12 dB, Off 

Bx Compression Threshold −16.00 … 0.0, Off 

Bx Speech Compression Threshold −16.00 … 0.0, Off 

Bx Attack 4.0 … 50.0 ms, Off 

Speech Bx Attack 4.0 … 50.0 ms, Off 

Bx Limiter Attack 0 … 100% 

Bx Delta Release −6 … 6 

Bx Knee 1…50 dB 

Bx Compression Ratio 1:1… :1 

Bx Breakpoint 1…50 dB 

Transient Enhance 0…10 ms 
 

Table 3-8: Multiband Attack / Release Controls 
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The SPEECH MB RELEASE control overrides the MB RELEASE control when OPTIMOD 
XPN-AM automatically detects speech (page 3-6). You may wish to set the SPEECH 

MB RELEASE control faster for speech (to maximize smoothness and uniformity) and 
slower on music (to prevent excessive build-up of density). 

Figure 3-11 on page 3-23 shows the effect of compressor attack and release on the 
amplitude of the audio waveform. 

Compression Threshold; Speech Compression Threshold controls set the compression 
threshold for music and speech in each band (following OPTIMOD XPN-AM’s auto-
matic speech/music discriminator), in units of dB. We recommend making small 
changes around the factory settings to preserve the internal headroom built into the 
processing chain. These controls will affect the spectral balance of the processing 
above threshold, but are also risky because they can significantly affect the amount 
of distortion produced by the back-end clipping system. 

You can use these controls to set independent frequency balances for music and 
speech (page 3-6). 

Multiband Gate Threshold control determines the lowest input level that will be rec-
ognized as program by OPTIMOD XPN-AM; lower levels are considered to be noise 
or background sounds and cause the AGC or multiband compressor to gate, effec-
tively freezing gain to prevent noise breathing. 

There are two independent gating circuits in OPTIMOD XPN-AM. The first affects the 
AGC and the second affects the five-band compressor. Each has its own threshold 
control. 

The multiband silence gate causes the gain reduction in bands 2 and 3 of the five-
band compressor to move quickly to the average gain reduction occurring in those 
bands when the gate first turns on. This prevents obvious midrange coloration un-
der gated conditions, because bands 2 and 3 have the same gain. 

The gate also independently freezes the gain of the two highest frequency bands 
(forcing the gain of the highest frequency band to be identical to its lower neigh-
bor), and independently sets the gain of the lowest frequency band according to the 
setting of the DJ BASS boost control (in the Equalization screen). Thus, without in-
troducing obvious coloration, the gating smoothly preserves the average overall 
frequency response “tilt” of the five-band compressor, broadly maintaining the “au-
tomatic equalization” curve it generates for a given piece of program material. 

If the MB GATE control is turned OFF, the DJ BASS control (in the Equaliza-
tion screen) is disabled. 

B1/B2 Crossover (Band 1 to Band 2 Crossover Frequency) sets the crossover frequency 
between bands 1 and 2 to either 100 Hz or 200 Hz. It significantly affects the bass 
texture, and the best way to understand the differences between the two crossover 
frequencies is to listen. 
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Figure 3-8 on page 3-19 is a conceptual depiction of the frequency response of the 
crossover filters. 

B1/B2 Crossover Slope (SHALLOW, STEEP) determines the selectivity of the filter used 
to separate the frequencies applied to the band 1 and band 2 crossover sidechains, 
which compute the gain applied to the audio in each frequency band. The control 
does not affect the shape of the crossover in the audio path, only in the sidechain, 
where it determines how much the band 1 and band 2 gain reductions are affected 
by frequencies outside the main passband of a given band. For example, when this 
control is set to STEEP and the B1/B2 CROSSOVER control is set to 200 Hz, a strong 
signal at 100 Hz (which is outside the main frequency range covered by band 2) will 
produce less gain reduction in band 2 than it would if the control was set to 
SHALLOW.  

Subjectively, a setting of STEEP produces a more consistent bass texture between 
various program elements than does a setting of SHALLOW. STEEP is the preferred 
choice if you want consistent, punchy bass texture. On the other hand, SHALLOW pre-
serves more of the original bass coloration of the source because it produces less 
gain reduction difference between band 1 and band 2 than does STEEP.  

Mono Bass causes the two input channels to be blended to mono below a frequency 
set by the MONO BASS CROSSOVER control. Although it is found in the AM MULTIBAND 

tab, it is located in the signal path before the AM/HD split and affects both chains 
equally. This function is implemented via a linear-phase highpass filter applied to 
the stereo difference channel (L−R). A compensating delay in the stereo sum channel 
makes the transition between subjectively perfect separation and mono as narrow-
band as possible. 

If there is significant bass energy in the L−R channel, this process will reduce the 
overall bass heard by the listener. Because the process precedes the multiband com-
pressor, this will tend to restore this loss of bass by producing less gain reduction in 
band 1. This will be most effective if the B1/B2 CROSSOVER SLOPE control is set to 
STEEP and you use 100 Hz B1/B2 CROSSOVER. 

Sometimes, it is useful to use the bass shelving equalizer in the EQ section to pro-
duce a bit of bass boost to compensate statically for bass loss caused by the mono 
bass process. 

Mono Bass Crossover (see MONO BASS above) 

MB Downward Expander (“Multiband Downward Expander Threshold”) determines 
the level below which the single-ended noise reduction system’s downward expand-
er begins to decrease system gain and below which the high frequencies begin to 
become low-pass filtered to reduce perceived noise. There are three controls: the MB 

DOWN EXPANDER and SPEECH MB DOWN EXPANDER controls set the expansion thresh-
old in Bands 1-4 for Music and Speech modes, while the B5 DOWN EXPANDER DELTA 

THRESHOLD control offsets the expansion threshold in Band 5 with respect to the ac-
tive MB DOWN EXPANDER threshold for both Speech and Music modes. Activate the 
single-ended dynamic noise reduction by setting these controls to a setting other 
than OFF. 



OPTIMOD XPN-AM  OPERATION 3-53 

 

 

The single-ended noise reduction system combines a broadband downward expand-
er with a program-dependent low-pass filter. These functions are implemented by 
causing extra gain reduction in the multiband compressor. You can see the effect of 
this extra gain reduction on the gain reduction meters. The maximum expander gain 
reduction achievable is constrained to 6 dB in bands 2-5 and 18 dB in band 1, as this 
range often contains hum and/or rumble that can benefit from extra noise reduc-
tion. 

Ordinarily, the gating on the AGC and multiband limiter will prevent objectionable 
build-up of noise and you will want to use the single-ended noise reduction only on 
unusually noisy program material. Modern commercial recordings will almost never 
need it. We expect that its main use will be in talk-oriented programming, including 
sports. 

Please note that it is impossible to design such a system to handle all program mate-
rial without audible side effects. You will get best results if you set the MB DOWN 

EXPANDER control of the noise reduction system to complement the program materi-
al you are processing. The MB DOWN EXPANDER should be set higher when the input 
is noisy and lower when the input is relatively quiet. The best way to adjust the MB 

DOWN EXPANDER control is to start with the control set very high. Reduce the control 
setting while watching the gain reduction meters. Eventually, you will see the gain 
increase in sync with the program. Go further until you begin to hear noise modula-
tion—a puffing or breathing sound (the input noise) in sync with the input program 
material. Set the MB DOWN EXPANDER control higher until you can no longer hear the 
noise modulation. This is the best setting. 

Obviously, the correct setting will be different for a sporting event than for classical 
music. It may be wise to define several presets with different settings of the MB 

DOWN EXPANDER control and to recall the preset that complements the program ma-
terial of the moment. 

Note also that it is virtually impossible to achieve undetectable dynamic noise reduc-
tion of program material that is extremely noisy to begin with, because the program 
never masks the noise. It is probably wiser to defeat the dynamic noise reduction 
with this sort of material (traffic reports from helicopters and the like) to avoid ob-
jectionable side effects. You must let your ears guide you. 

Band 5 is particularly critical for noise reduction because much of the Downward 
Expander’s utility lies in hiss reduction. Hiss has most of its energy in band 5, while 
program material typically has less energy in this band, so the B5 DOWN EXPANDER 

control’s setting is critical to removing hiss while minimizing removal of desired pro-
gram energy. 

Band 5 is uncoupled from the lower bands so the band 5 downward expander can 
produce less gain reduction than other bands. This can help prevent loss of desired 
high frequency material in the program.  

B3>B4 COUPLING control determines the extent to which the gains of band 4 (cen-
tered at 3.7 kHz) and 5 (above 6.2 kHz) are determined by and follow the gain of 
band 3 (centered at 1 kHz). Set towards 100% (fully coupled) this control reduces 
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the amount of dynamic upper midrange boost, preventing unnatural upper mid-
range boost. The gain of band 5 is further affected by the B4>B5 COUPLING control. 

Excessive HF energy is one cause of audibly objectionable artifacts in low bitrate co-
decs. The B3>B4 COUPLING AND B4>B5 COUPLING controls can be very useful in reduc-
ing such artifacts: Setting them for large amounts of coupling will minimize 
OPTIMOD XPN-AM’s ability to increase high frequency energy dynamically.  

B4>B5 COUPLING controls the extent to which the gain of band 5 (6.2 kHz and 
above) is determined by and follows the gain of band 4. 

The sum of the high frequency limiter control signal and the output of the B4>B5 

COUPLING control determines the gain reduction in band 5. The B4>B5 COUPLING 

control receives the independent left and right band 4 gain control signal. Range is 
0 to 100% coupling. 

B3>B2 Coupling and B2>B3 Coupling controls determine the extent to which the 
gains of bands 2 and 3 track each other.  

When combined with the other coupling controls, these controls can adjust the five-
band processing to be anything from fully independent operation to quasi-
wideband processing.  

B2>B1 Coupling control determines the extent to which the gain of band 1 (below 
100Hz or 200Hz, depending on crossover setting) is determined by and follows the 
gain of band 2 (centered at 400Hz). Set towards 100% (fully coupled), it reduces the 
amount of dynamic bass boost, preventing unnatural bass boost. Set towards 0% 
(independent), it permits frequencies below 100Hz (the “slam” region) to have max-
imum impact in modern rock, urban, dance, rap, and other music where bass punch 

Band Mix  
Advanced Name Range 

B2>B1 Coupling     0 ... 100 % 

B2>B3 Coupling    0 ... 100 % 

B3>B2 Coupling    0 … 100 % 

B3>B4 Coupling    0 ... 100 % 

B4>B5 Coupling    0 ... 100 % 

B1 Output Mix −6.0 … +6.0 

B2 Output Mix −6.0 … +6.0 

B3 Output Mix −6.0 … +6.0 

B4 Output Mix −6.0 … +6.0 

B5 Output Mix −6.0 … +6.0 

B1 On/Off   On, Off 

B2 On/Off   On, Off 

B3 On/Off   On, Off 

B4 On/Off   On, Off 

B5 On/Off   On, Off 
 

Table 3-9: MB Band Mix Controls 
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is crucial. 

Bx Output Mix  Because these controls mix after the band compressors, they do not 
affect the compressors’ gain reductions and can be used as a graphic equalizer to 

fine-tune the spectral balance of the program material over a 6 dB range. 

Their range has been purposely limited because the only gain control element after 
these controls is the look-ahead limiter, which can produce pumping or distortion if 
overdriven. The thresholds of the individual compressors have been tuned to pre-
vent audible distortion with almost any program material. Large changes in the fre-
quency balance of the compressor outputs will change this tuning, leaving OPTIMOD 
XPN-AM more vulnerable to unexpected audible distortion with certain program 
material. 

You can also get a similar effect by adjusting the compression threshold of the indi-
vidual bands. This is comparably risky with reference to look-ahead limiter overload, 
but unlike the MB BAND MIX controls, the threshold adjustments do not affect the 
frequency response when a given band is below threshold and is thus producing no 
gain reduction. 

B1-B5 On/Off switches allow you to mute any combination of bands in the five-band 
compressor and permit you to “solo” any individual band. This can be useful when 
you are designing new user presets. 

B1-B5 Attack (Time); Speech B1-B5 Attack controls set the speed with which the gain 
reduction in each band responds to level changes at the input to a given band’s 
compressor for music and speech respectively, following OPTIMOD XPN-AM’s auto-
matic speech/music detector. These controls are risky and difficult to adjust appro-
priately. They affect the sound of the processor in many subtle ways. The main 
trade-off is “punch” (achieved with slower attack times) versus distortion and/or 
pumping produced in the look-ahead limiter (because slower attack times increase 
overshoots that the look-ahead limit must eliminate). The results are strongly pro-
gram-dependent and must be verified with listening tests to a wide variety of pro-
gram material. 

Because there are separate controls for music and speech (page 3-6), you can set at-
tack times faster for speech (to minimize look-ahead limiter artifacts) and slower for 
music (to maximize punch and transient definition). 

The ATTACK time controls are calibrated in arbitrary units that very approximately 
correspond to milliseconds. Higher numbers correspond to slower attacks. 

Limiter Attack controls allow you to set the limiter attack anywhere from 0 to 100% 
of normal in the Five-Band compressors, each of whose gain reduction has a fast-
release (limiter) and slow-release (compressor) component. Because the limiter and 
compressor characteristics interact, you will usually get best audible results when 
you set these controls in the range of 70% to 100%. Below 70%, you will usually 
hear gain pumping because the compressor function is trying to create some of the 
gain reduction that the faster limiting function would have otherwise achieved. If 
you hear pumping in a band and you still wish to adjust the limiter attack to a low 
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setting, you can sometimes ameliorate or eliminate the pumping by slowing down 
the compressor attack time in that band. 

These controls have nothing to do with the final peak limiter. 

Delta Release controls are differential controls. They allow you to vary the release 
time in any band of the Five-Band compressor/limiter by setting an offset between 
the MULTIBAND RELEASE setting and the actual release time you achieve in a given 
band. For example, if you set the MULTIBAND RELEASE control to medium-fast and the 
BAND 3 DELTA GR control to −2, then the band 3 release time will be the same as if 
you had set the MULTIBAND RELEASE control to medium and set the BAND 3 DELTA GR 

control to 0. Thus, your settings automatically track any changes you make in the 
MULTIBAND RELEASE control. In our example, the release time in band 3 will always be 
two “click stops” slower than the setting of the MULTIBAND RELEASE control. 

If your setting of a given DELTA RELEASE control would otherwise create a release 
slower than “slow” or faster than “fast” (the two end-stops of the MULTIBAND 

RELEASE control), the band in question will instead set its release time at the appro-
priate end-stop. 

Band 1-5 Max Delta GR controls set the maximum permitted gain difference be-
tween the left and right channels for each band in the multiband limiter. The five-
band processing chain uses a full dual-mono architecture, so the channels can be 
operated anywhere from fully coupled to independent. We recommend operating 
band 1-4 fully coupled (BAND 1-4 MAX DELTA GR = 0) for best stereo image stability. 
However, audio-processing experts may want to experiment with lesser amounts of 
coupling to achieve a wider, “fatter” stereo image at the cost of some image insta-
bility. 

B5 MAX DELTA GR is set OFF most factory presets. This permits band 5 to be used as a 
fast-operating high frequency limiter that works independently on the left and right 
channels. This prevents gain reduction in one channel from causing audible spectral 
modulation on the other channel. However, the additional stereo difference chan-
nel energy created by independent operation can adversely affect certain low bi-
trate codecs (like WMA). It is wise to do careful listening tests through the codec to 
determine if it sounds better with B5 MAX DELTA GR = 0 dB. 

B1-B5 Compression Ratio sets the compression ratio of a given band at its thresholds 
of compression. Beyond threshold, the ratio increases with increased gain reduction 

until it becomes :1 at the amount of gain reduction (in dB) set by the B[X] 

COMPRESSOR KNEE control. When you adjust these controls, the thresholds of the 
multiband compressors change automatically so that the total amount of gain re-
duction stays approximately the same. (This automatic adjustment is internal to the 
XPN-AM’s DSP; the MB THRESH controls’ displayed settings do not show it.) 

To achieve a classic soft knee characteristic, set the COMPRESSION  RATIO control to 1:1 
and set the COMPRESSION KNEE control to the gain reduction in dB at which you wish 

the compression ratio to level off to :1. The maximum setting produces the softest 

knee. Setting the KNEE to 0 dB produces a classic hard knee curve with :1 compres-
sion ratio regardless of the setting of the corresponding COMPRESSION  RATIO control. 
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See Figure 3-16 on page 3-57 for the curves of output level vs. input level for various 
settings of the KNEE and RATIO controls.  

Compression Knee (see COMPRESSION RATIO above). 

Compression Breakpoint The release rate (measured in dB/second) in the XPN-AM’s 
compressors is constant when the gain reduction is higher than the control’s setting, 
and exponential when the gain reduction is lower than the control’s setting. 

When the release is exponential, the release rate is proportional to the amount of 
gain reduction.. 

Compression-induced audio density remains constant when the gain reduction is 
above the BREAKPOINT setting. When the gain reduction is below the BREAKPOINT 

 

Figure 3-16: Output level in dB (y) for a given input level in dB (x) at various settings of the 

KNEE and RATIO control 
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setting, density decreases proportionally to the amount of gain reduction. 

For example, if the BREAKPOINT is set to 10 DB, the release rate (in dB/second) will be 
constant when the gain reduction is above 10 dB. Between 10 dB and 0 dB gain re-
duction, the release rate will slow down more and more. 

The calibration of the BREAKPOINT controls is only accurate when KNEE = 0 dB and/or 
RATIO = infinity:1 — i.e., when the compression ratio is essentially infinite. When the 
ratio is less than infinite, the effective breakpoint of the compressor will be lower 
than COMPRESSOR BREAKPOINT setting. 

The main use of the COMPRESSOR BREAKPOINT control is to prevent the compressor 
from objectionably increasing audio density when using low compression ratios and 
a significant amount of gain reduction—for example, 10 dB. The BREAKPOINT control 
is best adjusted by ear. If you find that density increases too much as gain reduction 
increases, lower the COMPRESSOR BREAKPOINT control’s setting. If you want more 
density at high amounts of gain reduction, increase the COMPRESSOR BREAKPOINT 
control’s setting. 10 dB is a good starting point for setting this control. 

Loudness Threshold sets the maximum subjective loudness allowed by the CBS Loud-
ness Controller with reference to the input of the XPN-AM’s MB look-ahead limiter. 
(See Loudness Control on page 3-20.)  

Loudness Controller Attack: See Loudness Control on page 3- 20. 

Loudness Controller Bass Couple: See Loudness Control on page 3- 20. 

BS.1770 Threshold: See BS.1770 Safety Limiter on page 3-22. 

Peak Limiter 

Regardless of whether MX mode is ON or OFF, a bass pre-limiter stage controls low 
frequency peaks ahead of the main peak limiter, while a “true-peak”-aware look-
ahead limiter (equivalent to the look-ahead limiter in Orban products like 
OPTIMOD-PC 1101) implements final peak control. This limiter typically constrains 
the true peak overshoot (i.e., the maximum peak value that would appear after an 
ideal digital-to-analog converter) to 0.2 dB or less. (See Figure 3-9: Peak Limiter Out-
put vs. Input on page 3-20.) 

OPTIMOD XPN-AM’s OUTPUT meter shows peak levels based on audio 
sample values. To assess the accuracy of OPTIMOD XPN-AM’s true peak 
limiting, you can use the free Orban Loudness Meter, available for down-
load from www.orban.com/meter. This displays the “Reconstructed Peak” 
level, which is the same as “True Peak” level. 

Bass Clip Threshold sets the threshold of the bass pre-limiter with respect to the 
threshold of the final peak limiter. The BASS LIMITER gain reduction meters show the 
amount of bass clipping or limiting in each audio channel. 

http://www.orban.com/meter
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The SPEECH BASS CLIP THRESHOLD control overrides the BASS CLIP THRESHOLD control 
when OPTIMOD XPN-AM automatically detects speech (page 3-6). 

Bass Pre-Limit Mode sets the operation of the bass pre-limiter to HARD, MEDIUM, or 
SOFT. This control only works when the MX limiter is ON. When the MX limiter is 
OFF, the bass clip mode is always MEDIUM. 

 HARD produces the most harmonic distortion. 

This can be useful if you want maximum bass punch, because this setting 
allows bass transients (like kick drums) to make square waves. The peak 
level of the fundamental component of a square wave is 2.1 dB higher 
than the peak level of the flat top in the square wave. Therefore, this al-
lows you to get low bass that is actually higher than 100% modulation 
(or 0 dBFS)—the phase of the harmonics produced by the clipping works 
to reduce the peak level of the overall program. 

The squarewaves produced by this clipper are lowpass-filtered to reduce 
the audibility of the higher clipper-generated harmonics. Nevertheless, 
the downside is that material with sustained bass (including speech) can 
sound somewhat less clean than it will with the MEDIUM or SOFT settings. 

The HARD clip algorithm used in XPN-AM is improved compared to that 
used in older Optimods. It uses a different algorithm that is less likely to 
cause audible distortion, so HARD bass clipping in the XPN-AM is more 
useful than it was in older Optimods. 

 MEDIUM uses more sophisticated signal processing than HARD to reduce distortion 

substantially. 

 SOFT uses the most sophisticated look-ahead signal processing to reduce distor-

tion further. 

The tradeoff of using MEDIUM or SOFT bass clipping is less bass punch compared to 
HARD. 

MB Final Limit Drive control adjusts the level of the audio driving the peak limiter, 

Peak Limiter Controls  
Name Range 

Bass Clip Shape  0.0 … 10.0 

Bass Clip Threshold −6.0 … +6.00, Off 

Bass Limiting  0…−6 

BassPre-Limit Mode (MX mode) Soft, Medium, Hard 

Bass Pre-Limiting (MX mode)  0 … 1  

Distortion Control (MX mode)  0 … 1 

Final Limit Drive −10.0 … +12.0 

MX Limiter On, Off 

MX Limiter Threshold (MX mode) −6.0 … +6.00, Off 

MX Overshoot Limit Mode Hard, Soft 

Speech Bass Clip Threshold −6.0 … +6.00, Off 

Transient Enhance  0…10 ms 

Table 3-10: Peak Limiter Controls 
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thereby adjusting the peak-to-average ratio of the processed audio. The MB FINAL 

LIMIT DRIVE control primarily determines the loudness/distortion trade-off. 

Turning up the MB FINAL LIMIT DRIVE control drives the look-ahead limiter harder, 
reducing the peak-to-average ratio, and increasing the loudness of the output. 
When the amount of limiting is increased, the audible intermodulation distortion 
caused by limiting increases, even though special algorithms minimize the increase 
compared to less sophisticated designs. Lower settings reduce loudness, of course, 
but result in a cleaner sound. 

The MX peak limiter uses a variety of tactics to adapt its operation intelligently to 
the program material applied to it. Compared to the look-ahead peak limiter in 
non-MX mode, the MX peak limiter produces a different set of artifacts when over-
driven. Depending on how you set the other controls, these artifacts may include 
loss of bass punch, harsh clipper-like distortion, “soft” IM distortion, and/or excessive 
density that can cause fatigue. If you intend to make adjustments to the FINAL LIMIT 

DRIVE control, it is wise to familiarize yourself with these artifacts by purposely over-
driving the peak limiter via the MB FINAL LIMIT DRIVE control and listening to what 
happens with different types of program material. 

When using preemphasis, it is usually necessary to turn down the MB FINAL LIMIT 

DRIVE control to prevent the peak limiter from causing objectionable artifacts. 

You may find it illuminating to recall several Factory Presets, adjust LESS-
MORE to several points in its range, and then open the Full Control screen 
to examine the trade-offs between the release time and FINAL LIMIT drive 
made by the factory programmers. However, note that all Factory Presets 
were created to complement FLAT preemphasis. As explained above, you 
must turn down the FINAL LIMIT DRIVE control when using preemphasis. 

Transient Enhance is mainly useful in mastering. This control allows you to insert an 
audio delay in the sidechain of the five-band compressor. By delaying the gain con-
trol signal, this allows attack transients to pass through the multiband compressor 
uncompressed, which can increase punch. There is a tradeoff between this control 
and the activity of the look-ahead limiter, which will have to eliminate attack transi-
ents exceeding the look-ahead limiter’s threshold. For any material, there will be an 
optimum setting for the TRANSIENT ENHANCE control that provides the most punch 
without triggering peak limiter artifacts. 

MX Technology Peak Limiter Controls 

The AM processing chain always uses MX peak limiting. It is optional in the HD 
chain; when it is off, the HD chain uses a low-IM look-ahead limited for final peak 
control. Note that turning the HD MX limiter on and off will cause a brief audio 
glitch (about 110 ms program material will be skipped or repeated), so it you use it 
for one on-air preset, you should use it for all such presets. 

MX Limiter When MX LIMITER is ON, additional peak control occurs between the bass 
pre-limiter and the look-ahead limiter, and the look-ahead limiter is used very light-
ly for final overshoot control only. When the peak limiter section is being driven 
heavily, the MX peak limiter, which uses a psychoacoustic model, provides decreased 
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audible distortion, more transient punch and a crisper, more open high frequency 
texture. 

When MX LIMITER is OFF, the final look-ahead limiter implements all peak control 
and is more likely to cause audible gain pumping when driven heavily.  

The MX limiter’s sophisticated processing increases the amount of CPU power re-
quired compared to non-MX mode, Defeating the HD MX limiter can allow more 
instances of processing to be run on the CPU. 

When the HD target loudness is below −12 LKFS, the MX limiter is unlikely to pro-
vide significant audible advantages because the overall peak limiter section is not 
being driven hard, so the final look-ahead limiter (which is quite capable) is unlikely 
to produce audible artifacts when used alone. If you want to minimize CPU usage 
and/or delay, it is wise to perform listening tests to see if the MX limiter provides 
audible advantages with your program material. 

The controls described below are only active when the MX limiter is ON. They allow 
you to trade off loudness, distortion, and bass energy. Increasing bass increases the 
likelihood that audible IM distortion between bass and other program elements will 
occur. Depending on the program material you are processing, you may prefer to 
have a cleaner sound (with less bass) or a sound with more distortion but punchier 
bass. We offer controls, explained below, that allow you to make this tradeoff. 

MX Limiter Threshold sets the threshold of the MX limiter with respect to the 
threshold of the final look-ahead limiter, used for overshoot control. This control is 
normally set to 0 dB. When the peak limiter is driven very hard (as determined by 
the setting of the MB FINAL LIMIT DRIVE control), setting the MB LIMITER THRESHOLD 
slightly below 0 dB can reduce gain pumping artifacts that would otherwise be 
caused by the final look-ahead limiter. 

Bass Pre-Limiting The MX bass pre-limiter can intelligently reduce the bass applied to 
the main peak limiter to reduce or prevent audible IM distortion. It does so when 
the pre-limiter’s analysis of the program material indicates that this action is needed 
to prevent or minimize audible IM distortion between the bass (125 Hz and below) 
and other program elements in the main peak limiter. The BASS PRE-LIMITING control 
allows you to specify the maximum amount of bass reduction that can occur. Lower 
settings increase bass punch but do not protect against IM distortion as effectively as 
higher settings do. 

There are two controls, one for Speech mode and one for Music mode, allowing you 
to have separate settings depending on whether OPTIMOD XPN-AM automatically 
detects speech or music input. 

Bass Limiting Like the bass pre-limiter, the main peak limiter can automatically re-
duce bass when it detects potentially audible IM distortion. The BASS LIMITING control 
allows you to limit the amount of potential bass reduction at the expense of a pos-
sible increase in IM distortion. The scale shows the maximum amount of dynamic 
bass cut that can be produced, in dB. 
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Distortion Control This control determines the amount of audible distortion that the 
main peak limiter is permitted to create. Higher settings can increase loudness and 
punch at the expense of audible clipping distortion. Lower settings are cleaner but 
may reduce punch and loudness. We prefer it at 0, which is its cleanest setting. All 
MX factory presets use this setting. 

The best way to familiarize yourself with the effects of this control is by listening 
extensively to different types of program material while experimenting with differ-
ent settings of the control. Because the MX peak limiter uses advanced algorithms 
that differ from those used by past Orban processors, the loud-
ness/distortion/brightness/punch tradeoffs are also different and it is worthwhile to 
take the time to get a feel for the MX limiter’s capabilities.  

Phase Corrector Controls 

These controls are located in the LESS-MORE tab. See Left/Right Phase Skew Correc-
tion on page 3-15.  

Phase Corrector Controls  

Name Range 

Phase Corrector In, Out 

Phase Corrector Crossover 62.5…796 Hz 
 

Table 3-11: Phase Corrector Controls 

 

Test Modes 

The Test Modes screen allows you to switch between OPERATE, BYPASS, and TONE. 

When you switch to BYPASS or TONE, OPTIMOD XPN-AM saves the preset you had on-
air and will restore it when you switch back to OPERATE. Even if you had been edit-
ing a preset and did not yet save these changes as a User preset, you will not lose 
the edits you made. 

Available Tone waveforms are SINE, SQUARE, and PINK NOISE. 

The pink noise spectrum is accurate to ±0.05 dB, 20-20,000 Hz.  

“Squarewaves” are available up to 1 kHz. 

Your Optimod is a band-limited system (like any digital system). Because 
of the Gibbs phenomenon, no band-limited system can produce true 
squarewaves without overshoot. Instead, your Optimod generates useful 
squarewave-like waveforms without overshoot by applying a waveform 
whose sample values periodically switch between +1 and –1 to a non-
overshooting pulse-shaping lowpass filter. This eliminates overshoot at 
the cost of increasing the risetime of the “squarewave” edges. 
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The main purpose of these waveforms is to test the transmission system 
following the Optimod to determine if the path introduces overshoot, 
tilt, or ringing into the “squarewave.” This is particularly important if you 
are using an analog signal path after the Optimod because the –3 dB fre-
quency of the path must be 0.15 Hz or lower to prevent 50 Hz 
squarewaves from overshooting more than 1% and increasing peak lev-
els. 

To prevent aliasing and ensure that only odd-order harmonics are gener-
ated, the source waveform is generated at 192 kHz sample rate and has 
an identical, integer number of samples in its “+1” and “–1” segments. 
Hence, output frequencies that are not submultiples of 96 kHz (like 315 
Hz) will differ from their labeled values by a few percent. This causes no 
problems when testing transmission systems. 

Table 3-12: Test Modes on page 3-63 shows the facilities available, which should be 
largely self-explanatory. 

In TONE mode, any channel can be set to OFF (the tone is off). ON (the tone is on) or 
BYPASS (equivalent to placing that channel in BYPASS mode). When bench testing 
OPTIMOD XPN-AM, you can cause one hardware output to emit a tone while leav-
ing the remaining channels in BYPASS. This eliminates the need for an external test 
oscillator. 

Setup: Test  
Parameter Labels Units Default Range (CCW to CW) Step 

Mode --- Operate Operate, Bypass, Tone --- 

Tone Waveform --- --- Sine, Square, Pink Noise --- 

Bypass Gain  dB 0.0 18 … +25 1 

Tone Frequency  
(Sine) 

Hz 400 16, 20, 25, 31.5, 40, 50,  
63, 80, 100, 125, 160,  
200, 250, 315, 400, 500,  
630, 800, 1000, 1250, 1600, 
2000, 2500, 3150, 4000, 5000,  
6300, 8000, 9500, 16000, 12500, 
13586.76, 15000, 20000 

LOG  

Tone Frequency  
(Square) 

Hz 400 16, 20, 25, 31.5, 40, 50,  
63, 80, 100, 125, 160,  
200, 250, 315, 400, 500,  
630, 800, 1000 

LOG  

Tone Level % 100 0 … 121 1 

Lf Tone --- Bypass Off, On, Bypass --- 

Rf Tone --- Bypass Off, On, Bypass --- 

Ls Tone --- Bypass Off, On, Bypass --- 

Rs Tone --- Bypass Off, On, Bypass --- 

C Tone --- Bypass Off, On, Bypass --- 

LFE Tone --- Bypass Off, On, Bypass --- 

Lb Tone --- Bypass Off, On, Bypass --- 

Rb Tone --- Bypass Off, On, Bypass --- 
 

Table 3-12: Test Modes 
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Creating Custom “Factory” Presets 

You can create custom “factory” presets that support LESS-MORE functionality. 
These presets will behave like the factory presets. 

OPTIMOD XPN-AM’s software has the ability to interpolate all 19 available LESS-

More increments (1.0 through 10.0) from two or more LESS-MORE “anchor” preset 
files. Additionally, you must create a “factory preset” file that corresponds to the 
default value of LESS-MORE for your preset. The instructions below show you how to 
create these files from user preset files that you have saved. 

In the examples below, the specified file locations are based on OPTIMOD XPN-AM’s 
default locations. Using Windows Explorer, check the factory preset file locations on 
your computer to find out where these files are actually located. You must place 
your new “factory preset” files in analogous locations.  

 
To create a custom “factory” preset: 

1. Make a working directory for your preset. 

When you have finished making it the preset, you will copy it into the 
OPTIMOD XPN-AM folder in the Windows C:\Program Files 

(x86)\Orban\OPTIMOD XPN-AM directory. 

2. Choose a name for the preset. 

You cannot use the name of an existing factory preset without damaging it. We 
will use “My Preset” as the preset name in the examples below. 

3. Create a folder for your presets. 

Create a folder named “My Preset” within your working directory. 

4. Choose the default LESS-MORE value for your preset. 

5. Using XPN-AM PC, create user presets for each LESS-MORE anchor point. 

See Customizing Processing Presets starting on page 1-32. 

Because LESS-MORE works only on the dynamics processing, you must choose a 
set of equalizer settings for your new preset that is the same for all anchor pre-
sets. Table 3-6: Equalizer Controls on page 3-40 shows the controls that must be 
set identically in all anchor presets. 

You must create at least two anchor presets, one for LESS-MORE = 1.0 and one 
for LESS-MORE = 10.0. Additionally, if the default LESS-MORE value you chose in 
step 4 is neither 1.0 nor 10.0, you must create a third anchor preset for the de-
fault LESS-MORE value. 

You may add as many additional anchor presets as you wish to fine-tune the be-
havior of LESS-MORE. 
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From the OPTIMOD XPN-AM Control Application, save each preset as a user pre-
set in plain text (unencrypted) form, naming it My Preset LMxxx, where xxx 
stands for the LESS-MORE setting that corresponds to that preset. For example, 
for LESS-MORE = 1.0, xxx = 010. 

6. Copy the user presets you made. 

Copy these presets in the \[working directory]\My Preset\ folder that you 
made in step 3. 

7. Edit the file extensions. 

In Windows, change the extension of all of your presets’ file names to orb1600f 

8. Edit the text within the preset files. 

A) In turn, open each of your preset files in a text editor 
like Notepad or WordPad. The editor you use must 
open and save files in plain text format. 

B) Edit the second line of the file as follows: 

Preset Name=<MY PRESET LMxxx> size=[yyy]  

where LMxxx agrees with the file name. 

Do not change the number after size. 

C) Edit the third line of the file as follows: 

Factory Preset Name=<MY PRESET>  

D) Edit the fifth line of the file as follows: 

Preset File Name= <MY PRESET LMxxx.orb1600f>  

where MY PRESET LMxxx.orb1600f is the same as the 
file name.  

E) At the end of the file, find the “LESS-MORE” line and 
edit it as follows: 

C:<LESS MORE>Cent:x;D:y;  

Replace the “x” and the “y” with the LESS-MORE data corresponding to 
the LESS-MORE value that you chose for your new preset. See Table 3-13. 

F) Save your edited file as a plain text file. (This should happen automatically if 
you edited the file using a text editor, not a word processor.) 

G) Repeat steps (A) through (F) for each anchor file you created. 

9. Create the factory preset file. 

A) Copy the LESS-MORE file corresponding to your preset’s default LESS-MORE 
setting, placing the copied file in 

C:\Users\Public\Documents\Orban\  

Optimod XPN-AM PC Remote\presets 

LESS-
MORE 

x y 

1.0 100 0 

1.5 150 1 

2.0 200 2 

2.5 250 3 

3.0 300 4 

3.5 350 5 

4.0 400 6 

4.5 450 7 

5.0 500 8 

5.5 550 9 

6.0 600 10 

6.5 650 11 

7.0 700 12 

7.5 750 13 

8.0 800 14 

8.5 850 15 

9.0 900 16 

9.5 950 17 

10.0 1000 18 

 

Table 3-13: LESS-MORE Reference 
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B) Edit the file name of the file you copied to remove LMxxx, including the space 
before the “L.” The example file name is 

MY PRESET.orb1600f  

C) Open MY PRESET.orb1600f in a text editor. 

D) Edit the second line of the file as follows: 

Preset Name<MY PRESET> size=126  

Do not change the number after size. 

E) Edit the fifth line of the file as follows: 

Preset File Name= <MY PRESET.orb1600f>  

F) In Windows, give all of the files you just created the “read-only” attribute. 

10. Copy your new preset to the OPTIMOD XPN-AM program file directory. 

Copy both the MY PRESET folder and the MY PRESET.orb1600f file to  

 C:\Program Files (x86)\Orban\OPTIMOD XPN-AM\presets. 

Because this modifies files and folders within the Windows program file directo-

ries, you need Administrator privileges to do this. 

Your new “factory preset” is now ready for use. When you recall a preset via the 
OPTIMOD XPN-AM Control Application, the new preset should appear in the OPEN 

PRESET window. After you recall it, LESS-MORE should be available. 

The most common mistake is to put the incorrect LESS-MORE value in the 
My Preset.orb1600f file or its corresponding LESS-MORE file. This will 
cause LESS-MORE not to work. 

It is wise to back up your new “factory” preset (i.e., the factory preset file and less-
more anchor files) elsewhere. 
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Appendix A: Using the ITU BS.1770 and CBS Loudness 
Meters to Measure Loudness Controller Performance 

 

[Note: This Appendix is a reprint of a stand-alone white paper. For this reason, it 
contains some explanatory material regarding the CBS and BS.1770 meters that is 
also found elsewhere in this manual.] 

 

ITU-R BS.1770 

In 2009, the ATSC released a Recommended Practice: Techniques for Establishing 
and Maintaining Audio Loudness for Digital Television (A/85:2009). This was later 
updated as A/85:2011. A/85 specifies use of a long-term loudness meter based on the 
ITU BS.1770 algorithm for measuring the loudness of DTV broadcasts. 

In December 2011, the FCC adopted rules implementing the CALM Act4, which, by 
law, forbids commercials from being louder than non-commercial program material. 
The new FCC rules incorporated ATSC A/85 (and, by implication, the BS.1770 meter) 
as an objective means of verifying that the rule was being obeyed. 

Because loudness measurement per BS.1770 uniformly integrates all program mate-
rial, quiet passages tend to lower the measured value. To prevent this, the ITU add-
ed gating to the BS.1770 standard, which was revised as BS.1770-2 in March 2011. 
The gating causes the meter to ignore silence and to integrate only program mate-
rial whose loudness falls within a floating window extending from the loudest 
sounds within the specified integration period to sounds that are 10 dB quieter than 
the loudest sounds. This is because humans tend to assess loudness based on the 
louder sounds in a given program. As of this writing, ATSC A/85 has not been updat-
ed to incorporate the BS.1770-2 standard. 

The ATSC A/85 2011, ITU-R BS.1770-2, and EBU R128 documents are available as free 
downloads and can easily be located with a search engine. 

 

CBS Loudness Meter 

For many years, Orban has used the Jones & Torick loudness controller and loudness 
measuring technology5 in its products for loudness control of sound for picture. De-
veloped after 15 years of psychoacoustic research at CBS Laboratories, the CBS loud-

                                                      

4 The CALM Act applies only to U.S. broadcasters and cable providers. 

5 Jones, Bronwyn L.; Torick, Emil L., “A New Loudness Indicator for Use in Broadcast-
ing,” J. SMPTE September 1981, pp. 772-777. 
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ness controller accurately estimates the amount of perceived loudness in a given 
piece of program material. If the loudness exceeds a preset threshold, the controller 
automatically reduces it to that threshold. The CBS algorithm has proven its effec-
tiveness by processing millions of hours of on-air programming and greatly reducing 
viewer complaints caused by loud commercials. 

Since first licensing the CBS algorithm and using it in its Optimod-TV 8182 in the ear-
ly 1980s, Orban has continually refined and developed this technology. In the last 
30+ years, audio processors from Orban and CRL using the CBS loudness controller 
have processed millions of hours of on-air television programming — an unsur-
passed track record that no other subjective loudness controller technology can 
claim. 

 

Comparing the Meters 

Because the ATSC recommends the BS.1770 algorithm, many broadcast and cable 
engineers facing the problem of controlling broadcast loudness have wondered how 
the CBS and BS.1770 technologies compare. An earlier version of this Orban white 
paper compared the CBS and BS.1770-1 (non-gated) meter. The paper you are now 
reading was revised in March 2012 to incorporate results from tests using the 
BS.1770-2 algorithm and EBU − TECH 3342 “Loudness Range” algorithm. The new 
measurements were performed using Version 2 of the Orban Loudness Meter6. This 
revision compares the CBS and BS.1770-2 meters because we expect that the ATSC 
will eventually update A/85 to specify BS.1770-2, which will more closely harmonize 
A/85 with its European counterpart, EBU R128. 

A/85 and R128 differ significantly in their philosophy and recommendations. Proba-
bly most important difference is that A/85 asserts that the loudness of a so-called 
“anchor element” (which is typically dialog except in programs emphasizing music, 
like live concert recordings) is most important, while R128 asserts that the integrated 
loudness of the entire program is most important7 and therefore, program loudness 
should be normalized based on an integrated BS.1770-2 measurement. The philoso-
phy behind A/85 is similar to that of Dolby Laboratories, which for many years has 
asserted that dialog anchors most film and television programs and that listeners set 
their volume controls to make dialog comfortably intelligible8. (We agree more with 
A/85 than with R128). 

                                                      

6 This software is available for free download at http://orban.com/meter/.  

7 EBU – TECH 3343, “Practical guidelines for Production and Implementation in ac-
cordance with EBU R128,” version 1 (February 2011), p. 29 

8 Riedmiller, J., Lyman, S., Robinson, C., “Intelligent program loudness measurement 
and control: what satisfies listeners?” AES Convention Paper 5900, 115th Convention 
(October 2003) 

http://orban.com/meter/
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Figure 3-17: Unprocessed Input— 

 Peak Output of the BS.1770 and CBS Loudness Me-

ters in each 10-second Interval as a Function of Time 

Figure 3-18: Unprocessed Input— 

Histograms sorting loudness measurements into 0.25 

dB bins. 
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Figure 3-19:  Loudness-Controlled Audio— 

Peak Output of the CBS and BS.1770 Loudness Me-

ters in each 10-second Interval vs. Time 

Figure 3-20: Loudness-Controlled Audio— 

Histograms sorting loudness measurements into 0.25 

dB bins 

Test Setup 

A stereo recording of approximately 30 minutes of unprocessed audio from the out-
put of the master control of a San Francisco network station was applied to the 2.0 
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processing chain of an Optimod-Surround 8685 processor, set for normal operation 
using its TV 5B GEN PURPOSE preset. The digital output of the processor was applied 
to the digital input of an Orban XPN-AM soundcard, which was adjusted to pass the 
audio without further processing and to apply it to an OPTIMOD XPN-AM software-
based loudness meter that simultaneously computes the BS.1770-2 Integrated loud-
ness and CBS loudness. The first 750-second segment of the program material was a 
daytime drama with commercial and promotional breaks, while the remainder was 
local news, also with commercial and promotional breaks. 

The BS.1770-2 meter was adjusted to produce a 10-second integration window in 
which, per the BS.1770 standard, all data are equally weighted. The CBS Loudness 
Gain control was set to −3.12 dB. Data were logged every 10 seconds and included 
the maximum meter indication produced by both the BS.1770 and CBS meters in 
each 10-second interval. This produced 165 data points, which were imported into a 
scientific plotting application9. 

Orban’s experimental long-term loudness measurement, based on the CBS meter 
and first published in 2008, was also included in the measurements and is shown in 
the bottommost charts. This algorithm attempts to mimic a skilled operator’s mental 
integration of the peak swings of a meter with “VU-like” dynamics. The operator 
will concentrate most on the highest indications but will tend to ignore a single high 
peak that is atypical of the others. This algorithm can be seen to share certain char-
acteristics with the floating gate first introduced in EBU R128 and later adopted in 
BS.1770-2. 

The Orban algorithm displays the average of the peak indications of the meter over 
a user-determined period: 10 seconds for these measurements. The average is per-
formed before dB conversion. All peak indications within the period are weighted 
equally with the following exceptions: 

 If the maximum peak in the window is more than 3 dB higher than the sec-

ond highest peak, it is discarded. 

 All peaks more than 6 dB below the maximum (or second-to-maximum, if 

the maximum peak was discarded) are discarded.  

Because the CBS long-term measurement discards a single peak if it is more than 3 
dB higher than the second highest peak, the CBS long-term measurement tends to 
be biased about 3 dB lower than a measurement that shows the maximum peak in-
dication of the CBS meter in a 10-second period. This depends on whether or not the 
loudness applied to the meter’s input is well controlled. This bias can be seen in the 
figures in the paper. Because the Orban meter allows control of the level applied to 
the CBS algorithm via the “CBS Gain” control, setting it 3 dB higher could better 
match the CBS long-term measurement to the BS.1770-2 Integrated measurement at 
the expense of moving the “maximum peak loudness” indication 3 dB higher.  

                                                      

9 PSI Plot: http://www.polysoftware.com/plot.htm  

http://www.polysoftware.com/plot.htm
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Results 

Unprocessed Audio Input: To provide a baseline for discussion of the loudness-
controlled results, we measured the unprocessed audio that was applied to the Op-
timod OPTIMOD XPN-AM’s input. Figure 3-17 and Figure 3-18 on page 3-69 show 
the loudness of the unprocessed audio both as a function of time and as a histo-
gram. The histogram sorts the meter outputs into 0.25 dB or 0.25 LK10-wide slices 
and shows the number of measurements that fit into each of these slices. The histo-
gram thus portrays loudness consistency — when the histogram is clustered tightly 
within a few bins, the loudness is more consistent than it is when the histogram is 
spread out into a larger number of bins. 

With all meters, the histogram of the unprocessed audio shows a wide spread. This is 
consistent with the EBU Loudness Range measurement for the entire clip, which was 
16.5 LK, while the LRA for the daytime drama alone was 19.2 LK (including commer-
cials). The BS.1770-2 Integrated loudness was −20 LKFS, integrated over the entire 
measurement period, although the inconsistencies between the loudness of pro-
gram material and commercials are large enough to make this 30-minute measure-
ment essentially meaningless.  

In general, the loudest parts of the unprocessed audio are commercials and promos, 
both network and local. These are anywhere from 5 to 10 dB (or LK) louder than the 
rest of the program material. This inconsistency was not a problem because the sta-
tion in question was using an Orban automatic loudness controller on-air, which 
smoothed out loudness differences before its input. 

While the general shapes of the CBS and BS.1770 loudness vs. time curves are similar, 
there were some significant differences. For example at approximately 1250 seconds, 
the CBS measurement shows a sharp loudness spike that was caused by a network 
news report that was equalized to emphasize frequencies around 2 to 3 kHz, where 
the ear is most sensitive. The BS.1770-2 measurement did not indicate this as being 
louder than the surrounding program material although to our ears, it clearly was. 

Loudness-Controlled Audio: Figure 3-19 and Figure 3-20 on page 3-70 show the re-
sults after automatic loudness control. (To present the data with optimum graphic 
resolution, we made the loudness scales of Figure 3-19 and Figure 3-20 narrower 
than the scales in Figure 3-17 and Figure 3-18.) 

Both the loudness vs. time graphs and the histograms show the Orban OPTIMOD 
XPN-AM controls loudness well, although the details of the meters’ indications are 
different. Both the BS.1770 and CBS measurements indicate that most of the data 
points are in a ±1 dB/LK window. 

                                                      

10 Unfortunately, two terms for the same loudness units have been used in different 
standards documents. For convenience, we will use LK and LKFS (as used in ATSC 
A/85); these units are the same as LU and LUFS (used in EBU R128 and BS.1770) re-
spectively. 
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The peak CBS readings fit within a ±2 dB window. The BS.1770 readings also fit with-
in a ±2 LK window except for four short intervals, which appear as low-probability 
outliers in the left side of the histogram. These intervals correspond to dialog with-
out background music and in the author’s opinion illustrate a weakness in BS.1770-
2: based on our extensive listening tests, we have concluded that the meter does not 
effectively lock onto the A/85 “anchor element” (almost entirely dialog in the test 
material used to prepare this paper) and instead indicates that loudness increases 
when dialog level is held constant while underscoring or effects are added to the 
mix.11 

Problems with Low Peak-to-RMS Ratio Material 

In the subjective testing to validate the BS.1770 meter, there were outliers as large 
as 6 dB (i.e., the meter disagreed with human subjective perception by as much as 6 
dB12.) The subjective testing to validate the CBS meter found outliers up to 3 dB, alt-
hough fewer items were used in this testing. We hypothesize that the fact that the 
worst-case error of the BS.1770 meter was substantially larger than that of the CBS 
meter is caused by the BS.1770’s meter’s not modeling loudness summation or the 
loudness integration time constants of human hearing.  

BS.1770-2 states: “It should be noted that while this algorithm has been shown to be 
effective for use on audio programmes that are typical of broadcast content, the 
algorithm is not, in general, suitable for use to estimate the subjective loudness of 
pure tones.” We have noted that the meter tends to over-indicate the loudness of 
program material that had been subject to large amounts of “artistic” dynamic 
compression, as is often done for commercials and promotional material — in other 
words, the meter over-indicates the loudness of program material having an unusu-
ally low peak-to-average ratio, which, at the limit, approaches the peak-to-average 
ratio of a pure tone. We have encountered heated complaints by mixers13 and pro-
ducers who stated that such material, when “matched” to the loudness of the sur-
rounding program material via the BS.1770 meter, is considerably quieter in subjec-
tive terms. In turn, this has constrained the ability of producers to specify the type of 
audio processing they had previously used to give this material excitement and 
punch. We hypothesize that this problem is related to the fact that BS.1770 does not 
accurately indicate the loudness of pure tones. 

                                                      

11 In the first published version of the paper, we observed the similar dips in the 
BS.1770-1 (ungated) loudness and hypothesized that they were caused by lack of 
gating on silence and low-level material. For this reason, we were surprised that 
BS.1770-2 gating made little difference in the measurements of this material. 

12 Refer to the scatter plots in Figs. 11, 12, and 13 of the ITU-R BS.1770-2 standard. 

13 For example: “I did a –24 [LKFS] piece for Fox that was wall to wall singing and 
music for two minutes. Because of the overall loudness and continued full audio sig-
nal I had to bring it down and when it aired, it was 3 db too quiet even though it 
matched the magic LKFS number. I have no problem using these meters or meeting 
specs but they are faulty.”  
—“wheresmyfroggy,” AVID board, 3-28-2011 
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Some studies have indicated that when people are asked to assess the loudness of a 
given piece of material, they state that it sounds louder when underscoring or ef-
fects are added to constant-level dialog. The EBU has used these studies to justify 
the position taken in R128 that a listener’s impression of total loudness is more im-
portant than dialog level14. In our opinion, this misses the point. A more relevant 
question is whether viewers would want to turn down their volume controls to 
make dialog quieter when underscoring and effects appear. (In other words, wheth-
er effective TV commercial loudness control requires nothing more than applying 
gain control to commercials such that the BS.1770-2 “short-term” loudness15 is al-
ways limited to 0 LK.) Regarding this, Orban and Dolby Labs hold similar views. We 
believe that dialog is the most important element in most television audio and that 
listeners do not want to turn down their volume controls every time that underscor-
ing or effects appear under the dialog. The popular Dolby LM100 Loudness Meter16 
in its current revision uses the same Leq(RLB) algorithm as BS.1770 but adds gating 
to eliminate non-speech material, including silence. The author has used the Dolby 
LM100 to measure the output of the Orban OPTIMOD XPN-AM with a wide variety 
of speech material, and has observed that this material is almost always controlled 
within a ±1 dB window as measured on the LM100. In the author’s opinion, this 
demonstrates the benefits of a dialog-centric measurement. Moreover, the author 
believes it is unwise to rely on a BS.1770 measurement to set the on-air loudness of 
unadorned dialog because this can cause the dialog to be too loud with respect to 
other material. The author has experimented with “inverse short-term BS.1770 
loudness control” and believes that it sounds unnatural, pumping dialog loudness 
up and down in a subtly inartistic way as underscoring and effects come and go.17 

Studies indicating that BS.1770 is inaccurate at very low frequencies 

Another weakness of BS.1770 is that, unlike the CBS loudness controller and meter 
as implemented in Orban products, the BS.1770 algorithm does not take into ac-

                                                      

14 Dash, Ian; Bassett, Mark; Cabrera, Densil, “Relative Importance of Speech and Non-
Speech Components in Program Loudness Assessment,” AES Convention Paper 8043, 
128th AES Convention (May 2010). 

15 EBU R128 specifies short-term loudness as a BS-1770-1 (ungated) measurement 
with a three-second integration time. 

16 http://www.dolby.com/professional/products/broadcast/test-and-
measurement/lm100.html 

17 See Begnert, Fabian; Ekman, Håkan; Berg, Jan, “Difference between the EBU R-
128 Meter Recommendation and Human Subjective Loudness Perception,” AES Con-
vention Paper 8489, 131st AES Convention, (October 2011). This paper states, “These 
loudness-equalized signals gave rise to a perceived maximum loudness difference of 
2.8 dB.” This is very close to the 3 dB number that has come up in other discussions 
(such as the one quoted in footnote 13 on page 3-89). While the authors of this pa-
per consider 3 dB to be insignificant, others do not necessarily share this view, par-
ticularly advertisers who hear their expensive commercials aired 3 dB quieter than 
surrounding program material! 
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count the loudness contributed by the LFE channel, for good reason. Nacross and 
Lavoie18 tried to extend the BS.1770 algorithm to include the LFE channel by sum-
ming the K-weighted LFE channel’s power into the current BS.1770 algorithm, 
where the gain is weighted for the fact that LFE channel receives a 10 dB gain boost 
on playback, per Dolby’s standards. This modified BS.1770 algorithm failed to agree 
with the judgments of a subjective listening panel unless a 10 dB attenuation 
“fudge factor” was applied to the LFE channel prior to its power summation with 
the other channels. Nacross and Lavoie concluded: 

A problem exists however, should ITU-R BS.1770 be modified to simply 
include an attenuated version of the LFE channel. Because the LFE chan-
nel receives a 10 dB boost on playback, the low-frequencies on this chan-
nel would contribute differently to a loudness measure if they were 
moved to one of the other main channels, even though the perceived 
loudness would not appreciably change. This suggests that while LFE con-
tent does contribute to the perceived loudness, Equation (2)19 does not 
sufficiently predict how that content should be included. 

An Australian study may shed light on the failure of BS.1770 when program material 
contains considerable energy at very low frequencies.20 The authors used octave-
band noise in subjective listening tests with the goal of verifying the K-weighting 
curve used in BS.1770. The authors state: 

Comparison of the test results with an image of the filter curve currently 
specified in ITU-R Recommendation BS.1770 (Figure 13) shows good 
agreement at 250 Hz and above 500 Hz, reasonable agreement at 500 
Hz, but marked difference in the bottom two octaves. 

The relatively good performance of the BS.1770 algorithm in ITU trials 
suggests that, in partial loudness terms, there was probably not much 
test content in the 125 Hz band or below. While the existing BS.1770 fil-
ter curve is probably a good choice in applications where the program is 
dominated by speech, and it is certainly an improvement on the A and B 
curves in that application, it is likely to give significant errors in measur-
ing the loudness of other programs with more partial loudness in the 
lower frequencies, such as movie soundtracks and popular music. It is 
therefore desirable to improve on this filter for more general measure-
ment of program loudness. 

                                                      

18 Norcross, Scott G; Lavoie, Michel C.,” Investigations on the Inclusion of the LFE 
Channel in the ITU-R BS.1770-1 Loudness Algorithm,” AES Convention Paper 7829, 
127th AES Convention (October 2009) 

19 
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20 Cabrera, Densil; Dash, Ian; Miranda, Luis, “Multichannel Loudness Listening Test,” 
AES Convention Paper 7451, 124th AES Convention (May 2008) 
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Discussion and Conclusions 

Several studies have shown that the loudness “comfort range” for typical television 
listening is +2, −5 dB21. Beyond this range, a viewer is likely to become annoyed, 
eventually reaching for the remote control to change volume (or worse from the 
broadcaster’s point of view, to mute a commercial). Whether measured via the CBS 
or BS.1770 algorithms, the CBS loudness controller algorithm in Orban’s current 
products effectively controls subjective loudness to much better than this +2, −5 dB 
window. 

In the original version of this paper, we had assumed that results using BS.1770 me-
tering would be more consistent if that algorithm employed gating to prevent una-
dorned dialog from reading low compared to music and dialog with substantial 
background music or effects. However, this did not prove to be true with the pro-
gram material we used for testing—the results from the BS.1770-1 (ungated) and 
BS.1770-2 (gated) measurements were similar when measuring material that had 
been processed by the CBS Loudness Controller. It is likely that the loudness-
controlled material seldom caused the gate to act. (The CBS algorithm does not 
need silence gating because it is a “short-term” loudness measurement that incorpo-
rates cascaded models of the “instantaneous” and “short-term” loudness time con-
stants of human hearing22, which the BS.1770 algorithm does not.) 

Controlling loudness to a standard such as BS.1770 says nothing about the subjective 
acceptability of the loudness controller’s action. We have found that a simple loud-
ness controller that uses the inverse of the BS.1770 short-term meter’s output to 
control loudness by gain reduction can cause unnatural-sounding gain pumping of 
dialog when underscoring and effects appear under the dialog. More complex au-
tomatic loudness controllers can produce all of the well-known artifacts of dynamics 
processing, including noise breathing, spectral inconsistency, gain pumping, and 
harshness. Improperly designed multiband compressors can reduce dialog intelligi-
bility23. This is why it is important to carefully assess the audio quality and side ef-
fects that an automatic loudness controller produces so that one can choose a device 
that controls loudness effectively without producing objectionable and unnatural 
artifacts that can fatigue audiences. Different loudness controllers do not provide 
equally good subjective results even if they produce identical measurements on a 
loudness meter. 

                                                      

21 ATSC A/85:2009 Annex E, “Loudness Ranges” 

22 For example, see Glasberg, B.R. & Moore, B.C.J. (2002) "A Model of Loudness Ap-
plicable to Time-Varying Sounds,” J.AES, vol.50:5, pp.331-342, May 2002. 

23 Stone, Michael A.; Moore, Brian C. J.; Füllgrabe, Christian; Hinton, Andrew C., 
”Multichannel Fast-Acting Dynamic Range Compression Hinders Performance by 
Young, Normal-Hearing Listeners in a Two-Talker Separation Task,” J. AES Volume 
57 Issue 7/8 pp. 532-546; July 2009 

http://www.aes.org/e-lib/browse.cfm?elib=14833
http://www.aes.org/e-lib/browse.cfm?elib=14833
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Based on extensive experimentation with typical broadcast material, we believe that 
the CBS loudness meter locks onto dialog more effectively than does BS.1770, par-
ticularly when the dialog is accompanied by underscoring and/or effects. According-
ly, the CBS Loudness Controller in Orban products, which uses the CBS loudness me-
tering algorithm as its core loudness reference, produces consistent and naturally 
balanced dialog levels regardless of the program material and mixing style. Unlike 
the BS.1770 meter, the CBS technology does not unnaturally penalize material hav-
ing a low peak-to-RMS ratio, so it allows mixers and producers to freely use “artistic 
compression”24 and other well-established production techniques with the 
knowledge that such material will be neither too loud nor too quiet when com-
pared to the surrounding program. 

 

—Robert Orban, revised March 2012 

 

                                                      

24 It appears that the group that created R128 may be biased against this style of 
production: “Again, this does NOT mean that within a programme the loudness lev-
el has to be constant, on the contrary! It also does NOT mean that individual com-
ponents of a programme (for example, pre-mixes or stem-mixes, a Music & Effects 
version or an isolated voice-over track) have all to be at the same loudness level! 
Loudness variation is an artistic tool, and the concept of loudness normalisation ac-
cording to R128 actually encourages more dynamic mixing!” EBU TECH 3343, op. cit., 
p. 17 
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 Section 4 

 Software Summary 
 

OPTIMOD XPN-AM Software Summary 

 The OPTIMOD XPN-AM software version num-
ber is available through the Control Application 
Help > About menu. 

Application Installation File 

SetupXPN-AMxxx.exe − Installer: 

 Installs the Control Application− 

OptimodXPN-AM.exe 

 Installs the Agent –  

 OptimodXPN-AMAgent.exe 

 Installs the Service –  

 OptimodXPN-AMService.exe 

 Installs the factory presets 

 Installs run-time libraries 

 

Service 

 Implements the audio signal processing and provides hooks into the Windows 
sound I/O system. 

 Provides remote control security and access. 

 Starts 120 seconds after Windows finishes booting. This delay allows Windows to 
settle down so that it does not compete with the Service for CPU cycles. When it 
starts automatically, the Service will load the same processing presets that were 
active on the OPTIMOD XPN-AM Processors when the computer shut down, and 
will start processing audio. 

 Will only start up if it can determine that the USB security key is plugged into an 
available USB socket. The key is driverless; no driver installation is necessary. 

 Supports the API 
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 Supports SNMP. 

SNMP is not supported in v0.9 software. 

Agent (Tray Icon) 

 The OPTIMOD XPN-AM Agent is a tray icon that allows you to launch the 
OPTIMOD XPN-AM Control Application from the Windows System Tray. 

 If you right click the tray icon, a menu pops up with a checkable item named 
AUTO-START THE TRAY ICON. (The “Auto-start the tray icon” item will be checked by 
default.) 

 If you uncheck AUTO-START THE TRAY ICON, the tray icon will not re-appear when 
you re-start the PC. 

 To re-engage the icon, go to Start/Programs/Orban/OPTIMOD XPN-AM and select 
OptimodPcAgent. 

You do not need to open the OPTIMOD XPN-AM Control Application to 
toggle the auto-start feature on and off. 

XPN-AM PC Control Application 

 Provides access to all OPTIMOD XPN-AM I/O Mixer controls, DSP processing pa-
rameters, and presets. 

 Can be used as a client to remotely access OPTIMOD XPN-AM Processors running 
on computers other than those doing the audio processing. 

 Is not copy-protected and can be installed on as many computers as you wish. 

 It is not necessary (or desirable) for the Service to run on a computer that does 
not do audio processing but only hosts XPN-AM PC. (The OPTIMOD XPN-AM in-
staller will not install the Service if you tell it during the install process to install 
only the remote client.) 

Registry 

 I/O Settings 

 Active Preset 

 Encrypted Security 

 Application GUI Settings 
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 Section 5 

 Control API 
 

OPTIMOD XPN-AM Control API 

 OPTIMOD XPN-AM Service application hosts a TCP/IP terminal server to allow exter-
nal control of OPTIMOD XPN-AM processors from either a Telnet client or a custom 
third party application. All commands are simple text strings. Upon receiving valid 
commands, OPTIMOD XPN-AM will confirm by returning a simple text string status 
message. By implementing external control this way, multiple OPTIMOD XPN-AM 
Processors can be controlled using standards-based network protocols (that are not 
Microsoft Windows-specific) anywhere that network connectivity is available. 

To protect the Terminal Server from unauthorized remote access, the default setting 
for the control “Use localhost only for Terminal Access” is enabled. In this case, only 
Telnet connections from the localhost address 127.0.0.1 on the default port 12101 
are accepted. Disabling this will allow Telnet connections via Ethernet from other 
computers, using the IP address of the host computer. This control is located in the 
OPTIMOD XPN-AM remote application in the TOOLS>SERVICE SETUP dialog box and is 
accessible only when the application is disconnected from an XPN-AM processor (i.e. 
when controls and meters are not displayed). The default port can be changed here 
too. 

Command Function 

HELP Lists important API commands 

VERSION Retrieves control application version information. 

PLIST Returns a list of all processing controls available to the API. 

SLIST Returns list of all controls available to the API in Settings (configuration). 

PSTATUS Returns values for each control in the active preset. 

SSTATUS Returns values for each control in the active Settings configuration. 

HEADER Returns all control information formatted to be included in a C program file. 

AP ?? Retrieves all available Presets. 
AP ? Retrieves Active Preset. 
RP preset name Recalls Processing Preset. 
DP preset name Deletes a preset. 

AS ?? Retrieves all available Settings files. 

AS ? Retrieves Active Settings file. 

RS settings name Recalls a Settings file. 

HEADER Returns all control information, formatted to be include in a C program file 

disconnect Disconnects Telnet connection. 
 

Table 5-1: Top-Level Telnet Command List 
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To control OPTIMOD XPN-AM externally, establish a Telnet connection and issue 
commands and parameters, either by typing them directly into a Telnet client or by 
placing them within batch files. Then process them with a scriptable Telnet client 
that supports this operation, such as PuTTY, along with its companion command-line 
interpreter, Plink. Both of these applications are available for free download. Search 
“PuTTY” with a search engine like Google to find a download site. 

Automating control changes is possible by using the Windows Task Scheduler to 
launch batch files at the desired time. 

Custom third party applications can be developed to use this protocol. Additionally, 
you can include this protocol in an existing application by using small subsets of the 
standards-based Telnet protocols directly, or for simplicity, by using scripting or by 
calling batch files with a Telnet client such as PuTTY along with its companion com-
mand-line interpreter, Plink. Scripting eliminates the need to develop networking 
code or otherwise contend with complex, limited-function Microsoft Windows spe-
cific programming APIs. Developing a third party application or including the proto-
col in an existing application eliminates having to install and configure additional 
applications. Using small subsets of the standards-based Telnet protocol allows more 
operational flexibility without a system performance hit and simplifies development 
compared to proprietary OEM APIs. 

Table 5-1 on page 5-1 describes the available command strings and their functions. 
To demonstrate this functionality, you may type the commands directly into a Telnet 
client terminal and see OPTIMOD XPN-AM confirmation and status messages. 

Commands are case-sensitive and must be entered exactly as shown. Replace “preset 
name” and “setting name” with the actual Preset name and Settings name respec-
tively. 

Using the API: Example 

This example shows how PuTTY and Plink can be used to control OPTIMOD XPN-AM 
using scripting files on a local or remote computer as the OPTIMOD XPN-AM to be 
controlled. Plink and all associated scripting text, PuTTY, and .cmd files should be 
located together in the same user-defined directory unless the path is specified in 
the .cmd files. 

In the example, replace “127.0.0.1” with the IP address of the computer running the 
Service that implements the controlled Processor and “12101” with the card’s port 
number. 12101 is the default; see step 2 on page 2-9. 

127.0.0.1 is “localhost” and is used if you are running the Service on the 
same computer you are using to connect to the API. 

Each control session requires two ASCII files and one optional Shortcut file: 

 a .cmd file that calls Plink to establish a Telnet connection to OPTIMOD XPN-AM  

 a reference.txt file that contains the actual control script. 
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 an optional Windows Shortcut .lnk file calls the .cmd file with a suppressed 

Command Box. 

Recalling the AM GENERAL MEDIUM preset 

These two files will recall the AM GENERAL MEDIUM preset.  

 

The file “recall_AM_GEN_MEDIUM_preset.cmd” contains: 

 

plink -telnet -P 12101 127.0.0.1 < recall_AM_GEN_MEDIUM_preset.txt 

 

 

The file “recall_AM_GEN_MEDIUM_preset.txt” contains: 

 

RP AM GENERAL MEDIUM 

disconnect 

 

 

 

Administering OPTIMOD XPN-AM through Ethernet 
TCP/IP 

Using a terminal program like PuTTY, you can control an OPTIMOD XPN-AM Proces-
sor through a network Ethernet TCP/IP connection to the computer that hosts the 
XPN-AM you wish to access. An ASCII programmable GPIO device, such as a Broad-
cast Tools SRC-16, with an appropriate Serial-Ethernet server, can also be used for 
hardware control and status. Multiple connections and devices can be used. When 
you are connected, you can retrieve information and change settings on the XPN-
AM by using simple ASCII commands as discussed in OPTIMOD XPN-AM Control API 
starting on page 5-1. 

 Valid commands are in either upper or lower case, not a combination. 

 Only one valid command is permitted per line. 
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 OPTIMOD XPN-AM will not respond to unrecognized commands. 

 The character code supported is ASCII. 

Connecting via TCP/IP Using PuTTY on a PC 

 You can use the XPN-AM with any computer or terminal that is compatible with 

TCP/IP networking. 

 The OPTIMOD XPN-AM Service Settings determine network connection security: 
 

A) Using the OPTIMOD XPN-AM Control Application, select TOOLS > SERVICE 
SETTINGS. 

B) Assign an available TCP/IP Port. (Default is 12101.) 

C) If you will be communicating from a computer other than the computer host-
ing the Service, uncheck “Use localhost only for Terminal Access.” 

D) (Optional) Check “Use Network Accept List” and add allowed IP addresses to 
list. (Step 2 on page 2-9 has more detail.) 

Because the API does not use passwords in the individual commands, it is 
important to use the “Use Network Accept List” feature to enforce secu-
rity if you wish to communicate from a computer other than the comput-
er hosting the Service.  

 Connect your computer or terminal with an Ethernet cable: 
 

A) Connect an appropriate Ethernet cable on your terminal, computer, or device 
to either an Ethernet port on the XPN-AM’s host computer or the Ethernet 
network that will allow access the XPN-AM host computer. 

 If connecting to a standard Ethernet network, use a standard Ethernet ca-

ble and TCP/IP network connection. 

 If connecting directly to another computer, use a crossover Ethernet cable.  

When a crossover Ethernet cable is used, at least one computer must 
have a static IP address. The other computer may have a static address or 
may have DHCP enabled. 

To enable DHCP in a given computer, its Internet Protocol (TCP/IP) Prop-
erties must be set to “Obtain an IP address automatically.” Internet Pro-
tocol (TCP/IP) Properties is also where you set a computer’s static IP ad-
dress. 

In either case, when using a crossover cable, both computers should be 
assigned the same IP subnet unless special routing has been configured. 

B) Start PuTTY 

The CONFIGURATION dialog box appears. 
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C) Set the Host Address to that of the OPTIMOD XPN-AM Service host computer. 

D) Set the Port Number to that of the OPTIMOD XPN-AM Service host computer, 
(Default is 12101). 

E) Select TELNET as the CONNECTION TYPE. 

F) (Optional) Type a name for your connection in the SAVED SESSIONS box and 
click SAVE. 

G) Click OPEN. 

The XPN-AM will immediately connect and the XPN-AM connect banner 
will display: 

Orban OPTIMOD XPN-AM Control vx.x.x.xx 

Press your computer’s ENTER key once. Commands may now be sent and status 
received. 

OPTIMOD XPN-AM Command and Status Reference is in OPTIMOD XPN-
AM Control API starting on page 5-1. 
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Processing Controls Available From the API 

A vast majority of users will have no reason to adjust processing controls from the 
API because it is much more convenient to do it from the XPN-AM PC application. 
The processing controls API is mainly useful for developers who wish to develop a 
custom interface.  

The valid values for a given control correspond to the available values of the control 
as displayed in the XPN-AM’s GUI (PC application). You must use the identical for-
mat, including whether a decimal point is included, and if it is, how many decimal 
places are displayed. For example, 12, 12.0, and 12.00 are not equivalent because the 
values are parsed as strings and not as numerical values. You can tell if you have en-
tered a valid value because the API will return an acknowledgement. To fetch a list 
of all valid values, type the control name followed a space and two question marks 
(see the example below).   

The HEADER command returns a list of all controls (both Processing and Settings) and 
their valid values. To capture the header to a text file, refer to the PuTTY command 
CREATING A LOG FILE OF YOUR SESSION in PuTTY help. 

Example to change the control value: 

Type the following: 

AGC On 

 

(returns) 

AGC:On 

 

Example to query the control value: 

Type the following: 

AGC ? 

 

(returns) 

AGC:On 

 

Example to fetch the valid settings of a control: 

Type the following: 

AGC ?? 

 

(returns) 

AGC 

On 

Off 
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Processing Controls Available From the API  

AGC  

AGC_BASS_ATTACK  

AGC_BASS_COUPLE  

AGC_BASS_RELEASE  

AGC_BASS_TH  

AGC_DIFF_GR  

AGC_DRIVE  

AGC_MASTER_ATTACK  

AGC_RATIO  

AGC_RELEASE  

AGC_WINDOW_RELEASE  

AGC_WINDOW_THRESH  

AM_ALLF_PEQ_IN_OUT         HD_ALLF_PEQ_IN_OUT       

AM_ALL_EQ_IN_OUT           HD_ALL_EQ_IN_OUT         

AM_AM_HF_EQ_GAIN           HD_B12_CROSSOVER         

AM_AM_HF_EQ_SHAPE          HD_B1B2_XOVER_SLOPE      

AM_AM_LOUDNESS             HD_B1_ATTACK             

AM_B12_CROSSOVER           HD_B1_BREAKPOINT         

AM_B1B2_XOVER_SLOPE        HD_B1_COMP_KNEE          

AM_B1_ATTACK               HD_B1_COMP_RATIO         

AM_B1_BREAKPOINT           HD_B1_COMP_THRSH         

AM_B1_COMP_KNEE            HD_B1_DELTA_REL          

AM_B1_COMP_RATIO           HD_B1_DIFF_GR            

AM_B1_COMP_THRSH           HD_B1_LIMIT_ATTACK       

AM_B1_DELTA_REL            HD_B1_ON_OFF             

AM_B1_DIFF_GR              HD_B1_OUTPUT_MIX         

AM_B1_LIMIT_ATTACK         HD_B2_ATTACK             

AM_B1_ON_OFF               HD_B2_BREAKPOINT         

AM_B1_OUTPUT_MIX           HD_B2_COMP_KNEE          

AM_B2_ATTACK               HD_B2_COMP_RATIO         

AM_B2_BREAKPOINT           HD_B2_COMP_THRSH         

AM_B2_COMP_KNEE            HD_B2_DELTA_REL          

AM_B2_COMP_RATIO           HD_B2_DIFF_GR            

AM_B2_COMP_THRSH           HD_B2_LIMIT_ATTACK       

AM_B2_DELTA_REL            HD_B2_ON_OFF             

AM_B2_DIFF_GR              HD_B2_OUTPUT_MIX         

AM_B2_LIMIT_ATTACK         HD_B3_ATTACK             

AM_B2_ON_OFF               HD_B3_BREAKPOINT         

AM_B2_OUTPUT_MIX           HD_B3_COMP_KNEE          

AM_B3_ATTACK               HD_B3_COMP_RATIO         

AM_B3_BREAKPOINT           HD_B3_COMP_THRSH         

AM_B3_COMP_KNEE            HD_B3_DELTA_REL          

AM_B3_COMP_RATIO           HD_B3_DIFF_GR            

AM_B3_COMP_THRSH           HD_B3_LIMIT_ATTACK       

AM_B3_DELTA_REL            HD_B3_ON_OFF             

AM_B3_DIFF_GR              HD_B3_OUTPUT_MIX         

AM_B3_LIMIT_ATTACK         HD_B4_ATTACK             

AM_B3_ON_OFF               HD_B4_BREAKPOINT         

AM_B3_OUTPUT_MIX           HD_B4_COMP_KNEE          

AM_B4_ATTACK               HD_B4_COMP_RATIO         

AM_B4_BREAKPOINT           HD_B4_COMP_THRSH         

AM_B4_COMP_KNEE            HD_B4_DELTA_REL          

AM_B4_COMP_RATIO           HD_B4_DIFF_GR            

AM_B4_COMP_THRSH           HD_B4_LIMIT_ATTACK       

AM_B4_DELTA_REL            HD_B4_ON_OFF             

AM_B4_DIFF_GR              HD_B4_OUTPUT_MIX         

AM_B4_LIMIT_ATTACK         HD_B5_ATTACK             

AM_B4_ON_OFF               HD_B5_BREAKPOINT         

AM_B4_OUTPUT_MIX           HD_B5_COMP_KNEE          

AM_B5_ATTACK               HD_B5_COMP_RATIO         

AM_B5_BREAKPOINT           HD_B5_COMP_THRSH         
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Processing Controls Available From the API  

AM_B5_COMP_KNEE            HD_B5_DELTA_REL          

AM_B5_COMP_RATIO           HD_B5_DIFF_GR            

AM_B5_COMP_THRSH           HD_B5_DWNWRD_EXP         

AM_B5_DELTA_REL            HD_B5_LIMIT_ATTACK       

AM_B5_DIFF_GR              HD_B5_ON_OFF             

AM_B5_DWNWRD_EXP           HD_B5_OUTPUT_MIX         

AM_B5_LIMIT_ATTACK         HD_BAND_21_COUPL         

AM_B5_ON_OFF               HD_BAND_23_COUPL         

AM_B5_OUTPUT_MIX           HD_BAND_32_COUPL         

AM_BAND_21_COUPL           HD_BAND_34_COUPL         

AM_BAND_23_COUPL           HD_BAND_45_COUPL         

AM_BAND_32_COUPL           HD_BASS_CLIP             

AM_BAND_34_COUPL           HD_BRILLIANCE            

AM_BAND_45_COUPL           HD_BRILLIANCE_IN_OUT     

AM_BASS_CLIP               HD_BS1770_LDNES_CTRL_THR 

AM_BRILLIANCE              HD_DE_STEREO_COUPL       

AM_BRILLIANCE_IN_OUT       HD_DJ_BASS_BOOST         

AM_DE_STEREO_COUPL         HD_DWNWRD_EXP            

AM_DJ_BASS_BOOST           HD_FINAL_LIMIT_DRIVE     

AM_DWNWRD_EXP              HD_HF_ENHANCER           

AM_FINAL_LIMIT_DRIVE       HD_HF_ENHANCER_IN_OUT    

AM_HARMONIC_ENHANCER       HD_HF_ENHANCE_SENS       

AM_HF_ENHANCER             HD_HF_ENHANCE_THRESH     

AM_HF_ENHANCER_IN_OUT      HD_HF_PEQ_IN_OUT         

AM_HF_PEQ_IN_OUT           HD_HIGH_PASS             

AM_HIGH_PASS               HD_HIGH_PASS_Q           

AM_HIGH_PASS_Q             HD_LESS_MORE             

AM_LESS_MORE               HD_LF_PEQ_IN_OUT         

AM_LF_PEQ_IN_OUT           HD_LF_SHELF_IN_OUT       

AM_LF_SHELF_IN_OUT         HD_LOUDNESS              

AM_LOW_BASS_FREQ           HD_LOUDNESS_ATTACK       

AM_LOW_BASS_GAIN           HD_LOUDNESS_BASS_CPL     

AM_LOW_BASS_Q              HD_LOUDNESS_THR          

AM_MB_DRIVE                HD_LOW_BASS_FREQ         

AM_MB_GATE_THR             HD_LOW_BASS_GAIN         

AM_MB_RELEASE              HD_LOW_BASS_Q            

AM_MF_PEQ_IN_OUT           HD_LOW_PASS              

AM_MONO_BASS               HD_LOW_PASS              

AM_MONO_BASS_XOVER         HD_LOW_PASS_EQ_Q         

AM_MUSIC_SPEECH_MODE       HD_MB_DRIVE              

AM_MX_BASS_LIMIT           HD_MB_GATE_THR           

AM_MX_BASS_PRELIM          HD_MB_RELEASE            

AM_MX_BASS_PRELIM_MODE     HD_MF_PEQ_IN_OUT         

AM_MX_CLIP_DIST            HD_MX_BASS_LIMIT         

AM_MX_CLIP_THR             HD_MX_BASS_PRELIM        

AM_MX_SP_BASS_PRELIM       HD_MX_BASS_PRELIM_MODE   

AM_PEQ_ALL_FREQ            HD_MX_CLIP_DIST          

AM_PEQ_ALL_GAIN            HD_MX_CLIP_THR           

AM_PEQ_ALL_WIDTH           HD_MX_SWITCH             

AM_PEQ_HIGH_FREQ           HD_PEQ_ALL_FREQ          

AM_PEQ_HIGH_GAIN           HD_PEQ_ALL_GAIN          

AM_PEQ_HIGH_WIDTH          HD_PEQ_ALL_WIDTH         

AM_PEQ_LOW_FREQ            HD_PEQ_HIGH_FREQ         

AM_PEQ_LOW_GAIN            HD_PEQ_HIGH_GAIN         

AM_PEQ_LOW_WIDTH           HD_PEQ_HIGH_WIDTH        

AM_PEQ_MID_FREQ            HD_PEQ_LOW_FREQ          

AM_PEQ_MID_GAIN            HD_PEQ_LOW_GAIN          

AM_PEQ_MID_WIDTH           HD_PEQ_LOW_WIDTH         

AM_PHASE_CORRECTOR         HD_PEQ_MID_FREQ          

AM_PHASE_CORRECT_XOVER     HD_PEQ_MID_GAIN          

AM_PHASE_ROTATOR           HD_PEQ_MID_WIDTH         
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Processing Controls Available From the API  

AM_SENSITIVITY_TRIM        HD_SP_B1_ATTACK          

AM_SPEECH_HPF              HD_SP_B1_COMP_THRSH      

AM_SP_B1_ATTACK            HD_SP_B2_ATTACK          

AM_SP_B1_COMP_THRSH        HD_SP_B2_COMP_THRSH      

AM_SP_B2_ATTACK            HD_SP_B3_ATTACK          

AM_SP_B2_COMP_THRSH        HD_SP_B3_COMP_THRSH      

AM_SP_B3_ATTACK            HD_SP_B4_ATTACK          

AM_SP_B3_COMP_THRSH        HD_SP_B4_COMP_THRSH      

AM_SP_B4_ATTACK            HD_SP_B5_ATTACK          

AM_SP_B4_COMP_THRSH        HD_SP_B5_COMP_THRSH      

AM_SP_B5_ATTACK            HD_SP_DWNWRD_EXP         

AM_SP_B5_COMP_THRSH        HD_SP_HIGH_PASS          

AM_SP_DWNWRD_EXP           HD_SP_HIGH_PASS_Q        

AM_SP_HIGH_PASS_Q          HD_SP_MB_RELEASE         

AM_SP_MB_RELEASE           HD_SUBHARMONIC_INJECTION 

AM_SUBHARMONIC_INJECTION   HD_SUBHARM_IN_OUT        

AM_SUBHARM_IN_OUT          HD_TRANSIENT_ENHANCE     

AM_THRESHOLD_TRIM           

AM_TRANSIENT_ENHANCE        

GATE_THRESH                 

IDLE_GR                     

SE_AMOUNT                   

SE_IN_OUT                   

SE_RATIO_WIDTH              

STEREO_SYNTH_ALG            

STEREO_SYNTH_MODE           

STEREO_SYNTH_SEPARATION     

 

Settings Controls Available From the API 

The Settings API can be used to automate proof-of-performance tests. Another im-
portant application is using the DIVERSITY_DELAY control to interface with an exter-
nal monitor that automatically corrects incorrect values of diversity delay. 

Settings Controls Available From the API  

ALGORITHM              AM_LP_FILTER_FREQ_P0     

INP_REF_LEVEL          AM_LP_FILTER_SHAPE_P0    

INP_REF_PPM_LEVEL      AM_TX_EQ_LF_GAIN_P0      

AM_OUT_LEVEL           AM_TX_EQ_LF_FREQ_P0      

AM_OUT_DITHER          AM_TX_EQ_HF_SUM_FREQ_P0  

AM_GLOBAL_LOUDNESS     AM_TX_EQ_HF_DIF_FREQ_P0  

HD_OUTPUT_LEVEL        AM_TX_EQ_HF_SUM_DELAY_P0 

HD_GLOBAL_LOUDNESS     AM_TX_EQ_HF_DIF_DELAY_P0 

HD_PROCESSING          TRANSMISSION_PRESET      

STUDIO_CHASSIS         FREQUENCY                

UPMIX_DEFEAT           SQUARE_FREQUENCY         

STEREO_SYNTH_DEFEAT    TEST_WAVEFORM            

METER_DELAY            L_FRONT_TONE             

DIVERSITY_DELAY        R_FRONT_TONE             

PHASE_CORRECT_DEFEAT   FRONT_TONE               

BYPASS_GAIN            L_REAR_1_TONE            

TEST_MOD_LEVEL         R_REAR_1_TONE            

AM_RATINGS_LOOP        L_REAR_2_TONE            

AM_INPUT_MODE          R_REAR_2_TONE            

AM_DELAY_CHANGE_MODE   LFE_TONE                 

AM_OUTPUT_1_POLARITY   DOWNMIX1_L_TONE          

AM_POS_PEAK_P0         DOWNMIX1_R_TONE          



5-10 CONTROL API   ORBAN  

 

 

 



OPRIMOD XPN-AM  SPECIFICATIONS  6-1 

 

 Section 6 

 Specifications 
 

Specifications 

SYSTEM 

Audio Processors: One instance of OPTIMOD XPN-AM software realizes a stereo AM and 

stereo HD/netcast audio processor. Each processor consists of the following cascaded 

processing elements: Internal Processing: Input  DC Removal  Stereo Synthesizer 

 Mono Bass  Left/Right Phase Skew Corrector  Stereo Enhancer  Two-Band 

defeatable AGC with window gating  Ratings Loop-through  Equalizer/HF Enhancer 

 Subharmonic Synthesizer  Multiband Compressor  Peak Limiter  Automatic 

Loudness Controller (HD only)  Transmitter Equalizer (AM only)  Output. The AM 

and HD processors split after the AGC 

Number of Audio Processors: In the most common configuration, the host computer runs 

one instance of Optimod XPN-AM and (optionally at extra cost) one or more instances of 

Optimod PCn 1600 (when a streaming processor with independent AGC is desired). The 

number of Processors realizable on a given computer depends on the processing fea-

tures used and the power of the computer’s CPU. The base configuration can run one 

instance of XPN-AM and up to two instances of 1600PCn. 

Frequency Response: ±0.1dB, 2-20,000Hz (Bypass software running). 

Input/Output Delay: Typically 450 to 1000 ms. Varies according to the number of pro-

cessing features that are activated. By using a Windows multichannel Playback audio 

device, the delay difference between the HD and AM outputs is controlled to single-

sample accuracy. 

Input/Output Resolution: 16-bit or 24-bit fixed point. If the output is configured for 16 bits, 

First-order noise-shaped dither can be applied prior to truncation to 16 or 24 bits from 

32-bit float. 

Input/Output Sample Rate: 44.1, 48, 96, or 192 kHz. 48 KHz is native. 44.1, 96, and 192 

kHz use high-quality synchronous sample rate converters built into OPTIMOD XPN-AM 

and do not rely on Windows’ built-in SRC. To minimize CPU load, we recommend run-

ning the XPN-AM software at 48 KHz sample rate. If sample rate conversion is needed, 

use XPN-AM with a soundcard having built-in hardware SRC, like the Orban Optimod-

PC 1101e. 

Internal Resolution: 32-bit or 64-bit floating point, as appropriate for the processing being 

performed. 

Internal Sample Rate: 48-256 kHz as needed. 

Noise: The output noise floor depends upon how much gain the processor is set for (Limit 

Drive, AGC Drive, Multiband Drive, Limiter Drive), gating level, equalization, noise re-

duction, etc. For analog I/O, it also depends on the performance of the I/O sound device. 

XPN-AM’s internal signal path is 32-bit float, with 16 or 24-bit fixed point I/O. With 24-bit 

digital I/O, the measured, unweighted RMS noise at the AM digital output is better than 

97 dB below 100% modulation with NRSC (9.5 KHz) bandwidth, Input Reference Level 

set to –20 dBFS (VU), and .the AM GENERAL MEDIUM preset active. 
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Distortion: It is impossible to provide a simple, perceptually meaningful specification for dis-

tortion. The base distortion in the signal path is determined by the performance of the 

I/O sound devices, including A/D and D/A converters (if used). In Operate mode, percep-

tual distortion is entirely dominated by the MX peak limiter, which uses a psychoacoustic 

masking model to minimize distortion audibility and allows the user to trade off percep-

tual distortion against coverage and/or transmitter power savings. 

AM Peak Control: The AM Peak limiter is oversampled at 256 kHz, yielding a worst-case 

overshoot with 9.5 KHz bandwidth of 0.3 dB (0.1 dB typical) at an analog or digital out-

put and for all output sample rates. 

HD Peak Control: The HD peak limiter is oversampled at 192 KHz (non-MX mode) or 256 

kHz (MX mode), yielding a worst-case overshoot with 20 KHz bandwidth of 0.5 dB (0.15 

dB typical) at an analog or digital output and for all output sample rates. 

AM Steep-Slope Lowpass Filters: 2.5 to 9.5 KHz (NRSC) in 500 Hz steps for setting 

transmitted AM bandwidth. The filter is distributed throughout the processing to control 

the output spectrum and to prevent the processing from working on frequencies that will 

not be transmitted. The filter’s input section has a parametric transition shape between 

the passband and stopband, where the frequency at the edge of the passband can be at 

0.1, 3.0, or 6.0 dB down, allowing the user to trade off brightness against ringing. 

HD Steep-Slope Lowpass Filter: 10-19 KHz in 1 KHz steps, OFF. Can be used to provide 

additional anti-aliasing for low sample rate services. 

Parametric Lowpass Filter: 4 – 15 KHz in 1kKHz steps with selectable slopes of 6, 12, 18 

or 24 dB/octave. Intended for program equalization. 

Highpass Filter: 20, 30, 40, 50, 60, 70, 80, 90, 100, 110, 120, 130, 140, 150, 170 or 200 

Hz with selectable slopes of 6, 12, 18 or 24 dB/octave. 

Equalizers: Shelving Low Bass EQ, selectable 6 dB, 12dB or 18dB/octave. Four-band Par-

ametric EQ with analog-style bell-shaped curves. Program Adaptive HF Enhancer.  Bril-

liance control uses Band 5 of the multiband compressor as a steep slope shelving equal-

izer (12 or 18 dB/octave for linear-phase or allpass crossovers respectively).  

Receiver Equalizer (AM chain only): Parametric 18 dB/octave shelf, typically +3.0 dB at 2 

KHz (see Figure 3-14 on page 3-45). NRSC pre-emphasis is available. 

Subharmonic Synthesizer: Frequencies from 50-90 or 60-120 Hz will produce subharmon-

ics exactly one octave below, ensuring musicality of the effect. Subharmonic synthesis is 

defeated when speech is detected or when the program material already has energy in 

the frequency range occupied by the subharmonics. 

AGC (Automatic Gain Control): 24dB gain reduction range with adjustable “Idle Gain” 

(typically –10 dB), Two-Band, with adjustable stereo coupling and band coupling, com-

pression ratio control, silence gate and window gate. 

Stereo Enhancer: Orban-developed L−R dynamic expansion triggered by L+R transients. 

To avoid artifacts and over-enhancement, it only expands L–R energy above 200 Hz. 

Multiband Compressors: 25dB gain reduction range, Five-Band. 

HD MB Crossover Frequencies: 6.2 KHz, 1.6 KHz, 420 Hz, and 200/150/100 Hz (se-

lectable).  

AM MB Crossover Frequencies: 3.8 kHz, 1.6 kHz, 420 Hz, and 100/150/200 Hz (se-

lectable) 

Limiter: >12dB gain reduction range (HD), >24 dB range (AM). The HD limiter provides two 

modes: low-IM look-ahead (to minimize CPU usage) and MX (to achieve highest per-

formance).  
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Transmitter Equalizer (AM chain only): Four presets, each with LF Gain, LF Frequency, 

HF Frequency, and HF Delay controls. Remote controllable via XPN-AM PC Remote 

application and API. 

Limiter Asymmetry Control (AM chain only): 100-150% positive peaks. Included in 

transmitter equalizer preset. 

BS.1770 Loudness Meter (AM and HD): Dual-display BS.1770-4 Integrated loudness, 

where the integration is equally weighted over 3-second and 10-second trailing intervals 

and the relative gate for each display is recalculated every 100 ms. A blue vertical bar 

displays the 3-second measurement; a white floating horizontal bar displays the 10-

second measurement. For AM and HD, the meters display loudness relative to the AM 

and HD active Target Loudness setting respectively.  (The 3-second measurement is in 

the spirit of the BS.1770 “Short-Term” measurement, except that the absolute and rela-

tive gates specified for the Integrated measurement are applied. We believe that this is 

more representative of perceived loudness, particularly with speech material.)  

 

In the HD processing chain, the BS.1770 meter and Safety Limiter are calibrated con-

ventionally in units of LUFS, where the reference is 0 dBFS in the transmission chain fol-

lowing the Optimod. In the AM processing chain, the BS.1770 meter and Safety Limiter 

are calibrated such that 0 dBFS100% negative modulation and are frequency 

weighted with a third-order Bessel lowpass filter with a –3 dB frequency of 2 kHz. This 

simulates a “average” AM radio
1
. 

CBS Loudness Meter (FM and HD): Per Jones & Torick, “A New Loudness Indicator for 

Use in Broadcasting,” J. SMPTE September 1981. (See page 2-25 of this manual.) The 

meter’s sensitivity is scaled with respect to the active target loudness (FM or HD) to 

make it indicate close to 0 dB when the measured BS.1770 loudness is at the target 

loudness. NOTE: In the AM chain, the CBS Loudness Meter is located before the AM 

peak limiting so it does not indicate decreases in loudness (which can be significant) 

caused by this limiting. It is frequency weighted to simulate an average AM radio by a 

third-order Bessel lowpass filter with a –3 dB frequency of 2 kHz. 

Loudness Controller (HD chain only): Constrains subjective loudness to a user-

adjustable threshold via the 1981 Jones & Torick CBS Technology Center algorithm, as 

further refined and developed by Orban. The algorithm also drives a subjective loudness 

meter, which is displayed on the XPN-AM’s GUI. In dual-mono mode, there are two in-

dependent loudness controllers and meters. 

BS.1770 Safety Limiter (HD chain only): Constrains Integrated BS.1770-2 (and higher) 

loudness to preset value, with an attack time of 10 seconds and a release time of 3 sec-

onds. 

Number of User Presets: Essentially unlimited. User presets can be saved on the host 

computer’s hard drive or on other storage devices.  

                                                      

1 National Radio Systems Committee: “Consumer Testing of AM Broadcast Transmis-
sion Bandwidth and Audio Performance Measurements of Broadcast AM Receivers,” 
September 2006.  
http://www.nrscstandards.org/AFAB/AMSTG%20report%20summary.pdf 

http://www.nrscstandards.org/AFAB/AMSTG%20report%20summary.pdf
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Audio I/O 

OPTIMOD XPN-AM uses Windows’ built-in WASAPI sound kernel for audio input and out-

put, and is compatible with sound devices whose drivers support WASAPI, including 

software Audio-Over-IP drivers. Mono or stereo AM processing requires a stereo Record 

and Playback devices; ratings encoder loop-through functionality with HD requires use 

of 5.1-channel Record and Playback devices. The audio device installed in a given sys-

tem is customized based on the customer’s needs. 

Base I/O Device: The base audio I/O device is an Orban Optimod-PC 1101e card, which 

provides two AES3 digital inputs, two AES3 digital outputs, one stereo analog input pair, 

and one stereo analog output pair. Its two virtual sound devices can support AM and HD 

I/O, or AM and ratings encoder loop-through. It also includes a streaming audio proces-

sor that can be used as a low-delay headphone monitor or to process a stream. Basic 

functions such as input and output levels can be controlled from the XPN-AM Control 

Application; advanced functions can be controlled from the 1101e PC Control Applica-

tion. For further information, please refer to the 1101e pages at www.orban.com.  

Optional I/O Device: RME HDSPe AES supports Stereo AM, HD, and rating encoder 

loopthrough with four AES3 digital inputs and four AES3 digital outputs, plus wordclock 

input and output. AM//HD I/O uses 5.1-channel I/O via one AES3 input and two AES3 

outputs. 

COMPUTER  

CPU: Supplied Intel CPU and chipset depends on the current offerings from Intel. Full AM + 

HD processing with MX limiting requires an Intel i-series processor, 7
th
-generation or 

higher, with clock speed of 3.9 GHz or higher. 

Operating System: Microsoft® Windows® 10 LTSC (Long-Term Servicing Channel), 64-bit 

Software: 

XPN-AM Service: The core audio processor runs as a Windows Service. It is copy-

protected via a USB key. 

XPN-AM PC Control application: provides subjective adjustment controls of the audio pro-

cessing and remote administration. It also allows factory and user presets and system 

setups to be recalled from and saved to a host storage device such as a hard disk drive. 

The control application client can address multiple OPTIMOD XPN-AM Processors via 

TCP/IP, either from the same computer that hosts the Service or from other computers 

on a network. The application is not copy-protected and may be installed on as many 

computers as desired. 

XPN-AM Agent: The OPTIMOD XPN-AM Agent is a tray icon that allows you to launch the 

OPTIMOD XPN-AM Control Application from the Windows System Tray. It is not copy-

protected 

API: 

IP API: provides complete remote administration over TCP/IP. The XPN-AM Service appli-

cation hosts a TCP/IP Terminal Server to allow external control of XPN-AM from either a 

Telnet client or a custom third party application. All XPN-AM Presets and Mixer Controls 

are accessible and all commands are simple text strings. 

Telnet/SSH: RFC 318 compliant basic subset. Compatible with Windows Telnet and PuTTY 

Telnet clients. 

TCP/IP Port: user assignable. 

http://www.orban.com/


OPTIMOD XPN-AM  SPECIFICATIONS  6-5 

 

 

Security: 

Multi-Level Security: In addition to normal security built into Windows, XPN-AM provides 

three basic password-protected security levels for its software components: Service 

Administrator, Processor Administrator, and Processor User. 
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 Index 
 

1 

1101e card  1- · 3 

A 

aacPlus  1- · 11 

AC Line Cord Standard 2- · 2 

active setup  2- · 44 

Administering XPN-AM Through 

Terminal Program  5- · 3 

Adobe Reader  1- · 1 

AGC 
bass attack control  3- · 38 

bass coupling control  3- · 37 

bass release control  3- · 39 

bass threshold control  3- · 38 

control list  3- · 35 

controls  3- · 35 

defeating  2- · 26 

drive control  3- · 35 

gate threshold control  3- · 36 

idle gain control  3- · 38 

master attack control  3- · 38 

master release control  3- · 35 

meter  3- · 1 

ratio control  3- · 38 

AGC  3- · 16 

agent  4- · 2 

AM analog loudness 
adjusting  2- · 42 

analog landline  1- · 16 

analog reference level, I/O setup  2- · 

27 

anchor element  3- · 68, 73 

antenna system  1- · 21 

API 

connecting via PuTTY  5- · 4 

examples  5- · 2 

serial  6- · 4 

table of Processing Controls  5- · 6 

Table of Settings  5- · 9 

API  2- · 9 

API  5- · 1 

API  6- · 4, 5 

asymmetry  1- · 19, 20 

ATSC A/85  3- · 67 

Attack 
Multiband  3- · 55 

attack  3- · 38 

Audio I/O 
setting up  2- · 6 

B 

B1/B2 crossover control  3- · 51 

B1/B2 Crossover Slope  3- · 52 

band coupling  3- · 53 

Band Mix controls  3- · 55 

band on/off controls  3- · 55 

Bass Clip Mode  3- · 59 

Bass Clip Threshold  3- · 58 

bass limiter meter  3- · 2 

Bass Limiting control  3- · 61 

bass threshold  3- · 38 

bounce  1- · 18 

breakpoint  3- · 57 

Brilliance control  3- · 42 

BS.1770 
algorithm  1- · 27 

LF accuracy · 74 

safety limiter  3- · 22 

threshold control  3- · 22 

BS.1770  1- · 10 
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BS.1770  3- · 67 

BS.1770 safety limiter  1- · 31 

bypass 
test mode  1- · 70 

Bypass mode  3- · 62 

C 

CALM Act  3- · 67 

CBS loudness controller   1- · 30 

CBS loudness meter 
long-term loudness  3- · 71 

CBS loudness meter  1- · 25 

CBS loudness meter  3- · 67 

CIDR format  2- · 9 

clipping  3- · 5 

clocks 
locking  1- · 16 

comfort range  3- · 76 

compression  3- · 5 

Compression Ratio controls  3- · 56 

compressor 
tutorial  3- · 25 

compressor gate  3- · 36 

computer 
connecting to  2- · 3 

connect menu  3- · 4 

connection 
cannot make  2- · 46 

control 
Loudness Attack  3- · 21 

Loudness Threshold  3- · 20 

control application · 1 
setting up  2- · 25 

control application  4- · 2 

control application  6- · 4 

control pane  3- · 3 

controls 
B1/B2 Crossover Slope  3- · 52 

Band Mix  3- · 55 

band on/off · 55 

breakpoint  3- · 57 

Compression Ratio  3- · 56 

Final Limit  3- · 59 

knee  3- · 57 

Less-More  3- · 26 

Loudness Threshold  3- · 58 

Mono Bass  3- · 52 

Multiband Attack  3- · 55 

subharmonic synthesizer  3- · 46 

Transient Enhance  3- · 60 

crossfade 
balancing loudness during  2- · 41 

D 

DC removal  3- · 13 

default port  2- · 55 

delay 
diversity  2- · 43 

managing input/output  1- · 40 

delay  6- · 1 

Delay Change Mode  2- · 27 

delta release control  3- · 56 

dialnorm 
and Loudness Controller  3- · 20 

and MB limiter drive  3- · 19 

re Loudness Level meter  1- · 28 

dialnorm  1- · 28 

dialnorm  3- · 2 

digital links  1- · 14 

distortion  2- · 48 

Distortion Control control  3- · 62 

diversity delay  2- · 43 

DJ Bass control  3- · 43 

Dolby Laboratories  3- · 68 

downward expander  3- · 52 

DSP block diagram  3- · 14 

dual microwave STLs  1- · 15 

dynamic processing 
tutorial  3- · 25 

E 

EBU R128  1- · 25 

EBU R128  3- · 67 

edit menu  3- · 4 

equalizer 
bass shelf  3- · 39 

control list  3- · 39 

parametric  3- · 41 

transmitter  1- · 19 

Equalizer 
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Bass Gain  3- · 39 

Bass Shelf Hinge Frequency  3- · 39 

Bass Slope  3- · 39 

Ethernet 
and terminal program  5- · 3 

crossover cable  5- · 4 

F 

factory presets 
creating custom  3- · 64 

tv  3- · 30, 31 

factory presets  1- · 31, 33 

features  1- · 7 

file 
setup  4- · 1 

file menu  3- · 4 

filter 
highpass  3- · 17 

lowpass  3- · 18 

Final Limit control  3- · 59 

Firewall 
NAT  2- · 56 

Firewall  2 · 53 

five-band 
band coupling controls  3- · 53 

delta release control  3- · 56 

downward expander thresold control  

3- · 52 

full modify control list  3- · 49 

limiter attack control  3- · 55 

multiband drive control  3- · 49 

multiband gate threshold control  3- · 

48, 51 

mutiband release control  3- · 50 

output mix controls  3- · 55 

five-band  3- · 48 

G 

gate 
threshold control  3- · 48, 51 

gate  3- · 36 

Gate indicators  3- · 2 

glitching 
CPU requirements  2- · 5 

H 

Hard Overshoot mode 
cannot be activated  2- · 45 

harshness  2- · 49 

HD controls 
importing  2- · 42 

HD Output Level 
setting  2- · 41 

headphones  1- · 41 

headroom 
in codecs  1- · 39 
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